Cornerstone May 2018 Release Notes
# Table of Contents

What's New for May 2018 .......................................................... 4
What's New for May ’18 .......................................................... 5
New and Enhanced Permissions for May ’18 Release ......................... 23
Master List of New Report Fields - May ’18 Release .......................... 27
Release Notes Updates for May ’18 Release .................................. 31
29 June Patch Release Functionality ............................................. 37
    What's New for the 29 June 2018 Patch Release ......................... 38
    Android Learn App ....................................................... 40
Document Management System Material Service .......................... 64
Duplicate Phone Number Check Enhancement ................................ 73
RTDW Updates to Reporting, API, and Data Explorer ....................... 74
18 May Patch Release Functionality ............................................ 76
    What's New for the 18 May 2018 Patch Release ......................... 77
    Add to Move to Requisition Logic Supported in Mobile-Friendly Workflow ................................. 79
    ADP WOTC Integration Changes ....................................... 81
    Form Approval Workflow ................................................ 82
    FTP Account Management - Password Reset .......................... 88
Hiring Manager Shortlist Summary Email Tag SSO Enhancement .......... 93
Historical Upload Tool (HUT) Retirement ................................... 94
Manage Events and Sessions - UI Enhancements ............................ 95
Applicant Profile Creation Terms of Service Checkbox ..................... 98
View People - Additional Fields ............................................. 99
1 June Patch Release Functionality ............................................ 100
    What's New for the 1 June 2018 Patch Release ......................... 101
    Engage - Manager Hierarchy View .................................... 103
    Form Approval Workflow ................................................ 108
    GDPR - Recruiting Ad Hoc Anonymization Support .................. 114
    Reporting API ............................................................ 115
Compensation ................................................................. 117
    Compensation Statement Decimal Precision .......................... 118
Custom Reports - Compensation Fields ..................................... 122
Employee Salary Management Modification History ....................... 126
Content ............................................................................... 134
Local Network Player - New Version - Overview .......................................................... 135
Core .............................................................................................................................. 137
End of IE10 Support .................................................................................................. 138
FTP Account Management - Password Reset ......................................................... 139
General Data Protection Regulation (GDPR) Readiness Program ......................... 144
Google Tag Manager Integration ............................................................................. 181
Historical Upload Tool (HUT) Retirement ................................................................. 182
Reporting 2.0 (Early Adopter) ................................................................................ 183
Secure Page Timeout ............................................................................................... 202
Cornerstone HR ........................................................................................................ 203
Form Approval Workflow ....................................................................................... 204
Edge ............................................................................................................................ 210
ADP Workforce Now (WFN) Core Data Inbound Integration On Demand Sync Enhancement .... 211
Custom Connectors - Tools for Developers ............................................................. 216
Edge Import - Employee Salary Load (Early Adopter) ............................................. 218
Employee API - Overview ....................................................................................... 236
Kronos OU Outbound Integration ......................................................................... 238
Engage ........................................................................................................................ 240
Engage - Manager Hierarchy View - Patch Item ...................................................... 241
Custom Reports - Engage ....................................................................................... 242
Learning ..................................................................................................................... 248
Attendance and Scoring Page Pagination ............................................................... 249
Auto Upgrade to Content Publishing Redesign with Online Course Versioning in 2019 .......................... 254
Certificate No Longer Available for Exempt Statuses ............................................ 255
Curriculum Assignment - Child Training Transcript History ................................ 256
Curriculum Creation with Pending Version – Validation Messages ...................... 263
Custom Reports - Learning .................................................................................... 265
Document Management System (DMS) Material Versioning Service .................. 281
Edit Availability in Course Console ......................................................................... 290
End Support of Microsoft Live Meeting ................................................................ 302
External Content ....................................................................................................... 303
Insights Home - Favorites ...................................................................................... 327
Learning Playlists .................................................................................................... 329
Training Removal Tool Enhancements .................................................................. 354
Performance ............................................................................................................ 358
Custom Reports - Development Plan Fields ............................................................ 359
Development Plans Redesign (Early Adopter) ........................................................ 361
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Suite Technology Update</td>
<td>418</td>
</tr>
<tr>
<td>Planning</td>
<td>419</td>
</tr>
<tr>
<td>Moving Positions (Seats) Enhancements</td>
<td>420</td>
</tr>
<tr>
<td>Planning Comments</td>
<td>426</td>
</tr>
<tr>
<td>Recruiting</td>
<td>430</td>
</tr>
<tr>
<td>Accept/Decline Offer Letter on Mobile Device</td>
<td>431</td>
</tr>
<tr>
<td>Add to Move to Requisition Logic Supported in Mobile-Friendly Workflow</td>
<td>435</td>
</tr>
<tr>
<td>Apply with LinkedIn (with Apply Starters)</td>
<td>437</td>
</tr>
<tr>
<td>Compliance Enhancements to Application Workflow</td>
<td>447</td>
</tr>
<tr>
<td>Custom Reports - Recruiting Fields</td>
<td>449</td>
</tr>
<tr>
<td>Hiring Manager Shortlist Summary Email Tag SSO Enhancement</td>
<td>450</td>
</tr>
<tr>
<td>Manage Candidates Early Adopter</td>
<td>451</td>
</tr>
<tr>
<td>Mobile-Friendly Candidate Experience Enhancements</td>
<td>467</td>
</tr>
<tr>
<td>Recruiting Suite Technology Update</td>
<td>487</td>
</tr>
<tr>
<td>Retirement of Apply with LinkedIn 1.0</td>
<td>488</td>
</tr>
<tr>
<td>Retirement of Mobile Optimized Career Site Support (August '18 Release)</td>
<td>489</td>
</tr>
<tr>
<td>Succession</td>
<td>490</td>
</tr>
<tr>
<td>Custom Reports - Succession Fields</td>
<td>491</td>
</tr>
<tr>
<td>View</td>
<td>493</td>
</tr>
<tr>
<td>Display Country Name on Org Chart Flyout</td>
<td>494</td>
</tr>
<tr>
<td>View People - Additional Fields</td>
<td>495</td>
</tr>
<tr>
<td>View People Enhancements</td>
<td>496</td>
</tr>
</tbody>
</table>
What's New for May 2018
What's New for May '18

The following release resources are available within Online Help:

- **Printable Release Notes** - This topic provides a printable version of all release notes content. See [Printable Release Notes](#).
- **New and Enhanced Permissions** - This topic provides a list of all permissions that are newly added or modified with this release. See [New and Enhanced Permissions for May '18 Release](#) on page 23 for additional information.
- **New Custom Reporting Fields** - This topic provides a list of all custom reporting fields that are newly added with this release. See [Master List of New Report Fields - May '18 Release](#) on page 27 for additional information.
- **Release Notes Updates** - This topic provides a complete list of all changes that have been made to the release notes. See [Release Notes Updates for May '18 Release](#) on page 31 for additional information.

Safe Harbor Statement: Any unreleased services or features referenced in this or other documents or public statements are not currently GENERALLY available and may not be delivered on time or at all. Customers who purchase Cornerstone OnDemand applications should make their purchase decisions based upon features that are currently available.

The following new features and enhancements are available for the May '18 release:

### Compensation Features

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compensation Statement Decimal Precision</td>
<td>Yes</td>
<td>With this enhancement, the following information can be configured for custom formula tags by administrators:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Decimal precision from one to four decimal points or the number of decimal places required by the employee’s currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Rounding Rules</td>
</tr>
<tr>
<td>Custom Reports - Compensation Fields</td>
<td>Yes</td>
<td>With this enhancement, administrators can report on approval workflows and current approvers using new fields available in the new Compensation Task Approval Workflow report field section in Custom Reports. These new fields allow administrators to improve organization during compensation tasks.</td>
</tr>
<tr>
<td>Edge Import -</td>
<td>In Stage portals, this is</td>
<td>With this enhancement, the Edge Import Employee Salary Load is now available to early adopters. This tool provides</td>
</tr>
</tbody>
</table>
### Core Features

<table>
<thead>
<tr>
<th>Feature Name</th>
<th>Automatically Enabled?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee API</td>
<td>Enable through Edge Marketplace</td>
<td>With the May '18 release, the Employee API is generally available, allowing administrators to manage employee records via User Administration, Data load Wizard, Reporting, and data feeds.</td>
</tr>
<tr>
<td>End of IE10</td>
<td>Yes</td>
<td>Cornerstone is retiring support for Microsoft Internet Explorer 10. To keep up with browser security requirements and the latest</td>
</tr>
<tr>
<td>FEATURE NAME</td>
<td>AUTOMATICALLY ENABLED?</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Support</td>
<td></td>
<td>software enhancements, support for Microsoft Internet Explorer 10 is discontinued with the May ‘18 Release. If you have not already done so, please reach out to your IT department to make plans to convert to one of the compatible browsers prior to the release.</td>
</tr>
<tr>
<td>FTP Account Management - Password Reset</td>
<td>Yes</td>
<td>With this enhancement, when an administrator needs to update their FTP account password, they can do so via self-service in the Cornerstone system, with new permissions. This allows administrators to quickly and securely reset FTP account passwords on their own.</td>
</tr>
<tr>
<td>General Data Protection Regulation (GDPR) Readiness Program</td>
<td>To request this functionality, submit a request to Global Product Support (GPS). Applicant anonymized via Compliance Enablement Preferences.</td>
<td>Cornerstone clients, particularly in the European Union, require the ability to anonymize/delete data associated with a user to ensure compliance with local and federal regulatory requirements, among which General Data Protection Regulation (GDPR) is the most prominent change. This can also have an impact on US clients with users in Europe who are covered by the related regulations.</td>
</tr>
<tr>
<td>Google Tag Manager Integration</td>
<td>Enable by request</td>
<td>With this enhancement, organizations can use the Google Tag Manager integration to deploy code snippets at their own convenience, without the intervention of Cornerstone’s development or services teams. The Google Tag Manager tool is separate from Google Analytics and can be used to set up code from any provider or source. Once the integration has been enabled in the Cornerstone system, administrators can add code snippets to system pages and track user behavior on those pages using the features available.</td>
</tr>
<tr>
<td>Historical Upload Tool</td>
<td>Yes</td>
<td>With the May ‘18 Release, Cornerstone no longer supports, and organizations no longer have access to, the Historical Upload Tool (HUT). HUT was a legacy tool used to upload</td>
</tr>
</tbody>
</table>
## Cornerstone May 2018 Release Notes: What's New for May 2018

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>(HUT) Retirement</td>
<td></td>
<td>Event/Session data and associate users to groups. Built prior to Data Load Wizard (DLW), the tool has seen declining/limited usage over time and is not enabled in newer portals. Organizations still using the HUT should contact their Client Success Manager to determine which solution will be most effective moving forward.</td>
</tr>
<tr>
<td>Reporting 2.0 (Early Adopter)</td>
<td>No, self-enabled</td>
<td>Reporting 2.0 is the new reporting tool for standard and custom reports. The new tool must be self-enabled and is intended to provide you with a simplistic and intuitive way to build and use reports. This is a powerful new engine that delivers a single application for creating reports. With the May '18 release, Recruiting and Performance are now supported along with the Learning, which was introduced as part of the February '18 release. In addition, scheduling and delivery are now available, as well as new sorting features and report sharing.</td>
</tr>
<tr>
<td>Secure Page Timeout</td>
<td>Yes</td>
<td>For security purposes, if a user has been idle for over 60 minutes (no mouse clicks or key presses), a session timeout message will appear at the top of certain pages.</td>
</tr>
</tbody>
</table>

### Content

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Network Player (New Version)</td>
<td>No. Download of new version required</td>
<td>With the May '18 release, a new version of the Local Network Player is available for download. This new version supports TLS 1.1 and TLS 1.2, providing increased security. The new version of Local Network Player must be downloaded in order to continue using the Local Network Player.</td>
</tr>
</tbody>
</table>

### Cornerstone HR

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Yes</td>
<td>With this enhancement, the <strong>Country</strong> field on the user flyout on</td>
</tr>
</tbody>
</table>
# Cornerstone May 2018 Release Notes: What's New for May 2018

<table>
<thead>
<tr>
<th>Feature Name</th>
<th>Automatically Enabled?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country Name on Org Chart Flyout</td>
<td></td>
<td>the Org Chart page will display the full name of the country instead of the ISO code. For example, prior to this enhancement, Sweden appeared as SWE. Following this enhancement, the country will be spelled out.</td>
</tr>
<tr>
<td>Edge Import - Employee Salary Load (Early Adopter)</td>
<td>In Stage portals, this is enabled for organizations using the Compensation or Cornerstone HR functionality and also the Data Load Wizard (DLW). In Pilot and Production portals, submit a case with Global Product Support (GPS).</td>
<td>With this enhancement, the Edge Import Employee Salary Load is now available to early adopters. This tool provides organizations with the ability to load employee salary data even if it includes custom wage types. Employee Salary Management Modification History, when enabled in a portal, is also updated using the Edge Import load. Both of these functions are not possible when using the Data Load Wizard (DLW). Cornerstone HR clients are also able to report on updates to the Employee Salary Management Modification History using the User Audit Report - Detailed standard report.</td>
</tr>
<tr>
<td>Employee API</td>
<td>Enable through Edge Marketplace</td>
<td>With the May '18 release, the Employee API is generally available, allowing administrators to manage employee records via User Administration, Data load Wizard, Reporting, and data feeds.</td>
</tr>
<tr>
<td>Employee Salary Management Modification History</td>
<td>No, to enable this functionality, submit a case to Global Product Support (GPS).</td>
<td>With this enhancement, organizations using Compensation or Cornerstone HR (CHR) that do not use Data Load Wizard or a custom feed to load their employee salary data can enable Employee Salary Modification History via a backend setting. Once enabled, the Employee Salary Management Modification History is updated whenever an employee salary is updated either through the system interface, compensation task completion, or via the new Edge Import - Employee Salary Load.</td>
</tr>
<tr>
<td>FEATURE NAME</td>
<td>AUTOMATICALLY ENABLED?</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Form Approval Workflow - Approve by Group or OU</td>
<td>Yes</td>
<td>This enhancement will be released as part of a post-release patch. With this enhancement, organizations can add a group or organizational unit (OU) to a form approval workflow. This enables more powerful employee and manager self-service capabilities through enhanced workflow configuration, which frees administrator time to work on other priorities.</td>
</tr>
<tr>
<td>Kronos OU Outbound Integration</td>
<td>Integration is available via the Edge Marketplace.</td>
<td>With this enhancement, the Kronos integration is enhanced to also sync organizational unit (OU) data from Cornerstone to Kronos. When an administrator adds or modifies an OU, changes are automatically sent to the corresponding Kronos entity.</td>
</tr>
</tbody>
</table>

### Edge Features

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
</table>
| ADP Workforce Now (WFN) Core Data Inbound Integration On Demand Sync Enhancement | Enable through Edge Marketplace | With this enhancement, the ADP Workforce Now (WFN) Core Data Inbound integration is enhanced to support:  
- On-Demand Full Sync  
- On-Demand Delta Sync |
<p>| Custom Connectors - | Publicly Available through Edge | With the May ’18 release, integration testing functionality for validating integration testing code is available in Edge, which allows developers to test their integrations without needing access to a Cornerstone portal. These testing tools are publicly |</p>
<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools for Developers</td>
<td>available in the API Explorer and do not require developers to have any permissions or login credentials.</td>
<td></td>
</tr>
<tr>
<td>Edge Import - Employee Salary Load (Early Adopter)</td>
<td>In Stage portals, this is enabled for organizations using the Compensation or Cornerstone HR functionality and also the Data Load Wizard (DLW). In Pilot and Production portals, submit a case with Global Product Support (GPS).</td>
<td>With this enhancement, the Edge Import Employee Salary Load is now available to early adopters. This tool provides organizations with the ability to load employee salary data even if it includes custom wage types. Employee Salary Management Modification History, when enabled in a portal, is also updated using the Edge Import load. Both of these functions are not possible when using the Data Load Wizard (DLW). Cornerstone HR clients are also able to report on updates to the Employee Salary Management Modification History using the User Audit Report - Detailed standard report.</td>
</tr>
<tr>
<td>Employee API</td>
<td>Enable through Edge Marketplace</td>
<td>With the May '18 release, the Employee API is generally available, allowing administrators to manage employee records via User Administration, Data load Wizard, Reporting, and data feeds.</td>
</tr>
<tr>
<td>Kronos OU Outbound Integration</td>
<td>Integration is available via the Edge Marketplace.</td>
<td>With this enhancement, the Kronos integration is enhanced to also sync organizational unit (OU) data from Cornerstone to Kronos. When an administrator adds or modifies an OU, changes are automatically sent to the corresponding Kronos entity.</td>
</tr>
<tr>
<td>Planning Data in Reporting API</td>
<td>Enable in Edge</td>
<td>With this enhancement, programmatic access to Planning data through Reporting API will allow planners to extract specific, valuable data from their headcounts plans.</td>
</tr>
</tbody>
</table>
### Engage Features

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Reports - Engage</td>
<td>Yes</td>
<td>With this enhancement, a new Engage Response custom report type is available. Users with associated permissions can create, share, schedule, and run reports that include individual Engage survey responses, to allow organizations to better use the data gathered with Engage.</td>
</tr>
<tr>
<td>Manager Hierarchy View</td>
<td>Yes</td>
<td>This enhancement was released in the June 1 patch. With the June 1, 2018 patch, users with the appropriate permission can view Engage results by manager, filter for specific managers, compare multiple managers, and traverse the reporting hierarchy to discover areas of opportunity within the organization.</td>
</tr>
</tbody>
</table>

### Learning Features

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attendance and Scoring Page Pagination</td>
<td>Yes</td>
<td>With this enhancement, the Attendance and Scoring page for ILT sessions is paginated, with a limited amount of data for the session displaying on each page. Administrators can navigate through pages of registered users, and each page will load without the system timing out, because the entire session's roster does not need to be processed at one time.</td>
</tr>
<tr>
<td>Auto Upgrade to Content Publishing Redesign with Online Course Versioning in 2019</td>
<td></td>
<td>In 2019, Cornerstone will retire the Course Publisher, and all portals will be automatically upgraded to the Content Uploader with Online Course Versioning, which was made generally available during the October '17 release. The exact date of the automatic upgrade is yet to be</td>
</tr>
<tr>
<td>FEATURE NAME</td>
<td>AUTOMATICALLY ENABLED?</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Activating the new Content Uploader and Online</td>
<td>Yes</td>
<td>Activating the new Content Uploader and Online Course Versioning functionality remains optional until 2019. When Course Publisher is retired, it will no longer be accessible in the system.</td>
</tr>
<tr>
<td>Certificate No Longer Available for Exempt</td>
<td>Yes</td>
<td>With this enhancement, users in an Exempt status for training with an associated certificate will NOT be able to access or print the learning certificate from any system location. When a user is in an Exempt status for a training item, the following features, as they relate to the exempted training, are not available to the user:</td>
</tr>
</tbody>
</table>
| statuses                                         |                        | o The View Certificate link is not available on the Transcript Details page for the training  
|                                                  |                        | o The certificate cannot be printed from the Assignment and Version History page for the training  
<p>| Curriculum Assignment - Child Training Transcript History | Yes                    | Following this enhancement, the transcript history for child LOs within a curriculum is mapped to the learning assignments used to assign the |</p>
<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
</table>
| Curriculum Creation with Pending Version – Validation Messages | Yes                    | With this enhancement, when a curriculum is created and a pending version is available, validation messages display to offer clarity on the behavior.  
Curriculum Transcript report type is available, allowing users to report on attributes related to curricula within learners' transcripts. The Curriculum Transcript report is comprised of several existing report sections as well as new sections which can be used to report on data related to curricula. **Note:** This new report must be used each time administrators want to report on data related to child training within a curriculum. Attempting to use other report types for this information will result in unexpected report results.  
A new Learning Playlist report is also available, allowing users to run reports on learning playlists and the new external content training type, which are both generally available with the May '18 release. |
| Custom Reports - Learning                        | Yes                    | With this enhancement, the following new custom report types are available:  
o A new custom Curriculum Transcript report type is available, allowing users to report on attributes related to curricula within learners' transcripts. The Curriculum Transcript report is comprised of several existing report sections as well as new sections which can be used to report on data related to curricula. **Note:** This new report must be used each time administrators want to report on data related to child training within a curriculum. Attempting to use other report types for this information will result in unexpected report results.  
o A new Learning Playlist report is also available, allowing users to run reports on learning playlists and the new external content training type, which are both generally available with the May '18 release. |
| Document Management System (DMS) Material Versioning Service | No                      | **This enhancement will be released as part of a post-release patch.**  
Document management systems (DMS) are electronic systems designed to manage, store, distribute, and archive documents. A DMS |
<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material Versioning Service</td>
<td></td>
<td>Material versioning service can be used to create and version material learning objects (LOs) in the learning management system (LMS), with links to those documents stored in the DMS, allowing learners to access DMS resources as material LOs in the LMS via URL links. A beta version of the DMS service was released in July 2016, and this service has been enhanced for the May 2018 release.</td>
</tr>
<tr>
<td>Edit Availability in Course Console</td>
<td>Yes</td>
<td>With this enhancement, learning content availability can be configured from the Course Console. This functionality is particularly beneficial when used in conjunction with Learning Playlist functionality, released in March 2018.</td>
</tr>
<tr>
<td>End of Microsoft Live Meeting Support</td>
<td>Yes</td>
<td>As of December 2017, Microsoft has discontinued Live Meeting, a virtual instructor-led training (vILT) integration. As a result, Cornerstone no longer supports the Live Meeting vILT integration.</td>
</tr>
<tr>
<td>External Content</td>
<td>Yes</td>
<td>With this enhancement, a new training type called &quot;external content&quot; can be created when building learning playlists, allowing playlist creators to not only include internal training in their playlists, but also content that exists outside the system, such as Youtube videos, books, training courses, and more. External content can be added to the learning transcript and completed like other training types, and its availability can be set via the Course Console. External</td>
</tr>
<tr>
<td>FEATURE NAME</td>
<td>AUTOMATICALLY ENABLED?</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>content items can be found within playlists, on Learner Home and Learning Search, and on the Global Search page. Certain external content information can also be reported on using Custom Reporting functionality.</td>
</tr>
<tr>
<td>Insights Home - Favorites</td>
<td>Yes</td>
<td>With this enhancement, you can now tag your favorite Insights and access them from a new Favorites section right at the top of the Insights homepage.</td>
</tr>
<tr>
<td>Learning Playlists</td>
<td>Yes</td>
<td>In March 2018, Learning Playlist functionality was released as part of an Early Adopter program. With the May 2018 release, Learning Playlist functionality has been enhanced in the following ways: o External content can be added to learning playlists (See External Content - Overview on page 303 for additional information.) o Data related to playlists is discoverable in reporting o Email digest options are available for playlists o Deep linking functionality can be used to share playlists o Information about the playlists a user has created and followed displays on the Learner Home page</td>
</tr>
<tr>
<td>Training Removal Tool Enhancements</td>
<td>Yes</td>
<td>With these Training Removal Tool enhancements, the Training Removal Tool uses consistent behaviors for removing event and session learning objects (LOs) from users’ transcripts, and payment refund logic has been redesigned to facilitate an intuitive,</td>
</tr>
</tbody>
</table>
### Performance Features

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Reports - Development Plan Fields</td>
<td>Yes, when redesigned Development Plans are enabled.</td>
<td>When Development Plans are created using the redesigned Development Plans, additional custom reporting fields are now available for development plans.</td>
</tr>
<tr>
<td>Development Plans Redesign (Early Adopter)</td>
<td>No, self-activated from the Corporate Preferences page.</td>
<td>With this Early Adopter feature, the Development Plan Experience is redesigned to focus on providing the essential functionality with a modern, responsive user interface (UI), while improving the infrastructure for faster performance. Development plans are now easier to use, with reduced time and effort to build and manage plans. The responsive design accommodates users on any platform. Machine learning is now integrated into the functionality to provide recommended learning to users as they create their development plan. In addition, attachments can now be added to plans.</td>
</tr>
<tr>
<td>Performance Suite Technology Update</td>
<td>In addition to the functionality your users work with every day, Cornerstone is also making valuable changes behind the scenes and has started moving to a microservices architecture to bring our clients increased stability, flexibility, long-term scalability, and innovation. First announced in October 2017, Cornerstone gradually has started building, updating, and hosting applications and functionality in Amazon Web Services (AWS) data centers. As part of this ongoing process, in the May '18 Release, we plan to begin moving Development Plans Redesign of Performance to AWS. Other functionality for various modules will be migrated over time without additional AWS announcements. For more information, please see the announcement in the</td>
<td></td>
</tr>
</tbody>
</table>
### Planning Features

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moving Positions (Seats) Enhancements</td>
<td>Yes</td>
<td>With this enhancement, planners can move positions to different managers within their organization at any month during plan period.</td>
</tr>
<tr>
<td>Planning Comments</td>
<td>Yes</td>
<td>With this enhancement, planners can provide qualitative commentary about their plans to others, enabling more seamless collaboration within the application.</td>
</tr>
</tbody>
</table>

### Recruiting Features

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept/Decline Offer Letter on Mobile Device</td>
<td>Yes</td>
<td>With this enhancement, applicants can now accept/decline offer letters via a mobile-friendly experience on the candidate’s My Profile page on the career site.</td>
</tr>
<tr>
<td>Add to Move to Requisition Logic Supported in Mobile-Friendly Workflow</td>
<td>Yes</td>
<td><em>This enhancement will be released as part of a post-release patch.</em> With this enhancement, when an applicant is added or moved to a new requisition and some but not all answers have been answered from the first requisition, the applicant will continue with the second application using the mobile-friendly candidate workflow. In addition, the applicant's previously answered questions will populate in the new mobile-friendly workflow.</td>
</tr>
<tr>
<td>Apply with LinkedIn</td>
<td>Enable in Edge</td>
<td>Apply with LinkedIn (with Apply Starters) is a plugin that you can implement on your career site, enabling candidates to apply with their LinkedIn profiles in the application workflow.</td>
</tr>
<tr>
<td>Feature Name</td>
<td>Automatically Enabled?</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>2.0 (with Apply Starters)</td>
<td>When applying with LinkedIn, a job seeker’s profile information instantly populates the resume fields and gets sent directly to the Applicant Tracking System (ATS) upon submission. This makes for a fast and easy candidate experience. Recruiters can easily view an applicant’s LinkedIn profile, getting access to valuable information that cannot always be found on a resume.</td>
<td></td>
</tr>
<tr>
<td>Compliance Enhancements to Application Workflow</td>
<td>Yes</td>
<td>To ensure GDPR and OFCCP compliance, this enhancement updates compliance in the application workflow for veteran status and the option to be searchable for other positions.</td>
</tr>
<tr>
<td>Custom Connectors - Tools for Developers</td>
<td>Publicly Available through Edge</td>
<td>With the May '18 release, integration testing functionality for validating integration testing code is available in Edge, which allows developers to test their integrations without needing access to a Cornerstone portal. These testing tools are publicly available in the API Explorer and do not require developers to have any permissions or login credentials.</td>
</tr>
<tr>
<td>Custom Reports – Recruiting Fields</td>
<td>Yes</td>
<td>With this enhancement, a new User-specific Comment field is added for Recruiting Custom Reports and Multi-Module Reports.</td>
</tr>
<tr>
<td>Hiring Manager Shortlist Summary Email Tag SSO Enhancement</td>
<td>This enhancement will be released as part of a post-release patch. For organizations that use SSO, the REVIEW.APPLICANT.RESUME.SUMMARY email tag will now be SSO enabled so that hiring managers do not have to log in to Cornerstone to review applicants. Many hiring managers do not log into Cornerstone on a daily basis, so needing to remember a new login only to review resumes is unnecessary.</td>
<td></td>
</tr>
<tr>
<td>Manage Candidates (Early Adopter)</td>
<td>No, self-enable</td>
<td>This enhancement will be released as part of a post-release patch. As part of a post-release patch, a new Manage Candidates page will be available for Recruiting. The Manage Candidates page redefines the recruiter experience by making it easier to</td>
</tr>
<tr>
<td>Feature Name</td>
<td>Automatically Enabled?</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>view resumes and change statuses in a visually appealing, responsive UI.</td>
</tr>
</tbody>
</table>
| Mobile-Friendly Candidate Experience Enhancements | Available after self-enablement | Mobile-Friendly Application Workflow – Custom Integrations  
Mobile-Friendly Application Workflow – Preview Workflow  
Mobile Friendly Career Sites – Custom Banner Image On Job Details Page  
Mobile-Friendly Career Sites – Social Sharing |
| Recruiting Suite Technology Update | In addition to the functionality your users work with every day, Cornerstone is also making valuable changes behind the scenes and has started moving to a microservices architecture to bring our clients increased stability, flexibility, long-term scalability, and innovation. First announced in October 2017, Cornerstone gradually has started building, updating, and hosting applications and functionality in Amazon Web Services (AWS) data centers. As part of this ongoing process, in the May ’18 Release, we plan to begin moving Manage Candidates of Recruiting to AWS. Other functionality for various modules will be migrated over time without additional AWS announcements.  
For more information, please see the announcement in the Success Center. |
| Retirement of Apply with LinkedIn 1.0 | LinkedIn is sun-setting their current version of Apply with LinkedIn by the end of 2018. Clients who have a LinkedIn Recruiter contract, or a LinkedIn corporate account with active LinkedIn job slots, can leverage the new Apply with LinkedIn 2.0. The new Apply with LinkedIn 2.0 will only be supported on mobile friendly workflows. |
| Retirement of Mobile Optimized Career Site Support (August) | Following the August ’18 Release, Cornerstone will remove the option "Enable Mobile Site" from the Standard Career Site. To create a mobile supported career site after the August ’18 Release, clients will need to create a Mobile-Friendly Career Site on the Career Site Management page. Mobile optimized career sites created prior to the August ’18 Release will be able to continue to be used but Cornerstone will no longer support fixing defects for mobile optimized career sites and when |
### Succession Features

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Reports - Succession Fields</td>
<td>Yes</td>
<td>With this enhancement, additional custom reporting fields are now available for succession metric calibration and resume data.</td>
</tr>
<tr>
<td>Display Country Name on Org Chart Flyout</td>
<td>Yes</td>
<td>With this enhancement, the Country field on the user flyout on the Org Chart page will display the full name of the country instead of the ISO code. For example, prior to this enhancement, Sweden appeared as SWE. Following this enhancement, the country will be spelled out.</td>
</tr>
</tbody>
</table>

### View

<table>
<thead>
<tr>
<th>FEATURE NAME</th>
<th>AUTOMATICALLY ENABLED?</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Country Name on Org Chart Flyout</td>
<td>Yes</td>
<td>With this enhancement, the Country field on the user flyout on the Org Chart page will display the full name of the country instead of the ISO code. For example, prior to this enhancement, Sweden appeared as SWE. Following this enhancement, the country will be spelled out.</td>
</tr>
<tr>
<td>View People - Additional Fields</td>
<td>Yes</td>
<td>As part of upcoming May and June 2018 patches, new field types can be added as Succession Metric filters and Career Preferences Attribute filters to View People Preferences. The new field types can then be used as filters on the View People page.</td>
</tr>
<tr>
<td>View People Enhance</td>
<td>Yes</td>
<td>This enhancement will be released as part of a post-release patch.</td>
</tr>
<tr>
<td>FEATURE NAME</td>
<td>AUTOMATICALLY ENABLED?</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Comments</td>
<td></td>
<td>With this enhancement, SSO support is added for the deep link that appears in the email when sharing lists from the My Lists page. This allows recipients of a shared list, who have availability to SSO, to access the list directly from the email without being prompted to manually log in to the portal. In addition, administrators can determine the click behavior of the user card. Prior to this enhancement, the user card opened the employee's profile within View People. With this enhancement, administrators can redirect to the employee's profile or a specific tab on their Universal Profile page.</td>
</tr>
</tbody>
</table>
New and Enhanced Permissions for May '18 Release

The following permissions have been added or updated with this release:

New Permissions

The following permissions are new for the May '18 release:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Core</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access FTP Account - View</td>
<td>Grants access to the FTP account landing page where the available accounts are displayed. Currently, this permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
<tr>
<td><strong>Reporting</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reporting - Delivery</td>
<td>Grants ability to deliver reports in Reporting 2.0. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Subordinates, and Employee Relationship.</td>
<td>Reporting</td>
</tr>
<tr>
<td></td>
<td>This permission is used in conjunction with the view permission for Reporting 2.0 and can also be used in conjunction with the various product, section, and field level permissions. Users must have permission to view Reporting 2.0 in order to have access to a report that is delivered to them. If they do not have view access, then the Reporting 2.0 navigation sublink will not display for them. Users who have permission to manage Reporting 2.0 can edit a report that is delivered to them. They can also copy the delivered report.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note about Constraints:</strong> The constraints for this permission determine who you can deliver the report to. The constraints do not pertain to the data you can see in the report.</td>
<td></td>
</tr>
<tr>
<td>Reset Password and Public Keys - Manage</td>
<td>Grants ability to manage FTP account login password and public keys when applicable. Currently, this permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>


## Cornerstone May 2018 Release Notes: What's New for May 2018

### Edge

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Edge Import</td>
<td>Grants access to the Edge Import tool, which enables administrators to load data into their portal. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Import - Load</td>
<td>Grants access to the employee salary data load via Edge Import. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge Import</td>
</tr>
<tr>
<td>Employee Salary</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Engage

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Engage Response Report - Create</td>
<td>Grants ability to create and edit custom Engage reports. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Direct Reports.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Engage Response Report - View</td>
<td>Grants ability to view results of custom Engage reports created by self or shared by others. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Direct Reports.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>

### Learning

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Playlist Reports - Create</td>
<td>Grants the ability to create and edit custom Playlist reports.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Playlist Report - View</td>
<td>Grants ability to view results of custom Playlist reports created by self or shared by others.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Transcript Reports - Create</td>
<td>Grants ability to create and edit Custom Transcript (Training Record) reports. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User's Direct Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Transcript</td>
<td>Grants ability to view results of Custom Transcript reports.</td>
<td>Reports -</td>
</tr>
</tbody>
</table>
Reports - View

(Training Record) reports created by self or shared by others. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User's Direct Subordinates.

DMS Status Preferences - Manage

Grants ability to enable and configure DMS status values, which appear on user's transcripts.

External Content - Create

Grants the ability to create external content. This permission can be constrained by OU or by aspects of the user. When a user creates external content, the availability is determined by the constraints of the permission. This is an end user permission.

Performance

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended Learning - View Recommended Learning for Others</td>
<td>Grants ability to view the recommended learning that is generated by machine learning for another user. The availability of this permission is controlled by a backend setting. This permission can be constrained by OU. This is a manager permission.</td>
<td>Performance</td>
</tr>
</tbody>
</table>

Enhanced/Updated Permissions

The following existing permissions are enhanced or updated for the May '18 release:

Performance

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plans - Manage</td>
<td>Grants ability to create, edit and manage development plans for self (and others depending on role and permissions). This is an end user permission. For organizations using the Redesigned Development Plans functionality, the Snapshot - Development Plans permission enables user to create, edit, and manage development plans. However, users must also have the &quot;Development Plans - Manage&quot; permission to create a development plan.</td>
<td>Performance</td>
</tr>
</tbody>
</table>
| MyTeam Development Plans | Grants ability for manager (or others depending on constraints) to view and manage progress of development plans via MyTeam and Talent Profile. Managers can also edit a subordinate’s development plan. This permission can be constrained by OU, User’s OU, User’s Direct Reports, User, and User Self and Subordinates. The permission constraints determine for which users the Dev Plans tab is available when viewing a user in My Team. Note: By design, for any My Team permission that is included in the Manager default security role, all of the manager’s direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role. Note: If the user’s permission is also constrained by User Self and Subordinates, then this overrides the User’s Direct Reports constraint.

For organizations using the Redesigned Development Plans functionality, this permission enables the user to access the Development Plans List page. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance</td>
<td></td>
</tr>
</tbody>
</table>
| Snapshot - Development Plans | Enables user to view the Development Plans widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User’s OU, User Self and Subordinates, User, User’s Self, User’s Manager, User’s Superiors, User’s Subordinates, User’s Direct Reports, and Employee Relationship. **Best Practice:** For most users, this permission should be constrained by User Self and Subordinates. 

For organizations using the Redesigned Development Plans functionality, this permission also grants the ability to create, edit, and manage development plans. In order to create a development plan, users must also have the Development Plans - Manage permission. |
| Universal Profile | |
Master List of New Report Fields - May '18 Release

This page provides the master list of new report fields for the May '18 release.

**Compensation**

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>SECTION</th>
<th>CUSTOM REPORT NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Condition Defined</td>
<td>Compensation Task Approval Workflow</td>
<td>Compensation Report</td>
</tr>
<tr>
<td>Approval Condition Met</td>
<td>Compensation Task Approval Workflow</td>
<td>Compensation Report</td>
</tr>
<tr>
<td>Approver Type</td>
<td>Compensation Task Approval Workflow</td>
<td>Compensation Report</td>
</tr>
<tr>
<td>Approver's First Name</td>
<td>Compensation Task Approval Workflow</td>
<td>Compensation Report</td>
</tr>
<tr>
<td>Approver's Last Name</td>
<td>Compensation Task Approval Workflow</td>
<td>Compensation Report</td>
</tr>
<tr>
<td>Approver's Step Number</td>
<td>Compensation Task Approval Workflow</td>
<td>Compensation Report</td>
</tr>
<tr>
<td>Approver's User ID</td>
<td>Compensation Task Approval Workflow</td>
<td>Compensation Report</td>
</tr>
<tr>
<td>Is Current Approver</td>
<td>Compensation Task Approval Workflow</td>
<td>Compensation Report</td>
</tr>
</tbody>
</table>

**Learning**

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>SECTION</th>
<th>CUSTOM REPORT NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course Code (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Created By (Name) (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Created By (UserID) (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Curriculum Section Title (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Curriculum Title (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Curriculum Version (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Keywords (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Language (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Last Modified By (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Last Modified By (UserID) (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>FIELD NAME</td>
<td>SECTION</td>
<td>CUSTOM REPORT NAME</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Last Modified Date (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Training Active (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Training Deactivation Date (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Training Description (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Training Object ID (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Training Purpose (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Training Status (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Training Subject (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Training Type (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Training Version Effective Date (Curriculum)</td>
<td>Curriculum</td>
<td>Curriculum Transcript Report</td>
</tr>
<tr>
<td>Transcript Status (From Curriculum)</td>
<td>Transcript</td>
<td>Curriculum Transcript Report, Transcript Report</td>
</tr>
<tr>
<td>Transcript Due Date (Curriculum)</td>
<td>Transcript</td>
<td>Curriculum Transcript Report, Transcript Report</td>
</tr>
<tr>
<td>Curriculum Latest Registration?</td>
<td>Transcript</td>
<td>Curriculum Transcript Report, Transcript Report</td>
</tr>
<tr>
<td>Created By (Name) (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Created By (User ID) (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Keyword (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Language (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Last Modified By (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Last Modified By (User ID) (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Last Modified Date (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Private Status (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Training Active (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Training Annotation (in Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Training Creation Date (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Training Date/Time Added (in Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Training Date/Time Modified (in Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
</tbody>
</table>
## What's New for May 2018

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>SECTION</th>
<th>CUSTOM REPORT NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training Description (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Training ID (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Training Object ID (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Training Order (in Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Training Status (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Training Title (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
<tr>
<td>Training Type (Playlist)</td>
<td>Playlist</td>
<td>Playlist Report</td>
</tr>
</tbody>
</table>

### Performance

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>SECTION</th>
<th>CUSTOM REPORT NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dev Plan Created by Full Name</td>
<td>Dev Plan</td>
<td>Development Plan Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Multi-Module Report</td>
</tr>
<tr>
<td>Dev Plan Created by User ID</td>
<td>Dev Plan</td>
<td>Development Plan Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Multi-Module Report</td>
</tr>
<tr>
<td>Dev Plan Template External ID</td>
<td>Dev Plan</td>
<td>Development Plan Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Multi-Module Report</td>
</tr>
<tr>
<td>Dev Plan Template Title at Plan Creation</td>
<td>Dev Plan</td>
<td>Development Plan Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Multi-Module Report</td>
</tr>
</tbody>
</table>

### Recruiting

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>SECTION</th>
<th>CUSTOM REPORT NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-specific Comment</td>
<td>Applicant</td>
<td>Recruiting Custom Reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Multi-Module Custom Reports</td>
</tr>
</tbody>
</table>

### Succession

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>SECTION</th>
<th>CUSTOM REPORT NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>[metric name] - Calibration Source</td>
<td>User Succession</td>
<td>Succession Report</td>
</tr>
<tr>
<td></td>
<td>Metrics and</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Successor</td>
<td></td>
</tr>
<tr>
<td>Resume Last Modified By</td>
<td>Resume</td>
<td>Resume Report</td>
</tr>
<tr>
<td>FIELD NAME</td>
<td>SECTION</td>
<td>CUSTOM REPORT NAME</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Resume Last Modified Date</td>
<td>Resume</td>
<td>Resume Report</td>
</tr>
</tbody>
</table>
# Release Notes Updates for May '18 Release

The following changes have been made to the release notes since they were initially published:

**Changes made on 1 June 2018:**

## Learning

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curriculum Assignment - Child Training Transcript History</td>
<td>Curriculum Assignment - Transcript History</td>
<td>Added additional information at the end of the topic about Transcript History behavior for previously existing learning assignments.</td>
</tr>
<tr>
<td>Form Approval Workflow</td>
<td>Form Approval Workflow - Overview</td>
<td>Added the following consideration: The OU/group enrollment is dynamic as applied to Forms Approval Workflows. Changes to the OU/group enrollment will dynamically update the users within the OU/group who can approve the form.</td>
</tr>
<tr>
<td>FTP Account Management - Password Reset</td>
<td>FTP Account Access - Passwords</td>
<td>Added the following note: <em>FTP password rules are enforced by the FTP service, Globalscape, and the Reset Password page’s password requirements reflect the password requirements configuration as set in Globalscape. The rules which display on your organization’s page may differ from what is shown in the screen shot below for this reason. Organizations may increase the complexity of their passwords as desired through Globalscape.</em></td>
</tr>
<tr>
<td>Manage Events and Sessions - UI Enhancements</td>
<td>Manage Events and Sessions - UI Enhancements</td>
<td>An additional project has been added to the May 18th patch. With this enhancement, updates have been made to the user interface (UI) of the Manage Events and Sessions page. These updates help clarify the purpose of different options on the Manage Events and Sessions page.</td>
</tr>
</tbody>
</table>

**Changes made on 6 May 2018:**
### Learning

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learning Playlists</td>
<td>Learning Playlists - Social Sharing</td>
<td>Added the following note: <strong>Note:</strong> Sharing functionality for playlists leverages existing Deep Linking functionality. In order for playlist sharing links to function correctly, your organization must ensure that the portals Deep Link base URLs are correctly configured. If your playlists are not generating functional links, ensure the Base URLs you have configured for Deep Links are correct. For more information about configuring Deep Links, see Deep Link Management.</td>
</tr>
</tbody>
</table>

*Changes made on 4 May 2018:*

### Core

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee API</td>
<td>Employee API - Overview</td>
<td>Updated Implementation section to indicate the Employee API is not available to all portals.</td>
</tr>
<tr>
<td>General Data Protection Regulation (GDPR) Readiness Program</td>
<td>General Data Protection Regulation (GDPR) Readiness Program</td>
<td>Rephrased a sentence in the introductory paragraph to address non-European clients. Previously, this sentence incorrectly only addressed United States (US) clients.</td>
</tr>
<tr>
<td>General Data Protection Regulation (GDPR) Readiness Program</td>
<td>General Data Protection Regulation (GDPR) Readiness Program</td>
<td>Updated the description of the User Based Removal scenario.</td>
</tr>
<tr>
<td>General Data Protection Regulation (GDPR) Readiness Program</td>
<td>General Data Protection Regulation (GDPR) Readiness Program</td>
<td>Corrected the Implementation instructions to guide clients to first speak with their Client Success Manager (CSM) as we offer different enablement paths depending on the complexity of your requirements. Once requirements are defined, a work order should then be submitted to Global Product Support (GPS) to enable the</td>
</tr>
</tbody>
</table>
## What's New for May 2018

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Data Protection Regulation (GDPR) Readiness Program</td>
<td>Effective Dated Record Anonymization User Record Anonymization</td>
<td>Updated the Original Hire Date and Last Hire Date values to reflect that they are set to 1/1/1901. Previously, this was listed as 1/1/1900.</td>
</tr>
<tr>
<td>General Data Protection Regulation (GDPR) Readiness Program</td>
<td>Universal Profile Data Deletion and Anonymization</td>
<td>Added information on how documents are impacted by user anonymization.</td>
</tr>
<tr>
<td>FTP Account Management - Password Reset</td>
<td>FTP Account Management - Password Reset and FTP Account Access - Passwords</td>
<td>Updated topics to state that the functionality will be available in Production in the first post release patch, and Account URLs display on the FTP Account Management page.</td>
</tr>
</tbody>
</table>

### Learning

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insights Home - Favorites</td>
<td>Insights Home - Favorites</td>
<td>This is a new enhancement for the May '18 release.</td>
</tr>
</tbody>
</table>

### Performance

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plans Redesign (Early Adopter)</td>
<td>Approve Development Plans</td>
<td>Added this as a new topic.</td>
</tr>
</tbody>
</table>

### Recruiting

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to Move to Requisition</td>
<td>Add to Move to</td>
<td>This enhancement is part of a post-</td>
</tr>
</tbody>
</table>
### Logic Supported in Mobile-Friendly Workflow
- **Requisition Logic Supported in Mobile-Friendly Workflow**
  - release patch and is being communicated with the May '18 release.

### Compliance Enhancements to Application Workflow
- **Compliance Enhancements to Application Workflow**
  - This is a new enhancement for the May '18 release.

### Custom Reports - Recruiting Fields
- **Custom Reports - Recruiting Fields**
  - Removed "Multi-Module Reports" language, as this enhancement is not available for Multi-Module custom reports.

Changes made on 20 April 2018:

#### Core

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure Page Timeout</td>
<td>Secure Page Timeout</td>
<td>Added the LCMS Sync and Smashfly Recruitment Marketing Integration pages.</td>
</tr>
<tr>
<td>FTP Account Management - Password Reset</td>
<td>FTP Account Management - Password Reset - Overview</td>
<td>Updated Implementation section to note that FTP Password Reset functionality will be available in the April 19th Stage deployment.</td>
</tr>
</tbody>
</table>

#### Edge

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Import - Employee Salary Load (Early Adopter)</td>
<td>Edge Import - Employee Salary Load (Early Adopter)</td>
<td>Added the Access Edge Import permission, which is required to access the Edge Import tool.</td>
</tr>
</tbody>
</table>
## ENHANCEMENT NAME
<table>
<thead>
<tr>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Manage Data Loads Create/Validate Data Load</td>
<td></td>
</tr>
</tbody>
</table>

### Learning

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curriculum Assignment - Child Training Transcript History</td>
<td>Curriculum Assignment - Child Training Transcript History</td>
<td>Updated title of second use case to &quot;Direct Subordinate or Approver Training Delivery.&quot;</td>
</tr>
<tr>
<td>Curriculum Creation with Pending Version – Validation Messages</td>
<td>Curriculum Creation with Pending Version – Validation Messages</td>
<td>Added new enhancement: With this enhancement, when a curriculum is created and a pending version is available, validation messages display to offer clarity on the behavior.</td>
</tr>
<tr>
<td>Edit Availability in Course Console</td>
<td>Activate and Deactivate Training from Course Console</td>
<td>New topic added to release notes to document the following additional new functionality: With this enhancement, learning objects (LOs) can be activated and deactivated from the Course Console page. Using the Active/Inactive toggle switch available on the Course Console, administrators can easily activate and deactivate an LO in the system.</td>
</tr>
<tr>
<td>Training Removal Tool Enhancements</td>
<td>Training Removal Tool Enhancements - FAQ</td>
<td>Added new topic with frequently-answered questions and answers related to the enhancement.</td>
</tr>
</tbody>
</table>
## Performance

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plans Redesign (Early Adopter)</td>
<td>Development Plan Title Email Tag</td>
<td>This is a new topic.</td>
</tr>
</tbody>
</table>

## Planning

<table>
<thead>
<tr>
<th>ENHANCEMENT NAME</th>
<th>NAME OF UPDATED TOPIC</th>
<th>PURPOSE OF CHANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning Data in Reporting API</td>
<td>Planning Data in Reporting API</td>
<td>This enhancement has been removed from the May ‘18 release.</td>
</tr>
</tbody>
</table>
29 June Patch Release Functionality
## What's New for the 29 June 2018 Patch Release

The following is released along with the 29 June 2018 patch release:

<table>
<thead>
<tr>
<th>MODULE</th>
<th>FEATURE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core</td>
<td><strong>RTDW Updates to Reporting, API, and Data Exporter</strong></td>
<td>Impacting only clients using Reporting API, Replicated Data Warehouse, and Data Exporter, the following Real-Time Data Warehouse categories will be impacted, deprecated, or may break applications, scripts, or functionalities that are based on earlier version of RTDW objects. Documentation that describes RTDW views and fields used in Custom Reports will be posted and updated the week of July 2 in the <strong>RTDW Documentation for Reporting API, RDW, and Data Exporter Community</strong>. Join and follow the community to be notified of new posts.</td>
</tr>
</tbody>
</table>
| Learning     | **Android Learn App**                                        | With this enhancement, a state-of-the art new Cornerstone Learn app is available for learners with Android devices. The Cornerstone Learn app provides learners with a fast, modern, and intuitive mobile learning experience. Using the Cornerstone Learn app, mobile learners can interact with the following learning features:  
  o Learner Home  
  o Learning Search  
  o Learning Transcript |
| Learning     | **Document Management System (DMS) Material Service**        | A beta version of the DMS service was released in July 2016, and this service was enhanced for the May 2018 release.  
  A beta version of the DMS service was released in July 2016, and this service was enhanced for the May 2018 release. The DMS material versioning service, with additional enhancements, is generally available to organizations using the Learning module with the June 29, 2018 patch. Please contact your Account Manager for more information. |
<p>| Recruiting   | <strong>Duplicate Phone Number Check Enhancement</strong>                 | With this enhancement, duplicate profiles will no longer be created on career sites when an applicant’s phone number has the same numerals as a phone number that is already associated with a |</p>
<table>
<thead>
<tr>
<th>MODULE</th>
<th>FEATURE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>profile</td>
<td></td>
</tr>
</tbody>
</table>
Android Learn App
Android Learn App - Overview
With this enhancement, a state-of-the-art new Cornerstone Learn app is available for learners with Android devices. The Cornerstone Learn app provides learners with a fast, modern, and intuitive mobile learning experience.

Using the Cornerstone Learn app, mobile learners can interact with the following learning features:
- Learner Home
- Learning Search
- Learning Transcript

Use Cases

Use Case 1: Log In
Laurence's Android phone displays content in French, but she works at a Santa Monica office, so her company's learning portal language is English. She just installed the Cornerstone Learn app and opens it, and the Log In screen is in French, like her device. She logs into the application with her credentials and receives a prompt to enable Touch ID, which she does.

Once Laurence has logged into the app, the app pages display to her in the display language set on her user record.

Use Case 2: Learner Home
John opens the Cornerstone Learn app on his Android, and the first thing he sees is his company's marketing banner. Below that, he sees a welcome message and his training metrics, which quickly show him the general status of training items on his transcript. When scrolling down the page, he sees carousels with training content recommended for him. The carousel order and availability respect the learning administrator's configurations, but the content itself is powered by machine learning. Because he can only see mobile training on the carousels, he can interact with all the training he sees by requesting, launching, and saving a training for later.

Use Case 3: Learning Search
Mike wants to find a course on leadership that he can take in less than fifteen minutes. He taps on the Search bar in his Cornerstone Learn app and taps Enter on his mobile keyboard. Because he ran a blank search, up to 50 mobile training items available to him display in search results. He taps on the filter icon and decides to filter for courses under fifteen minutes. He selects a subject filter as well, and twenty-three results are returned this time. On the search results page, he can see twenty-three mobile training items related to the Leadership subject that are shorter than fifteen minutes.

Use Case 4: Transcript
Mark visits the Transcript page of the Cornerstone Learn app, and the first thing he sees is the Continue Learning carousel, with the last course he opened in the first slot in the
carousel. Scrolling down, he sees all the active mobile-enabled training on his transcript. He can launch items, mark items complete, and view the Training Details pages for training items. After completing training, he can view completed training items on the Completed transcript page in the application.

Considerations

- The Cornerstone Learn app was also released for iOS devices in February 2018.
- Access to the app and all pages inside it is controlled by the Enable Mobile Access checkbox on the Mobile Preferences page. Any users included in an organizational unit (OU) configured to allow mobile access can navigate to any page in the app, even if they do not have permission to access the desktop version of these pages. See Mobile Preferences for more information about setting Mobile Preferences.
- Only online courses, materials, and videos can be launched inside the app. Items that are not mobile-enabled are hidden by default, but the user can choose to see them by toggling the Mobile switch to the Off position in the app settings. Note: Because curricula are not currently supported by the app, supported learning types cannot be accessed within the app when assigned within a curriculum.

Implementation

This functionality is automatically available for all organizations using the Learning module.

Permissions

The following existing permission applies to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile Preferences</td>
<td>Grants ability to manage Mobile Preferences. This permission cannot be constrained.</td>
<td>Mobile</td>
</tr>
</tbody>
</table>
Android Learn App - Log In

Mobile learners can log into the Cornerstone Learn app using either of the following methods, if available:

- System Credentials
- SSO

To access the Log In screen for the app, launch the Cornerstone Learn app from your device.
**System Credentials**

To log into the app using system credentials:

1. Populate the following fields:
   - **Portal** - The name of your organization's learning portal (If the portal field is wrong, the user receives an error status explaining that it could not be found)
   - **Username** - Your username for your organization's learning portal
   - **Password** - Your password for your organization's learning portal

2. After populating the above fields, tap the **LOG IN** button. If the credentials are correct, you are authenticated and are granted access to the app. If the credentials are incorrect or an error occurs, an error message displays and you can attempt to re-enter your credentials.

*Note:* The **LOG IN** button is disabled until all required fields are populated.

**SSO Sign On**

If SSO functionality is enabled, users can log into the application via SSO either by using their portal log-in information or by registering their device from the Mobile Devices tab in My Account. See My Account - Devices for additional information about registering your device.

To access the SSO Sign On page on the app, swipe the Credentials login page to the left. Then, populate the following fields:

- **Portal** - The name of your organization's learning portal
- **Username** - Your username for your organization's learning portal

After populating the required fields, tap the **LOG IN** button. If the SSO authentication is successful, you are granted access to the application. If the credentials are incorrect or an error occurs, an error message displays and you can attempt to re-enter your credentials.

*Note:* The **LOG IN** button is disabled until all required fields are populated.

*Note:* The SSO page is visible even for organizations that do not support SSO.
Language Considerations
The Android Learn app displays to users in the display language specified in the user record. The Android Learn app does NOT default to the display language of the device.
Android Learn App - Learner Home

The Learner Home page functions as the landing page for the Cornerstone Learn app, allowing mobile learners to browse for and request relevant training, search and filter for specific training, and prioritize mandatory training. The Learner Home includes several features which enable learners to easily select subjects of interest, discover training based on machine learning, and quickly access and request new training.

To access Learner Home on the app, log into the Cornerstone Learn app. To navigate back to the Learner Home after navigating to other pages, click the Options icon in the upper-left corner of the screen, then click the Home option.

Note: The permission to access Learner Home is NOT required in order to access this page in the app.
Search

The Search bar can be opened at the top of the Learner Home page by clicking the Search icon, and allows users to search for training. See Android Learn App - Search Training.

Welcome Banner

Across the top of the page, a carousel of banners created by the learning administrator display to the mobile learner. The carousel cycles through all available banners. Note: No buttons can display in the mobile version of Learner Home banners.

Below the banner carousel, the message, "Welcome to your Learner Home, [User]" displays if the user is accessing the page for the first time. The message, "Welcome back,
"[User]" displays if the user has previously accessed the page. These welcome messages display the user’s name as it appears in their user record.

**Training Metrics**

In the Training Metrics section, the following information about training on the user’s transcript displays:

- **Training Past Due** - This field displays the number of training items on the user’s transcript which have due dates that have passed.
- **Training Due Soon** - This field displays the number of training items on the user’s transcript that are due within the next ten days.
- **Assigned Training** - This field displays the number of training items on the user’s transcript that have been assigned without a due date.

**Training Carousels**

Below the welcome message, several different carousels of training may display to the user if applicable training is available and the learning administrator has enabled the carousel via Learner Home Preferences. Each carousel provides relevant training recommendations to learners, and learners can page through the carousel to see all recommendations.

*Note: Only mobile-enabled training displays in the training carousels on the app, unless the user has not opted to enable the Only Show Mobile Training option on the Settings page of the app.*

*Note: Not all the carousels available on the desktop version of Learner Home are available on the mobile version of Learner Home.*
Each training tile displays with its associated thumbnail image, training type, and training title.

<table>
<thead>
<tr>
<th>CAROUSEL</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continue Learning</td>
<td>This section displays training that is on the user’s active transcript. Training in this section is sorted by the last transcript status change date, and a maximum of 20 training items can display in the section. If no training is on the user’s active transcript, this section is hidden. <strong>Note:</strong> The last transcript status change date is a date field that tracks when a training moves from one transcript status to another transcript status.</td>
</tr>
<tr>
<td>Saved for Later</td>
<td>This section displays training that has been saved by the user. Training in this section is sorted by most recently saved first, and there is no limit on the number of training items that can display in this section. If the user has not saved any training, this section is hidden. If any of the user's saved training has been made inactive or unavailable, that training is removed from the section automatically. <strong>Note:</strong> This section displays the most recent version of the saved training. For example, if the user saved Leadership Skills (Version 1), and Leadership Skills (Version 2) has since been published, Version 2 of the training displays for the user in this section.</td>
</tr>
</tbody>
</table>
| Top Picks for User     | This section displays training that is recommended to the user based on their training history. Training in this section is sorted by relevancy to the user (determined by machine learning), and a maximum of 20 training items can display in this section. If no recommendation results are found for the user, the system considers the training history of users in the user's position, division, and location, and then neighboring positions, divisions, and locations in the hierarchy to find recommendations. This section is hidden if any of the following are true:  
  o The backend setting for machine learning course recommendations is not enabled.  
  o No recommendation results are found for the user.  
  o An error occurs.  |
| Trending for Your Position | This section displays training that is recommended to the user based on their position. Training in this section is sorted by relevancy to the user (determined by machine learning), and a maximum of 20 items can display in this section. If no recommendations are found for the user's position, then the system considers the user's division and location, then neighboring positions, divisions, and locations in the hierarchy to find recommendations. This section is hidden if any of the following are true:  
  o The backend setting for machine learning course recommendations is not enabled.  
  o No recommendation results are found for the user.  
  o An error occurs.  |
CAROUSEL | DETAILS
--- | ---
is not enabled.  
o No recommendation results are found for the user.  
o An error occurs.

Inspired by Your Subjects | This section displays training that is recommended to the user based on subjects in which the user has indicated interest. See Learner Home - Subjects. Training in this section is sorted by relevancy to the user (determined by machine learning), and a maximum of 20 items can display in the section. If the user has not selected any subjects, then the section displays a prompt for the user to add subjects. If no recommendations are found for the user’s selected subjects, the system considers the user’s division and location, then neighboring positions, divisions, and locations in the hierarchy to find recommendations. This section is hidden if any of the following are true:  
o The backend setting for machine learning course recommendations is not enabled.  
o No recommendation results are found for the user.  
o An error occurs.

Most Popular | This section displays training that was requested the most number of times in the last 60 days. Training in this section is sorted by the highest number of requests, and a maximum of 20 items can display in the section. If no training has been requested in the last 60 days, this section is hidden.

Training Tile Actions
When a learner taps on a training tile, they are navigated to the Training Details page for that training. When a learner taps the Options icon for a training item, different actions are available depending on whether or not the training is on the user’s transcript, what type of training it is, and what status the training is currently in.
The following options may be available for training items that are already on the learner’s transcript:

- **Primary Transcript Action** - The current primary action on the user’s transcript for the specific training item displays as the top option. For example, if the primary training action is Launch, the user can tap **Launch** to open the training. **Note:** Only online courses, materials, and videos can be launched from a carousel on the mobile version of Learner Home.

- **Secondary Transcript Actions** - Any other transcript actions available to the user for the training item appear in the list of options and allow the user to perform the associated action on the training. See **Transcript (Universal Profile) - Status and Options for all available actions**. **Note:** Tapping some transcript actions causes the user to be redirected to their learning transcript.
See Details - Tap this option to access the Training Details page for the training item.

Save for Later (if available) - Tap this option to save the training item. Saved training items display in the Saved for Later section on the Learner Home. Any training item available to the user or on their transcript can be saved except for certifications, and there is no limit on the number of items which can be saved.

Remove from Saved (if available) - This option is only available if the training has already been saved by the user. Tap this link to remove the training item from the Saved for Later section.

The following options may be available for training items that are NOT already on the learner's transcript:

Launch (if available) - Tap this option to launch the training. This opens the training and adds the training item to the user's transcript. **Note: Only online courses, materials, and videos can be launched from a carousel on the mobile version of Learner Home.**

Request (if available) - Tap this option to request the training. This adds the training item to the user's transcript. The page will then refresh to the transcript.

See Details - Tap this option to access the Training Details page for the training item.

Save for Later (if available) - Tap this option to save the training item. Saved training items display in the Saved for Later carousel on the Learner Home page. Any training item available to the user or on their transcript can be saved except for certifications, and there is no limit on the number of items which can be saved.

Remove from Saved (if available) - This option is only available if the training has already been saved by the user. Tap this link to remove the training item from the Saved for Later section.
Android Learn App - Search Training

At the top of every page in the Cornerstone Learn app, a Search icon allows users to open a search box and search for specific learning using powerful search technology. Users can enter words relating to the following training attributes into the search box to receive relevant training results that are sorted by relevance:

- Title
- Keywords
- Description

To search for training, click the Search icon in the upper-right corner of the screen. A search bar appears.

**Note:** The permission to access Learner Home is NOT required in order to access Learning Search in the app.
Search Training

To search for training in the Cornerstone Learn app:

1. Enter a search term or phrase into the search box and press the Enter key on your phone keyboard. A maximum of 50 search results can be returned.
2. Peruse the results which display on the Learning Search page and use the available filters to receive more specific training results, if necessary. Search results are separated into two sections: In Your Transcript, which shows relevant training results which are already on your transcript, and Available, which shows training that is available to you and not already on your transcript. In each section, search results are sorted by relevance, and text queries are matched with content title, descriptions, and keywords.
Each training result displays with a thumbnail image, the training type, the title of the training, and the duration, if applicable. If the training is on the user's transcript, the status of the training item displays under the training title. Tap a training result to access the Training Details page for the training.

If the training is already on the user's transcript, and the training is an online course, material, or video, a play icon displays over the training's thumbnail image, and tapping the training thumbnail image launches the training. Training that is on the user's transcript can also be launched by tapping the Play icon over the training's thumbnail image or by navigating to the Training Details page for the item.

**Training Options**

Tap on the training item to access the Training Details page for the item. Training Details page provides access to information and options available for the training item.
The following options may be available, depending on the training type and the current status of the training:

- **Primary Transcript Action** - The current primary action on the user’s transcript for the specific training item displays in the menu. For example, if the primary training action is Launch, the user can tap **Launch** to open the training.

- **Secondary Transcript Actions** - Any other transcript actions available to the user for the training item appear in the list of options and allow the user to perform the associated action on the training. *See Transcript (Universal Profile) - Status and Options for all available actions*. **Note:** Tapping some transcript actions causes the user to be redirected to their learning transcript.
- **Save for Later** - Tap this option to add the training to the Saved for Later carousel on Learner Home. This option is only available if the training is NOT currently contained in the Saved for Later carousel.

- **Remove from Saved** - Tap this option to remove the training item from the Saved for Later carousel on Learner Home. This option is only available if the training is currently contained in the Saved for Later carousel.

**Filters**

Users can filter the training results that appear by clicking the Filter icon in the upper-right corner of the search results page. The following filters are available:

- Training Type
- Duration
- Subject
- Language

To apply a filter to your training search results, toggle a filter option to the On position or select a filter option from the drop-down, depending on the filter type. The blue button at the bottom of the screen displays text stating, "See [X] Results," X being the number of search results which meet the currently selected search criteria and search filters.

View the table below for more information about the available filters:

<table>
<thead>
<tr>
<th>FILTER</th>
<th>SELECTION TYPE</th>
<th>OPTIONS</th>
<th>ADDITIONAL NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training Type</td>
<td>Multi-select toggles</td>
<td>o Curriculum</td>
<td>Type options display based on the entered search terms, meaning that if, for example, no curricula meet the user's search criteria, the Curriculum filter option does not display.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Event</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Library</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Material</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Online Class</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Program</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Quick Course</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Test</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Video</td>
<td></td>
</tr>
<tr>
<td>Duration</td>
<td>Drop-down menu</td>
<td>o Any Duration (default)</td>
<td>Duration options display based on the entered search terms, meaning that if no training that meets a user's search criteria has a duration of greater than two hours, then the 2+ hours filter option doesn't display.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o &lt; 15 minutes</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o &lt; 30 minutes</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o &lt; 1 hour</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o &lt; 2 hours</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o 2+ hours</td>
<td></td>
</tr>
<tr>
<td>FILTER</td>
<td>SELECTION TYPE</td>
<td>OPTIONS</td>
<td>ADDITIONAL NOTES</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subject</td>
<td>Multi-select toggles</td>
<td>The top ten subjects related to the search result display, all unselected by default</td>
<td>If no training that meets the user's search criteria has an associated subject, the subject filter does not display.</td>
</tr>
<tr>
<td>Language</td>
<td>Multi-select toggles</td>
<td>Languages related to the search results display alphabetically, all unselected by default</td>
<td>Language options display based off the text query (e.g. if no training returned in the results has an Available Language of 'Spanish', then 'Spanish' wouldn't display as a language option). The language filter will not display if only 1 language matches the training returned in the results (e.g. all training returned in the results has a language of 'English (US)', then the language filter won't display). When many, many languages are displayed, a scroll-bar will appear within the section.</td>
</tr>
</tbody>
</table>

To remove all filters from the search, tap the **Reset** link in the upper-right corner of the screen.

To exit the filters panel, click the X icon in the upper-left corner of the screen.
Android Learn App - Transcript

On the Transcript page of the Cornerstone Learn app, mobile learners can access both their active and completed transcript pages, launch certain types of training, and view information about the training on their transcripts. **Note:** Only mobile-enabled training items that have been assigned to or requested by the user display on the Cornerstone Learn app transcript by default.

To access the Transcript page of the app, tap the Menu icon in the upper-left corner of the screen and then tap the **Transcript** link.

Continue Learning

The Continue Learning carousel on the Active transcript page displays training that is already on the user's transcript. Training in the carousel is sorted by the last transcript status change date, and a maximum of 20 training items can display in the section. If no training is on the user’s active transcript, this section is hidden. **Note:** The last transcript status change date is a date field that tracks when a training moves from one transcript status to another transcript status.

Each training tile displays with its associated thumbnail image, training type, and training title. For more information about interacting with training carousels and training tiles, see **Android Learn App - Learner Home**.
**Active Transcript**

On the Active transcript page, training that has been assigned to the user but not yet completed displays in order of earliest due date to latest, with the following information for each item:

- Thumbnail image
- Training type
- Training Title
- Transcript Status
- Duration (if available)

If the training is an online course, video, or material, a Play icon displays over the thumbnail image for the training. Tap the Play icon to launch the training.

Tap the arrow to the right of the training result to access the Training Details page for the training. If the training is an online course, video, or material, the training can also be launched from the Training Details page by tapping the Play icon.

*Note:* *Online courses, videos, and materials CANNOT be launched from within curricula via the Learning App.*

**Completed Transcript**

To access the Completed transcript page, swipe the Completed tab. Training the user has completed displays on the Completed transcript page with the following information:

- Thumbnail image
- Training type
- Training Title
- Completed Status
- Duration (if available)

If the training is an online course, video, or material, a Play icon displays over the thumbnail image for the training. Tap the Play icon to launch the training.

Tap the arrow to the right of the training result to access the Training Details page for the training. If the training is an online course, video, or material, the training can also be launched from the Training Details page by tapping the Play icon.

*Note:* *Online courses, videos, and materials CANNOT be launched from within curricula via the Learning App.*

**Transcript Actions**

A Play icon displays over the thumbnail image for a training item if it can be launched from the Learning app. Tap the play icon to launch the training. You can also tap the training tile to access the Training Details page for the training, where additional options may be available depending on the training type and status of the training.
Android Learn App - Settings

The Settings page of the Learning App allows mobile learners to:

- Log out of the Learning App.
- Choose to see non mobile-enabled training in the app

Access the Settings page by tapping the menu icon in the upper-left corner of the screen and then selecting the **Settings** option.
Only Show Mobile Training
To see all available training in the app, including training that is not mobile-enabled, toggle the Only Show Mobile Training switch to the Off position. This selection will be saved for future log ins.

Log Out
To log out of the Learning App, tap the Log Out link. You will be logged out of the application and redirected to the Log In screen.
Document Management System Material Service
Document Management System Material Versioning Service

Document management systems (DMS) are electronic systems designed to manage, store, distribute, and archive documents. A DMS material versioning service can be used to create and version material learning objects (LOs) in the learning management system (LMS), with links to those documents stored in the DMS, allowing learners to access DMS resources as material LOs in the LMS via URL links.

A beta version of the DMS service was released in July 2016, and this service was enhanced for the May 2018 release.

The DMS material versioning service, with the enhancements documented in the below section, is generally available to organizations using the Learning module with the June 29, 2018 patch. Please contact your Account Manager for more information.

Original Version of DMS Material Versioning Service

The original version of the DMS material service supported the following actions:

- Create materials (URL source only), with the following metadata supported:
  - Title
  - Material Type
  - Provider
  - Description
  - Material Source
  - Effective Date
  - Start Date

- Version Materials

Note: DMS-sourced material cannot be versioned through the user interface.

- Assign reversioned materials to users who meet dynamic learning assignment criteria (This includes users with a status of Not Started, In Progress, and Completed. This cannot be changed.)
- Trigger curriculum reversion
- Assign curriculum reversioned as a result of a versioned material to users who meet dynamic learning assignment criteria
- Track DMS material versioning via Modification History in the LMS

Updates to DMS Material Service

With the June 28, 2018 release, the existing features listed above continue to be available, and the following additional features are supported by the DMS material service:

- A new field can be used to display whether the reversioned material is Released, Effective, or Obsolete (this field is reportable)
- A new preference allows administrators to customize the DMS status field
Cornerstone May 2018 Release Notes: What's New for May 2018

- Material LO metadata can be edited via the DMS without triggering a new version of the material
- Custom fields can be edited via the DMS
- The DMS can be used to deactivate initial versions of materials
- Effective dates can be set for initial versions of materials
- Start Dates can be set for initial versions of materials
- A new Training Version is Effective email trigger is available

**Implementation**

For existing DMS material service users:
- Contact Cornerstone if you wish to receive the benefits of any new enhancements:
  - Even if no change is needed, organizations should still plan to test the updated service. The timeline of this testing period can be customized.
  - If change is needed, organizations must plan for regression and new feature tests. The timeline of this process can be customized.
- When custom scripts have been upgraded and testing has been completed in Pilot, the enhanced DMS material versioning service can be upgraded in Production portals.
- Until an organization is migrated to the enhanced DMS service, their original integration will continue to work without interruption.

For non-DMS material service users:
- With the June 29, 2018 patch, the updated version of the DMS material service will be generally available. Please contact your Account Manager to build a custom project for your organization, if needed.

**Permissions**

The following new permission applies to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMS Status Preferences - Manage</td>
<td>Grants ability to enable and configure DMS status values, which appear on user’s transcripts.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>
DMS - Status Field

With the June 29, 2018 release, a **DMS Status** field displays on the Training Details page for materials when an organization is using a DMS service. The **DMS Status** field displays the current version status of the DMS material. Available statuses include:

- **Released** - The material version is available in the system, but is not yet the current version.
- **Effective** - The material version is available in the system and is the current version which allows learners to maintain compliance.
- **Obsolete** - The End Date of the version has passed, and the material version is no longer the current version.

The **DMS Status** field is reportable, allowing organizations to ensure learners have completed the current effective version of the material. A new DMS Status field is added to the Training section available in Custom Reporting:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMS Status</td>
<td>Text</td>
<td>This field displays the value of a Document Management System (DMS)-sourced material status, if enabled. Possible values include: Released, Effective, Obsolete. This field is available in the Training section of the following custom report types: Assignment Report, Certification Report, Evaluation Report, Multi-Module Report, Training Report, Transcript Report, Training Plan Report</td>
</tr>
</tbody>
</table>

*Note: A new preference page allows administrators to customize the values of the DMS Status field. See **DMS Status Preferences** on page 285 for additional information.*
DMS Status Preferences

Administrators can enable and customize the values of the DMS Status field via the DMS Status Preferences page. DMS Status values, if enabled, can appear to learners on their transcripts, so organizations may wish to customize these values.

To set DMS Status Preferences, go to **ADMIN > TOOLS > LEARNING > LEARNING PREFERENCES** and click the **DMS Status Preferences** link.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMS Status Preferences - Manage</td>
<td>Grants ability to enable and configure DMS status values, which appear on user's transcripts.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>

DMS Status Preferences

The **DMS Status** field is disabled by default. To enable the **DMS Status** field, toggle the **Enable the DMS Status field on Transcript** switch to the On (green) position. When this field is enabled, users will see this field and its related values for DMS-sourced materials on their transcripts. Organizations can customize the values to reflect their own DMS values. After enabling the **DMS status** field, the DMS Status Preferences page refreshes to display additional options:

- **When Start Date is not reached** - In this field, enter a word which will be used to indicate that the Start Date for a DMS-sourced material has not yet been reached. This field defaults to a value of **Released**.
o **When Start Date is reached** - In this field, enter a word which will be used to indicate that the Start Date for a DMS-sourced material has been reached. This field defaults to a value of **Effective**.

o **When End Date is reached** - In this field, enter a word which will be used to indicate that the End Date for a DMS-sourced material has been reached. This field defaults to a value of **Obsolete**.

To reset the fields to their default values, you can click the **Reset Fields** link.

**Save**

To save any changes made to DMS Status Preferences, click the **SAVE** button at the bottom of the page, or click the **CANCEL** button to discard any changes without saving.
DMS - Version Behavior

With the June 29, 2018 patch, Effective Dates and Start Dates can be provided for DMS-sourced material versions, allowing versions to be automatically released, made effective, and deactivated as the relevant dates pass. These new fields are also available in the Transcript section of Custom Reports, allowing administrators to quickly report on which users have a DMS-sourced material in an Effective status that has not yet been completed.

- When the Effective Date for a DMS-sourced material version passes, the material version has a status of Effective. **Note: Materials with an Effective Date set in the future are labeled as Pending Version in the Course Catalog and are not available for users to search for in the system.**
- When the Start Date for a DMS-sourced material version passes, the material version has a status of Released. The material is available to search for and request in the system, and is the current version of the material.
- When the End Date for a material version passes, the material version is automatically deactivated and has a status of Obsolete.

*See DMS - Status Field* on page 284 for additional information.
DMS - Training Version is Effective (DMS) Email Trigger

With the June 29, 2018 patch, a new Training Version is Effective (DMS) email trigger is available in Email Administration. The Training Version is Effective (DMS) email trigger is triggered when the Start Date of the material version is reached and the training becomes effective. **Start Date** is an Append Versioning option. This email trigger is applicable to all materials, whether DMS-sourced or created via the learning management system (LMS).

This new email trigger enables organizations to increase compliance and training completion by sending automatic emails a specified number of days before the training becomes effective.

See the following resources for Email Administration and creating emails:

- Email Administration
- Email - Create
DMS - Custom Fields

With the June 29, 2018 patch, the DMS material service will support the creation and update of the following custom field types:

- Localized Short Text Box
- Localized Scrolling Text Box
- Date Field
- Drop-down
- Multiple Choice Checkbox
- Checkbox
- Numeric Fields
Duplicate Phone Number Check Enhancement

With this enhancement, duplicate profiles will no longer be created on career sites when an applicant's phone number has the same numerals as a phone number that is already associated with a profile.

Prior to this enhancement, duplicate profiles could be created when an applicant used the same numerals in their phone number but included special characters between the digits, (e.g., 555-555-5555 or 555.555.5555). Now, special characters will be ignored in phone numbers when comparing for duplicate applicants.

Use Case

1. A candidate applies to two different jobs on Acme’s career site.
2. For the first job, she creates a profile and includes 555-555-5555 as her phone number.
3. For the second job, she cannot remember if she already created a profile on Acme’s career site, so she attempts to create a new one.
4. When creating her profile a second time, she uses the phone number (555) 555-5555.
5. She clicks CREATE PROFILE.
6. She is redirected to the Forgot Password page to log in to her existing profile.

Note: If an applicant cannot remember their login credentials, they can manually click Forgot Password on the Create a Profile page to reset their password.

Implementation

This functionality is automatically available for all organizations using Recruiting.
**RTDW Updates to Reporting, API, and Data Exporter**

Impacting only clients using Reporting API, Replicated Data Warehouse, and Data Exporter, the following Real-Time Data Warehouse categories will be impacted, deprecated, or may break applications, scripts, or functionalities that are based on earlier version of RTDW objects.

Documentation that describes RTDW views and fields used in Custom Reports will be posted and updated the week of July 2 in the [RTDW Documentation for Reporting API, RDW, and Data Exporter Community](#). Join and follow the community to be notified of new posts.

<table>
<thead>
<tr>
<th>CATEGORY</th>
<th>OBJECT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training and Transcript</td>
<td>Deleted deprecated view</td>
<td>Use report.vw_rpt_transcript Cf2 instead of deprecated view</td>
</tr>
<tr>
<td></td>
<td>report.vw_rpt_transcript Cf2</td>
<td></td>
</tr>
<tr>
<td>Training and Transcript</td>
<td>Deleted deprecated view</td>
<td>Use report.vw_rpt_training Cf2 instead of deprecated view</td>
</tr>
<tr>
<td></td>
<td>report.vw_rpt_training Cf2</td>
<td></td>
</tr>
<tr>
<td>Training and Transcript</td>
<td>Deleted deprecated view</td>
<td>Use report.vw_rpt_training instead of deprecated view</td>
</tr>
<tr>
<td></td>
<td>report.vw_rpt_training_base</td>
<td></td>
</tr>
<tr>
<td>Training and Transcript</td>
<td>Deleted deprecated view</td>
<td>Use report.vw_rpt_transcript instead of deprecated view</td>
</tr>
<tr>
<td></td>
<td>report.vw_rpt_transcript_base</td>
<td></td>
</tr>
<tr>
<td>Training and Transcript</td>
<td>Deleted deprecated view</td>
<td>Use report.vw_rpt_training (columns: training_version_start_dt, training_version_end_dt) instead of deprecated view</td>
</tr>
<tr>
<td></td>
<td>report.vw_rpt_lo_material</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Training Version Start Date and End Date for training type 'Material')</td>
<td></td>
</tr>
<tr>
<td>Training and Transcript;</td>
<td>Deleted deprecated column</td>
<td>Use [user_lo_minutes_participated] column instead of deprecated column</td>
</tr>
<tr>
<td>Certification; Certification;</td>
<td>[user_lo_time] from views:</td>
<td></td>
</tr>
<tr>
<td>Evaluations; Transaction;</td>
<td>report.vw_rpt_transcript</td>
<td></td>
</tr>
<tr>
<td>Compliance</td>
<td>report.vw_rpt_certification</td>
<td></td>
</tr>
<tr>
<td></td>
<td>report.vw_rpt_evaluations</td>
<td></td>
</tr>
<tr>
<td></td>
<td>report.vw_rpt_transaction</td>
<td></td>
</tr>
<tr>
<td></td>
<td>report.vw_rpt_compliance</td>
<td></td>
</tr>
<tr>
<td>Succession</td>
<td>Deleted all user custom fields</td>
<td>Use report.vw_rpt_user Cf for user custom fields. Join report.vw_rpt_succession_successor on ss_successor_user_id = user Cf_user_id from report.vw_rpt_user Cf</td>
</tr>
<tr>
<td></td>
<td>report.vw_rpt_succession_successor</td>
<td></td>
</tr>
<tr>
<td>Job Pool</td>
<td>Deleted all user custom fields</td>
<td>Use report.vw_rpt_user Cf for user custom fields. Join report.vw_rpt_succession_successor on ss_successor_user_id = user Cf_user_id from report.vw_rpt_user Cf</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>CATEGORY</th>
<th>OBJECT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>from report.vw_rpt_smp_job_pool_in cumbent</td>
<td>custom fields. Join report.vw_rpt_smp_job_pool_incumb ent on incumbent_user_id = user_cf_user_id from report.vw_rpt_user_cf</td>
<td></td>
</tr>
<tr>
<td>Job Pool</td>
<td>Deleted all user custom fields from report.vw_rpt_smp_job_pool_successor</td>
<td>Use report.vw_rpt_user_cf for user custom fields. Join report.vw_rpt_smp_job_pool_successor on successor_user_id=user_cf_user_id from report.vw_rpt_user_cf</td>
</tr>
</tbody>
</table>
18 May Patch Release Functionality
## What's New for the 18 May 2018 Patch Release

The following is released along with the 18 May 2018 patch release:

<table>
<thead>
<tr>
<th>MODULE</th>
<th>FEATURE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core</td>
<td>FTP Account Management - Password Reset</td>
<td>With this enhancement, when an administrator needs to update their FTP account password, they can do so via self-service in the Cornerstone system, with new permissions. This allows administrators to quickly and securely reset FTP account passwords on their own.</td>
</tr>
<tr>
<td>Core</td>
<td>Historical Upload Tool (HUT) Retirement</td>
<td>With the May ’18 Release, Cornerstone no longer supports, and organizations no longer have access to, the Historical Upload Tool (HUT). HUT was a legacy tool used to upload Event/Session data and associate users to groups. Built prior to Data Load Wizard (DLW), the tool has seen declining/limited usage over time and is not enabled in newer portals. Organizations still using the HUT should contact their Client Success Manager to determine which solution will be most effective moving forward.</td>
</tr>
<tr>
<td>Cornerstone HR</td>
<td>Form Approval Workflow - Approve by Group or OU</td>
<td>With this enhancement, organizations can add a group or organizational unit (OU) to a form approval workflow. This enables more powerful employee and manager self-service capabilities through enhanced workflow configuration, which frees administrator time to work on other priorities.</td>
</tr>
<tr>
<td>Recruiting</td>
<td>Add to Move to Requisition Logic Supported in Mobile-Friendly Workflow</td>
<td>With this enhancement, when an applicant is added or moved to a new requisition and some but not all answers have been answered from the first requisition, the applicant will continue with the second application using the mobile-friendly candidate workflow. In addition, the applicant’s previously answered questions will populate in the new mobile-friendly workflow.</td>
</tr>
<tr>
<td>Recruiting</td>
<td>ADP WOTC Integration Changes</td>
<td>With this enhancement, the process of enabling the ADP WOTC integration is updated.</td>
</tr>
<tr>
<td>Recruiting</td>
<td>Hiring Manager Shortlist</td>
<td>For organizations that use SSO, the REVIEW.APPLICANT.RESUME.SUMMARY email</td>
</tr>
<tr>
<td>MODULE</td>
<td>FEATURE</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Summary Email Tag SSO Enhancement</strong></td>
<td>Tag will now be SSO enabled so that hiring managers do not have to log in to Cornerstone to review applicants. Many hiring managers do not log into Cornerstone on a daily basis, so needing to remember a new login only to review resumes is unnecessary.</td>
</tr>
<tr>
<td>Recruiting</td>
<td><strong>Applicant Profile Creation Terms of Service Checkbox</strong></td>
<td>A terms of service checkbox is added to the Create a Profile page on career sites. Applicants must check the box in order to create a profile.</td>
</tr>
<tr>
<td>View</td>
<td><strong>View People - Additional Fields</strong></td>
<td>As part of the May and June 2018 patch releases, new field types can be added as Succession Metric filters and Career Preferences Attribute filters to View People Preferences. The new field types can then be used as filters on the View People page.</td>
</tr>
</tbody>
</table>
Add to Move to Requisition Logic Supported in Mobile-Friendly Workflow

This functionality was announced with the 4 May 2018 release and is being released as part of the 18 May 2018 patch release.

With this enhancement, when an applicant is added or moved to a new requisition and some but not all answers have been answered from the first requisition, the applicant will continue with the second application using the mobile-friendly candidate workflow. In addition, the applicant's previously answered questions will populate in the new mobile-friendly workflow.

Use Case

1. Scott is a recruiter for IMEC. Scott has self-enabled the new mobile-friendly candidate experience in his Production portal.
2. Alex is interested in a position at IMEC and applies for the Senior Project Manager role. Alex completes the application in the mobile-friendly workflow.
3. Scott really likes Alex but thinks she is more qualified for the Junior Project Manager role. Scott moves Alex to the Junior Project Manager role. There are a few additional questions in the Junior Project Manager role that were not in the original Senior Project Manager Application workflow. Scott invites Alex to apply to the new requisition.
4. Alex receives an email to apply to the Junior Project Manager role. Alex clicks the link to apply and is prompted to sign in. For security reasons, Alex will have to claim her account or log in to continue the new application with her previously answered questions populated.
5. When the application workflow loads, it is in the new mobile-friendly application workflow, not the standard workflow. Alex is taken to page 1 of the application. All previously answered questions from the Senior Project Manager role populate the new application.
6. On page 2, the pre-screening questions are exactly the same on the Senior and Junior Project Manager requisition, so her previously answered questions are populated. On page 3, only some of the pre-screening questions are the same. Because some and not all of the pre-screening questions are the same on page 3, Alex's previously answered pre-screening questions do not populate.

Considerations

- The questions in the two requisitions (source and new requisition) have to be exactly the same in order for an applicant's answers to pre-populate.
- If some but not all pre-screening questions in a specific section are the same, then none of the previously answered pre-screening questions will populate.
- The applicant will be taken to the first page of the application workflow, regardless of how many questions are complete.
• Applicants will have to log in or claim their account in order to continue on the new application and have their previously answered questions populate on the new application.

**Implementation**

This functionality is available for Recruiting clients who have self-enabled the mobile-friendly candidate experience.

For information about enabling the mobile-friendly candidate experience, see the Enable Mobile-Friendly Candidate Experience topic in Online Help.
ADP WOTC Integration Changes

With this enhancement, the process of enabling the ADP WOTC integration is updated. The following changes are made:

- **Subscription Token** - Upon purchasing the integration in ADP Marketplace, a subscription token will now be emailed to you. You will need to enter the code into the new Subscription Token field that has been added to the Edge Integration > Settings page.

- **Client Email ID** - This is a new field that has been added to the Edge Integration > Settings page. This field will need to be completed when enabling the integration. Success and/or error notifications during the enablement process will be sent to this email address.

- **Client ID and Client Secret** - These fields will now be auto-populated on the Edge Integration > Settings page upon saving the page.

*Note:* There are no changes to the Company Code and Authentication Code fields. It is still necessary to work with your ADP team and manually complete these fields on the Edge Integration > Settings page.

Enablement Workflow

As a result of this enhancement, the following is the new workflow for enabling the ADP WOTC integration:

1. Administrator purchase the ADP WOTC integration from ADP Marketplace.
2. Administrator signs consent form (terms and conditions) on ADP Marketplace.
3. Administrator receives email with subscription token.
4. Administrator logs into their portal.
5. Administrator purchases ADP WOTC integration on Edge Marketplace.
6. Administrator enters subscription token and email address on Edge Integration > Settings page.
7. Administrator saves Edge Integration > Settings page.
8. The portal retrieves and auto-populates the Client ID and Client Secret fields.
Form Approval Workflow
Form Approval Workflow - Approve by Group or Organizational Unit (OU) - Overview

Prior to this enhancement, form approvals could only be completed by specific users or employee relationships.

With the May 16, 2018 patch, organizations can add groups or organizational units (OUs) to a form approval workflow. This enables more powerful employee and manager self-service capabilities through enhanced workflow configuration, which frees administrator time to work on other priorities.

Clients can configure approval workflows that include:

- Employees
- Employee Relationships
- Groups (new with this enhancement)
- OUs (new with this enhancement)

Use Cases

Marissa is an administrator at Acme Financial and needs to ensure that the Employee Address Update form is approved by a member of the HR group. When configuring the approval workflow for the form, Marissa adds the HR group as the form approver.

Curtis, an HR manager and member of the HR group, sees that he and the rest of the HR group receive form approval notifications and requests associated with the Employee Address Update form.

Considerations

- Forms utilizing Group/OU Approvals are not supported for Onboarding Form Tasks.
- The Include Subordinates option is NOT supported for groups and OUs.
- For group/OU approvals, the first response will progress the approval workflow.
- The OU/group enrollment is dynamic as applied to Forms Approval Workflows. Changes to the OU/group enrollment will dynamically update the users within the OU/group who can approve the form.

Implementation

This functionality is available in for all Stage portals using Cornerstone HR on May 16, and will be released to Production portals in an upcoming patch. Administrators can configure the approval workflow for forms.

Permissions

The following existing permission applies to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
</table>

### Forms - Manage

Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.

**Note:** *This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.*
Form Approval Workflow - Add Approver

Prior to this enhancement, it was possible to add specific users and employee relationships as approvers in a form approval workflow. With this enhancement, when creating or editing a form approval workflow, you can also add organizational units (OUs) or groups as approvers in the workflow. This allows users included in selected OUs or groups to act as approvers for the form. When multiple users are included in the OU or group, the first user to respond to the approval request advances the workflow to the next step, and the request is no longer available to the other users in the OU or group.

To add approvers to an approval workflow, go to: ADMIN > TOOLS > CORE > FORM MANAGEMENT, and click the Form Approval Workflows link. Then, either click the CREATE WORKFLOW button or click the Edit option next to an existing approval workflow that is not currently in use.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forms - Manage</td>
<td>Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Forms Management Administration</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.</td>
<td></td>
</tr>
</tbody>
</table>
Add Approval Step

On the Create/Edit Form Approval Workflow page, to add an OU or a group as an approver for the workflow:

1. Click the **ADD APPROVAL STEP** button.
2. In the Approver box that appears, click the drop-down menu.
3. To add either an OU or a group as the approver, choose either the **OU** option from the drop-down.
4. After making your selection, click the **Select OU Criteria** dropdown and select an OU type.
5. Click the search icon which appears beneath the dropdown. This opens the Select window.
6. Search for and select the specific OU or group you wish to add as an approver to the approval workflow step. For example, if you selected **Group** from the drop-down, you might search for and select the HR group from the Select Group window. Only one group or OU can be selected at a time. **Note:** The OU or group you wish to use in an approval step must already be created prior to creating the approval workflow.
7. Click the **ADD APPROVER** button, and your selected criteria will be added as an approver in the workflow.
8. Continue adding approvers and approval steps if needed, and populate the remaining fields on the Create Form Approval Workflow page before saving the approval workflow. *See Create Form Approval Workflow for more information.*
Users included in the selected OU or group can approve or deny approval requests for forms applicable to their approval workflow when their workflow step is active. See Form - Approve or Deny for more information.
FTP Account Management - Password Reset
FTP Account Management - Password Reset - Overview

This functionality was announced with the 4 May 2018 release and is being released as part of the 18 May 2018 patch release.

Prior to this enhancement, when an administrator needed to update their FTP account password, it was necessary to submit a case to Global Product Support (GPS). A new password would then be configured and sent to the user.

With this enhancement, when an administrator needs to update their FTP account password, they can do so via self-service in the Cornerstone system, with new permissions. This allows administrators to quickly and securely reset FTP account passwords on their own.

Considerations

More features will be added to this functionality in future releases and post-release patches.

Implementation

This functionality was made available during the April 19th Stage deployment, and it will be available in Production portals with the May 18th patch. This functionality is automatically enabled for all portals. The two new permissions described in the below section are automatically assigned to system administrators.

Permissions

The following new permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access FTP Account - View</td>
<td>Grants access to the FTP account landing page where the available accounts are displayed. Currently, this permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Reset Password and Public Keys - Manage</td>
<td>Grants ability to manage FTP account login password and public keys when applicable. Currently, this permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>
FTP Account Access - Passwords

Administrators with the appropriate permissions may reconfigure passwords for FTP accounts associated with their portals.

To configure a password for an FTP account, go to: ADMIN > TOOLS > CORE and click the FTP Account Access link.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access FTP Account - View</td>
<td>Grants access to the FTP account landing page where the available accounts are displayed. Currently, this permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Reset Password and Public Keys - Manage</td>
<td>Grants ability to manage FTP account login password and public keys when applicable. Currently, this permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>

FTP Account Access

The FTP Account Access page provides access to available FTP accounts. Some users may have access to the account list page, but not the Reset Password function, as they are controlled by different permissions. Each account displays with the name, partial folder path, and login URL.
Reset Password

On the FTP Account Access page, locate the account for which you want to configure a password, and click the "..." icon to the right of the account name. This opens the **Options** menu. Click the **Reset Password** option to access the Reset Password page.

On the Reset Password page:

1. Enter the new password in the **Create New Password** field. Ensure the new password conforms to the password standards described on the page.
2. Enter the new password again in the **Confirm New Password** field. If the two passwords do not match, you will receive an error and will need to re-enter your password in one or both fields to ensure they are the same.
3. Click the **PROCEED** button. This causes a validation message to appear.
4. In the Read Before You Proceed pop-up message, ensure you understand the ramifications of your password change, and then enter a reason for changing the account's password. This field is required. If you wish to exit the Reset Password process without changing the account's password, you can click the **Cancel** link.
5. Click the **SUBMIT** button after entering a reason for the change. The new password will be applied to the FTP account.

![Read Before You Proceed](image.png)
Hiring Manager Shortlist Summary Email Tag SSO Enhancement

This functionality was announced with the 4 May 2018 release and is being released as part of the 18 May 2018 patch release.

For organizations that use SSO, the REVIEW.APPLICANT.RESUME.SUMMARY email tag will now be SSO enabled so that hiring managers do not have to log in to Cornerstone to review applicants. Many hiring managers do not log into Cornerstone on a daily basis, so needing to remember a new login only to review resumes is unnecessary.

Hiring managers and recruiters want to be able to use their SSO functionality so that they can quickly and easily review candidates. Prior to this enhancement, hiring managers were sent to the custom login page after clicking the REVIEW.APPLICANT.RESUME.SUMMARY email tag.

For organizations that use SSO, hiring managers will be logged in automatically when they click on an applicant within the Review Applicant Daily Summary email. For organizations that do not use SSO, hiring managers will be directed to the custom log in page.
Historical Upload Tool (HUT) Retirement

This functionality was announced with the 4 May 2018 release and is being released as part of the 18 May 2018 patch release.

With the May ’18 Release, Cornerstone no longer supports, and organizations no longer have access to, the Historical Upload Tool (HUT). HUT was a legacy tool used to upload Event/Session data and associate users to groups. Built prior to Data Load Wizard (DLW), the tool has seen declining/limited usage over time and is not enabled in newer portals. Organizations still using the HUT should contact their Client Success Manager to determine which solution will be most effective moving forward.
Manage Events and Sessions - UI Enhancements

With this enhancement, updates have been made to the user interface (UI) of the Manage Events and Sessions page. These updates help clarify the purpose of different options on the Manage Events and Sessions page.

To access the Manage Events and Sessions page, go to: ADMIN > TOOLS > LEARNING > CATALOG MANAGEMENT and click the Events and Sessions link.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events - Create</td>
<td>Grants ability to create new instructor led training events. This permission works in conjunction with Events - View permission. This permission can be constrained by OU, User's OU, ILT Provider, and User's ILT Provider. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Events - Edit</td>
<td>Grants ability to edit/update existing instructor led training events. This permission works in conjunction with Events - View permission. This permission can be constrained by OU, User's OU, ILT Provider, and User's ILT Provider. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Events - View</td>
<td>Grants view-only access to instructor led training events, enabling the user to view all details/options that were selected when the event was created. This permission can be constrained by OU, User's OU, User's ILT Provider, and ILT Provider. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>

Search for Events or Sessions

In the Search All Events section of the Manage Events and Sessions page, the following existing search options have been separated into a Search for Events or Sessions section, to help clarify the function of the options:

- Search for all Events
- Search for all Sessions
Legend

Above the Events table on the Manage Events and Sessions page, a legend has been added, which contains a key of available event management options and their associated icons. This allows administrators to easily interpret which icons can perform which actions in the Events table.

The following options display in the Legend, along with their associated icons:

- **Edit Evaluation** - Associate evaluations to events. *See Manage Evaluations for additional information.*
- **View Evaluation Report** - Run an evaluation report.
- **Edit Event** - Make changes to an existing event.
- **Copy Event** - Copy an existing event. The Event Properties, Availability, Pricing and Session Details are copied. The Event Title and Event Number are blank by default when you copy an event. Sessions and emails under the original event are not copied.
- **View Sessions** - Edit or create a session.
- **Map Certification** - Map an event to a certification. *See Map Training to Certification Areas for additional information.*
Event Name

In the Events table, gray shading has been added to the Event Name column.
Applicant Profile Creation Terms of Service Checkbox

A terms of service checkbox is added to the Create a Profile page on career sites. Applicants must check the box in order to create a profile. This also applies to applicants when creating a profile via Connect With Us and Apply as Guest.

Implementation

This functionality is automatically enabled for all organizations using Recruiting.
View People - Additional Fields

This functionality was announced with the 4 May 2018 release. Some field types are being released as part of the 18 May 2018 patch release and will also be released as part of the 15 June 2018 patch release.

As part of the May and June 2018 patch releases, new field types can be added as Succession Metric filters and Career Preferences Attribute filters to View People Preferences. The new field types can then be used as filters on the View People page.

Succession Field Types

The following additional Succession field types can be added to View People:

- Checkbox - Available 15 June 2018 as part of a patch release
- Dropdown - Available 18 May 2018 as part of a patch release
- Radio Button - Available 15 June 2018 as part of a patch release

Career Preferences Field Types

- Location Bank Questions - Available 18 May 2018 as part of a patch release
- Standard and Custom Organizational Unit Type - Available 18 May 2018 as part of a patch release

Implementation

On the above-mentioned patch date, this functionality will be automatically enabled for all organizations using View and that also have Succession enabled.

Security

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>View People Preferences Page</td>
<td>Grants access to the View People Preferences page, which allows administrators to configure the View People page according to their needs per organizational unit (OU). This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User's Subordinates.</td>
<td>View</td>
</tr>
<tr>
<td>View People: View</td>
<td>Grants access to open View People to see results and share lists. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User's Subordinates.</td>
<td>View</td>
</tr>
</tbody>
</table>
1 June Patch Release Functionality
## What's New for the 1 June 2018 Patch Release

The following is released along with the 1 June 2018 patch release:

<table>
<thead>
<tr>
<th>MODULE</th>
<th>FEATURE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core</td>
<td>GDPR - Recruiting Ad Hoc Anonymization Support</td>
<td>GDPR (Recruiting) – Clients can ad hoc anonymize applicant data outside of the specified compliance settings timeframe. Please submit a ticket to Global Product Support (GPS) in order to request this for an applicant.</td>
</tr>
<tr>
<td>Cornerstone HR</td>
<td>Form Approval Workflow - Approve by Group or OU</td>
<td>With this enhancement, organizations can add a group or organizational unit (OU) to a form approval workflow. This enables more powerful employee and manager self-service capabilities through enhanced workflow configuration, which frees administrator time to work on other priorities.</td>
</tr>
<tr>
<td>Edge</td>
<td>Reporting API</td>
<td>With the June 1 patch, the following enhancements have been made to the Reporting API:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- A count parameter has been added as part of the API response. This field provides users with the total number of records their query will return. This allows users to validate that the number of records returned over multiple requests with the number of records the API query provides. For more details on how to enable this feature, please contact Global Product Support (GPS).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- To provide better response times, optimizations have been made to the following views:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- vw_rpt_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Vw_rpt_training</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Vw_rpt_user_cf</td>
</tr>
<tr>
<td>Engage/Performance</td>
<td>Engage - Manager Hierarchy View</td>
<td>With this enhancement, users with the appropriate permission can view Engage results by manager, filter for specific managers, compare multiple managers.</td>
</tr>
<tr>
<td>MODULE</td>
<td>FEATURE</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>within a team, and traverse the reporting hierarchy to discover areas of opportunity within the organization.</td>
</tr>
</tbody>
</table>
Engage - Manager Hierarchy View
Engage - Manager Hierarchy View - Overview

Prior to this enhancement, administrators and managers could view data by division, location, or position, but they were unable to view scores for specific managers, aside from their own aggregate scores.

With this enhancement, users with the appropriate permission can view Engage results by manager, filter for specific managers, compare multiple managers within a team, and traverse the reporting hierarchy to discover areas of opportunity within the organization.

Use Cases

- Kim is the head of HR at ACME. When she navigates to the Engage reporting page, she can filter to see the scores for employees of a specific executive, so she can provide developmental coaching to help the executive address opportunities within their team.
- Mike is a manager at ACME. He can easily filter Engage results to see what his direct reports are saying about their experience at the company, so he can ensure he is doing all he can to develop his employees and their careers.

Considerations

- Indirect and matrixed managers are not yet supported by this functionality.
- Individual contributors with no direct reports cannot be used as filters on the Engage Dashboard.
- It is not possible to view the survey responses of individual users using the Select Manager filter.
- View Engage Reporting users are restricted to their own hierarchy.
- The Manager filter allows users to view scores from direct reports only, on a per manager basis. Unlike other organizational unit (OU) filters, it does not aggregate up across all managers.
- The Manager filter always restricts visible Engage data to direct reports only, and also respects any other filters that have been set, including Location, Division, etc. When using the Manager filter, even in combination with other filters, results are always restricted to direct reports only.

Implementation

This functionality is automatically enabled for all portals using the Engage module.

Permissions

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Engage</td>
<td>Grants access to both the reporting and campaign</td>
<td>Engage</td>
</tr>
<tr>
<td>View Engage Reporting</td>
<td>Grants ability to see the reporting dashboard, but it is limited to the user’s subordinates. This permission is intended for managers.</td>
<td>Engage</td>
</tr>
</tbody>
</table>
Manager Hierarchy View - Select Manager

Administrators and managers can apply manager filters to the data displayed on the Engage Dashboard using the Select Managers flyout.

To access the Engage Dashboard, go to: ANALYTICS > ENGAGE.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Engage</td>
<td>Grants access to both the reporting and campaign dashboards in Engage. This is an administrator permission.</td>
<td>Engage</td>
</tr>
<tr>
<td>View Engage Reporting</td>
<td>Grants ability to see the reporting dashboard, but it is limited to the user’s subordinates. This permission is intended for managers.</td>
<td>Engage</td>
</tr>
</tbody>
</table>

Select Manager

To filter by manager, click Select Filters on the Engage Dashboard. The filters flyout appears on the left side of the page. Select the + button under Manager to bring up the Manager filter. Toggle the Use Filters switch to the On (blue) position. The hierarchy of managers appears, with All Managers at the top level.

You can explore the hierarchy of managers, select a manager, and click the SUBMIT button at the bottom of the flyout to view survey response data for their direct reports on the Engage dashboard. See Engage Dashboard for more information about the report widgets available on the Engage Dashboard.

Note: Users with no direct reports do not appear as filters in the Select Manager flyout.

Note: Scores for a manager do NOT include responses the manager themselves may have given for an Engage survey.
Form Approval Workflow
Form Approval Workflow - Approve by Group or Organizational Unit (OU) - Overview

Prior to this enhancement, form approvals could only be completed by specific users or employee relationships.

With the May 16, 2018 patch, organizations can add groups or organizational units (OUs) to a form approval workflow. This enables more powerful employee and manager self-service capabilities through enhanced workflow configuration, which frees administrator time to work on other priorities.

Clients can configure approval workflows that include:

- Employees
- Employee Relationships
- Groups (new with this enhancement)
- OUs (new with this enhancement)

Use Cases

Marissa is an administrator at Acme Financial and needs to ensure that the Employee Address Update form is approved by a member of the HR group. When configuring the approval workflow for the form, Marissa adds the HR group as the form approver.

Curtis, an HR manager and member of the HR group, sees that he and the rest of the HR group receive form approval notifications and requests associated with the Employee Address Update form.

Considerations

- Forms utilizing Group/OU Approvals are not supported for Onboarding Form Tasks.
- The Include Subordinates option is NOT supported for groups and OUs.
- For group/OU approvals, the first response will progress the approval workflow.
- The OU/group enrollment is dynamic as applied to Forms Approval Workflows. Changes to the OU/group enrollment will dynamically update the users within the OU/group who can approve the form.

Implementation

This functionality is available in for all Stage portals using Cornerstone HR on May 16, and will be released to Production portals in an upcoming patch. Administrators can configure the approval workflow for forms.

Permissions

The following existing permission applies to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forms - Manage</td>
<td>Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission. <strong>Note:</strong> This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.</td>
<td>Forms Management Administration</td>
</tr>
</tbody>
</table>
Form Approval Workflow - Add Approver

Prior to this enhancement, it was possible to add specific users and employee relationships as approvers in a form approval workflow. With this enhancement, when creating or editing a form approval workflow, you can also add organizational units (OUs) or groups as approvers in the workflow. This allows users included in selected OUs or groups to act as approvers for the form. When multiple users are included in the OU or group, the first user to respond to the approval request advances the workflow to the next step, and the request is no longer available to the other users in the OU or group.

To add approvers to an approval workflow, go to: ADMIN > TOOLS > CORE > FORM MANAGEMENT, and click the Form Approval Workflows link. Then, either click the CREATE WORKFLOW button or click the Edit option next to an existing approval workflow that is not currently in use.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forms - Manage</td>
<td>Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission. <strong>Note:</strong> This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.</td>
<td>Forms Management Administration</td>
</tr>
</tbody>
</table>
Add Approval Step

On the Create/Edit Form Approval Workflow page, to add an OU or a group as an approver for the workflow:

1. Click the **ADD APPROVAL STEP** button.
2. In the Approver box that appears, click the drop-down menu.
3. To add either an OU or a group as the approver, choose either the **OU** option from the drop-down.
4. After making your selection, click the **Select OU Criteria** dropdown and select an OU type.
5. Click the search icon which appears beneath the dropdown. This opens the Select window.
6. Search for and select the specific OU or group you wish to add as an approver to the approval workflow step. For example, if you selected **Group** from the drop-down, you might search for and select the HR group from the Select Group window. Only one group or OU can be selected at a time. **Note: The OU or group you wish to use in an approval step must already be created prior to creating the approval workflow.**
7. Click the **ADD APPROVER** button, and your selected criteria will be added as an approver in the workflow.
8. Continue adding approvers and approval steps if needed, and populate the remaining fields on the Create Form Approval Workflow page before saving the approval workflow. **See Create Form Approval Workflow for more information.**
Users included in the selected OU or group can approve or deny approval requests for forms applicable to their approval workflow when their workflow step is active. See Form - Approve or Deny for more information.
GDPR - Recruiting Ad Hoc Anonymization Support

With this enhancement, clients can anonymize applicant data on an ad hoc basis outside of the specified compliance settings timeframe and without forcing a candidate to log in to their profile to anonymize their own data.

Prior to this enhancement, anonymization had to be enabled in Compliance Enablement Preferences. Administrators could allow applicants to request anonymization of their profiles via a setting that appears on their career site profile. Or, administrators could allow the system to anonymize applicant data after a period of inactivity by the applicant.

Now, administrators can submit a Global Product Support (GPS) ticket to have an applicant's information anonymized instantly, regardless of their period of inactivity.

Use Case

1. Sarah has applied for a position at ACME, a European company based in Italy. Sarah would like her application anonymized for data privacy reasons, even though she applied a day ago. Her status is still active and is tied to an open requisition. Sarah does not want to log in to her profile to request the anonymization of her data. Instead, she emails ACME and requests that her email be anonymized.
2. Francis is an administrator at ACME. Francis creates a GPS work order to have Sarah's profile information anonymized.
3. When Francis views the active requisition, Sarah is no longer there. Instead, Sarah's data has been anonymized, and Francis cannot access Sarah's profile.

Implementation

This functionality is only available by submitting a work order to GPS. Once the work order has been completed, the applicant will be anonymized, regardless of their period of inactivity.

If an applicant requests to be anonymized, and the applicant is still in an active status for an open requisition, the applicant will stay in their current status but no one will be able to interact with their profile after the anonymization takes place.
Reporting API

Previously, the Reporting API was made available in the Edge Marketplace. Using the Reporting API, users are able to access the Real Time Data Warehouse (RTDW), which adheres to ODATA minimal compliance specifications.

With the June 1 patch, the following enhancements have been made to the Reporting API:

- A count parameter has been added as part of the API response. This field provides users with the total number of records their query will return. This allows users to validate that the number of records returned over multiple requests with the number of records the API query provides. For more details on how to enable this feature, please contact Global Product Support (GPS).
- To provide better response times, optimizations have been made to the following views:
  - vw_rpt_user
  - Vw_rpt_training
  - Vw_rpt_user_cf

Implementation

The Reporting API is available for purchase in the Edge Marketplace for portals using the Edge module.

For more information about the Reporting API, navigate to the Edge API Explorer. For more information about the Edge API Explorer, see Edge - API Explorer.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge - API Explorer</td>
<td>Grants access to the API Explorer, which provides access to help documentation for various API applications.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Integrations - Manage</td>
<td>Grants access to the Integrations service for Edge Integrate where the administrator can configure, enable, and disable their third-party integrations that are used within the Cornerstone system. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Marketplace - Manage</td>
<td>Grants access to the Marketplace service for Edge Integrate where the administrator can browse and purchase third-party integrations that can be used to extend the Cornerstone system. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
</tbody>
</table>
Compensation Statement Decimal Precision
Compensation Statement Decimal Precision - Overview
Prior to this release, custom formula tags always used a decimal precision of four, which sometimes prevented administrators from defining various payment types with the needed decimal precision.

With this enhancement, the following information can be configured for custom formula tags by administrators:

- Decimal precision from one to four decimal points or the number of decimal places required by the employee’s currency
- Rounding Rules

Use Cases
Jane, an administrator, needs a Total Cash field to display on a Compensation Statement at her organization, which is comprised of equity, base salary, bonus, and other payments to her US employee base. Jane configures a custom formula tag that will be provided on the compensation statement, to show her employee base how much each employee is paid in total cash. Jane defines her Total Cash custom formula tag with two decimal precision points in order to show the value in USD.

Implementation
This functionality is automatically enabled in all portals using the Compensation module.

Permissions
The following existing permission applies to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compensation Tag Management</td>
<td>Manage Tags for Compensation fields for use in Custom Formulas and Compensation Statements - Manage. This permission cannot be constrained. This is an administrator permission.</td>
<td>Compensation - Administration</td>
</tr>
</tbody>
</table>
Custom Formula Tags

The Compensation Tag Management page enables administrators to manage compensation tag names for fields used in custom compensation formulas and statements. With this enhancement, administrators can also configure decimal precision and rounding rules for Custom Formula tags.

To access Compensation Tag Management, go to ADMIN > CONFIGURATION TOOLS > COMPENSATION. Then, select Compensation Tag Management.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compensation Tag Management</td>
<td>Manage Tags for Compensation fields for use in Custom Formulas and Compensation Statements - Manage. This permission cannot be constrained. This is an administrator permission.</td>
<td>Compensation - Administration</td>
</tr>
</tbody>
</table>

Decimal Precision

The Decimal Precision field can be configured for custom formula tags by clicking the Decimal Precision drop-down menu when creating a new tag or when modifying an existing tag. Administrators can select a decimal precision from zero to four, or they can select the User's Currency option. Selecting the User's Currency option causes the formula output to use the number of decimal points required by the user's currency (i.e. two decimal points for the US dollar, or three decimal points for the Algerian dinar). When the tag is used in a Compensation Statement, the output of the formula uses the configured number of decimal points.

Rounding Rule

A rounding rule can be configured for custom formula tags by clicking the Rounding Rule drop-down menu when creating a new tag or when modifying an existing tag. Administrators can choose from the following options:

- Arithmetic - Selecting this option for the Rounding Rule field causes the output of the formula to be rounded up to the next decimal point if the last decimal digit of the output is five or higher, and causes the output of the formula to be rounded down to the next decimal point if the last decimal digit of the output is lower than five (i.e. 1.55 would be rounded to 1.6, and 1.34 would be rounded to 1.3).
- **Up** - Selecting this option for the **Rounding Rule** field causes the output of the formula to be rounded up to the next decimal point, if needed (i.e. 3.44 would be rounded to 3.5, and 3.88 would be rounded to 3.9).
- **Down** - Selecting this option for the **Rounding Rule** field causes the output of the formula to be rounded down to the next decimal point, if needed (i.e. 8.23 would be rounded to 8.2, and 8.99 would be rounded to 8.9).

### Save

After creating a new tag or making edits to an existing tag, click the **SAVE** icon to save your changes.
Custom Reports - Compensation Fields
Custom Reports - Compensation Fields - Overview

Prior to this enhancement, it was not possible to report on the approvers for compensation tasks, and there was no way to summarize and report on approval workflow information without using complex Excel formulas.

With this enhancement, administrators can report on approval workflows and current approvers using new fields available in the new Compensation Task Approval Workflow report field section in Custom Reports. These new fields allow administrators to improve organization during compensation tasks.

Use Cases

Jane, an administrator, works for a 50,000 employee company with 5,000 compensation managers. Compensation tasks at her organization each require three approvers. It is five days before the end of the Compensation Task, and she still has 2,000 outstanding compensation tasks and needs to reach out to the task approvers and remind them to complete the tasks currently assigned to them. She can run a custom report and quickly determine who she needs to contact.

Implementation

This functionality is automatically enabled for all portals using the Compensation module and Custom Reporting.

Permissions

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Compensato n Report - Create</td>
<td>Grants ability to create and edit custom Compensation reports. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Subordinates, and User's Direct Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Compensation Report - View</td>
<td>Grants ability to view results of custom Compensation reports created by self or shared by others. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Direct Subordinates, and User's Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>
New Compensation Fields

A new section is available for Compensation reports, called the Compensation Task Approval Workflow section. Several new fields are included in the Compensation Task Approval Workflow report field section.

To create a Compensation custom report, go to REPORTS > CUSTOM REPORTS and click the NEW button. Select Compensation Report from the drop-down menu.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Compensation Report - Create</td>
<td>Grants ability to create and edit custom Compensation reports. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User’s Subordinates, and User’s Direct Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Compensation Report - View</td>
<td>Grants ability to view results of custom Compensation reports created by self or shared by others. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User’s Direct Subordinates, and User’s Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>

Compensation Task Approval Workflow Fields

The following new fields are included in the Compensation Task Approval Workflow report field section:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Condition Defined</td>
<td>Yes/No</td>
<td>This field indicates whether or not a condition is defined for the approver.</td>
</tr>
<tr>
<td>Approval Condition Met</td>
<td>Yes/No</td>
<td>This field indicates whether or not the defined condition has been met for the approver.</td>
</tr>
<tr>
<td>Approver Type</td>
<td>Text</td>
<td>This field is the employee relationship defined in the approval workflow (i.e. manager, next level manager, etc.).</td>
</tr>
<tr>
<td>Approver’s First Name</td>
<td>Text</td>
<td>This is the first name of the user designated as the approver.</td>
</tr>
<tr>
<td>Approver’s Last Name</td>
<td>Text</td>
<td>This is the last name of the user designated as the approver.</td>
</tr>
<tr>
<td>FIELD NAME</td>
<td>FIELD TYPE</td>
<td>FIELD DESCRIPTION</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Approver's Step Number</td>
<td>Numeric</td>
<td>This field indicates which numbered step in the approval process the approver is assigned.</td>
</tr>
<tr>
<td>Approver's User ID</td>
<td>Text</td>
<td>This is the user ID of the system user designated as the approver.</td>
</tr>
<tr>
<td>Is Current Approver</td>
<td>Yes/No</td>
<td>This field indicates whether or not the user is the current approver.</td>
</tr>
</tbody>
</table>
Employee Salary Management Modification History
**Employee Salary Management Modification History**

With this enhancement, organizations using Compensation or Cornerstone HR (CHR) that do not use Data Load Wizard or a custom feed to load their employee salary data can enable Employee Salary Modification History via a backend setting. Once enabled, the Employee Salary Management Modification History is updated whenever an employee salary is updated either through the system interface, compensation task completion, or via the new Edge Import - Employee Salary Load. Organizations using Cornerstone HR can also report on updates to the Employee Salary Management Modification History using the User Audit Report - Detailed standard report.

**Implementation**

This functionality is available to organizations using the Compensation or Cornerstone HR functionality. To enable this functionality, submit a case to Global Product Support (GPS). This functionality cannot be enabled for organizations that are using Data Load Wizard (DLW) or any custom feed to load employee salary data.

**Security**

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compensation Individual Targets - View</td>
<td>Grants ability to view bonus and equity targets for individual users. The administrator can view the Individual Target history and Modification History for the user. However, the administrator is not able to create, edit, or delete a target. With individual targets, adjustment guidelines that have a bonus or equity type component have the option of setting target values to individual targets. This permission can be constrained by OU, User's OU, or User. This is an administrator permission.</td>
<td>Compensation - Administration</td>
</tr>
<tr>
<td>Employee Salary Management - View</td>
<td>Grants access to the Employee Salary Management page view users' salaries or rates. This permission can be constrained by OU, User's OU, and User. This is an administrator permission.</td>
<td>Compensation - Administration</td>
</tr>
<tr>
<td>Employee Salary Management</td>
<td>Grants access to the Employee Salary Management page to edit, add, and view users' salaries or rates. This permission can be constrained by OU, User's OU, and User. This is an administrator permission.</td>
<td>Compensation - Administration</td>
</tr>
<tr>
<td>User Audit Report - Detailed</td>
<td>Grants access to the User Audit standard report, which displays detailed changes to user data. Users with this permission must also have permission to view user fields in other areas of the system. The users and fields available in this report are controlled by additional permissions. This permission can be constrained by OU, User's OU, User's Subordinates, User's Direct Subordinates, User's Self, User Self and Subordinates, User, and Employee Relationship. The constraints on this permission limit the users and OUs that are available when running the report. This is an administrator permission.</td>
<td>Reports - System</td>
</tr>
</tbody>
</table>
Employee Salary Management - Edit Salary Details

With this enhancement, organizations can enable a Modification History for employee salaries. When this functionality is enabled and an administrator is editing a user’s salary via Employee Salary Management, the administrator can now view the user’s salary modification history.

To edit the salary details for a user, go to **ADMIN > TOOLS > COMPENSATION MANAGEMENT > EMPLOYEE SALARIES**. Then, click the Edit icon in the Actions column for the appropriate user.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Salary Management - View</td>
<td>Grants access to the Employee Salary Management page view users’ salaries or rates. This permission can be constrained by OU, User’s OU, and User. This is an administrator permission.</td>
<td>Compensation - Administration</td>
</tr>
<tr>
<td>Employee Salary Management</td>
<td>Grants access to the Employee Salary Management page to edit, add, and view users’ salaries or rates. This permission can be constrained by OU, User’s OU, and User. This is an administrator permission.</td>
<td>Compensation - Administration</td>
</tr>
</tbody>
</table>
Modification History

This section is only available if enabled via a backend setting. When enabled, this section displays the following information for each modification to the user's salary information:

- **Effective Date** - This displays the date on which the modification is effective.
- **Change Date** - This displays the date and time at which the modification was made.
- **Field Changed** - This displays which field was modified.
- **Changed From** - This displays the original value for the field.
- **Changed To** - This displays the new value for the field.
- **Changed By** - This displays the name of the user or task that made the modification. For example, if the modification was made via a compensation task, then the name of the task is displayed.
- **Update Type** - This displays the type of update that was made.
User Audit Report - Detailed

With this enhancement, organizations can enable a Modification History for employee salaries. When this functionality is enabled additional modification fields are available in the User Audit Report - Detailed report. This enables organizations to report on modifications to the user's salary.

This report is only available to organizations using Cornerstone HR.

To run the User Audit report, go to REPORTS > STANDARD REPORTS. Then, select the System tab and click the User Audit Report - Detailed link.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compensation Individual Targets - View</td>
<td>Grants ability to view bonus and equity targets for individual users. The administrator can view the Individual Target history and Modification History for the user. However, the administrator is not able to create, edit, or delete a target. With individual targets, adjustment guidelines that have a bonus or equity type component have the option of setting target values to individual targets. This permission can be constrained by OU, User's OU, or User. This is an administrator permission.</td>
<td>Compensation - Administration</td>
</tr>
<tr>
<td>Employee Salary Management - View</td>
<td>Grants access to the Employee Salary Management page view users' salaries or rates. This permission can be constrained by OU, User's OU, and User. This is an administrator permission.</td>
<td>Compensation - Administration</td>
</tr>
<tr>
<td>User Audit Report - Detailed</td>
<td>Grants access to the User Audit standard report, which displays detailed changes to user data. Users with this permission must also have permission to view user fields in other areas of the system. The users and fields available in this report are controlled by additional permissions. This permission can be constrained by OU, User's OU, User's Subordinates, User's Direct Subordinates, User's Self, User Self and Subordinates, User, and Employee Relationship. The constraints on this permission limit the users and OUs that are available when running the report. This is an administrator permission.</td>
<td>Reports - System</td>
</tr>
</tbody>
</table>
**Fields Modified - Compensation**

This section enables you to select which compensation fields are included in the report output. This section is only available if compensation auditing is enabled.

The *Fields Modified - Compensation* section is comprised of multiple subsections that contain different types of compensation fields. All subsections are displayed in alphabetical order, and they are collapsed by default. To expand the subsection to view the section's fields, click the down arrow icon to the right of the subsection heading. Up to 50 total fields can be selected for the report. This includes fields in the User Record and Compensation sections.

**Security Note:** *In order for audits of compensation fields to be included in the output of the report, the target user must be within the constraints of the applicable permissions. For Base Compensation fields, these are the Employee Salary Management - View and User Audit Report - Detailed permissions. For Individual Targets fields, these are the Compensation Individual Targets - View and User Audit Report - Detailed permissions.*

The following subsections appears in the *Fields Modified - Compensation* section:

- Base Compensation
- Individual Targets - This section includes standard and custom individual targets.
Local Network Player - New Version - Overview

The current Local Network Player uses Transport Layer Security (TLS) to provide privacy and data integrity when data needs to be securely exchanged over a network. TLS is an industry-standard encryption protocol which has continued to evolve and provide more secure versions over time. Currently, the Local Network Player uses TLS 1.0. This version will no longer be supported after the May '18 release, in an effort to address the PCI Security Standards Council's compliance requirements.

With the May '18 release, a new version of the Local Network Player is available for download. This new version supports TLS 1.1 and TLS 1.2, providing increased security. The new version of Local Network Player must be downloaded in order to continue using the Local Network Player.

Use Cases

Ventonix is a retail company with employees across the globe. Previously, they enabled the Local Network Player so that when employees take training, the network bandwidth is not affected, and the courses are played from a local location.

Jeremy is the learning administrator at Ventonix. He receives a notification that a new version of the Local Network Player is available to support security enhancements. Jeremy informs the IT department about the changes and provides them with the new version once available.

The IT team uninstalls the current version and distributes the new version to all users’ computer devices. Employees are able to use the new version of the Local Network Player normally.

Considerations

The following considerations apply to this enhancement:

- The support of the new versions of TLS is the only enhancement made to the new version of the Local Network Player. All other functionality is unaffected.
- Prior to installing the new version of the Local Network Player, the previous version must be uninstalled.
- Following the May '18 release, the previous version of the Local Network Player will no longer be supported.

Implementation

This functionality is NOT automatically enabled. It is necessary for administrators to uninstall the previous version of the Local Network Player and download the new version of the Local Network Player.

To download the new version of the Local Network Player, go to: **ADMIN > TOOLS > CATALOG > COURSE CATALOG** and click the **Options** menu in the upper-right corner of the Course Catalog page. Select the **Download Network Player** option. The Local Network Player begins downloading. Once downloaded, you can proceed with the installation on...
your device. **Note:** The Download Network Player link is only available to administrators with permission to view the network player installer.

## Permissions

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Network Player - Download Courses from Catalog</td>
<td>Grants access to the Download Network Player link in Course Catalog. Also, grants access to download courses to the local network from the Course Catalog. Users must also have permission to access the Course Catalog. A user can download any course to which the user has permission to view within the Course Catalog. This permission is controlled by a backend setting. This permission is recommended for end users of the LMS, local trainers, and LMS administrators.</td>
<td>Learning</td>
</tr>
<tr>
<td>Local Network Player - File Download Link - View</td>
<td>Grants access to the Download Network Player link in Course Catalog and on the Transcript. Users must also have permission to access the Course Catalog. This permission cannot be constrained. This permission is recommended for local trainers who deliver course content remotely. This is an end user and local trainer permission. If the user no longer needs to view the download link after installation, this permission can be removed for those users.</td>
<td>Learning</td>
</tr>
<tr>
<td>Local Network Player - Launch Courses Offline Through the Network Player</td>
<td>Enables users to see the Launch Locally link on their transcript for courses that have been downloaded and can be launched through the local network. This permission cannot be constrained. This permission is recommended for end users of the LMS.</td>
<td>Learning</td>
</tr>
<tr>
<td>Local Network Player - Set Network Player Download Paths Preference</td>
<td>Grants ability to set the preference that allows administrators to set the download paths to which users can choose to download courses. This permission is controlled by a backend setting. This permission can be constrained by OU or User’s OU. This permission is recommended for local trainers and LMS administrators.</td>
<td>Learning</td>
</tr>
</tbody>
</table>
End of IE10 Support

Cornerstone is retiring support for Microsoft Internet Explorer 10. To keep up with browser security requirements and the latest software enhancements, support for Microsoft Internet Explorer 10 is discontinued with the May ’18 Release. If you have not already done so, please reach out to your IT department to make plans to convert to one of the compatible browsers prior to the release.
FTP Account Management - Password Reset
FTP Account Management - Password Reset - Overview

Prior to this enhancement, when an administrator needed to update their FTP account password, it was necessary to submit a case to Global Product Support (GPS). A new password would then be configured and sent to the user.

With this enhancement, when an administrator needs to update their FTP account password, they can do so via self-service in the Cornerstone system, with new permissions. This allows administrators to quickly and securely reset FTP account passwords on their own. This functionality is currently only available in Stage portals.

Considerations

More features will be added to this functionality in future releases and post-release patches.

Implementation

This functionality is automatically enabled in all Stage portals with the May 18th patch, and it will be available in Production portals in a future patch. The two new permissions described in the below section are automatically assigned to system administrators in Stage.

Permissions

The following new permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access FTP Account - View</td>
<td>Grants access to the FTP account landing page where the available accounts are displayed. Currently, this permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Reset Password and Public Keys - Manage</td>
<td>Grants ability to manage FTP account login password and public keys when applicable. Currently, this permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>
FTP Account Access - Passwords

Administrators with the appropriate permissions may reconfigure passwords for FTP accounts associated with their portals.

To configure a password for an FTP account, go to: ADMIN > TOOLS > CORE and click the FTP Account Access link.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access FTP Account - View</td>
<td>Grants access to the FTP account landing page where the available accounts are displayed. Currently, this permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Reset Password and Public Keys - Manage</td>
<td>Grants ability to manage FTP account login password and public keys when applicable. Currently, this permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>

FTP Account Access

The FTP Account Access page provides access to available FTP accounts. Some users may have access to the account list page, but not the Reset Password function, as they are controlled by different permissions. Each account displays with the name, partial folder path, and login URL.
Reset Password

On the FTP Account Access page, locate the account for which you want to configure a password, and click the "..." icon to the right of the account name. This opens the Options menu. Click the Reset Password option to access the Reset Password page.

Note: FTP password rules are enforced by the FTP service, Globalscape, and the Reset Password page's password requirements reflect the password requirements configuration as set in Globalscape. The rules which display on your organization's page may differ from what is shown in the screen shot below for this reason. Organizations may increase the complexity of their passwords as desired through Globalscape.

On the Reset Password page:

1. Enter the new password in the Create New Password field. Ensure the new password conforms to the password standards described on the page.

2. Enter the new password again in the Confirm New Password field. If the two passwords do not match, you will receive an error and will need to re-enter your password in one or both fields to ensure they are the same.

3. Click the PROCEED button. This causes a validation message to appear.
4. In the Read Before You Proceed pop-up message, ensure you understand the ramifications of your password change, and then enter a reason for changing the account's password. This field is required. If you wish to exit the Reset Password process without changing the account's password, you can click the **Cancel** link.

5. Click the **Submit** button after entering a reason for the change. The new password will be applied to the FTP account.
General Data Protection Regulation (GDPR) Readiness Program
General Data Protection Regulation (GDPR) Readiness Program

Cornerstone clients, particularly in the European Union, require the ability to anonymize/delete data associated with a user to ensure compliance with local and federal regulatory requirements, among which General Data Protection Regulation (GDPR) is the most prominent change. This can also have an impact on non-European clients with users in Europe who are covered by the related regulations.

For internal users, organizations can request that employee data be made anonymous based on the following removal scenarios:

- **User Based Removal** - For non-applicant users, this type of anonymization occurs when requested by a client. This type of removal is not dependent on the user's status or Legal Entity. When this type of removal, if the user is Inactive, the user record is anonymized and peripheral data is deleted; if the user is Active, the user record is not impacted but the peripheral data is deleted.
- **Time Based Removal** - This type of anonymization occurs automatically after a certain period of time. All internal users (not applicants) must be Inactive to be removed. For this type of removal, the user does need to have a Termination Date populated, and the user must belong to a Legal Entity. The Legal Entity determines the user record retention period.
- **Peripheral Data** - Organizations can set criteria for the deletion of peripheral data, such as performance reviews, development plans, etc, and this deletion may occur before a user is anonymized. When a user is anonymized, all peripheral data is removed as well.

For applicants, organizations can request that applicant data be made anonymous based on the following removal scenarios:

- **As a part of deletion of individual applications**, a user's application will be deleted when the following has occurred:
  - The requisition is closed or the user is in a closed status
  - The non-hired application in that closed requisition has exceeded the retention period as defined per the Location Organizational Unit (OU) (primary location) of that requisition
  - A user has left a legal entity, becomes inactive, and either requests to be forgotten OR whose data has exceeded the retention period for that Location OU of the closed requisition or exceeded the retention period for the Legal Entity (whichever comes first)
  - An applicant requests from the administrator that their application be deleted at any given point in time (whether or not the application has exceeded the data retention period of a closed requisition)
- **As a part of anonymization**, a user's information will be anonymized when the following has occurred:
  - The applicant has exceeded the period of inactivity as defined by the administrator in the Compliance Enablement Preferences area and that applicant has been dispositioned from a requisition
There are two types of data removal:

- **Deletion** - Data deletion removes the data from all databases, and the data is not recoverable.
- **Anonymization** - Data anonymization scrambles the user's identifiable information, and this process is not reversible.

Data removal can be configured based on a new standard organizational unit (OU), Legal Entity. The Legal Entity OU can only be used for data removal.

**Considerations**

Although Learning and other product suites are not explicitly mentioned in this documentation, all suites are impacted by data anonymization. For example, Learning records will remain available when a user is anonymized, but the records are not identifiable.

**Implementation**

Except for applicant anonymization, this functionality is controlled by a backend setting that is disabled by default.

To enable this feature please first speak with your Client Success Manager (CSM) as we offer different enablement paths depending on the complexity of your requirements. Once requirements are defined, submit a work order to Global Product Support (GPS) to enable the data retention rules for Legal Entity and Location OUs.

**Map Data Retention to Legal Entity/Location OU**

To define the data retention rules for Legal Entity and Location OUs, you must submit a work order to GPS.
**User Record Anonymization**

After a user record is anonymized, certain fields are anonymized and other fields are deleted. Also, the Modification History section does not show any identifiable information.

When editing a user record that has been anonymized, changes cannot be saved. A message is displayed at the top of the user record to indicate that the user record has been anonymized and can no longer be edited.

A user record can only be anonymized if their status is Inactive.

When a user record is anonymized, the following information is anonymized:

- Prefix
- First Name
- Middle Name
When a user record is anonymized, the following information is deleted:

- Last Name
- Suffix
- Username
- User ID
- Local System ID
- Original Hire Date - This is set to 1/1/1901
- Last Hire Date - This is set to 1/1/1901
- Address Line 1
- Address Line 2
- City
- State
- Zip
- Phone
- Fax
- Mobile Phone

For organizations using the fields below, the following information is also deleted:

- User Type and Sub Type
- Employment Status
- Leave Type
- Termination Reason
- Termination Date
- Termination Type
- Eligible for Rehire
- Rehired Employee
- For Sensitive Personally Identifiable Information (SPII) fields present in the Data Load Wizard and reporting that do not display on the user record, the values are deleted.

When a user record is anonymized, the following information is not impacted:

- Organizational Units (e.g., Division, Position, Grade)
User Record - Legal Entity OU

When Data Deletion is enabled, a new Legal Entity organizational unit (OU) is available on the user record. The Legal Entity OU is used when configuring Data Deletion Preferences. With the exception of applicant data, data deletion preferences can only be configured by Cornerstone.
Users Administration - Anonymized Users

When a user has been anonymized, the user record is still available in the Users Administration area, and the user appears when searching for users. However, the user’s information is anonymized in the search results.

To access the User Records Administration page, go to ADMIN > TOOLS > CORE FUNCTIONS > USERS.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users - View</td>
<td>Grants ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Users - View Core and Edit Custom Fields</td>
<td>Grants ability to view core information on a user record, including first name, last name, username, assigned OUs, custom relationships, and custom fields. This permission also includes the ability to edit any custom fields that are visible to the administrator. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. This is an administrator permission.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>

**Note:** When the User Record Redesign is enabled in a portal, this permission is disabled. Administrators who previously had this permission are automatically assigned the following permissions:

- Universal Profile - User Record - Edit Users
- Universal Profile - User Record - View Users
- Users - Edit Custom Field Information
- Users - View Custom Field Information
- Users - View General Information

This permission is obsolete following the retirement of the legacy User Record in the May
<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Core Administration</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Users - View Criteria Search</strong></td>
<td>Enables those who can search for and view users via the Admin/User screen to search by OU and Group criteria. This permission only works when assigned in conjunction with the Users - View permission.</td>
<td></td>
</tr>
<tr>
<td><strong>Users - View Manager Search</strong></td>
<td>Enables those who can search for and view users via the Admin/User screen to search by users' assigned manager. This permission only works when assigned in conjunction with the Users - View permission.</td>
<td></td>
</tr>
</tbody>
</table>
Data Load Wizard - Legal Entity OU Load

To support the Legal Entity organizational unit, a Legal Entity OU load is available. This data load enables administrators to load Legal Entity OU data into the system.

In addition, the Users data load enables administrators to associate users with a Legal Entity OU.
Cornerstone HR Data Anonymization
Effective Dated Record Anonymization

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user’s data is outside of the data retention period, effective dated records are anonymized. When an effective dated record is anonymized, certain fields are anonymized and other fields are deleted.

When an effective dated record is anonymized, the following information is anonymized:

- Prefix
- First Name
- Middle Name
- Last Name
- Suffix
- Username
- User ID
- Local System ID
- Original Hire Date - This is set to 1/1/1901
- Last Hire Date - This is set to 1/1/1901
- Address Line 1
- Address Line 2
- City
- State
- Zip
- Country
- Time Zone
- Phone
- Fax
- Mobile Phone
- Signature
- User Status
- Relationships
- Allow Reconciliation

When a user record is anonymized, the following information is deleted:

- Email Address
- Personal Email Address
- Absent Status
- User Type and Sub Type
- Employment Status
- Leave Type
- Termination Reason
- Termination Date
- Termination Type
- Eligible for Rehire
Rehired Employee
Custom Fields
For Sensitive Personally Identifiable Information (SPII) fields present in the Data Load Wizard and reporting that do not display on the user record, the values are deleted.

When a user record is anonymized, the following information is not impacted:
- Organizational Units (e.g., Division, Position, Grade)
- Display Language
**Forms Anonymization**

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user’s data is outside of the data retention period, all forms related to the user are deleted.

When the anonymized user is the subject of the form, the following occurs:
- The form is deleted from Snapshot Documents, including all attachments.
- Any tasks related to the form are deleted from the Actions tab within Actions.
- Any open form that is not completed or completed but not approved are deleted.

When the anonymized user is a manager, the following occurs:
- Any form tasks in the manager's Actions tab are deleted.

When the anonymized user is an approver, the following occurs:
- Pending approvals are removed from the approver's Requests tab.
Performance Data Anonymization
GDPR - Performance Review Task Administration - Data Deletion and Anonymization

When an administrator who has created a performance review task leaves a Legal Entity organizational unit (OU) and requests to be forgotten, their name is anonymized in the Created By column on the Performance Review Task Administration page.

To access Performance Review Task Administration, go to ADMIN > TOOLS > PERFORMANCE MANAGEMENT > TASKS.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Review Task Administration</td>
<td>Grants ability to create/assign performance review tasks and manage activity within those tasks. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User.</td>
<td>Performance - Administration</td>
</tr>
<tr>
<td>Task - View</td>
<td>Grants ability to view assigned tasks via Scheduled Tasks screen and Welcome Page My Tasks widget. This is an end user permission.</td>
<td>Core</td>
</tr>
<tr>
<td>View Performance Reviews</td>
<td>Grants ability to view the Performance Reviews page, which displays a user’s own past performance reviews as well as performance review task steps they've been assigned to complete. This also grants ability to view the Batch Rating page. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. This is an end user permission.</td>
<td>Performance</td>
</tr>
</tbody>
</table>
# Performance Review Task Administration

## Create a Performance Review Task

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Created By</th>
<th>Task Period</th>
<th>Status</th>
<th>Active</th>
<th>Dynamically Assigned</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billable Project Review</td>
<td>This is a review that can be launched from the end user or manager level.</td>
<td>Mullen, Lori</td>
<td>Off Cycle</td>
<td>In Progress</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feedback on Project</td>
<td>This is a review that can be launched from the end user or manager level.</td>
<td>Loffey, Jon</td>
<td>Off Cycle</td>
<td>Not Started</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feedback on Project Review</td>
<td>This is a review that can be launched from the end user or manager level.</td>
<td>Mullen, Lori</td>
<td>Off Cycle</td>
<td>In Progress</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interim Performance Discussion Doc...</td>
<td>This task may be launched by employee at will, to formally document a performance discussion that to...</td>
<td>Pauley, Keilie</td>
<td>Off Cycle</td>
<td>In Progress</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manager's Interim Performance Discussion Doc...</td>
<td>This task may be launched by manager at will, to formally document a performance discussion that to...</td>
<td>Pauley, Keilie</td>
<td>Off Cycle</td>
<td>In Progress</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
GDPR - Performance Reviews Data Deletion and Anonymization

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user’s data is outside of the data retention period, performance reviews are impacted in the following ways:

- **Reviewee** - If the user is a reviewee, the user's performance review and any underlying Form Sections are deleted.
- **Reviewer** - If the user is a reviewer, the user's core data such as First Name and Last Name are anonymized, such as in areas of the performance review PDF. That is, the reviewee's scores and comments remain intact, but any references to the reviewer are anonymized. This includes if the reviewer is a peer reviewer or a co-planner.
  - **Sign-off Section** - In the Sign-off section, the review's signature is anonymized.
- **Administrator** - If the user is an administrator, the user's core data such as First Name and Last Name are anonymized throughout Performance Review Task Administration.

When a data deletion request is made based on time, the performance review task end date is used to determine when the data is deleted or anonymized.
**GDPR - Goals Data Deletion and Anonymization**

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user’s data is outside of the data retention period, goals are impacted in the following ways:

- Individual Goals - If the user is the Goal Owner, the goal is deleted.
- Shared Goals - If the user is the Goal Owner of a shared goal, the goal is deleted.
- Manager Comments - If the user is a manager who has added comments to a subordinate’s goal, the manager’s core data such as First Name, Last Name, and Email Address are anonymized. That is, the comments remain intact, but any references to the manager are anonymized.

When a data deletion request is made based on time, the goal due date is used to determine when the data is deleted or anonymized. If the goal does not have a due date, then the goal creation date is used.

Considerations for Goals:

- When a user requests to be forgotten OR that user’s data is outside of the data retention period and that user has created a Feedback request, then any goals that are used in the Feedback Requests are not deleted since the Feedback Request uses a snapshot of the goal from when the request is made. A best practice for administrators is to request the deletion of both Goal and Feedback Requests.
- When a user requests to be forgotten OR that user’s data is outside of the data retention period and that user has goals within a Goal Rating or Goal Planning section of a Completed or Expired performance review, then those goals are not deleted because the goals reflected in these sections are snapshots of the goals. A best practice for administrators is to request the deletion of both Goal and Performance Review data.
- If an owner of a shared goal is leaving a legal entity, a best practice is to reassign the shared goal prior to making a data deletion request. This can be done from the Goals Edit page or the Manage Shared and Dynamic Goals page. The owner can re-assign the goal in the Managed by section.
GDPR - Competency Assessment Task Data Deletion and Anonymization

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user's data is outside of the data retention period, competency assessment tasks are impacted in the following ways:

- **Assessee** - If the user is an assessee, the user's competency assessment is deleted.
- **Assessor** - If the user is an assessor, the user's core data such as First Name and Last Name are anonymized. That is, the assessor's scores and comments remain intact, but any references to the assessor's core data are anonymized.
- **Administrator** - If the user is an administrator, the user's core data such as First Name and Last Name are anonymized throughout Competency Task Administration.

When a data deletion request is made based on time, then the competency assessment task end date is used to determine when the task data is deleted or anonymized. The last modified date is used to determine when competency ratings are deleted.
GDPR - Observation Checklist Data Deletion and Anonymization

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user’s data is outside of the data retention period, observation checklists are impacted in the following ways:

- **Assessee** - If the user is an assessee, the user's observation checklist is deleted.
- **Validator/Verifier** - If the user is a validator or verifier, the user's core data such as First Name and Last Name are anonymized. That is, the validator or verifier's validations remain intact, but any references to the validator/verifier are anonymized.
- **Validator/Verifier Electronic Signature** - If the user is a validator or verifier, and they have provided an electronic signature for an observation checklist, then the electronic signature is anonymized.
- **Administrator** - If the user is an administrator, the user’s core data such as First Name and Last Name are anonymized throughout Observation Checklist Administration.

When a data deletion request is made based on time, then the checklist completion date is used to determine when the data is deleted or anonymized. If the checklist is not yet complete, then the assignment date is used.

Considerations for Observation Checklists:

- With this phase, a user's LO-based observation checklists are not deleted when the user is anonymized. LO-based checklists that are within a curriculum will be deleted as part of a future release.
GDPR - Development Plan Data Deletion and Anonymization

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user’s data is outside of the data retention period, development plans are impacted in the following ways:

- **Individual Development Plans** - If the user is the Development Plan Owner, the development plan is deleted. This includes if the user creates a development plan or is assigned a development plan.

- **Development Plan Creator** - If the user is a manager or administrator who created a development plan for another user, the user’s core data such as First Name and Last Name is anonymized in the History section. This includes the Development Plan PDF.

- **Development Plan Comments** - If the user is a manager or administrator who has added comments to another user’s development plan, the manager or administrator’s core data such as First Name and Last Name is anonymized in the Comment section. This includes the Development Plan PDF. That is, the comments remain intact, but any references to the user are anonymized.

- **Development Plan Templates** - If the user has created a Development Plan Template, the development plan template is deleted.

When a data deletion request is made based on time, the development plan completion date is used to determine when the data is deleted or anonymized. If the development plan is not complete, then the development plan creation date is used.
GDPR - Skills Matrix Data Deletion and Anonymization

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user’s data is outside of the data retention period, roles are impacted in the following ways:

- Roles - If the user created a role or modified a role, the user’s core data such as First Name and Last name are anonymized in the Role’s Modification History and on the Manage Roles page.
GDPR - Feedback Data Deletion and Anonymization

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user’s data is outside of the data retention period, feedback is impacted in the following ways:

- Feedback Request - If the user has requested feedback, then the feedback request and any responses and ratings are deleted.
  - When a data deletion request is made based on time, then the feedback request date is used to determine when the data is deleted.
- Feedback Responder - If the user has replied to a feedback request for another user, user’s core data such as First Name and Last Name are anonymized. That is, the responder's ratings and comments remain intact, but any references to the responder are anonymized.
  - When a data deletion request is made based on time, then the feedback post date is used to determine when the data is anonymized.
- Unsolicited Feedback Post - If the user has received unsolicited feedback or a badge from another user, then the unsolicited feedback and any responses to the post for that recipient are deleted. If the user has provided unsolicited feedback for another user, then the user’s core data such as First Name and Last Name are anonymized. That is, the user’s feedback remains intact, but any references to the user are anonymized.
  - When a data deletion request is made based on time, then the feedback post date is used to determine when the data is deleted.
GDPR - Succession Planning Administration - Data Deletion and Anonymization

When an administrator leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user’s data is outside of the data retention period, Succession Planning Administration is impacted in the following ways:

- **Template Creator** - If the user created a succession planning template, then any references to their Core data such as First Name and Last Name are anonymized.
- **Task Creator** - If the user created a succession planning task, then any references to their Core data such as First Name and Last Name are anonymized.
- **Task User** - If the user is a user within a succession planning task, then any references to their Core data such as First Name and Last Name are anonymized.
- **Co-Planner** - If the user is a co-planner for a succession planning task, then any references to their Core data such as First Name and Last Name are anonymized.

When a data deletion request is made based on time, the following criteria is used to determine when data should be deleted or anonymized:

- **Succession Task** - For a succession task, the task expiration date determines when a user should be anonymized within the task.
**GDPR - Succession Planning Task Data Deletion and Anonymization**

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user's data is outside of the data retention period, succession planning tasks are impacted in the following ways:

- **Assessor** - If the user is an assessor, then any references to their Core data such as First Name and Last Name are anonymized.
- **Co-Planner** - If the user is a co-planner, then any references to their Core data such as First Name and Last Name are anonymized.
- **Task Reviewer** - If the user is a task reviewer, then any references to their Core data such as First Name and Last Name are anonymized.
- **Talent Conference Reviewer** - If the user is a talent conference reviewer, then any references to their Core data such as First Name and Last Name are anonymized.
- **Assessee** - If the user is an assessee in a Manager, Assessor, and Talent Conference tasks, the assessee is deleted from the task. In addition, any ratings, successors, or modification history associated with the assessee are also deleted.
- **Position Incumbent Rating** - If the user is a position incumbent in a Job Pool task, then any references to their Core data such as First and Last Name are anonymized. Also, the position incumbent ratings are deleted.
- **Position Successor** - If the user is a position successor in a Job Pool task, then the successor and any ratings associated with the successor are deleted.
GDPR - Evergreen Succession Data Deletion and Anonymization

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user's data is outside of the data retention period, evergreen succession data is impacted in the following ways:

- **Employee Rating** - All the user's evergreen ratings are deleted.
- **My User Based Successor** - All successors that have been named for the user are deleted.
- **My Position Successor** - Successors that have been named for the user's position are not affected.
- **User Based Successor** - The user is deleted as a successor for all users.
- **Position Based Successor** - The user is deleted as a successor for all positions.
- **Modification History of Position Successors** - Any modification history associated with the user's position successors is deleted.
- **Modification History of User Successors** - Any modification history associated with the user's successors is deleted.

When a data deletion request is made based on time, then the field's modification date is used to determine when the data is deleted.
**GDPR - Talent Pools Data Deletion and Anonymization**

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user’s data is outside of the data retention period, Talent Pool succession data is impacted in the following ways:

- **Talent Pool Creator** - If the user has created a talent pool, then any references to their Core data such as First Name and Last Name are anonymized.
- **Talent Pool Candidate** - If the user has been added to a talent pool, the user is deleted from the talent pool.
- **Nomination List Candidate** - If the user has been nominated as a candidate for a talent pool, the user is deleted from the nomination list.
- **Modification History** - Any modification history associated with the user within the talent pool is deleted.

When a data deletion request is made based on time, then the last modified date of the talent pool candidate within the talent pool is used to determine when the data is deleted.
GDPR - Universal Profile Data Deletion and Anonymization

When a user leaves a Legal Entity organizational unit (OU) and requests to be forgotten OR that user’s data is outside of the data retention period, Universal Profile is impacted in the following ways:

Universal Profile - Bio:
- Resume - All the user’s Bio: Resume data is deleted.
- Career Preferences - All the user’s Bio: Career data is deleted.
- Job Interests - All the user’s Bio: Career - Job Interest data is deleted.

Universal Profile - Snapshot:
- Goals - The Goal Progress widget is updated to reflect goals that have been deleted as a part of data deletion requests.
- Performance Reviews - The Performance Review widget scores are updated to reflect performance reviews that have been deleted as a part of data deletion requests.
- Competencies - The Competency Rating widget scores are updated to reflect competency assessment tasks that have been deleted as a part of data deletion requests.
- Badges - The Badges widget is updated to reflect badges that have been deleted as a part of data deletion requests.
- Succession:
  - Employee Succession Ratings are updated to reflect that evergreen succession ratings have been deleted as a part of data deletion requests.
  - User Based Successors are deleted to reflect that user’s successors have been deleted in evergreen succession as a part of data deletion requests.
  - User is deleted as Position Based Successor for all positions as a part of data deletion requests.
  - User’s Position Based Successors are not affected.
- Documents - All documents uploaded by the user are removed as a part of user anonymization.

*Note: A user’s peripheral data, such as Resume data, is only deleted if the user is anonymized.*
Recruiting Data Anonymization
Data Deletion to Support Data Privacy for Recruiting

The Data Deletion project ensures that user application data is not kept in the system longer than the defined amount of time set by the data retention period. As a part of this project, Data Deletion is divided into two areas:

- Deletion of individual applications within a requisition
- Anonymization

With this functionality, you can do the following:

- **Data Retention Mapping** - Map data retention periods to a Location Organizational Unit (OU). This is done by the administrator through submission of a work order to Global Product Support (GPS).
- **Delete Hired Employee Data** - Delete applications for hired employees who leave the Legal Entity, become inactive and who request to be forgotten OR whose data exceeds the data retention period.
- **Delete Application within a Closed Requisition** - Trigger the data deletion time-based event for closed requisitions.
- **Data Anonymization** - Applicants who have exceeded the period of inactivity for anonymization will not be dispositioned if that applicant is not dispositioned and part of a requisition that is in an Open status. In addition, the word "Archive" (or variations of it) has been replaced with Anonymization (or variations of it) in many instances throughout the system. The anonymized user is no longer searchable.

**Difference between Anonymization and Deletion**

- **Deletion** - Upon successful execution of data deletion, all non-hired applications within the Cornerstone system that have exceeded the data retention as configured by the administrator for a given Location OU, will be deleted. This deletion is permanent and non-reversible.
  - Removal method is dependent on the scenario:
    - For time-based: Deletion of non-hired applications based on a data retention period which is triggered following a pre-defined timeframe when the requisition is closed or the applicant is dispositioned.
  - **Anonymization** - Replacement of applicant core user data (Prefix, Suffix, First, Middle, Last Name, Email Address, City, State, Zip, Country) with randomized string of characters within the database
    - User of the Cornerstone system – When a user leaves a legal entity and requests to be forgotten or their core data is outside the entity’s data retention period, then that user’s core data is anonymized throughout the Cornerstone portal (e.g. Recruiter and/or Recruiting Administrator).
    - **Note:** The Compliance Enablement Preference for New Submission Anonymization is different than the anonymization described above. When the Anonymize personal applicant data for New Submissions option is selected in Compliance Enablement Preferences for a Location OU, the value in the Name column for applicants in a New Submission status is replaced with the applicant's
requisition number and applicant ID. The applicant ID is scrambled so that the applicant remains anonymous. Users can still sort the table using the Name column. However, once that applicant moves into a new status, their information is no longer anonymized.

Use Cases

Use Case 1: Caitlin, the Recruiter

Date Created: 1 January 2015

Primary location of requisition: Italy

Data Retention Period: 6 months

Background:

- 35 applicants apply to the position
- 10 candidates are dispositioned
- One candidate is hired and the requisition is closed (remaining candidates are dispositioned)

Result:

- 34 remaining non-hired applications are deleted when the data exceeds the data retention period

| Jan 1, 2015 - Caitlin creates a requisition | Feb 25, 2015 – Over the course of ~2 months, Caitlin receives 35 applications for the requisition. 10 candidates are dispositioned. | March 1, 2015 – She hires one applicant, closes the req. and the remaining candidates are dispositioned | Sept. 2, 2015: The 34 non-hired applications for that requisition are deleted |

Note: In this scenario, the hired applicant’s application will become part of the user record and will be deleted based on user deletion rules. This includes deletion upon the user leaving the entity and requesting to be forgotten or their data exceeding the defined data retention for that legal entity.

Use Case 2: Martha the recruiter defines the period of inactivity for 2 months and Jamie the applicant applies to a position
**Date Created:** 1 March 2015  
**Primary Location of Requisition:** Germany  
**Period of Inactivity:** 2 months (if applicant does not log back into Career Site, then their applicant core data is anonymized due to inactivity)

**Background:**
- Jamie applies to the role on 1 March (Jamie’s applied to only one requisition) and does not log back into the career site  
- Jamie is dispositioned from the requisition on 1 April 2015

**Result:**
- Jamie’s information is anonymized due to inactivity and her dispositioned application  
- Her information will not be available in Talent Pools or Saved Search

---

**Use Case 3: Tim, the hired applicant**

**Company:** Palmer Inc.  
**Legal Entity:** Sweden  
**Data Retention Period:** 2 years

**Background:**
- Tim applies to an application and gets hired  
- Tim’s application resides with him as a user upon getting hired

**Result:**
- When Tim leaves the Legal Entity, the application will be deleted when it is has exceeded the data retention period
Use Case 4: Sam wants to provide information through Connect with Us for ABC Co.

**Background:**
- ABC Co's period of inactivity preference is configured to 1 year after applicant submits their information
- Sam submits information through ABC Co's Connect with Us feature on 1 Jan 2015

**Result:**
- Sam's personal information is anonymized on 2 Jan 2016

**Considerations**
- The user's application is not deleted when moving from one Legal entity to another, provided that the user is in an Active status in the portal.
Applications from an external source are not impacted.

Even if a candidate exceeds the period of inactivity for a given requisition, an applicant's data is not anonymized if the applicant has an application in a job requisition that is in an Open status. However, if the applicant is dispositioned in an Open requisition for which they are the only applicant, then their data is anonymized.

When a requisition has multiple locations, the data deletion rules will apply to the primary location of that requisition.

If an applicant is hired, then their application will not be deleted until the user leaves the Legal Entity and either requests to be forgotten or their data exceeds the data retention period.
GDPR - Compliance Enablement Preferences - Applicants Settings

The Applicants section of Compliance Enablement Preferences allows administrators to define the settings for anonymizing applicants by defining a period of inactivity, after which time the applicant's profile is anonymized. The Applicants section also enables administrators to set personal applicant data as anonymous for new submissions and allow external applicants to deactivate their own profile.

The Applicants section of the Compliance Enablement Preferences topic contains details about each available option, including exceptions and use cases. See Compliance Enablement Preferences.

To access Compliance Enablement Preferences, go to ADMIN > TOOLS > RECRUIT > COMPLIANCE ENABLEMENT.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compliance Enablement Preferences - Manage</td>
<td>Grants ability to access and manage Compliance Enablement Preferences. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
</tbody>
</table>
GDPR - Deletion of Applications

When the data deletion event is triggered, all data for the applicant is permanently deleted and will no longer be recoverable and will not be available in the database. The following data will be deleted:

- General Applicant Information
- Comments
- Ratings
- History / Audits
- Interviews
- Offer Letters
- Reviewers
- Selection Responses
  - Realistic Job Preview
  - Selection Assessment
  - Skills Test
- Workflow Responses
  - Competency Assessment Task
  - Disclaimer
  - EEO Question
  - Training
  - Custom Integrations
  - Pre-Screening Responses
- Emails
- New Forms
- External Assessments
- Background Checks
- Attachments
- Flags
- Referrals / Costs
- Applicant Resume
- Hired applications for users who leave the Legal Entity, become inactive and data has exceeded the data retention period
- Applications on an ad-hoc basis through submission of a GPS work order

**Note:** If an application has been submitted through an Agency and that application is subject to time-based deletion and is deleted, then the actual Agency submission should be accurately reflected in Reporting.

**Note:** When a requisition has multiple locations, the data deletion rules will apply to the primary location.
GDPR - Anonymization by User

Users can request that their data be anonymized as a result of leaving the Legal Entity. Once the user leaves the Legal Entity, then their data is anonymized and the data cannot be recovered in its previously visible state.

This impacts the following areas of the system:

- **Manage Applicants** - Applicant profile data will be anonymized
- **Recruiting Dashboard** - Applies to the following:
  - View Snapshot > Submission Details / "Name" column in All Submissions subsection (only when user leaves the Legal Entity)
  - View Snapshot > Cost Details / "Applicant Name" column in Cost Details (only when user leaves the Legal Entity)
  - View Snapshot > Cost Details / "Modified by" column in Cost Details (only when user leaves the Legal Entity)
  - Recent Referrals / "Referred by" column
  - Recent Referrals / "Name and Contact" column (only when user leaves the entity)
- **Search Candidates** - Applies to Saved Searches
- **Review Applicants** - Applies to Review Applicants / "Owner(s)" column
- **Recruiting Manager Dashboard** - Applies to the following:
  - Recruiter Snapshot / "Recruiter name"
  - Recruiter Snapshot / Recruiter name in **Time to Hire** drop-down
- **Candidate Search Query** - Applies to Saved Searches / "Created by"
- **User Resume** (not applicant resume)

See Also:

- **Ad Hoc Anonymization**
Google Tag Manager Integration

With this enhancement, organizations can use the Google Tag Manager integration to deploy code snippets at their own convenience, without the intervention of Cornerstone's development or services teams. The Google Tag Manager tool is separate from Google Analytics and can be used to set up code from any provider or source. Once the integration has been enabled in the Cornerstone system, administrators can add code snippets to system pages and track user behavior on those pages using the features available.

Use Cases

Use Case #1: Adding Tracking Tags

Helen is a business process owner and system administrator at Ventonix, which is a well known provider of learning content that anyone can purchase online. She uses Google Analytics to track the behavior of potential customers, but is currently limited to page level insights. She would like to be able to determine which courses get the most inquiries.

Helen uses the Google Tag Manager integration to add new tracking tags to her pages. After a week, she checks her analytics dashboard and discovers that the Finance Fundamentals course receives the most inquiries. She notices that the training details for this page haven't been updated and can now work with her marketing team to revisit the content, to improve the company's conversion rates.

Use Case #2: Deploying Custom Code

Uzair is a business process owner and system administrator at ACME Corp. The company has partner guidelines that require them to use Adobe Analytics, which is not supported by Cornerstone. In addition, there are branding guidelines which provide specific styling and messaging that must be used on all end user-facing pages.

Uzair uses the Google Tag Manager integration to add the Adobe Analytics code, as well as custom HTML for styling. He is able to test and deploy this at his own pace, since his code is managed through the Google Tag Manager tool and does not require Cornerstone intervention.

Implementation

The Google Tag Manager integration will be available for User Acceptance Testing (UAT) in Stage portals with the April 19th deployment. Requests for enablement to Global Product Support (GPS) can be processed after April 19th.

Following the May ‘18 release, the Google Tag Manager integration can be enabled by request for any portal. Please contact Global Product Support to enable the new security object for the Google Tag Manager. Once the Google Tag Manager has been enabled in the portal, the Google Tag Manager Javascript code can be inserted into the code of the header for all system pages that use the standard header, allowing administrators to track the behaviors of system users.

For information about using Google Tag Manager, see the Google Tag Manager Help Center.
Historical Upload Tool (HUT) Retirement

With the May '18 Release, Cornerstone no longer supports, and organizations no longer have access to, the Historical Upload Tool (HUT). HUT was a legacy tool used to upload Event/Session data and associate users to groups. Built prior to Data Load Wizard (DLW), the tool has seen declining/limited usage over time and is not enabled in newer portals. Organizations still using the HUT should contact their Client Success Manager to determine which solution will be most effective moving forward.

This tool will be retired with the May 18 patch.
Reporting 2.0 (Early Adopter)
Report 2.0 (Early Adopter) Overview

Reporting 2.0 is the new reporting tool for standard and custom reports. The new tool must be self-enabled and is intended to provide you with a simplistic and intuitive way to build and use reports. This is a powerful new engine that delivers a single application for creating reports.

With the May ’18 release, Recruiting and Performance are now supported (support for Learning was introduced as part of the February ’18 release). In addition, delivery and scheduling are now available, as well as new sorting features and report sharing.

For detailed information about creating and viewing reports, see the following existing topics in Online Help:

- Reporting 2.0 - Homepage
- Reporting 2.0 - Create Report
- Reporting 2.0 - Report Viewer

Click here to download the Reporting 2.0 (Early Adopter) starter guide.

Note: You will continue to have full access to standard and custom reports following self-enablement of this functionality in your portal.

Reporting 2.0 - Early Adopter Details

Reporting 2.0 (Early Adopter) is intended to give you a chance to get familiar with the tool in your Production and/or Pilot environment before it is made generally available (GA) in a future release. Early Adopters can build both ad hoc reports and report templates with their data by adding columns, specifying filter logic, and specifying filter properties.

While all clients are encouraged to be a part of the Reporting 2.0 (Early Adopter), it is important to make sure the features meet your needs. The following are a few components of an Early Adopter:

- Experienced in building Custom Reports
  - The Early Adopter will build report templates and share them with other users. These other users do not necessarily need to be experienced in building Custom Reports as they will simply be using templates and downloading reports.

- My portal has User and Learning, Recruiting, or Performance Data
  - Succession, Compensation, and Extended Enterprise are not fully supported at this time.

- I understand that not all existing Custom Reporting features are currently available in the Early Adopter but I am eager to start using the features that are available now

Use Case

Anna Administrator

1. As Anna Administrator, I build and maintain reports for my organization.
2. I am most interested in the filter properties because I can:
   A. Make it easier for Viewers to know which criteria to set.
B. Hide confusing filters.
C. Limit how Viewers interact with filters.
3. I build reports and bring in my favorite standard and custom fields.
4. I share reports with other users and let them know they have a new report.
5. I spend the most time making sure the filter logic is correct and easy to use.

**Vicky Viewer**
1. As Vicky Viewer, I run reports for my team.
2. I do not have the create permission, thankfully, because I am too busy to learn how to build reports.
3. I love running report templates others have built for me. I change a couple filters like date.
4. If I need something complex changed in the report, I will talk to Anna Administrator and ask her to change it for me.

**Considerations**
Standard and custom compliance questions in Recruiting will be available in a post-release patch.

The following features are not available with the May '18 release but may be available as part of a future release:
- Succession and Compensation are not supported with the May '18 release
- Charts
- Dashboards
- Calculations
- Summary/Group By
- Custom Fields for:
  - Compliance Questions
  - Compensation
  - Succession
  - Job Pool
  - SF-182
  - Transaction
- Currency Conversion
- Folders

**Implementation**
Learning, Recruiting, and Performance data will be supported in Reporting 2.0 (Early Adopter) in Production and Pilot environments when the May '18 Release is deployed to those environments. Prior to the May '18 Release, Reporting 2.0 (Early Adopter) in Production and Pilot only supports User and Learning data.
This functionality must be self-enabled. For self-enablement information, See Enable Reporting 2.0. All clients can opt-in to Early Adopter in Stage, Pilot, and Production portals. Note

Each February 2018 Early Adopter client should have a stakeholder experienced with building custom reports. The stakeholder(s) should build report templates and share them with other users. The other users do not need Custom Reports experience, as they will simply be using templates and downloading reports. Note: Without a stakeholder with fair to moderate Custom Report experience (or comparable experience with a reporting/analytics tool), the user experience may not be as successful.

**Security**

The Reporting 2.0 functionality is controlled by a series of permissions that allow you to create more specific reports by report field. For this reason, permissions are at more of a granular level with this functionality.

The permissions are broken down by the main product level permission, section level, and then at the field level. For example, if you wanted to report on Instructor Led Training (ILT) in the system, you would need:

- The Reporting - Manage permission to create reports.
- The Reporting - View permission to preview reports and view reports.

You would also need:

- The top-level product specific permission to create reports related to that product.
  - e.g. Reporting - Learning - Manage
- The section specific permission to create reports for that feature within the product.
  - e.g. Reporting - Learning - ILT - Manage
- The field level permissions to be able to create reports with the specific fields for that feature within the product.
  - e.g. Reporting - Learning - ILT - ILT Facility - Manage

If a user does not have each level of permission, then they may not have access to the report builder, or the field section may not be visible, or the fields within the section may not be visible. Also, if a user does not have the top-level product specific permission, then none of the sections of fields for that product will be visible, such as the fields for LMS reports.

The power of this granularity of permissions is that you can give access to as many or as few field sections as necessary for your users. For example, you may give users access to some User field sections, but not give them access to the User Identifier field section if that contains sensitive data for your portal.

**Reporting 2.0 List of Permissions**

For the full list of new and existing permissions and their relationships, see the permissions spreadsheet in Online Help.
Permission Constraints

Constraints exist at the section specific level for permissions, such as for the Reporting - Learning - ILT - Manage permission. At this time, the following constraints are available:

- OU
- User’s OU
- User Self and Subordinates
- User’s Direct Report
- User
- Learning-specific constraints:
  - Provider
  - Training Item
  - Training Type
- Requisition-specific constraints:
  - User’s Division
  - User’s Position
  - User’s Location
  - Division
  - Position
  - Location

Share Reports Permission

The option for sharing reports is only visible to users who have the Reporting - Share Report permission. Users without the permission can still receive shared reports, but constraints (for other permissions, such as Reporting - Core permissions) will be respected. For example, if you share a report that contains data around Location A and the user receiving the report is constrained to only see data for Location B, the report would not contain any records.

The following constraints are available for this permission:

- OU
- User’s OU
- User Self and Subordinates
- User’s Direct Report
- User
- User’s Self
- User’s Manager
- User’s Superiors
- User’s Subordinates
- User’s Direct Subordinates
- Employee Relationship
Report Delivery Permission

The Reporting - Delivery permission grants the ability to deliver reports in Reporting 2.0. Users must also have permission to view reports. The permission can be used in conjunction with the various product, section, and field level permissions. Users must have permission to view Reporting 2.0 in order to have access to a report that is delivered to them. If they do not have view access, then the Reporting 2.0 navigation sublink will not display for them.

Users who have permission to manage Reporting 2.0 can edit a report that is delivered to them. They can also copy the delivered report.

The following constraints are available for this permission:

- OU
- User's OU
- User Self and Subordinates
- User
- User's Self
- User's Manager
- User's Superiors
- User's Subordinates
- User's Direct Subordinates
- Employee Relationship
Enable Reporting 2.0

Reporting 2.0 must be self-enabled in your portal in order for the functionality to be available for users. Once enabled, users must also be assigned the permissions necessary to access and use the new report builder.

Each May 2018 Early Adopter client should have a stakeholder experienced with building custom reports. The stakeholder(s) should build report templates and share them with other users. The other users do not need Custom Reports experience, as they will simply be using templates and downloading reports. **Note:** Without a stakeholder with fair to moderate Custom Report experience (or comparable experience with a reporting/analytics tool), the user experience may not be as successful.

**Click here to download the Reporting 2.0 (Early Adopter) starter guide.**

Self-Enablement

Administrators who are at the CESadmin level may complete the following steps to enable Reporting 2.0:

1. Navigate to **ADMIN > TOOLS > CORE FUNCTIONS > CORE PREFERENCES > SYSTEM PREFERENCES > REPORTING 2.0 ACTIVATION PREFERENCES.**

![Reporting 2.0 Early Adopter Activation Preferences](image)

2. Click the **ACTIVATE** button on the Reporting 2.0 Activation Preferences page. This opens a confirmation pop-up.

3. Click **ACTIVATE** on the pop-up to activate Reporting 2.0. This returns you to the activation page. A green success message appears if activation is successful.

Once the functionality has been activated, the activation cannot be undone. The activation will have no impact to standard or custom reports. All of your existing standard and custom reports and their settings will still be available. Any shared reports are also available. Existing permissions for standard and custom reports will still be available and remain assigned to users.

**Note:** You can click **CANCEL** in the confirmation pop-up if you do not want to activate Reporting 2.0 at this time. You can return to the activation page when you are ready to activate Reporting 2.0.

**Note about Copydowns:** If you request a copydown from a portal without Reporting 2.0 activated, please also request that the activation page be re-enabled. You will need to re-enable (e.g., if you are enabled in Stage but not Pilot/Production, and copydown, you will have to re-enable in Stage.)
Supported Environments

The following environments are supported:

- **Stage** - All clients may opt-in to Early Adopter.
- **Pilot** - All clients may opt-in to Early Adopter.
- **Production** - All clients may opt-in to Early Adopter.
Report Delivery and Scheduling

The Delivery option lets you send the report to yourself and other users via email. You can also schedule report delivery once, daily, weekly, or monthly.

Permissions

In addition to general permissions for creating and viewing reports in Reporting 2.0, users also need the following permission to deliver reports:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting - Delivery</td>
<td>Grants ability to deliver reports in Reporting 2.0. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Subordinates, and Employee Relationship. This permission is used in conjunction with the view permission for Reporting 2.0 and can also be used in conjunction with the various product, section, and field level permissions. Users must have permission to view Reporting 2.0 in order to have access to a report that is delivered to them. If they do not have view access, then the Reporting 2.0 navigation sublink will not display for them. Users who have permission to manage Reporting 2.0 can edit a report that is delivered to them. They can also copy the delivered report. Note about Constraints: The constraints for this permission determine who you can deliver the report to. The constraints do not pertain to the data you can see in the report.</td>
<td>Reporting</td>
</tr>
</tbody>
</table>
Report Delivery
To set report delivery:

1. Click the delivery icon in the upper-right corner of the Builder tab. This opens the Delivery panel.
2. Check the Myself box to deliver the report to your email.
3. Click ADD USERS to open the Select Users panel.
4. Search for and select users to deliver the report to. Up to 10 users can be selected.
5. Click SELECT to save the selections. This adds the users to the Delivery panel.
6. Select the delivery format from the Format drop-down. The following delivery options are available:
   A. Excel
   B. CSV
   C. PDF
   D. Word

You can remove users by clicking the X to the left of the user's name.
The report is delivered to the user's email that is in their user record.
Report Scheduling

Toggle the **Schedule Delivery Time** option to On. This enables the delivery options to appear. You can also schedule a one-time delivery or deliver the report daily, weekly, or monthly.

**Schedule One-Time Report**

1. Click the **Once** option in the frequency drop-down.
2. Enter the time of day in the **Time of Day** field. You can also use the clock to select a time.
3. From the drop-down, select the time zone in which to run the report. The default setting is the time zone of the user configuring the report.
4. Enter a start date in the **Start Date** field. You can also use the calendar option to select a date. By default, the start date is the current date.

The report will be delivered at the specified date and time.

**Schedule Daily Report**

Click the **Daily** option in the frequency drop-down. This enables the options to display below the drop-down for creating a report that runs daily. Complete the following fields:

- **Every** - This field enables you to determine the report interval. For example, if "3" is the value in the field, then the report runs every three days. Enter the number of days in the **Every** field. The default value is "1." This is a required field.
- **Time of Day** - Enter the time of day in the **Time of Day** field. You can also use the clock to select a time.
- **Time Zone** - From the drop-down, select the time zone in which to run the report. The default setting is the time zone of the user configuring the report.
- **Start Date** - Enter a start date in the **Start Date** field. You can also use the calendar option to select a date. By default, the start date is the current date.
- **End Date** - Enter the date on which to stop running the report. This is a required field.

**Schedule Weekly Report**

Click the **Weekly** option in the frequency drop-down. This enables the options to display below the drop-down for creating a report that runs weekly. Complete the following fields:

- **Every** - This field enables you to determine the report interval. For example, if "3" is the value in the field, then the report runs every three weeks. Enter the number of weeks in the **Every** field. The default value is "1."
- **On** - Select the day of the week on which the report will repeat.
- **Time of Day** - Enter the time of day in the **Time of Day** field. You can also use the clock to select a time.
- **Time Zone** - From the drop-down, select the time zone in which to run the report. The default setting is the time zone of the user configuring the report.
- **Start Date** - Enter a start date in the **Start Date** field. You can also use the calendar option to select a date. By default, the start date is the current date.
- **End Date** - Enter the date on which to stop running the report.
Schedule Monthly Report

Click the Monthly option in the frequency drop-down. This enables the options to display below the drop-down for creating a report that runs monthly. Complete the following fields:

- **Every** - This field enables you to determine the report interval. For example, if "3" is the value in the field, then the report runs every three months. Enter the number of months in the Repeat Every field. The default value is "1."

- **On** - This field allows you to configure when the report will run.
  - **Day** - Select "Day" from the drop-down to run the report on a specific day of the month. This enables a numeric text box to display to the right of the drop-down. In the text box, enter the day of the month on which the report will run.
  - **First** - Select "First" from the drop-down to run the report on the first <Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday> of the month.
  - **Second** - Select "Second" from the drop-down to run the report on the second <Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday> of the month.
  - **Third** - Select "Third" from the drop-down to run the report on the third <Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday> of the month.
  - **Fourth** - Select "Fourth" from the drop-down to run the report on the fourth <Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday> of the month.
  - **Last** - Select "Last" from the drop-down to run the report on the last <Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday> of the month.

- **Time of Day** - From the drop-down, select the time at which to run the report. The default setting is one hour from the current time.

- **Time Zone** - From the drop-down, select the time zone in which to run the report. The default setting is the time zone of the user configuring the report.

- **Start Date** - By default, the date on which the report starts running is the current date. You can modify the start date by entering a different date in the field.

- **End Date** - Enter the date on which to stop running the report.
Share Report

The feature for sharing reports is located in the upper-right corner of the Build tab. The option is only visible to users who have permission to share reports.

Users without permission to share reports can still receive shared reports, but constraints (for other permissions, such as Reporting - Core permissions) will be respected. For example, if you share a report that contains data around Location A and the user receiving the report is constrained to only see data for Location B, the report would not contain any records.

Permissions

In addition to general permissions for creating and viewing reports in Reporting 2.0, users also need the following permission to share reports:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting - Share Report</td>
<td>Grants access to share reports in Reporting 2.0. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Subordinates, and Relationship. This permission is used in conjunction with the view permission for Reporting 2.0 and can also be used in conjunction with the various product, section, and field level permissions. Users must have permission to view Reporting 2.0 in order to have access to a report that is shared with them. If they do not have view access, then the Reporting 2.0 navigation sublink will not display for them. Users who have permission to manage Reporting 2.0 can edit a report that is shared with them. They can also copy the shared report. Note about Constraints: The constraints for this permission determine who you can share the report with. The constraints do not pertain to the data you can see in the report.</td>
<td>Reporting</td>
</tr>
</tbody>
</table>

To share a report:

1. Click the Share icon 📈 to open the sharing flyout.
2. Search for the users and OUs with whom you would like to share the report.
3. Check the box to the left of the users and OUs with whom you would like to share the report. There is no limit to the number of users you can share with.
4. Click the Selected tab in the flyout. This tab displays the users and OUs you have selected and allows you to determine their view and edit access for the report, as well as include or exclude subordinates.

5. Set the view and edit access by clicking the viewing options drop-down to the right of the user or OU details. The following options are available:
Can View - This option is selected by default. Users will only be able to view the shared report and cannot edit it.

Can View and Edit - Select this option to allow users to view and edit the shared report. If a user receives edit access, they will have access to make changes to the master copy of the report. This means that any edits a shared user makes are also reflected in the original report.

6. Click SELECT to save the share settings. Then, click SAVE on the report to save and share the report.
Frequently Asked Questions

Can shared users share the report with other users?
The users with whom you share the report can only view the report, provided they have all of the necessary permissions to view the report. Or, if they have "Can View and Edit" access, then they can also edit the report if they have all of the necessary permissions for editing the report.

Can a shared user delete the report?
No. Shared users cannot delete a report that is shared with them.

What happens if the report owner deletes the report?
The report will no longer be available to the shared users. Even if a shared user had edit access, the report is still deleted for that user.

However, if a user copied the report, their copy of the shared report will not be deleted.
Sort Report

With the May '18 release, reports in Reporting 2.0 can now be sorted. The sort feature lets you define the sort order of the fields you selected for the report. By sorting the report fields, you can define which column displays first, and so forth, in the report output.

The report can be sorted by using the option in the Sort panel or by sorting from the Preview tab.

Sort from the Sort Panel

Sorting the report from the Sort panel is the recommended method for creating a sort order for your report.

To sort the report:

1. Click the properties icon to open the Sort panel.

2. Add fields by which to sort the report. You can do this by dragging a field from the Table Columns section. Or, click the Click to add a column... link. This opens a search fields option.
3. Search for and select the fields by which you would like to sort the report. The fields appear above the search option. The report can be sorted by up to five fields.
4. Determine the sort order, either **Ascending** or **Descending** by clicking the arrow to the left of the word.

5. You can change the sort order by clicking and dragging the field below or above another field in the sort order.

6. Click the X to the right of the field to remove the field from the sort.

7. Open the Preview tab.

8. Click **REFRESH** to refresh the data in the report. This is necessary to sort all the data in the system, not just the data in the preview.

To close the Sort panel, click the X to the right of the tab name.

Once all settings are made to the report, click **SAVE** to save the report.

**Sort from the Preview Tab**

You can sort the report directly from the Preview tab. However, changes you make to the columns will overwrite the sort order you created in the Sort panel. For this reason, it is a best practice to use the Sort panel to sort the report.

To sort from the Preview tab:

1. Click the name of a column (the field name) to sort the report by that field.
2. The sort order automatically changes to sort by the column you selected. Notice that the column sorting information in the Sort panel changes to show the column name you selected. If you had a sort order already configured in the Sort panel, those settings are overwritten by manually changing the sort order on the Preview tab.
3. The sort order is Ascending by default. Click the column name or click the arrow to the right of the column name to change the sort order to Descending.
4. Click the column name three times to remove the column from the sort.

Once all settings are made to the report, click **SAVE** to save the report.

**Tip:** You can also use the keyboard control Shift to add up to 5 columns to sort. Click a column header, hold the shift key, and click another column header to add it as the next level. Remember that the 3rd click will remove that column from sort. All changes to sort from Table Columns will be reflected in the Sort Panel.
Secure Page Timeout

For security purposes, if a user has been idle for over 60 minutes (no mouse clicks or key presses), a session timeout message will appear at the top of the following pages:

- **Learning**
  - Learning Search
  - Learner Home
  - Playlist Details (Learning > Playlists > Open Playlist)
  - User’s Playlist (Learning > Playlists)
  - Create Playlist (Learning > Playlists > Create Playlist)
  - LCMS Sync (Admin > Tools > Learning > Catalog Management > Course Catalog > Options > Sync Catalog)

- **Development Plans Redesign**
  - Create a Plan (Snapshot > Dev Plan > Create a Plan)
  - Manage Plan (Snapshot > Dev Plan > Manage Plan)
  - Development Plan Templates (Admin > Tools > Performance > Plan Templates)
  - Development Plan Categories (Admin > Tools > Performance > Plan Categories)
  - Objective Categories (Admin > Tools > Performance > Objective Categories)
  - Activity Types (Admin > Tools > Performance > Activity Types)
  - Development Plan Preferences (Admin > Tools > Performance > Development Plan Preferences)

- **Compensation**
  - Compensation Salary Structure (Admin > Tools > Compensation > Salary Structures)

- **Recruiting**
  - Smashfly Recruitment Marketing Integration (Recruit > Manage Requisitions > More Options > Manage Recruitment Marketing)

**Considerations**

- If the default session timeout for a portal has been set for longer than 60 minutes, the above pages will still timeout at 60 minutes.
- This change does not impact users who are logged in through SSO authentication.
- This change does not impact users who have launched and are in a course.

**Implementation**

This functionality is automatically enabled for all organizations using the Learning, Performance, or Compensation functionality.
Cornerstone HR
Form Approval Workflow
Form Approval Workflow - Approve by Group or Organizational Unit (OU) - Overview

Prior to this enhancement, form approvals could only be completed by specific users or employee relationships.

With the May 16, 2018 patch, organizations can add groups or organizational units (OUs) to a form approval workflow. This enables more powerful employee and manager self-service capabilities through enhanced workflow configuration, which frees administrator time to work on other priorities.

Clients can configure approval workflows that include:

- Employees
- Employee Relationships
- Groups (new with this enhancement)
- OUs (new with this enhancement)

Use Cases

Marissa is an administrator at Acme Financial and needs to ensure that the Employee Address Update form is approved by a member of the HR group. When configuring the approval workflow for the form, Marissa adds the HR group as the form approver.

Curtis, an HR manager and member of the HR group, sees that he and the rest of the HR group receive form approval notifications and requests associated with the Employee Address Update form.

Considerations

- Forms utilizing Group/OU Approvals are not supported for Onboarding Form Tasks.
- The Include Subordinates option is NOT supported for groups and OUs.
- For group/OU approvals, the first response will progress the approval workflow.
- The OU/group enrollment is dynamic as applied to Forms Approval Workflows. Changes to the OU/group enrollment will dynamically update the users within the OU/group who can approve the form.

Implementation

This functionality is available in for all Stage portals using Cornerstone HR on May 16, and will be released to Production portals in an upcoming patch. Administrators can configure the approval workflow for forms.

Permissions

The following existing permission applies to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Form Management</td>
<td>Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission. <strong>Note:</strong> This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.</td>
<td>Form Management Administration</td>
</tr>
</tbody>
</table>
Form Approval Workflow - Add Approver

Prior to this enhancement, it was possible to add specific users and employee relationships as approvers in a form approval workflow. With this enhancement, when creating or editing a form approval workflow, you can also add organizational units (OUs) or groups as approvers in the workflow. This allows users included in selected OUs or groups to act as approvers for the form. When multiple users are included in the OU or group, the first user to respond to the approval request advances the workflow to the next step, and the request is no longer available to the other users in the OU or group.

To add approvers to an approval workflow, go to: ADMIN > TOOLS > CORE > FORM MANAGEMENT, and click the Form Approval Workflows link. Then, either click the CREATE WORKFLOW button or click the Edit option next to an existing approval workflow that is not currently in use.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forms - Manage</td>
<td>Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission. Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.</td>
<td>Forms Management Administration</td>
</tr>
</tbody>
</table>
Add Approval Step

On the Create/Edit Form Approval Workflow page, to add an OU or a group as an approver for the workflow:

1. Click the **ADD APPROVAL STEP** button.
2. In the Approver box that appears, click the drop-down menu.
3. To add either an OU or a group as the approver, choose either the **OU** option from the drop-down.
4. After making your selection, click the **Select OU Criteria** dropdown and select an OU type.
5. Click the search icon which appears beneath the dropdown. This opens the Select window.
6. Search for and select the specific OU or group you wish to add as an approver to the approval workflow step. For example, if you selected **Group** from the drop-down, you might search for and select the HR group from the Select Group window. Only one group or OU can be selected at a time. **Note:** The OU or group you wish to use in an approval step must already be created prior to creating the approval workflow.
7. Click the **ADD APPROVER** button, and your selected criteria will be added as an approver in the workflow.
8. Continue adding approvers and approval steps if needed, and populate the remaining fields on the Create Form Approval Workflow page before saving the approval workflow. **See Create Form Approval Workflow for more information.**
Users included in the selected OU or group can approve or deny approval requests for forms applicable to their approval workflow when their workflow step is active. *See Form - Approve or Deny for more information.*
Edge
ADP Workforce Now (WFN) Core Data Inbound Integration
On Demand Sync Enhancement
ADP Workforce Now (WFN) Core Data Inbound Integration On Demand Sync Enhancement

For organizations using ADP Workforce Now (WFN) as their system of record for Human Resources data, the Core Data Integration is a solution that allows management of employee and organizational unit (OU) data in Cornerstone when there are changes to employee and OU records in ADP WFN. Prior to this enhancement, the ADP Workforce Now (WFN) Core Data Inbound integration synced nightly, but did not provide administrators with an option for manually triggering the integration to sync.

With this enhancement, the ADP Workforce Now (WFN) Core Data Inbound integration is enhanced to support:

- On-Demand Full Sync
- On-Demand Delta Sync

Administrators can trigger either a full or a Delta sync using the Settings tab of the integration within Edge Integrations. **Note:** Triggering a sync on demand does not interfere with or cancel the nightly scheduled sync.

Considerations

- Data is only sent from ADP to Cornerstone. User record data and OU data is not sent from Cornerstone to ADP if users or OUs are updated or added in Cornerstone.
- Only standard fields are sent from ADP to Cornerstone. Custom fields are currently not supported.
- Timezone data is not sent from ADP to Cornerstone for OUs or users.
- If an ADP WFN employee is in multiple companies with different positions, locations, etc., this is not supported by this integration.
- ADP WFN environments containing Validation Tables with codes that are not unique across all companies are not supported by this integration.

Implementation

This functionality is automatically available for the ADP Workforce Now (WFN) Core Data Inbound integration, which is available in the Edge Marketplace. See ADP Workforce Now (WFN) Core Data Integration for more information about this integration.

Permissions

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Integrations - Manage</td>
<td>Grants access to the Integrations service for Edge Integrate where the administrator can configure, enable, and disable their third-party integrations that</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Marketplace - Manage</td>
<td>Grants access to the Marketplace service for Edge Integrate where the administrator can browse and purchase third-party integrations that can be used to extend the Cornerstone system. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
</tbody>
</table>
ADP WFN - Trigger Manual Sync

Administrators can trigger either a full or a Delta sync using the Settings tab of the integration within the Edge Integrations. **Note:** *Triggering a sync on demand does not interfere with or cancel the nightly scheduled sync.*

To force the ADP Workforce Now (WFN) Core Data Inbound integration to sync manually, go to: **ADMIN > TOOLS > EDGE > INTEGRATIONS** and click the ADP Workforce Now Core Data Inbound integration.

**Permissions**

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Integrations -</td>
<td>Grants access to the Integrations service for Edge Integrate where the administrator</td>
<td>Edge</td>
</tr>
<tr>
<td>Manage</td>
<td>can configure, enable, and disable their third-party integrations that are</td>
<td></td>
</tr>
<tr>
<td></td>
<td>used within the Cornerstone system. This permission cannot be constrained. This is an</td>
<td></td>
</tr>
<tr>
<td></td>
<td>administrator permission.</td>
<td></td>
</tr>
</tbody>
</table>

![Setup Instructions](image)

- Subscription Token *
- Notification Email *
- Client id
- Client Secret
- Division: Business Unit
- Cost Center: Department
- User identifier: Associate Id

- Force Full Sync
- Force Delta Sync
Force Sync

The options to force the integration to sync are located on the Settings tab of the integration. At the bottom of the Settings page, the following options are available:

- **Force Full Sync** - Toggle this switch to the On (blue) position to initiate a full syncing of the integration.
- **Force Delta Sync** - Toggle this switch to the On (blue) position to initiate a Delta syncing of the integration. Delta Sync refers to syncing changes from the last time the integration was synced. This is an efficient sync because unchanged records are not involved in this process.

To initiate the selected type of sync, click the **SAVE SETTINGS** button at the bottom of the page. The sync will immediately begin, and the Force Full Sync and the Force Delta Sync options will revert back to the Off position when the sync is complete. The duration time of the sync depends on how many records are included in the sync and what type of sync was selected. When the sync is complete, two emails fire to the email address provided in the Notification Email field on the Settings tab of the integration:

- OU Sync Summary email
- User Sync Summary email

If there were any failures in the sync, the files included in the emails allow administrators to see the cause of each failure.
Custom Connectors - Tools for Developers

With the October '17 release, available recruiting integration specifications were exposed as "connectors" within the API Explorer under Edge Develop, and a code repository was made available to developers, allowing them to quickly begin creating their portion of new integrations. These enhancements allowed organizations to integrate with any background check or assessment vendor as long as they adhere to the workflow and specifications required by the Edge platform. However, it was necessary for developers to have access to a Cornerstone portal in order to test their integrations.

With the May '18 release, integration testing functionality for validating integration testing code is available in Edge, which allows developers to test their integrations without needing access to a Cornerstone portal. These testing tools are publicly available in the API Explorer and do not require developers to have any permissions or login credentials.

Considerations

Documentation for using the integration testing functionality is available in the API Explorer, along with the testing functionality itself. Separate testing pages are available for assessments and background checks.

The testing page for assessment checks is comprised of three tabs:

- Step 1 - Get Available Assessment Packages
- Step 2 - Initiate Assessment
- Step 3 - Update Assessment

The testing page for background checks is comprised of three tabs:

- Step 1 - Get Available Background Check Packages
- Step 2 - Request a Background Check
- Step 3 - Update Background Check

Each step walks developers through the processes for testing their recruiting integrations.

Implementation

This functionality is automatically available to any user of the Edge platform, whether or not they have login credentials. Cornerstone portal access is not needed to access the developer test tools.

To test an assessment integration, go to:

https://apiexplorer.csod.com/apiconnectorweb/apiexplorer#/customconnectorguides/assessment/tools

To test a background check integration, go to:

https://apiexplorer.csod.com/apiconnectorweb/apiexplorer#/customconnectorguides/bgcheck/tools
Permissions

No permissions are required to access this functionality.
Edge Import - Employee Salary Load (Early Adopter)
**Edge Import - Employee Salary Load (Early Adopter)**

With this enhancement, the Edge Import Employee Salary Load is now available to early adopters. This tool provides organizations with the ability to load employee salary data even if it includes custom wage types. Employee Salary Management Modification History, when enabled in a portal, is also updated using the Edge Import load. Both of these functions are not possible when using the Data Load Wizard (DLW). Cornerstone HR clients are also able to report on updates to the Employee Salary Management Modification History using the User Audit Report - Detailed standard report.

This functionality is in an Early Adopter phase. Organizations should consider enabling it if the following are true:

- Your organization uses multiple wage types (beyond hourly/annual) to pay employees in the Cornerstone system.
- Your organization would like to utilize Compensation Audit History for Employee Salary Management.
- Your organization is interested in Edge Import and is eager to start using the features that are available now.

**Implementation**

This functionality is automatically enabled in Stage portals for organizations using the Compensation or Cornerstone HR functionality and also utilize the Data Load Wizard (DLW).

To enable this functionality in Pilot and Production portals, submit a case with Global Product Support (GPS).

**Security**

The following new permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Edge Import</td>
<td>Grants access to the Edge Import tool, which enables administrators to load data into their portal. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Import - Load Employee Salary</td>
<td>Grants access to the employee salary data load via Edge Import. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge Import</td>
</tr>
</tbody>
</table>
**Edge Import Homepage**

The Edge Import Homepage is the central hub for administrators using Edge Import. From this page, administrators can configure their organization's import options and data mappings, initiate a data load, view recent data loads, and view data mapping configurations. Administrators can also access a data template guide to help get started or download a PGP key to encrypt their data load files.

To access the Edge Import Homepage, go to **ADMIN > TOOLS > EDGE > IMPORTS AND FEEDS**.

**Permissions**

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Edge Import</td>
<td>Grants access to the Edge Import tool, which enables administrators to load data into their portal. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge Import</td>
</tr>
<tr>
<td>Edge Import - Load Employee Salary</td>
<td>Grants access to the employee salary data load via Edge Import. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge Import</td>
</tr>
</tbody>
</table>
**Configurations**

A configuration describes data you want to import and how the system should interpret, validate, and import the data. To create and manage your data load configurations, select the Configurations panel. *See Manage Data Load Configurations* on page 224 for additional information.

**Loads**

To create and manage your data loads, select the Loads panel. *See Manage Data Loads* on page 230 for additional information.

**Recent Loads**

This section displays your organization's most recent data loads or validations. The following information is displayed for each load:

- Category and Type - This displays the category and type that is associated with the load.
- File Name - This displays the name of the file that was loaded or validated.
- Started - This displays the date and time at which the data load began.
- Loaded By - This displays the name of the user who initiated the data load.
Load Results - This displays the results of the data load. For example, if some records were not valid, then the number of invalid records is displayed. If all records were loaded without warnings, then All Successful is displayed.

Load Status - This displays the processing status of the data load, such as Queued, Loading, or Complete.

Select the data load to view the Load Details page. *See Edge Import - Create/Edit Data Load.*

Select the **Show only mine** option to view only data loads that you initiated.

**Recently Used Configurations**

This section displays your organization's most recently used data load configurations. The following information is displayed for each configuration:

- **Category and Type** - This displays the category and type that is associated with the configuration.
- **Name** - This displays the name that was provided when the configuration was created.
- **Last Used** - This displays the last time the configuration was used in a data load.
- **Owner** - This displays the name of the user who created the configuration.

Select the data load configuration to view the Configuration Details page. *See Edge Import - Configuration Details Page.*

Select the **Show only mine** option to view only data load configurations that you created.

**Get a Template Guide**

Data templates provide instructions and recommendations for organizing and formatting your data prior to creating your data load file.

To download a template guide:

1. Select the **GET A TEMPLATE GUIDE** button. This opens the Get a Template Guide flyout.
2. From the **Category and Type** drop-down menu, select the type of data you are loading.
3. From the **What culture should be used as a default** drop-down menu, select the default language for your data.
4. Select the **DOWNLOAD** button. The template begins downloading.

When loading employee salary data, the following tabs are available within the template:

1. Compensation-Employee Salary - This tab displays a description and other helpful information for each field in the template.
2. Considerations - This tab displays important considerations that are helpful when configuring your upload file and data.
3. Currency Code - This tab displays the currency ID and code for each available currency.
4. **Worksheet** - This tab provides all of the necessary data fields in which you can populate your organization's data.

**Download PGP Key**

You have the option of using PGP (Pretty Good Privacy) encryption for your data load files. To download a PGP key, select the **DOWNLOAD PGP KEY** button.
Manage Data Load Configurations

A configuration describes data you want to import and how the system should interpret, validate, and import the data. The Configurations page enables you to create and manage your organization’s data load configurations.

To access the Manage Data Load Configurations page, go to ADMIN > TOOLS > EDGE > IMPORTS AND FEEDS. Then, select the Configurations panel.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Edge Import</td>
<td>Grants access to the Edge Import tool, which enables administrators to load data into their portal. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Import - Load Employee Salary</td>
<td>Grants access to the employee salary data load via Edge Import. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge Import</td>
</tr>
</tbody>
</table>

Create New Configuration

To create a new data load configuration, select the NEW CONFIGURATION button. This opens the New Configuration flyout, which guides you through a multi-step process to create a new configuration. See Create Data Load Configuration on page 226 for additional information.

Filters

To filter which configurations are displayed in the table, select the FILTERS button. This opens the Configurations Filter flyout. The following options are available:

- **Category and Type** - Select an option to view only configurations of the selected category and type.
- **Filter by Owner** - Select a user to view only configurations for which the selected user is the owner.
o **Only show configurations used in feeds?** - Select Yes to view only configurations that are used in a data feed. Or, select No to view all available configurations.

Select the **APPLY** button to apply the selected filters to the Loads list.

**Configurations List**

The page displays all configurations that match the selected filters, if applicable. The following information is displayed for each configuration:

- Category and Type - This displays the category and type that is associated with the configuration.
- Name - This displays the name that was provided when the configuration was created.
- Last Used - This displays the last time the configuration was used in a data load.
- Owner - This displays the name of the user who created the configuration.

Select the data load configuration to view the Configuration Details page. *See Edge Import - Configuration Details Page.*
Create Data Load Configuration

A configuration describes data you want to import and how the system should interpret, validate, and import the data.

To create a new data load configuration, go to ADMIN > TOOLS > EDGE > IMPORTS AND FEEDS. Select the Configurations panel. Then, select the NEW CONFIGURATION button. This opens the New Configuration flyout, which guides you through a multi-step process to create a new configuration.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Edge Import</td>
<td>Grants access to the Edge Import tool, which enables administrators to load data into their portal. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Import - Load Employee Salary</td>
<td>Grants access to the employee salary data load via Edge Import. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge Import</td>
</tr>
</tbody>
</table>

Upload Step

In this step, you will upload a file is used to create your configuration.

1. From the Category and Type drop-down menu, select the data type that applies to the configuration you are creating.
2. In the Select File field, upload a file that contains the data headers that you will use for data loads. You can do this by dragging and dropping a file in to the field or by selecting the PICK A FILE button to browse for and select a file from your computer.
3. Select the UPLOAD button.

Options Step

In this step, you will set the processing options that help the system properly process your data loads.

1. In the General Questions section, answer the following questions:
   A. Which worksheet has your data? - This question appears if you uploaded an Excel file. Only one worksheet can be uploaded, so select the worksheet that contains the data that should be used to create your configuration. The drop-down contains all of the worksheets that exist within the file that you uploaded in the Upload step.
   B. Does your file have headers? - Select Yes if the first row of your file contains headings, or select No if the first row of your file contains data.
2. In the Employee Salary Questions section, answer the following questions:
A. **Only update users who are active** - Select Yes if you want the data load to only update users who are active in the system, or select No to update active and inactive users.

B. **What culture should be used as a default** - From the drop-down menu, select the default language for the configuration.

3. In the **Format Questions** section, answer the following questions:
   A. **How are your dates ordered?** - From the drop-down menu, select how dates are ordered in your data files.
   B. **How are your numbers formatted?** - From the drop-down menu, select how numbers are formatted in your data files.

### Mapping Step

In this step, you will map the data columns in your uploaded file to the system fields. The system reviews the uploaded file and may automatically match some fields. To match a data column with a system field, select the drop-down in the Map To Field column and select the appropriate system field. An asterisk displays next to a system field that must be mapped to a column in your file.

1. The following information is displayed in the table:
   A. Status - This indicates whether the column is mapped to a system field.
   B. Column Header - This displays the column titles from the first row of your uploaded file.
   C. Map To Field - This displays the system field to which the data column is mapped. You can select the drop-down to set or modify the mapping.
   D. Description - This displays the description of the selected system field. If no system field is selected in the Map To Field column, then this field is empty.

2. By default, all column headers from your file are displayed in the table. To filter which columns are displayed in the table, select the drop-down menu above the table.

3. If a system field is not matched to a data column from your file, the system field appears in the **Unmatched Fields** section. By default, only required unmatched fields are displayed in the **Unmatched Fields** section. To filter which fields are displayed in this section, select the drop-down menu in the upper-right corner of the page.

### Save Step

In this step, you will provide a name for the configuration and save it for future use.

1. Enter a name for your configuration. This name should clearly indicate its purpose so that it is clear to all administrators when the configuration should be used.

2. Select the **SAVE** button. This opens the Configuration Details page where you can view the details of the configuration and initiate a new data load. See **Configuration Details Page** on page 228 for additional information.
Configuration Details Page

A configuration describes data you want to import and how the system should interpret, validate, and import the data. The Configuration Details page displays the configuration's settings and enables you to initiate a data load using the configuration.

To access the Configuration Details page, go to ADMIN > TOOLS > EDGE > IMPORTS AND FEEDS. Select the Configurations panel. Then, select the appropriate configuration in the table.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Edge Import</td>
<td>Grants access to the Edge Import tool, which enables administrators to load data into their portal. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Import - Load Employee Salary</td>
<td>Grants access to the employee salary data load via Edge Import. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge Import</td>
</tr>
</tbody>
</table>
Start New Data Load

Select the NEW LOAD button to initiate a new data load using the selected configuration. See Create/Validate Data Load on page 232 for additional information.

Options

The Options tab displays the options that were selected on the Options step when the configuration was created. See Create Data Load Configuration on page 226 for additional information.

Mapping

The Mappings tab displays how data will be mapped to system fields with the configuration. This mapping was set on the Mapping step when the configuration was created. See Create Data Load Configuration on page 226 for additional information.
Manage Data Loads

The Loads page enables you to view your organization’s data loads and initiate new data loads.

To access the Manage Data Loads page, go to **ADMIN > TOOLS > EDGE > IMPORTS AND FEEDS**. Then, select the Loads panel.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Edge Import</td>
<td>Grants access to the Edge Import tool, which enables administrators to load data into their portal. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Import - Load Employee Salary</td>
<td>Grants access to the employee salary data load via Edge Import. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge Import</td>
</tr>
</tbody>
</table>

Create New Data Load

To create a new data load, select the **NEW LOAD** button. This opens the New Load page. See **Create/Validate Data Load** on page 232 for additional information.

Filters

To filter which loads are displayed in the table, select the **FILTERS** button. This opens the Loads Filter flyout. The following options are available:

- **Category and Type** - Select an option to view only loads of the selected category and type.
- **Filter by User** - Select a user to view only loads that were performed by the selected user.
- **Filter by Action** - Select the Load option to view In Progress and Completed loads. Select the Validate option to view In Progress and Completed validations.
Select the **APPLY** button to apply the selected filters to the Loads list.

**Loads and Validations List**

The page displays all data loads and validations that match the selected filters, if applicable. The following information is displayed for each load:

- Category and Type - This displays the category and type that is associated with the load.
- File Name - This displays the name of the file that was loaded or validated.
- Started - This displays the date and time at which the data load began.
- Loaded By - This displays the name of the user who initiated the data load.
- Load Results - This displays the results of the data load. For example, if some records were not valid, then the number of invalid records is displayed. If all records were loaded without warnings, then All Successful is displayed.
- Load Status - This displays the processing status of the data load, such as Queued, Loading, or Complete.

Select the data load to view the Load Details page. *See Edge Import - Create/Edit Data Load.*
Create/Validate Data Load

The New Load page enables you to either perform a one-time bulk import or validate your data. Following the validation or data load, an overview of the process is displayed.

To create a new data load, go to **ADMIN > TOOLS > EDGE > IMPORTS AND FEEDS.** Select the Loads panel. Then, select the **NEW LOAD** button. This opens the New Load page.

**Permissions**

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Edge Import</td>
<td>Grants access to the Edge Import tool, which enables administrators to load data into their portal. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Import - Load Employee Salary</td>
<td>Grants access to the employee salary data load via Edge Import. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge Import</td>
</tr>
</tbody>
</table>

![New Load Page Screenshot](image.png)

*This field is required*
New Load

1. From the Category and Type drop-down menu, select the data type that applies to the data you are loading.

2. In the Configuration field, you have two options for selecting a configuration for your data load:
   A. From the drop-down menu, select the configuration that most closely matches your data. You can modify the default Options and Mapping settings from the configuration for your data load by selecting the MODIFY button, but the modifications are not saved to the selected configuration.
   B. If none of the available configurations match your data, then select the NEW CONFIGURATION button to create a new configuration. See Create Data Load Configuration on page 226 for additional information.

3. In the Select File field, upload a file that contains the data that you are loading. You can do this by dragging and dropping a file in to the field or by selecting the PICK A FILE button to browse for and select a file from your computer.

Once the file is loaded and the settings are configured, you have two options:

- Select the VALIDATE ONLY button to only validate that your data is in the correct format and does not contain errors. When this button is selected, the Validation Details are displayed. See the Validation Details section below for additional information.
- Select the LOAD button to validate the data and load it to the system. See the Load Details section below for additional information.

Validation Details

When you choose to only validate your data, the system analyzes the selected file, and the Validation Details provide an overview of the validation.

The Record Details chart provides a visual overview of the validation progress and the number of records in each status. While data is being processed, the data is displayed as a bar graph. Once the data is fully processed, the data is displayed in a pie chart.

The Information section displays the following details about the validation or load:

- Category
- Type
- File Name
- Configuration - Select the View link to open a flyout that displays the Options and Mapping settings from the configuration.
- Validated By/Loaded By - This displays the name of the user who initiated the validation or load.
- Started - This displays the date and time at which the validation or load began.
- Completed - This displays the date and time at which the validation or load completed.

The Quick Stats section displays reports that can be downloaded. To download a report, select the record count in the Download column.
- Valid Records - This displays the number of valid records that were processed. Valid records may be processed successfully or with warnings. Any warnings are displayed in the downloaded report so that you can adjust the data, if necessary, prior to loading it.
- Not Valid - This displays the number of invalid records that were processed. Any errors are displayed in the downloaded report so that you can adjust the data and then load it.
- Total - This displays the total number of records that were processed.

The **Warning Details** section appears if your records have any warnings. This section displays any warnings that occurred and the number of records that encountered the warning.

The **Error Details** section appears if your records have any errors. This section displays any errors that occurred and the number of records that encountered the error.

Select the **LOAD** button to load the data to the system. *See the Load Details section below for additional information.*

---

**Load Details**

When you load your data, the system analyzes the selected file and then attempts to load the data. The Load Details provide an overview of the load.
The Record Details chart provides a visual overview of the load progress and the number of records in each status. While data is being processed, the data is displayed as a bar graph. Once the data is fully processed, the data is displayed in a pie chart.

The Information section displays the following details about the validation or load:

- Category
- Type
- File Name
- Configuration - Select the View link to open a flyout that displays the Options and Mapping settings from the configuration.
- Validated By/Loaded By - This displays the name of the user who initiated the validation or load.
- Started - This displays the date and time at which the validation or load began.
- Completed - This displays the date and time at which the validation or load completed.

The Quick Stats section displays reports that can be downloaded. To download a report, select the record count in the Download column.

- Loaded - This displays the number of valid records that were processed and loaded. Valid records may be processed successfully or with warnings. Any warnings are displayed in the downloaded report so that you can adjust the data, if necessary, prior to loading it.
- Not Loaded - This displays the number of invalid records that were not loaded. Any errors are displayed in the downloaded report so that you can adjust the data and then load it.
- Total - This displays the total number of records that were processed.

The Warning Details section appears if your records have any warnings. This section displays any warnings that occurred and the number of records that encountered the warning.

The Error Details section appears if your records have any errors. This section displays any errors that occurred and the number of records that encountered the error.
Employee API - Overview

The Employee API allows administrators to manage employee records via User Administration, Data load Wizard, Reporting, and data feeds. However, these methods require a user interface and a flat file integration. Organizations that do not wish to manually enter data into the system, or organizations that want to manage the transfer of user records from their active directory, may not be able to use these methods.

With this enhancement, a REST API framework which enables organizations to create, update, and receive user data in real time is available. Using the Employee API, administrators have access to the following features:

- Perform POST/PUT/PATCH/GET actions
- API documentation in the API Explorer
- Add new fields to the existing API contract

In addition, effective dating and rehire functionality is now available with the Employee API for portals using CHR.

Considerations

The following considerations and exclusions apply to the Employee API:

- Only the JSON content type can be used for the service.
- When using the API, administrators can no longer use basic authentication, such as username and password, for their web service authentication. A more secure token-based authentication is required
- Social security numbers and date of birth fields are not supported by the Employee API.
- Data deletion is not supported by the Employee API.
- It is not possible to add or modify a user’s group using the Employee API.

Implementation

The Employee API is available for all portals using the Edge module, including production portals, EXCEPT portals using the Cornerstone HR product or portals that have advance auditing enabled. The service will be available for CHR and advanced auditing portals in a future patch. The Employee API is available to all portals that have purchased and enabled Cornerstone REST APIs in the Edge marketplace.

Additional documentation for the Employee API is available in the API Explorer. To access the API Explorer, go to: ADMIN > TOOLS > EDGE. Then, click the API Explorer link.

Permissions

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge - API Explorer</td>
<td>Grants access to the API Explorer, which provides access to help documentation for various API applications.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Integrations - Manage</td>
<td>Grants access to the Integrations service for Edge Integrate where the administrator can configure, enable, and disable their third-party integrations that are used within the Cornerstone system. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Marketplace - Manage</td>
<td>Grants access to the Marketplace service for Edge Integrate where the administrator can browse and purchase third-party integrations that can be used to extend the Cornerstone system. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>Users - Edit General Information</td>
<td>Grants ability to edit the general fields on a user record, including first name, last name, username, assigned OUs, and custom relationships. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>
Kronos OU Outbound Integration

Prior to this enhancement, the Kronos integration synced user data from Cornerstone to Kronos.

With this enhancement, the Kronos integration is enhanced to also sync organizational unit (OU) data from Cornerstone to Kronos. When an administrator adds or modifies an OU, changes are automatically sent to the corresponding Kronos entity.

The system begins syncing users when the integration is enabled.

Error Handling

If the Kronos integration is enabled and an error occurs when the Cornerstone HR system submits an OU to the Kronos system for synchronization, then the Cornerstone HR system generates an email to the Kronos integration email address. This email contains the error messages that were indicated by Kronos. The email address to which these error emails are sent is the email address that is configured to receive messages in the event of sync failures.

Considerations

Custom fields on the OU are not currently shared with Kronos.

Custom OUs are not currently shared with Kronos.

The integration does not sync from Kronos to Cornerstone HR, meaning that if a user is added or updated in Kronos, these users are not added or updated in Cornerstone HR.

Implementation

The Kronos integration is available to try or to purchase via the Edge Marketplace. To access the Edge Marketplace, go to ADMIN > TOOLS > EDGE > MARKETPLACE.

This functionality is only available to organizations using Cornerstone HR. Organizations must also have a Kronos account.

Security

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Integrations - Manage</td>
<td>Grants access to the Integrations service for Edge Integrate where the administrator can configure, enable, and disable their third-party integrations that are used within the Cornerstone system. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>Edge Marketplace - Manage</td>
<td>Grants access to the Marketplace service for Edge Integrate where the administrator can browse and purchase third-party integrations that can be used to extend the Cornerstone system. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
</tbody>
</table>
Engage - Manager Hierarchy View - Patch Item

With the June 1, 2018 patch, users with the appropriate permission can view Engage results by manager, filter for specific managers, compare multiple managers, and traverse the reporting hierarchy to discover areas of opportunity within the organization.

Additional documentation will be made available for this enhancement with the June 1, 2018 patch.
Custom Reports - Engage
**Custom Reports - Engage**

Prior to this enhancement, administrators and managers could view aggregate Engage survey data using the Engage Dashboard, but it was not possible to export raw data. This was by design, to protect the confidentiality of Engage survey response information. However, this posed a challenge to business analysts who typically use data of this nature from their organization to compare the company to other verticals and identify at-risk employees for follow-up.

With this enhancement, a new Engage Response custom report type is available. Users with associated permissions can create, share, schedule, and run reports that include individual Engage survey responses, to allow organizations to better use the data gathered with Engage.

**Use Cases**

**Use Case #1: Export Participant Response Data**

As a business analyst supporting Engage, Andrew wants to run a raw data report across all survey responses. He combines the data with other internal sources to generate reports on his company's data. His company's engagement surveys are confidential, meaning that managers do not have access to this level of reporting; they can only receive aggregate results via the Engage Dashboard. Only Andrew and a select few are granted permission to view the raw data, to protect individuals who complete the Engage surveys.

**Use Case #2: Constrain Reporting in Transparent Organization**

As an HR business partner in a highly transparent organization, Kara has full access to her team's Engage responses. She tells her employees that their individual feedback WILL be visible to the HR team, and she has permission to view all of the Engage raw response data for her team. However, her permission is constrained to her own team, meaning she cannot view Engage responses for the entire organization. She primarily uses this to check for unusual scores so she can continue working to facilitate a positive team culture and ensure employee satisfaction.

**Implementation**

This enhancement is NOT enabled by default. This enhancement is enabled by request only. Please contact Global Product Support to enable the Engage Response custom report type and associated permissions.

**Permissions**

The following new permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Engage Response Report -</td>
<td>Grants ability to create and edit custom Engage reports. This permission can be constrained by</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create</td>
<td>OU, User's OU, User, User Self and Subordinates, User's Direct Reports.</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>Custom Engage Response Report - View</td>
<td>Grants ability to view results of custom Engage reports created by self or shared by others. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Direct Reports.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>
Engage Custom Report

A new custom Engage report is available through Custom Reporting, and allows administrators and managers to run reports that include campaign, question, individual response, and user data related to Engage campaigns. The data generated by the Engage custom report is constrained by the permissions for creating and viewing Engage reports.

To create andEngage custom report, go to REPORTS > CUSTOM REPORTS and click the NEW button. Select Engage Response Report from the drop-down menu.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Engage Response Report - Create</td>
<td>Grants ability to create and edit custom Engage reports. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User’s Direct Reports.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Engage Response Report - View</td>
<td>Grants ability to view results of custom Engage reports created by self or shared by others. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User’s Direct Reports.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>

Engage Response Report Field Sections

The following new field sections are included in the custom Engage report type:

- Campaigns section
- Questions section
- Responses section

The following existing report section is included in the custom Engage report type:

- User section

New Fields - Engage Response Report

Campaign Fields

The following fields are included in the Campaigns section of the Engage report:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign ID</td>
<td>Numeric</td>
<td>This is the ID provided for the campaign.</td>
</tr>
<tr>
<td>Campaign Name</td>
<td>Text</td>
<td>This is the name provided for the campaign by the creator.</td>
</tr>
</tbody>
</table>
## What's New for May 2018

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign Author</td>
<td>Text</td>
<td>This is the name of the user who created the campaign.</td>
</tr>
<tr>
<td>Campaign Internal Description</td>
<td>Text</td>
<td>This is the description provided for the campaign by the creator.</td>
</tr>
<tr>
<td>Campaign Type</td>
<td>Text</td>
<td>This field specifies whether the campaign type is Satisfaction, Engagement, or Commitment.</td>
</tr>
<tr>
<td>Campaign Status</td>
<td>Text</td>
<td>This field specifies the current status of the campaign (Draft, Scheduled, Active, or Completed).</td>
</tr>
<tr>
<td>Launch Date</td>
<td>Date</td>
<td>This is the date the campaign started.</td>
</tr>
<tr>
<td>Close Date</td>
<td>Date</td>
<td>This is the date the campaign ended.</td>
</tr>
<tr>
<td>Campaign Recurrence</td>
<td>Text</td>
<td>This field specifies the recurrence type of the campaign (Once, Daily, Weekly, Monthly, Quarterly, or Annually).</td>
</tr>
</tbody>
</table>

### Question Fields

The following fields are included in the Question section of the Engage report:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question ID</td>
<td>Numeric</td>
<td>This is the ID provided for the question.</td>
</tr>
<tr>
<td>Question Name</td>
<td>Text</td>
<td>This is the name of the Engage survey question.</td>
</tr>
<tr>
<td>Question Type</td>
<td>Text</td>
<td>This field specifies the type of question (Smiley or Open-Ended).</td>
</tr>
<tr>
<td>Question Author</td>
<td>Text</td>
<td>This is the name of the user who created the question.</td>
</tr>
<tr>
<td>Question Dimension</td>
<td>Text</td>
<td>This field specifies the dimension selected for the question (Satisfaction, Engagement, etc.)</td>
</tr>
<tr>
<td>Question Active</td>
<td>True/False</td>
<td>This field indicates whether or not the question is currently active.</td>
</tr>
</tbody>
</table>

### Response Fields

The following fields are included in the Response section of the Engage Raw Data report:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Score</td>
<td>Numeric</td>
<td>This is the raw score the user selected for the question.</td>
</tr>
</tbody>
</table>
### Field Name | Field Type | Field Description
--- | --- | ---
Response Text | Text | This is the response the user selected for the Smiley type question (Strongly Disagree, Disagree, etc.). **Note:** This field can only report on the responses for multiple choice type questions. Using this field for the Open Ended question type results in a blank output.
Open Ended Response | Text | This is the text the user provided as a comment or as a response to the Open-ended question type. If no response was provided, this field returns a blank output.

**Considerations**
The existing User report field section, which is also included in the Engage custom report, contains the same fields as when the section appears in other report types.
Learning
Attendance and Scoring Page Pagination
Attendance and Scoring Page Pagination - Overview

Prior to this enhancement, when more than 1000 users were registered for an instructor-led training (ILT) session, or a session was comprised of many parts, administrators would sometimes encounter system timeouts when working with the Attendance and Scoring page of the session roster, due to the large amount of data.

With this enhancement, the Attendance and Scoring page for ILT sessions is paginated, with a limited amount of data for the session displaying on each page. Administrators can navigate through pages of registered users, and each page will load without the system timing out, because the entire session’s roster does not need to be processed at one time.

Use Case

Susie, an administrator, is navigating the Attendance and Scoring page for an ILT session after the May 2018 release, when the Attendance and Scoring Page Pagination enhancement was released. She successfully loads a roster of 5,000 users without experiencing any system timeouts, and she is able to view twenty users per page.

Implementation

This functionality is automatically enabled for all portals using the Learning module.

Permissions

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events - View</td>
<td>Grants view-only access to instructor led training events, enabling the user to view all details/options that were selected when the event was created. This permission can be constrained by OU, User’s OU, User’s ILT Provider, and ILT Provider. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Roster - Manage</td>
<td>Grants ability to manage instructor led training session rosters, including updating attendance, and marking the ILT session complete to update student transcripts. A variety of other features are available depending upon additional roster permissions. This permission works in conjunction with Events - View, Sessions - View, and Roster - View permissions. This permission can be constrained by Instructor, User as Instructor, ILT Provider, and User’s ILT Provider. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Roster - View</td>
<td>Grants view-only access to instructor led training session rosters. This permission works in conjunction with Events - View and Sessions - View permissions. This permission can be constrained by Instructor, ILT Provider, User's ILT Provider, and User as Instructor. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Sessions - View</td>
<td>Grants view-only access to instructor led training sessions, enabling the user to view all details/options that were selected when the session was created. This permission works in conjunction with the Events - View permission. This permission can be constrained by OU, User's OU, Instructor, Facility, Facilities Owned by User, ILT Provider, User's ILT Provider, User, User as Instructor, and User Self and Subordinates. This is an administrator permission. With the October '16 release, this permission also enables administrators to view the Prior ILT Sessions widget on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission).</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>
Attendance and Scoring Page

If more than twenty users are registered for an instructor-led training (ILT) session, the Attendance and Scoring page of the session roster paginates, and users with permission to manage the roster can navigate through pages of registered users, with up to twenty users displaying per page.

To access the Attendance and Scoring page, go to: **ILT > MANAGE EVENTS AND SESSIONS** and click the Sessions icon for an event. Then, click the Roster icon for the desired session. Click the Attendance and Scoring tab of the session roster.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events - View</td>
<td>Grants view-only access to instructor led training events, enabling the user to view all details/options that were selected when the event was created. This permission can be constrained by OU, User's OU, User's ILT Provider, and ILT Provider. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Roster - Manage</td>
<td>Grants ability to manage instructor led training session rosters, including updating attendance, and marking the ILT session complete to update student transcripts. A variety of other features are available depending upon additional roster permissions. This permission works in conjunction with Events - View, Sessions - View, and Roster - View permissions. This permission can be constrained by Instructor, User as Instructor, ILT Provider, and User's ILT Provider. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Roster - View</td>
<td>Grants view-only access to instructor led training session rosters. This permission works in conjunction with Events - View and Sessions - View permissions. This permission can be constrained by Instructor, ILT Provider, User's ILT Provider, and User as Instructor. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Sessions - View</td>
<td>Grants view-only access to instructor led training sessions, enabling the user to view all details/options that were selected when the</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>
session was created. This permission works in conjunction with the Events - View permission. This permission can be constrained by OU, User's OU, Instructor, Facility, Facilities Owned by User, ILT Provider, User's ILT Provider, User, User as Instructor, and User Self and Subordinates. This is an administrator permission.

With the October '16 release, this permission also enables administrators to view the Prior ILT Sessions widget on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission).

Attendance and Scoring - Pagination

If more than twenty users are registered for a session, page navigation displays above the list of registered users. You can click a specific page number to navigate to a specific page of results, or you can use the arrow icons to navigate to the next or previous page of registered users. Up to twenty users can display per page.
Auto Upgrade to Content Publishing Redesign with Online Course Versioning in 2019

In 2019, Cornerstone will retire the Course Publisher, and all portals will be automatically upgraded to the Content Uploader with Online Course Versioning, which was made generally available during the October '17 release. The exact date of the automatic upgrade is yet to be determined, but is being announced far in advance to provide administrators with sufficient time to plan for the change.

Activating the new Content Uploader and Online Course Versioning functionality remains optional until 2019. When Course Publisher is retired, it will no longer be accessible in the system.

For documentation about the Content Uploader and Online Course Versioning, see the following Online Help resources:

- Learning Feature Activation Preferences.
- Create an Online Course - Overview.
- Content Uploader - Upload Files.
- Online Course Versioning vs. Modifying - Overview.
Certificate No Longer Available for Exempt Statuses

Prior to this enhancement, learners in an Exempt status for learning content with an associated certificate were able to access and print the learning certificate using the following system features:

- Transcript Details page
- Assignment and Version History page
- Transcript action
- Training Completion Page
- Curricula Player action

With this enhancement, users in an Exempt status for training with an associated certificate will NOT be able to access or print the learning certificate from any system location. When a user is in an Exempt status for a training item, the following features, as they relate to the exempted training, are not available to the user:

- The View Certificate link is not available on the Transcript Details page for the training
- The certificate cannot be printed from the Assignment and Version History page for the training
- The View Certificate option is not available for the training on the learning transcript
- The View My Certificate tile does not display on the Training Completion page
- The View Certificate option is not available for the training via the Curricula Player

Use Case

Lauren is a learning administrator at Acme Corp. She marks John as exempt for Leadership 101, because the requirements for this training were fulfilled by another training item he completed two weeks prior. John will not be able to access any certificate associated with Leadership 101, because certificates are not available to users in an Exempt status for training.

Implementation

This functionality is automatically enabled for all portals using the Learning module.
Curriculum Assignment - Child Training Transcript History
**Curriculum Assignment - Child Training Transcript History**

Prior to this enhancement, when administrators assigned a curriculum using the Learning Assignment Tool or using the option to assign training via the Training Details page, child learning objects (LOs) within that curriculum could not be easily traced back to the learning assignment by which they were assigned.

Following this enhancement, the transcript history for child LOs within a curriculum is mapped to the learning assignments used to assign the curriculum to users.

**Use Cases**

**Use Case #1: Learning Assignment Training Delivery**

Alisa is a learning administrator at Acme Electricity, and she assigns training using the Learning Assignment Tool. As part of a new Floor Safety campaign, Alisa creates a learning assignment with the **Assigned and Approved** option in the Training Assignment Workflow section selected. Mary, an employee, is included in the assignment and receives the Floor Safety Curriculum on her transcript. The curriculum contains an online course and several materials.

When Mary views the Transcript History of the training inside the curriculum, she can see she was assigned the training via a learning assignment, as part of the Floor Safety campaign.

When Alisa meets with auditors, she can show how her users received specific training items contained inside the curriculum, using the transcript history of both the curriculum and the transcript history of the curriculum's child LOs.

**Use Case #2: Direct Subordinate or Approver Training Delivery**

Reyna is a manager in ACME Sales and Marketing. She sees one of her direct reports would benefit from a Persuasive Presentation curriculum, which contains some online courses and materials. She assigns this curriculum to her employee via the Training Details page for the curriculum.

When her employee accesses the Training Details page for the curriculum or the child training with the curriculum he was assigned, he can see in the Transcript History section that the training was assigned to him by Reyna.

**Implementation**

This functionality is automatically enabled for all portals using the Learning module.

**Permissions**

The following existing permission applies to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Transcript Item</td>
<td>Grants ability to view details of learning objects</td>
<td>Learning</td>
</tr>
</tbody>
</table>
that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.
Curriculum Assignment - Transcript History

With this enhancement, the Transcript History section of the Training Details page displays detailed assignment history information for both curricula and the child learning objects (LOs) contained within curricula.

To view the Transcript History for an assigned training item, navigate to the user’s transcript and locate the training item. Click the Options drop-down menu to the right of the training and click the View Training Details link. The Transcript History section is located on the Training Details page.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Transcript Item</td>
<td>Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>

Assigned by Learning Assignment Tool

When an administrator creates a learning assignment, in the Training Assignment Workflow section of the Options step, the following assignment options are available:

- **Assigned Only** - When selected, the training will only be assigned and may still require the user to receive approval and register for the training before they are able to access the training. This option is selected by default.
- **Assigned and Approved** - When selected, the training will be automatically approved. No approval will be necessary before users are allowed to take the training, regardless of any configured approval workflows, but users may still need to register for the training.
- **Assigned, Approved, and Registered** - When selected, the training will be automatically approved and registered. No approval and no registration will be required before the users are allowed to access the training.

Each action (Assigned, Approved, and Registered) appears as a separate line item in the Transcript History section.
Examples

In the following examples, the referenced learning objects (LOs) are set to Pre-Approve and Auto-Register upon Approval in the Course Catalog. If these options have been selected for child LOs, these settings are reflected in the Transcript History.

Assigned Only

The administrator selects the Assigned Only option when assigning a curriculum to users. A record of the learning assignment appears in the Transcript History section for the curriculum and in the Transcript History section for each child LO contained in the curriculum.

Transcript History for curriculum:

```
Transcript History

Registered by Cheng Ly (cly) on 3/19/2018 10:03:34 PM
Assigned by Learning Assignment Tool (737) on 3/19/2018 9:21:41 PM Comments: Initial Request
* Time Zone: (UTC-08:00) Pacific Time (US & Canada)
```

Transcript History for child LOs within curriculum:

```
Transcript History

Registered by Cheng Ly (cly) on 3/19/2018 10:04:03 PM
Assigned by Learning Assignment Tool (737) on 3/19/2018 10:03:58 PM Comments: Initial Request
* Time Zone: (UTC-08:00) Pacific Time (US & Canada)
```

Assigned, Approved, and Registered

The administrator selected the Assigned, Approved, and Registered option when assigning a curriculum to users. The Transcript History section displays a line item with a time stamp for the assignment, for the approval, and for the registration of the curriculum as they occurred when the learning assignment processed. This information displays in the Transcript History section for the curriculum and in the Transcript History section for all the child LOs within the curriculum.

Transcript History for curriculum:
Transcript History for child LOs within curriculum:

**Assigned Manually via Training Details Page**

If a curriculum was assigned to a learner by a manager or another user with permission to assign training via the Training Details page, information about the assignment, including the user who assigned the training and the date and time the training was assigned, appears as a line item in the Transcript History section for the curriculum and in the Transcript History section for all child LOs within the curriculum.

Transcript History for curriculum:

Transcript History for child LOs within curriculum:
Impact to Transcript History for Old Records

If child learning objects (LOs) contained within curricula were activated prior to the May 2018 release, the Transcript History section of the Training Details page will NOT display enhanced Transcript History. This means you may see the same assigned curricula display different child history transcript histories. This is expected functionality.

In this simplified example of a learning assignment (123), the assignment is configured with the **Assigned, Approved, and Registered** option selected. In the first column, the child training was activated prior to the May 2018 Release.

In the second column, the child training was activated after the May 2018 release and will show enhanced history.

<table>
<thead>
<tr>
<th>PRIOR TO MAY 2018 RELEASE</th>
<th>AFTER MAY 2018 RELEASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>o Requested User (userid)</td>
<td>o Registered by Learning Assignment (123)</td>
</tr>
<tr>
<td>o Registered by User (userid)</td>
<td>o Approved by Learning Assignment (123)</td>
</tr>
<tr>
<td></td>
<td>o Assigned by Learning Assignment (123)</td>
</tr>
</tbody>
</table>
Curriculum Creation with Pending Version – Validation Messages

With this enhancement, when a curriculum is created and a pending version is available, validation messages display to offer clarity on the behavior:

- When a curriculum has a pending version, an informational message displays on the Curriculum Administration - Structure page.

- When the curriculum structure is modified by creating a new version, and the administrator saves the changes, a validation message appears to confirm that the new curriculum version will deactivate the pending version.

Implementation

This functionality is automatically enabled for all portals using the Learning module.
Permissions
The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curricula Admin - Manage</td>
<td>Grants ability to create new and edit/update existing curricula. This permission can be constrained by OU, User's OU, Provider, and User's LO Availability. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>
Custom Reports - Learning
Custom Reports - Learning - Overview

Prior to this enhancement, it was not possible to use custom reporting to report on certain aspects of curricula and the child training contained within curricula, as they existed on learners’ transcripts.

In addition, it was not possible to report on data related to Learning Playlists, which were previously released in March '18 as part of an Early Adopter program.

With this enhancement, the following new custom report types are available:

- A new custom Curriculum Transcript report type is available, allowing users to report on attributes related to curricula within learners’ transcripts. The Curriculum Transcript report is comprised of several existing report sections as well as new sections which can be used to report on data related to curricula. **Note:** This new report must be used each time administrators want to report on data related to child training within a curriculum. Attempting to use other report types for this information will result in unexpected report results.
- A new Learning Playlist report is also available, allowing users to run reports on learning playlists and the new external content training type, which are both generally available with the May ‘18 release.

Use Cases

**Use Case 1: Reviewing Learners' Progress on Curricula**

Julienne is an administrator at Acme Corp. She needs to track the progress of current curriculum registrations for her learners. She uses the Curricula Transcript custom report, with the "Curriculum Latest Registration?" field filter set to True. This allows her to see only the latest instance of curriculum registration, along with relevant transcript information, such as due dates and statuses.

Julienne shares her report with all managers, allowing them to easily ascertain the curriculum progress of their team.

**Use Case 2: Reporting on Curriculum Completion**

Julienne needs to report on all learners’ registrations in a curriculum. She uses the Curricula Transcript custom report without any filters applied to version or registration. This gives her a broad view of her company’s curriculum progress.

**Use Case 3: Auditors Request Curriculum Version Completion**

Chris is an auditor sent to Acme Corp. One specific curriculum version (v5) is compliance-related, and he wants to see all users and their progress at the time this version was on their transcripts. Julienne runs a Curricula Transcript report and filters for v5 of the curriculum, so only v5 transcript details appear in the report.

**Use Case 4: Playlist Reporting**

ACME Corp has begun using Learning Playlist functionality, and allows users to create playlists of training which can be accessed by learners at their organization. Julienne wants
to report on which users have created playlists and when they were created, so she runs a custom Playlist report to receive details about playlists, their creators, and their modification dates.

**Implementation**

This functionality is automatically enabled for all portals using the Learning module and Custom Reporting functionality.

**Permissions**

The following new permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Curriculum Transcript Report - Create</td>
<td>Grants ability to view results of custom Curriculum Transcript reports created by self or shared by others. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Direct Reports.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Curriculum Transcript Report - View</td>
<td>Grants ability to create and edit custom Curriculum Transcript reports. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Direct Reports.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Playlist Reports - Create</td>
<td>Grants the ability to create and edit custom Playlist reports.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Playlist Report - View</td>
<td>Grants ability to view results of custom Playlist reports created by self or shared by others.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>
Custom Curriculum Transcript Report

A new custom Curriculum Transcript report is available through Custom Reporting, and allows administrators and managers to report on curricula and child learning objects (LOs) within curricula, as they exist on users' transcripts. This report allows administrators to generate a clear output of the curriculum data available on users' transcripts. The following information is available only in this report:

- The statuses of child training items within curricula (Not activated and Pending Prior Training)
- Learning Assignment Tool assignment information for child training within curricula
- The specific due dates of child training within curricula (instead the earliest due date)
- The latest version of the training within the transcript for curricula and child training within curricula

To create a Curriculum Transcript custom report, go to REPORTS > CUSTOM REPORTS and click the **NEW** button. Select **Curriculum Transcript Report** from the drop-down menu.

**Permissions**

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Curriculum Transcript Report - Create</td>
<td>Grants ability to view results of custom Curriculum Transcript reports created by self or shared by others. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Direct Reports.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Curriculum Transcript Report - View</td>
<td>Grants ability to create and edit custom Curriculum Transcript reports. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Direct Reports.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>

**Curriculum Transcript Sections**

The following new section is included in the custom Curriculum Transcript report type:

- Curriculum

The following existing report sections are included in the custom Curriculum Transcript report type:

- Assignment section
- On the Job Training section
- Training section
- Transcript section
User section

New Fields - Curriculum Transcript Report

Curriculum Fields

This new section is the ONLY section that should be used to filter for curriculum information related to the below listed fields. For example, to filter a report by a curriculum's course code, the administrator should use the Course Code (Curriculum) field within the Curriculum Transcript Report.

The following fields are included in the Curriculum section of the Curriculum Transcript report:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course Code (Curriculum)</td>
<td>Text</td>
<td>This is the Course Code associated with the curriculum.</td>
</tr>
<tr>
<td>Created By (Name) (Curriculum)</td>
<td>Text</td>
<td>This is the full name of the user who created the curriculum.</td>
</tr>
<tr>
<td>Created By (User ID) (Curriculum)</td>
<td>Text</td>
<td>This is the user ID of the user who created the curriculum.</td>
</tr>
<tr>
<td>Curriculum Section Title (Curriculum)</td>
<td>Text</td>
<td>This is the title of the section within a curriculum.</td>
</tr>
<tr>
<td>Curriculum Title (Curriculum)</td>
<td>Text</td>
<td>This is the title of the curriculum.</td>
</tr>
<tr>
<td>Curriculum Version (Curriculum)</td>
<td>Numeric</td>
<td>This is the version number of the curriculum.</td>
</tr>
<tr>
<td>Keywords (Curriculum)</td>
<td>Text</td>
<td>This field returns the search keywords associated with the curriculum.</td>
</tr>
<tr>
<td>Language (Curriculum)</td>
<td>Text</td>
<td>This is the language in which the curriculum is available.</td>
</tr>
<tr>
<td>Last Modified By (Curriculum)</td>
<td>Text</td>
<td>This is the full name of the user who last made edits to the curriculum.</td>
</tr>
<tr>
<td>Last Modified By (User ID) (Curriculum)</td>
<td>Text</td>
<td>This is the user ID of the user who last made edits to the curriculum.</td>
</tr>
<tr>
<td>Last Modified Date (Curriculum)</td>
<td>Date</td>
<td>This is the date on which the curriculum was last modified.</td>
</tr>
<tr>
<td>Training Active (Curriculum)</td>
<td>Text</td>
<td>This field displays whether or not the curriculum is active.</td>
</tr>
<tr>
<td>Training Deactivation</td>
<td>Date</td>
<td>This is the deactivation date provided for the</td>
</tr>
</tbody>
</table>
### Field Descriptions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date (Curriculum)</td>
<td></td>
<td>curriculum, if applicable.</td>
</tr>
<tr>
<td>Training Description (Curriculum)</td>
<td>Text</td>
<td>This is the description of the curriculum.</td>
</tr>
<tr>
<td>Training Object ID (Curriculum)</td>
<td>Text</td>
<td>This is the unique, auto-generated ID associated with the curriculum.</td>
</tr>
<tr>
<td>Training Purpose (Curriculum)</td>
<td>Text</td>
<td>This field returns the training purpose(s) associated with the curriculum.</td>
</tr>
<tr>
<td>Training Status (Curriculum)</td>
<td>Text</td>
<td>This field displays the current status of the curriculum or its child training items on the user's transcript.</td>
</tr>
<tr>
<td>Training Subject (Curriculum)</td>
<td>Text</td>
<td>This is the subject(s) associated with the curriculum.</td>
</tr>
<tr>
<td>Training Type (Curriculum)</td>
<td>Text</td>
<td>This field displays the type of learning object (curriculum or the training type of child training items within the curriculum)</td>
</tr>
<tr>
<td>Training Version Effective Date (Curriculum)</td>
<td>Date</td>
<td>This is the effective date of the curriculum version.</td>
</tr>
</tbody>
</table>

### Transcript Fields

The following new fields are now included in the Transcript report field section:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transcript Status (From Curriculum)</td>
<td>Text</td>
<td>This is the status of the curriculum or the child training within the curriculum on the user's transcript.</td>
</tr>
<tr>
<td>Transcript Due Date (Curriculum)</td>
<td>Date</td>
<td>This is the due date that appears in the user's transcript for the curriculum. Note: This field only allows you to report on due dates for a specific curriculum. If the training is also in other curriculum with different due dates, you must use the Transcript Due Date field to report on these alternate due dates.</td>
</tr>
<tr>
<td>Curriculum Latest Registration?</td>
<td>Yes/No</td>
<td>This field indicates whether or not the instance of a curriculum on the user's transcript is the most recent registration. This value is propagated to the child training within the curriculum.</td>
</tr>
</tbody>
</table>
Updated Fields

Transcript Fields

The behaviors of the following Transcript fields are updated as follows:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>EXISTING DEFINITION</th>
<th>UPDATED BEHAVIOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curriculum Completion Percentage</td>
<td>This field enables reporting on the completion percentage of curricula. The completion percentage for each user is calculated once the user completes the first training item in the curriculum. The value is pulled from the Curriculum Progress field in the Curricula Player.</td>
<td>If a material or online course version within a curriculum is deactivated or disapproved, then the report shows the correct and updated completion percentage as reflected in the Curricula Player.</td>
</tr>
</tbody>
</table>

Report Field Section Considerations

Some exclusions and considerations apply to the existing report field sections that are included in the Curriculum Transcript report.

Assignment Section

The following considerations apply to the Assignment report field section within the Curriculum Transcript report:

- Fields in the Curriculum Assignment section track the activation of curricula on users’ transcripts, but not the individual activation dates of child training within curricula. The activation information for a curriculum is copied down to all of its child training items.

Training Section

The following fields in the Training fields section should NOT be used when the Training section is accessed via the Curriculum Transcript report:

- Curriculum Section Title (Training)
- Curriculum Title (Training)
- Curriculum Version (Training)
- Inside Curriculum

Using the above Training fields instead of the new corresponding fields in the Curriculum fields section will result in unexpected and potentially inaccurate report results.

Transcript Section

The following fields in the Transcript fields section should NOT be used when the Transcript section is accessed via the Curriculum Transcript report:

- Curriculum Section Title (Transcript)
Curriculum Transcript Statuses Considerations

Use the Transcript Status field to report on the curriculum status, because when using the new Transcript Status (from Curriculum) field, any statuses before Registration return a blank value.
Curriculum Transcript Report Examples

In the table below, fields for creating a basic Curriculum Transcript report are listed:

<table>
<thead>
<tr>
<th>FIELD NAME OR TYPE</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Information</td>
<td>Any fields from the User field section can be used to identify the users (for example, User ID, User Last Name, etc.).</td>
</tr>
<tr>
<td>Training Type</td>
<td>Use the <strong>Training Type</strong> field from the Training field section to report on the types of training within a curriculum.</td>
</tr>
<tr>
<td>Training Type (Curriculum)</td>
<td>This field will always generate an output of Curriculum for curricula included in the report. Using this field helps administrators easily identify curricula in the report.</td>
</tr>
<tr>
<td>Curriculum Title (Curricula)</td>
<td>This field can help administrators see when the titles of curriculum versions have differences.</td>
</tr>
<tr>
<td>Training Title</td>
<td>This field from the Training field section can be used to display the names of child training items within a curriculum.</td>
</tr>
<tr>
<td>Curriculum Version</td>
<td>Child training inherits the version number of the curriculum for better filtering capabilities. Use this field when you need to report on a specific curriculum version.</td>
</tr>
<tr>
<td>Training Version</td>
<td>This field from the Training field section displays the training version within the curriculum on the transcript.</td>
</tr>
<tr>
<td>Transcript Status (from Curriculum)</td>
<td>This field must be used to report on Not Activated and Pending Prior Training statuses of training within a curriculum.</td>
</tr>
<tr>
<td>Transcript Status</td>
<td>Use this field from the Transcript field section to display curriculum statuses before Registration (Please see the consideration for the Transcript Section, listed on the previous page.).</td>
</tr>
<tr>
<td>Transcript Due Date (from Curriculum)</td>
<td>This field displays the due dates of training within the curriculum.</td>
</tr>
<tr>
<td>Transcript Due Date</td>
<td>Use this field from the Transcript field section ONLY if you want to due dates with the Transcript Due Date field from the Curriculum section, to see if there is another due date for the training.</td>
</tr>
</tbody>
</table>
Assignment Fields

Use any assignment-related fields from the User field section to help identify the assignment at the curriculum level.

Use Case #1: Reviewing Learners' Progress on Curricula

An administrator wants to report on the current version of a curriculum on a user's transcript. The administrator adds the following fields to the report:

- User Full Name
- Training Type
- Curriculum Title (Curriculum)
- Training Title
- Training Version
- Transcript Status (from Curriculum)
- Transcript Due Date (Curriculum)
- Assignment Title
- Assignment ID
- Assignment Created By (User ID)
- Curriculum Latest Registration?

The administrator sets the following filters for the report:

- Curriculum Title (Curriculum): Curriculum Title starts with "May 2018"
- Curriculum Latest Registration: Curriculum Latest Registration? is True.

When the administrator generates the report, they are able to view the child training items within the curriculum that are on a user's transcript, the version of the curriculum, the versions of the child training items, the transcript statuses of the child training and curriculum, whether the training is the current registration, and more.

Use Case #2: Reporting on All Registrations or Versions of Curriculum Completion

An administrator wants to report on all versions and assignments of a curriculum on a user's transcript. The administrator adds the following fields to the report:
Cornerstone May 2018 Release Notes: What's New for May 2018

- User Full Name
- Training Type
- Curriculum Title (Curriculum)
- Training Title
- Curriculum Version (Curriculum)
- Training Version
- Transcript Status
- Transcript Due Date (Curriculum)
- Assignment Title
- Assignment ID
- Assignment Created By (User ID)
- Curriculum Latest Registration?

The administrator applies the following filter to the report:

- Curriculum Title (Curriculum): Curriculum Title starts with "May 2018"

After generating the report, the administrator can easily view which versions of the curriculum and its child training items are on a user's transcript, when they are due, what learning assignment the training was contained in, whether the curriculum is the latest registration, and more.

<table>
<thead>
<tr>
<th>Title: LS Curriculum Transcript Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Generated By: Laurence</td>
</tr>
<tr>
<td>Record Count: 10</td>
</tr>
<tr>
<td>Record Count Limit: 5000</td>
</tr>
<tr>
<td>Filter: (Curriculum Title) starts with May 2018</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Full Name</th>
<th>Training Type</th>
<th>Curriculum Title (Curriculum)</th>
<th>Training Title</th>
<th>Curriculum Version (Curriculum)</th>
<th>Training Version</th>
<th>Transcript Status (from Curriculum)</th>
<th>Transcript Due Date (Curriculum)</th>
<th>Assignment Title</th>
<th>Assignment Created By (User ID)</th>
<th>Curriculum Latest Registration?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barrett, Laurence</td>
<td>Curriculum</td>
<td>May 2018 Release Curriculum V1</td>
<td>May 2018 Release Curriculum V1</td>
<td>1.0</td>
<td>Registered</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Material</td>
<td>May 2018 Release Curriculum V1</td>
<td>Amazing May 2018 Release V1</td>
<td>1.0</td>
<td>Pending Prior Training</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Note</td>
<td>May 2018 Release Curriculum V1</td>
<td>Welcome to the May 2018 Release</td>
<td>1.0</td>
<td>Not Activated</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Online Class</td>
<td>May 2018 Release Curriculum V1</td>
<td>Awesome May 2018 Release V1</td>
<td>1.0</td>
<td>Not Activated</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Classroom</td>
<td>May 2018 Release Curriculum V2</td>
<td>May 2018 Release Curriculum V1</td>
<td>1.0</td>
<td>Registered</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Form</td>
<td>May 2018 Release Curriculum V2</td>
<td>Automation Form</td>
<td>1.0</td>
<td>Not Activated</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Material</td>
<td>May 2018 Release Curriculum V2</td>
<td>Amazing May 2018 Release V1</td>
<td>1.0</td>
<td>Pending Prior Training</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Note</td>
<td>May 2018 Release Curriculum V2</td>
<td>Welcome to the May 2018 Release</td>
<td>1.0</td>
<td>Not Activated</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Online Class</td>
<td>May 2018 Release Curriculum V2</td>
<td>Awesome May 2018 Release V1</td>
<td>1.0</td>
<td>Not Activated</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Classroom</td>
<td>May 2018 Release Curriculum V3</td>
<td>May 2018 Release Curriculum V2</td>
<td>1.0</td>
<td>Registered</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Form</td>
<td>May 2018 Release Curriculum V3</td>
<td>Automation Form</td>
<td>1.0</td>
<td>Not Activated</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Material</td>
<td>May 2018 Release Curriculum V3</td>
<td>Amazing May 2018 Release V1</td>
<td>1.0</td>
<td>Pending Prior Training</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Note</td>
<td>May 2018 Release Curriculum V3</td>
<td>Welcome to the May 2018 Release</td>
<td>1.0</td>
<td>Not Activated</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Barrett, Laurence</td>
<td>Online Class</td>
<td>May 2018 Release Curriculum V3</td>
<td>Awesome May 2018 Release V1</td>
<td>1.0</td>
<td>Not Activated</td>
<td>May 2018 Release Documentation</td>
<td>04/15/2018</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use Case #3: Auditors Request Specific Curriculum Version Completion

An administrator wants to provide proof that a user has completed Version 2 of a curriculum that was assigned to the user via a learning assignment. The administrator adds the following fields to the report:

- User Full Name
- Training Type
- Curriculum Title (Curriculum)
- Training Title
- Curriculum Version (Curriculum)
- Training Version
- Transcript Status (from Curriculum)

275
 negotiated filters to the report:

- Curriculum Title (Curriculum): Curriculum Title starts with "May 2018"
- Curriculum Version (Curriculum): Curriculum version starts with "2"

When the administrator generates the report, they are able to view Version 2 of the curriculum and its associated child training items on a user's transcript, along with the assignment in which the training was assigned and other relevant information.

<table>
<thead>
<tr>
<th>User Full Name</th>
<th>Training Type</th>
<th>Curriculum Title (Curriculum)</th>
<th>Training Title</th>
<th>Curriculum Version (Curriculum)</th>
<th>Training Version</th>
<th>Transcript Status (from Curriculum)</th>
<th>Transcript Due Date (Curriculum)</th>
<th>Assignment Title</th>
<th>Assignent ID</th>
<th>Assignment Created By (UserID)</th>
<th>Curriculum Latest Registration?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barra, Lawrence</td>
<td>Curriculum</td>
<td>May 2018 Release Curriculum V2</td>
<td>May 2018 Release Curriculum V1</td>
<td>5.0</td>
<td>May 2018 Release Curriculum V2</td>
<td>5.0</td>
<td>Registered</td>
<td>May 2018 Release Documentation V2</td>
<td>450 ca</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Barra, Lawrence</td>
<td>Form</td>
<td>May 2018 Release Curriculum V2</td>
<td>Automation Form</td>
<td>5.0</td>
<td>May 2018 Release Curriculum V2</td>
<td>5.0</td>
<td>Not Activated</td>
<td>May 2018 Release Documentation V2</td>
<td>450 ca</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Barra, Lawrence</td>
<td>Material</td>
<td>May 2018 Release Curriculum V2</td>
<td>Amazing May 2018 Release V2</td>
<td>5.0</td>
<td>May 2018 Release Curriculum V2</td>
<td>5.0</td>
<td>Pending/Traning</td>
<td>May 2018 Release Documentation V2</td>
<td>450 ca</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Barra, Lawrence</td>
<td>Material</td>
<td>May 2018 Release Curriculum V2</td>
<td>Amazing May 2018 Release V1</td>
<td>5.0</td>
<td>May 2018 Release Curriculum V2</td>
<td>5.0</td>
<td>Pending/Traning</td>
<td>May 2018 Release Documentation V2</td>
<td>450 ca</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Barra, Lawrence</td>
<td>Notes</td>
<td>May 2018 Release Curriculum V2</td>
<td>Welcome to the May 2018 Release</td>
<td>5.0</td>
<td>May 2018 Release Curriculum V2</td>
<td>5.0</td>
<td>Not Activated</td>
<td>May 2018 Release Documentation V2</td>
<td>450 ca</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Barra, Lawrence</td>
<td>Online Class</td>
<td>May 2018 Release Curriculum V2</td>
<td>Awesome May 2018 Releases</td>
<td>5.0</td>
<td>May 2018 Release Curriculum V2</td>
<td>5.0</td>
<td>Pending/Traning</td>
<td>May 2018 Release Documentation V2</td>
<td>450 ca</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
## Playlist Reporting

With this enhancement, it is possible to report on certain learning playlist and external content information using reporting functionality. There is a new Playlist report type, and some existing training fields may be used to report on playlists and external content.

To create a Playlist custom report, go to REPORTS > CUSTOM REPORTS and click the **NEW** button. Select **Playlist Report** from the drop-down menu.

### Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Playlist Reports - Create</td>
<td>Grants the ability to create and edit custom Playlist reports.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Playlist Report - View</td>
<td>Grants ability to view results of custom Playlist reports created by self or shared by others.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Training Reports - Create</td>
<td>Grants ability to create and edit Custom Training (Catalog) reports. This permission can be constrained by Provider. <strong>Note:</strong> When the constraint is set for the permission, users will only be able to view training data for the constrained providers.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Training Reports - View</td>
<td>Grants ability to view results of Custom Training (Catalog) reports created by self or shared by others. This permission can be constrained by Provider. <strong>Note:</strong> When the constraint is set for the permission, users will only be able to view training data for the constrained providers.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>

## Playlist Report

A new Playlist custom report type is available, which contains a new Playlist field section. In addition to the Playlist field section, the Playlist report type also includes the existing Training and User report field sections. See the chart below for the fields contained within the Playlist section:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By (Name) (Playlist)</td>
<td>Text</td>
<td>This is the full name of the user who created the playlist.</td>
</tr>
<tr>
<td>Created By (User ID)</td>
<td>Text</td>
<td>This is the user ID of the user who created the playlist.</td>
</tr>
<tr>
<td>FIELD NAME</td>
<td>FIELD TYPE</td>
<td>FIELD DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>(Playlist)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyword (Playlist)</td>
<td>Text</td>
<td>This field shows the keywords associated with the training item. All keyword are listed in the same cell separated by a comma.</td>
</tr>
<tr>
<td>Language (Playlist)</td>
<td>Text</td>
<td>This is the language in which the playlist was created.</td>
</tr>
<tr>
<td>Last Modified By (Playlist)</td>
<td>Text</td>
<td>This is the full name of the user who last modified the playlist.</td>
</tr>
<tr>
<td>Last Modified By (User ID) (Playlist)</td>
<td>Text</td>
<td>This is the user ID of the user who last modified the playlist.</td>
</tr>
<tr>
<td>Last Modified Date (Playlist)</td>
<td>Date</td>
<td>This is the date on which the playlist was last modified.</td>
</tr>
<tr>
<td>Private Status (Playlist)</td>
<td>Yes/No</td>
<td>Playlists can be created as either private or public. This field indicates whether or not the playlist is private.</td>
</tr>
<tr>
<td>Training Active (Playlist)</td>
<td>Yes/No</td>
<td>This field specifies whether or not the playlist is currently active in the system (for example, if a curator leaves the organization, an administrator may decide to deactivate the curator's playlists in the system).</td>
</tr>
<tr>
<td>Training Annotation (in Playlist)</td>
<td>Text</td>
<td>When creating a playlist, the playlist creator can add an annotation to each training item added to the playlist. This is the annotation provided for a training item within a playlist. This field is limited to 300 characters.</td>
</tr>
<tr>
<td>Training Creation Date (Playlist)</td>
<td>Date</td>
<td>This is the date on which the playlist was originally created.</td>
</tr>
<tr>
<td>Training Date/Time Added (in Playlist)</td>
<td>Date/Time</td>
<td>This is the date that the training was added to the Playlist.</td>
</tr>
<tr>
<td>Training Date/Time Modified (in Playlist)</td>
<td>Date/Time</td>
<td>This is the date that the training was re-ordered or a comment was edited</td>
</tr>
<tr>
<td>Training Description</td>
<td>Text</td>
<td>This is the description that was provided by the playlist creator when the playlist was created. This</td>
</tr>
</tbody>
</table>


### Training Report - Training Fields Applicable to Playlists and External Content

The following existing fields included in the Training custom report section can now be used to capture information about learning playlists and external content:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By (Name)</td>
<td>Text</td>
<td>This is the full name of the user who created the playlist or external content.</td>
</tr>
<tr>
<td>Created By (User ID)</td>
<td>Text</td>
<td>This is the user ID of the user who created the playlist or external content.</td>
</tr>
<tr>
<td>Language</td>
<td>Text</td>
<td>This is the language in which the playlist or external content was created.</td>
</tr>
<tr>
<td>Last Modified By</td>
<td>Text</td>
<td>This is the full name of the user who last modified the playlist or external content.</td>
</tr>
<tr>
<td>FIELD NAME</td>
<td>FIELD TYPE</td>
<td>FIELD DESCRIPTION</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Last Modified By (User ID)</td>
<td>Text</td>
<td>This is the user ID of the user who last modified the playlist or external content.</td>
</tr>
<tr>
<td>Last Modified Date</td>
<td>Date</td>
<td>This is the date on which the playlist or external content was last modified.</td>
</tr>
<tr>
<td>Training Active</td>
<td>Yes/No</td>
<td>This field indicates whether the learning object (LO) is active or inactive. The report displays &quot;Y&quot; for active and &quot;N&quot; for inactive. The value is pulled from the Active field for the LO.</td>
</tr>
<tr>
<td>Training Hours</td>
<td>Numeric</td>
<td>This is the number of training hours users can learn by completing the playlist or external content.</td>
</tr>
<tr>
<td>Training ID</td>
<td>Text</td>
<td>An ID is automatically generated for training on the backend. This field reports on the IDs of training items.</td>
</tr>
<tr>
<td>Training Status</td>
<td>Text</td>
<td>This field displays the status of the learning object (i.e., Approved, Expired, Tentative, Completed). This field does not display user transcript status for the LO. For the user transcript status, include the Transcript Status field in your report. For a list of training statuses and descriptions, see Transcripts Troubleshooting Guide.</td>
</tr>
<tr>
<td>Training Title</td>
<td>Text</td>
<td>This is the title of the playlist or external content.</td>
</tr>
<tr>
<td>Training Type</td>
<td>Text</td>
<td>This displays the learning object (LO) type of the training (i.e. playlist, external content)</td>
</tr>
<tr>
<td>Training Version</td>
<td>Numeric</td>
<td>This field displays the version number of the training. As of the May '18 release, it is not possible to reversion playlists or external content, so for these two training types, the Training Version value always defaults to 1.</td>
</tr>
<tr>
<td>User Training Availability</td>
<td>Text</td>
<td>This field displays the user availability criteria that is configured for the training. The value is obtained from the Criteria column in the Availability section of the Course Console or Course Catalog when &quot;Users&quot; has been selected from the Select Criteria drop-down. Note: This field only applies to individual users who are added to the Availability section; it does not apply to organizational unit (OU) criteria that may be defined in the Availability section. To include OU availability criteria data, you must include the OU Training Availability fields in the report.</td>
</tr>
</tbody>
</table>
Document Management System (DMS) Material Versioning Service
Document Management System Material Versioning Service

Document management systems (DMS) are electronic systems designed to manage, store, distribute, and archive documents. A DMS material versioning service can be used to create and version material learning objects (LOs) in the learning management system (LMS), with links to those documents stored in the DMS, allowing learners to access DMS resources as material LOs in the LMS via URL links.

A beta version of the DMS service was released in July 2016, and this service has been enhanced for the May 2018 release.

The DMS material versioning service, with the enhancements documented in the below section, will be made generally available to organizations using the Learning module during the June 29, 2018 patch. Please contact your Account Manager for more information.

Original Version of DMS Material Versioning Service

The original version of the DMS material service supported the following actions:

- Create materials (URL source only), with the following metadata supported:
  - Title
  - Material Type
  - Provider
  - Description
  - Material Source
  - Effective Date
  - Start Date

- Version Materials

**Note:** DMS-sourced material cannot be versioned through the user interface.

- Assign reversioned materials to users who meet dynamic learning assignment criteria (This includes users with a status of Not Started, In Progress, and Completed. This cannot be changed.)
- Trigger curriculum reversion
- Assign curriculum reversioned as a result of a versioned material to users who meet dynamic learning assignment criteria
- Track DMS material versioning via Modification History in the LMS

Updates to DMS Material Service

With the June 28, 2018 release, the existing features listed above continue to be available, and the following additional features are supported by the DMS material service:

- A new field can be used to display whether the reversioned material is Released, Effective, or Obsolete (this field is reportable)
- A new preference allows administrators to customize the DMS status field
Material LO metadata can be edited via the DMS without triggering a new version of the material.

Custom fields can be edited via the DMS.

The DMS can be used to deactivate initial versions of materials.

Effective dates can be set for initial versions of materials.

Start Dates can be set for initial versions of materials.

A new Training Version is Effective email trigger is available.

**Implementation**

For existing DMS material service users:

- Contact Cornerstone if you wish to receive the benefits of any new enhancements:
  - Even if no change is needed, organizations should still plan to test the updated service. The timeline of this testing period can be customized.
  - If change is needed, organizations must plan for regression and new feature tests. The timeline of this process can be customized.
- When custom scripts have been upgraded and testing has been completed in Pilot, the enhanced DMS material versioning service can be upgraded in Production portals.
- Until an organization is migrated to the enhanced DMS service, their original integration will continue to work without interruption.

For non-DMS material service users:

- With the June 29, 2018 patch, the updated version of the DMS material service will be generally available. Please contact your Account Manager to build a custom project for your organization, if needed.

**Permissions**

The following new permission applies to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMS Status Preferences - Manage</td>
<td>Grants ability to enable and configure DMS status values, which appear on user’s transcripts.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>
DMS - Status Field

With the June 29, 2018 release, a DMS Status field displays on the Training Details page for materials when an organization is using a DMS service. The DMS Status field displays the current version status of the DMS material. Available statuses include:

- **Released** - The material version is available in the system, but is not yet the current version.
- **Effective** - The material version is available in the system and is the current version which allows learners to maintain compliance.
- **Obsolete** - The End Date of the version has passed, and the material version is no longer the current version.

The DMS Status field is reportable, allowing organizations to ensure learners have completed the current effective version of the material. A new DMS Status field is added to the Training section available in Custom Reporting:

<table>
<thead>
<tr>
<th>FIEL D NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMS Status</td>
<td>Text</td>
<td>This field displays the value of a Document Management System (DMS)-sourced material status, if enabled. Possible values include: Released, Effective, Obsolete. This field is available in the Training section of the following custom report types:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Assignment Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Certification Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Evaluation Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Multi-Module Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Training Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Transcript Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Training Plan Report</td>
</tr>
</tbody>
</table>

*Note: A new preference page allows administrators to customize the values of the DMS Status field. See DMS Status Preferences on page 285 for additional information.*
**DMS Status Preferences**

Administrators can enable and customize the values of the DMS Status field via the DMS Status Preferences page. DMS Status values, if enabled, can appear to learners on their transcripts, so organizations may wish to customize these values.

To set DMS Status Preferences, go to **ADMIN > TOOLS > LEARNING > LEARNING PREFERENCES** and click the **DMS Status Preferences** link.

**Permissions**

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMS Status Preferences - Manage</td>
<td>Grants ability to enable and configure DMS status values, which appear on user’s transcripts.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>

**DMS Status Preferences**

The **DMS Status** field is disabled by default. To enable the **DMS Status** field, toggle the **Enable the DMS Status field on Transcript** switch to the On (green) position. When this field is enabled, users will see this field and its related values for DMS-sourced materials on their transcripts. Organizations can customize the values to reflect their own DMS values. After enabling the **DMS status** field, the DMS Status Preferences page refreshes to display additional options:

- **When Start Date is not reached** - In this field, enter a word which will be used to indicate that the Start Date for a DMS-sourced material has not yet been reached. This field defaults to a value of **Released**.
o **When Start Date is reached** - In this field, enter a word which will be used to indicate that the Start Date for a DMS-sourced material has been reached. This field defaults to a value of **Effective**.

o **When End Date is reached** - In this field, enter a word which will be used to indicate that the End Date for a DMS-sourced material has been reached. This field defaults to a value of **Obsolete**.

To reset the fields to their default values, you can click the **Reset Fields** link.

**Save**

To save any changes made to DMS Status Preferences, click the **SAVE** button at the bottom of the page, or click the **CANCEL** button to discard any changes without saving.
DMS - Version Behavior

With the June 29, 2018 patch, Effective Dates and Start Dates can be provided for DMS-sourced material versions, allowing versions to be automatically released, made effective, and deactivated as the relevant dates pass. These new fields are also available in the Transcript section of Custom Reports, allowing administrators to quickly report on which users have a DMS-sourced material in an Effective status that has not yet been completed.

- When the Effective Date for a DMS-sourced material version passes, the material version has a status of Effective. **Note:** Materials with an Effective Date set in the future are labeled as Pending Version in the Course Catalog and are not available for users to search for in the system.
- When the Start Date for a DMS-sourced material version passes, the material version has a status of Released. The material is available to search for and request in the system, and is the current version of the material.
- When the End Date for a material version passes, the material version is automatically deactivated and has a status of Obsolete.

See [DMS - Status Field](#) on page 284 for additional information.
DMS - Training Version is Effective (DMS) Email Trigger

With the June 29, 2018 patch, a new Training Version is Effective (DMS) email trigger is available in Email Administration. The Training Version is Effective (DMS) email trigger is triggered when the Start Date of the material version is reached and the training becomes effective. **Start Date** is an Append Versioning option. This email trigger is applicable to all materials, whether DMS-sourced or created via the learning management system (LMS).

This new email trigger enables organizations to increase compliance and training completion by sending automatic emails a specified number of days before the training becomes effective.

See the following resources for Email Administration and creating emails:

- *Email Administration*
- *Email - Create*
DMS - Custom Fields

With the June 29, 2018 patch, the DMS material service will support the creation and update of the following custom field types:

- Localized Short Text Box
- Localized Scrolling Text Box
- Date Field
- Drop-down
- Multiple Choice Checkbox
- Checkbox
- Numeric Fields
Edit Availability in Course Console
Edit Availability in Course Console - Overview

Prior to this enhancement, it was only possible to set learning content availability from the Availability tab within the advanced edit page of a training item in Course Catalog.

With this enhancement, learning content availability can be configured from the Course Console. This functionality is particularly beneficial when used in conjunction with Learning Playlist functionality, released in March 2018.

Use Cases

Tim is an administrator at ACME. He was recently told by a colleague that there is cyber security fundamentals training in the catalog that does not seem to be available to the Fulfillment Center Operations division within the company, who should be able to access the training.

Tim finds the training using Course Catalog Search and clicks its title. He is navigated to the Course Console page for the training and can quickly view the selected availability. He can also edit the availability to add the Fulfillment Center Operations group, which he realizes is mistakenly not included in the training availability.

Considerations

Availability cannot currently be edited in bulk using the Course Console. To edit the availability of multiple training items at one time, administrators can still use existing bulk edit functionality via the Course Catalog.

Implementation

This functionality is automatically enabled for all portals using the Learning module.

Permissions

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course Catalog - Update</td>
<td>Grants ability to manage/edit learning objects listed in the Course Catalog and also grants access to the Course Console, where LOs can also be managed/edited. This permission also grants access to the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, User, User Self and Subordinates, and User's LO Availability. This is an administrator</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Permission</td>
<td>Description</td>
<td>Administration</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Permission</td>
<td>With the Oct '17 release, this permission allows administrators to reversion online classes via the Course Console page.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Course Catalog - View</td>
<td>Grants access to view the learning objects in the course catalog and enables administrators to view the Course Console and the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, and User's LO Availability. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Training Request Form - Manage</td>
<td>Grant access to create and edit training request forms, manage request form statuses, and manage form statuses for users. This is an administrator permission.</td>
<td>Training Forms Administration</td>
</tr>
</tbody>
</table>
Course Console - View and Set Availability

Learning administrators can view and set availability for learning content via the Course Console page, allowing them to manage even more training metadata from one central location.

To access availability information for training content via the Course Console, go to ADMIN > TOOLS > LEARNING > CATALOG MANAGEMENT > COURSE CATALOG and search for the specific training item. Then, click the title of the training item you want to edit.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course Catalog - Update</td>
<td>Grants ability to manage/edit learning objects listed in the Course Catalog and also grants access to the Course Console, where LOs can also be managed/edited. This permission also grants access to the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, User, User Self and Subordinates, and User's LO Availability. This is an administrator permission. With the Oct '17 release, this permission allows administrators to reversion online classes via the Course Console page.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Course Catalog - View</td>
<td>Grants access to view the learning objects in the course catalog and enables administrators to view the Course Console and the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, and User's LO Availability. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Training Request Form - Manage</td>
<td>Grant access to create and edit training request forms, manage request form statuses, and manage Training Forms Administration</td>
<td>Training Forms Administration</td>
</tr>
</tbody>
</table>
form statuses for users. This is an administrator permission.

Availability

The Availability section is located above the Training Over Time section of the Course Console. If no availability has yet been configured for the training item, "No Availability Selected" displays in the section, along with options for adding availability criteria. The following options are available for selecting criteria:

- **Select Users** - Click **SELECT USERS** button to search for and select organizational units (OUs) or groups for which to set availability. See the Select Users section below for more information.
- **All Users** - Click this link to make the training available to all users in the system. See the All Users section below for more information.

Select Users

To configure availability for specific OUs or groups:
1. Click the **SELECT USERS** button. This opens a Select Users flyout.
2. From the drop-down menu, select the user criteria type. Available types include:
   - Cost Center
   - Division
   - Position
   - Grade
   - Group
   - Location
   - Position
   - Self Registration Group
   - Custom OUs
   - Users
3. Use search fields to find the desired OU or users. Available filters differ for OUs and users:
   - **OU search filters:**
     - OU Title
     - OU ID
     - OU Owner First Name or Last Name
     - OU Description
   - **User search filters:**
     - User First Name or Last Name
     - User ID
     - Username
     - Manager's First Name or Last Name
     - Position
     - Division
     - Location
4. Up to twenty search results display on each page of the Select Users flyout. To view additional pages of search results, click a page number or the navigation arrows near the bottom of the flyout.
5. Filter the search results if needed.
6. Each relevant user or OU appears in the search results as a tile with related information about the user or OU. If the OU has any child OUs, you can view them by clicking the arrow on the right side of the tile.
7. Check the box on the left side of the tile for the user or OU you wish to add to the availability. You may switch between user criteria type using the drop-down and then multi-select as many OUs or users as needed.
8. If you wish to review your selections before adding them to the training's availability, click the Selected tab at the top of the flyout.
9. Click the **SELECT** button at the bottom of the flyout. Your selections will be added to the Availability section in alphabetical order. If more than five criterion are added to the Availability section, the Availability section becomes paginated, and up to five criteria can display per page.
All Users

To make the training available to all users in the system, click the All Users link.

**Note:** If an administrator selects All Users but their permission to update the Course Catalog is constrained, only users within the administrator's constraints are included in the availability for the training.

Availability Criteria

After searching for and selecting availability criteria, each OU, group, or separate user appears in the Availability section with the appropriate metadata and configuration options. The options shown are not the same for all training types, but the metadata and configuration options can include the following fields and options:

- **Name** - The name of the selected OU, group, or user appears at the top of each criteria tile.
- **ID** - The ID of the OU, if available
- **Type** - The OU type (i.e. division, location, etc.)
- **Manager** - The manager of the OU
- **Owner** - The owner of the OU
- **Include Subordinates** - Check this box to include the OU's child OUs in the availability for the training. **Note:** This option does not display when the All Users option is selected for the availability criteria.
- **Pre-Approved** - Check this box to pre-approve users in the OU for the training item. Users in this OU will not need to receive approval from an approver prior to being able to register for the training.
- **Register Upon Approval** - Check this box to automatically register users in the OU into the training.
- **Availability Type** - Select an availability type from the drop-down menu:
  - None
  - Suggested - If the learning object is set to Suggested, it appears on the Welcome page under Suggested Training (if Suggested Training is active on the Welcome page).
  - Required - If the LO is set to Required, it appears on the Welcome page under Your Assigned Training or Required Training (if the Assigned Training widget or the Required Training widget is active on the Welcome Page). **Note:** Training set to Required is not actually assigned and must still be requested by the user.
  - Featured - If a learning object is set to Featured, the training item appears to the selected users in the Featured Training widget and also when users select Featured from the Training filter on the Browse for Training page.
- **Training Request Form** - From the drop-down, select a Training Form to be attached to this LO, if appropriate. Visibility of this option is controlled by the permission to manage training request forms.

**Note:** When adding criteria to training, the criteria is limited by any constraints applied to the administrator's permission to update the Course Catalog. If constraints are applied to the administrator's permission to update the Course Catalog, a system notification appears
when they add availability criteria, alerting them that their selections are limited by their constraints.

Search Added Criteria

Administrators are able to perform searches on sets of selected criteria. For example, if an administrator has added many specific users to the availability of a training item, they may wish to search for a specific user within the selected criteria to make changes to that user’s availability configurations.

To search for specific criteria within your availability selections, enter a search term into the Search bar and press the Enter key on your computer. The selections in the Availability section will be filtered based on the entered criteria, and you can edit or remove criteria
selections as needed. Ensure that you are viewing the Availability section in Edit mode if you wish to make changes to the criteria (See the Edit section below for more information).

**Note:** The Search bar is hidden if no availability criteria has been selected.

### Save

After configuring all availability criteria, click the **SAVE** button at the bottom of the Availability section. The availability criteria will be applied to the training. If you wish to cancel any changes you have made to the availability criteria before saving, click the **CANCEL** button. Any changes you made will be reverted to the previous saved state.

After saving the availability selections, the criteria is converted to read-only format.

### Edit

To edit the Availability section when criteria has already been saved, click the **Edit** link in the upper-right corner of the Availability section. The criteria is converted to an editable format, and criteria can be added and removed from the section.

### Remove Criteria

If needed, you can remove criteria from the availability section by clicking the Delete icon in the upper-right corner of the specific criteria tile, or you can delete all existing criteria by clicking the **Remove All** link. These options are only available when the Availability section is in the editable format.
Playlist Availability

Availability can be set for public playlists via the Course Console. However, if the playlist creator has designated the playlist as private, no availability options are available for that playlist.

<table>
<thead>
<tr>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>THIS PLAYLIST IS PRIVATE</td>
</tr>
<tr>
<td>Playlist availability cannot be edited for a private playlist. Any selection criteria previously made will not be used.</td>
</tr>
</tbody>
</table>

Considerations

- Once a playlist is created, the playlist creator is automatically included in the availability for the playlist. The playlist creator cannot be removed from the playlist availability.
- Only the options to Include Subordinates and select Availability Type display for criteria selected for playlists. The additional options available for other learning content types are NOT available for playlists.
Activate and Deactivate Training from Course Console

With this enhancement, learning objects (LOs) can be activated and deactivated from the Course Console page. Using the **Active/Inactive** toggle switch available on the Course Console, administrators can easily activate and deactivate an LO in the system.

To access the Active/Inactive toggle on the Course Console, go to **ADMIN > TOOLS > LEARNING > CATALOG MANAGEMENT > COURSE CATALOG** and search for the specific training item. Then, click the title of the training item you want to edit.

**Permissions**

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course Catalog - Update</td>
<td>Grants ability to manage/edit learning objects listed in the Course Catalog and also grants access to the Course Console, where LOs can also be managed/edited. This permission also grants access to the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, User, User Self and Subordinates, and User's LO Availability. This is an administrator permission. With the Oct '17 release, this permission allows administrators to reversion online classes via the Course Console page.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Course Catalog - View</td>
<td>Grants access to view the learning objects in the course catalog and enables administrators to view the Course Console and the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, and User's LO Availability. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>
Active/Inactive Toggle

On the right-hand side of the Course Console page, an **Active/Inactive** toggle switch displays. If the LO is currently active in the system, the toggle will be set to the Active (green) position. You can deactivate the LO by toggling the switch to the Inactive (gray) position. When you attempt to deactivate an LO via the Course Console, a validation message appears, asking if you are sure you want to deactivate the training. Click the **Yes** option to deactivate the training, or click the **Cancel** option to keep the training active.

If the LO is currently inactive, you can activate it by toggling the switch to the Active (green) position.
End Support of Microsoft Live Meeting

As of December 2017, Microsoft has discontinued Live Meeting, a virtual instructor-led training (vILT) integration. As a result, Cornerstone no longer supports the Live Meeting vILT integration.
External Content - Overview
With this enhancement, a new training type called "external content" can be created when building learning playlists, allowing playlist creators to not only include internal training in their playlists, but also content that exists outside the system, such as Youtube videos, books, training courses, and more. External content can be added to the learning transcript and completed like other training types, and its availability can be set via the Course Console. External content items can be found within playlists, on Learner Home and Learning Search, and on the Global Search page. Certain external content information can also be reported on using Custom Reporting functionality.

Use Cases

Use Case: Adding External Content to Playlist
Jen is a Regional Sales Manager at ACME Corporation. She has various accolades and her colleagues often ask her for advice and guidance on how to build a successful career path. Jen is eager to help others, so she creates a playlist of learning objects from the internal catalogs with her recommendations for "Foundational Sales Skills." She begins to distribute the playlist, but her colleagues continue to ask: "What else has helped you in your career? What type of content or courses are you taking outside of the training we have in the Learning Management System?"

Jen reviews her notes and finds other training that would help enhance her playlist. She adds her favorite sales podcast, "Sales Gravy," an article she read as an associate from Harvard Business Review, and a TED talk on Soft Skills. All these additions are added to the playlist as external content. Her playlist followers love the new additions and the fact that Jen can continue to add compelling external content for them to consume. Jen likes that she can increase the reach of her knowledge in her organization with her playlist.

Considerations
The following exclusions apply to external content:

- External content items do not appear on the Browse for Training page
- External content items do not have Transcript Details pages

Implementation
This functionality is automatically enabled for all portals using the Learning module. External content works in conjunction with playlist functionality, which was released in March 2018 as part of an early adopter program and is generally available with the May 2018 release. See the following resources for more information about playlists:

May ’18 Learning Playlist Enhancements:
- See Learning Playlists - Overview on page 329 for additional information.

Playlist Functionality prior to May ’18:
- Manage Playlists.
Create Playlists.
- Playlist Details.
- Playlists - End User View.

## Permissions

The following new permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Content -Create</td>
<td>Grants the ability to create external content. This permission can be constrained by OU or by aspects of the user. When a user creates external content, the availability is determined by the constraints of the permission. This is an end user permission.</td>
<td>Learning</td>
</tr>
</tbody>
</table>

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin Search Preferences -Manage</td>
<td>Grants ability to configure preferences for Global Search and Course Catalog within Search Preferences. The constraints of this permission are inherited from the Global Search Preferences -Manage permission. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Course Catalog -Update</td>
<td>Grants ability to manage/edit learning objects listed in the Course Catalog and also grants access to the Course Console, where LOs can also be managed/edited. This permission also grants access to the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission).This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, User, User Self and Subordinates, and User's LO Availability. This is an administrator permission. With the Oct '17 release, this permission allows administrators to reversion online classes via the Course Console page.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Course Catalog -View</td>
<td>Grants access to view the learning objects in the course catalog and enables administrators to view the</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Location</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Course Console and the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, and User's LO Availability. This is an administrator permission.</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Custom Training Reports - Create</td>
<td>Grants ability to create and edit Custom Training (Catalog) reports. This permission can be constrained by Provider. <strong>Note:</strong> When the constraint is set for the permission, users will only be able to view training data for the constrained providers.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Training Reports - View</td>
<td>Grants ability to view results of Custom Training (Catalog) reports created by self or shared by others. This permission can be constrained by Provider. <strong>Note:</strong> When the constraint is set for the permission, users will only be able to view training data for the constrained providers.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Default Training Image Preferences</td>
<td>Grants access to Default Training Image Preferences page where an administrator can configure custom default images for training by type. This permission cannot be constrained. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Global Search Preferences - Manage</td>
<td>Grants ability to configure Global Search Preferences. This is an administrator permission. The availability of this permission is controlled by a backend setting. This permission can be constrained by OU and User's OU. By default, this permission is constrained to the organization.</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Global Search - Training</td>
<td>Grants ability to search for training via Global Search. If this permission is constrained to a specific OU, then that constraint is automatically applied within Global Search, including search filters and search results. This is an end user permission. The availability of this permission is controlled by a backend setting.</td>
<td>Learning</td>
</tr>
<tr>
<td>Playlists - Create</td>
<td>Grants ability to create private Learning Playlists.</td>
<td>Learning -</td>
</tr>
<tr>
<td>Permission</td>
<td>Description</td>
<td>Area</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Playlists - View</td>
<td>Grants ability to view Learning Playlists within user’s availability. Select Playlist features will become visible to users with this permission. This permission cannot be constrained. This is an end user permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Learner Home</td>
<td>Grants access to the Learner Home and the Learning Search page. This is an end user permission. This permission cannot be constrained.</td>
<td>Learning</td>
</tr>
<tr>
<td>View Transcript Item</td>
<td>Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>
Create External Content

External content allows playlist creators to add training to their playlists even if the training is published outside the learning management system (LMS). Creators can add links to videos, books, external online courses, and more.

To add external content to a playlist, go to LEARNING > PLAYLISTS. You must have permission to create playlists and the permission to create external content. Either click the CREATE NEW button to create a new playlist, or click the title of an existing playlist to make changes to a previously created playlist.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course Catalog - Update</td>
<td>Grants ability to manage/edit learning objects listed in the Course Catalog and also grants access to the Course Console, where LOs can also be managed/edited. This permission also grants access to the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, User, User Self and Subordinates, and User's LO Availability. This is an administrator permission. With the Oct '17 release, this permission allows administrators to reversion online classes via the Course Console page.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Course Catalog - View</td>
<td>Grants access to view the learning objects in the course catalog and enables administrators to view the Course Console and the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, and User's LO Availability. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>External Content - Create</td>
<td>Grants the ability to create external content. This permission can be constrained by OU or by aspects of Learning.</td>
<td>Learning</td>
</tr>
<tr>
<td>Role</td>
<td>Permission</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Learner Home</td>
<td>Grants access to the Learner Home and the Learning Search page.</td>
<td>This is an end user permission. This permission cannot be constrained.</td>
</tr>
<tr>
<td>Playlists - Create</td>
<td>Grants ability to create private Learning Playlists.</td>
<td>This permission cannot be constrained. This is an end user permission.</td>
</tr>
<tr>
<td>Playlists - Make Visible</td>
<td>Grants the playlist creator the ability to make their playlists visible to others.</td>
<td>This permission can be constrained by OU, User's OU, User's Direct Reports, User, and User Self and Subordinates. If this permission is constrained, then only users within the constraints can see the playlist. If this permission is not constrained, all users in the portal can see the Playlist. This is an end user permission. If this permission is added to a standard security role (Approver, Cost Center Approver, Instructor, Manager, etc.), the constraints of the role are applied to the permission. The users included in the constraints of the role are also the users who can view the playlists made visible by a user with the Playlists - Make Visible permission. If this is not the desired result, add this permission to a non-standard security role to ensure the constraints appropriately limit access to playlists.</td>
</tr>
<tr>
<td>Playlists - View</td>
<td>Grants ability to view Learning Playlists within user's availability. Select Playlist features will become visible to users with this permission.</td>
<td>This permission cannot be constrained. This is an end user permission.</td>
</tr>
</tbody>
</table>
External Content

When creating a playlist, you can either add training from within the LMS, or you can add links to external content outside the system if you have the permission to create external content. To add external content to the playlist:

1. Click the External Content tab at the top of the playlist's structure. Instead of searching for training within the system, you will need to provide a link to the external content you wish to add.

2. Paste a link to the external content you wish to add into the **Paste a link to add to your playlist** field. Press the Enter key on your keyboard after entering your link.

3. The system automatically populates as much information about the external content as possible. If any fields for the external content are blank or incorrect, manually populate the fields. The following fields are available for each external content item:
   - **Title** - This is the title of the external content. The system attempts to automatically populate this field with information from the provided link. If needed, manually enter the correct title into this field.
   - **Description** - This is the description of the external content. The system attempts to automatically populate this field with information from the provided link. If needed, manually enter a description into this field.
- **Image** - If available, the thumbnail image for the external content is automatically populated. The thumbnail image can be removed by clicking the Remove Image link, and the system substitutes the default training image for external content, as defined in Default Training Image Preferences. See Default Training Image Preferences. The image displayed for the external content displays for the external content item when users view the playlist. **Note:** It is not possible to upload a custom image for external content.

- **Content Type** - From the drop-down menu, select the media type of the external content. Available media types include:
  - Article
  - Audio
  - Course
  - Document
  - Image
  - Video
  - Website

- **Duration** - The Duration fields indicate the number of hours and minutes the external content requires to complete. If available, the system automatically populates this information, but you can manually enter a duration for the external content if needed. **Note:** The Duration fields only display if Duration fields are enabled via Playlist Preferences.

- **Languages** - The Languages drop-down allows you to specify the languages in which the external content is available. The system automatically attempts to populate this field, but if not all available languages are selected, click the drop-down menu and select all applicable languages.

- **Comment** - The Comment field allows you to provide an annotation for the external content. This field is limited to 300 characters. This field is optional, but if a comment is provided, it appears to users on the Playlist Details page.

4. After ensuring all the options for the external content have been correctly configured, click the ADD ITEM button to save the external content to the playlist. Alternatively, if you wish to discard the external content without saving it to the playlist, you can click the Cancel link.

**Playlist Structure**

After external content has been added to a playlist, it displays as a training tile in the playlist structure. The following information displays for each external content tile:

- **Thumbnail Image** - The thumbnail image associated with the external content displays at the top of the training tile.

- **Content Type** - This is the content type of the external content, which displays next to the words "External Content."

- **Title** - This is the title of the external content.

- **Options** - The following options are available for each training tile:
  - **Move Content Up** - Click this icon to move the content higher in the playlist structure.
Move Content Down - Click this icon to move the content lower in the playlist structure.

Delete - Click this icon to remove the external content from the playlist structure.

Actions - The following additional actions may be available for external content items:

- **Launch** - Click the Launch option to launch the external content in a separate window. *Note: When a learner clicks the Launch option, they are automatically registered into the training, and the training is added to their transcript.*

- **Mark Complete** - Click the Mark Complete option to mark the external content complete on your transcript.

- **Add Comment** - Click this option to provide or edit the comment for the external content. Comments are limited to 300 characters.

- **Quick Add** - The titles of your five most recently updated playlists display as options. Click the title of a playlist to add the external content item to that playlist. A validation message displays at the top of the page when the training has been successfully added to the playlist.

- **Create New Playlist** - Click this option to begin creating a new playlist, using this training item as the playlist’s first item.

- **Save for Later** - Click the option to save the external content for later. The item is saved to the Saved for Later carousel on Learner Home. See Learner Home - Training and Banner Carousels for more information.
For more information about creating a playlist, see Create Playlists.

**External Content in Course Catalog and Course Console**

After an external content item has been added to a playlist, the external content becomes available as a learning object in Course Catalog Search. From the Course Catalog, administrators can access the Course Console page for the external content, where they can view and edit its metadata and view dashboard reports for the external content.

**Course Catalog Search**

On the Course Catalog Search page, you can use the Training Type drop-down filter to filter for external content. If you select only the external content training type, only external content items will display in search results below. Metadata for the course can be managed via the Course Console page for the external content, but NOT via the Course Catalog itself. Under the Options drop-down next to external content items in the search result, the following option is available:

- **View as User** - Click this option to launch the external content in a new browser window. You can view the external content as a learner.
Course Console

To make edits to an external content item's metadata, click the title of the external content. You will be navigated to the Course Console for the external content. From the Course Console, you can view information about the external content and modify certain fields and settings, including the external content's availability.

The following Course Console fields display for external content:

- Title
- Provider
- Keywords
- Description
- Thumbnail Image
- Version
- Active
- ID
- Status
- Created Date
- Created By
- Default Language
- Last Modified Date
- Language
- Exclude from Recommendations
- Availability
- Training Over Time
- Training Status
- Training Statistics
For more information about setting availability using the Course Console: *See Edit Availability in Course Console - Overview* on page 290 *for additional information.*

For general information about using the Course Console: *See Course Console - Overview.*

---

**External Content on Learner Home and Learning Search**

External content that has been added to a playlist can also be found using Learner Home and Learning Search. External content items appear as training tiles on both pages, with the following information:

- **Thumbnail Image** - The image associated with the external content. Clicking the image of the external content navigates you to the Training Details page for the external content.
- **Content Type** - The type of external content (i.e. video, website, document, etc.)
- **Training Type** - The type of learning object (external content)
- **Title** - The name of the external content. Clicking the title of the external content navigates you to the Training Details page for the external content.
- **Duration** - The number of hours and minutes required to complete the external content (only visible if configured to be visible via Playlist Preferences)
- **Options** - Click the "..." icon to access the following actions:
  - **Request** (if available) - Click this option to request the external content. This adds the training to the user's transcript. The page will then refresh to the transcript.
  - **Save for Later** (if available) - Click this link to save the external content. Saved training items display in the Saved for Later carousel on the Learner Home page.
  - **Remove from Saved** (if available) - This link is only available if the training has already been saved by the user. Click this link to remove the training item from the Saved for Later section.
External Content on Global Search

External content items can appear in Global Search results, and users can filter search results specifically for external content. See Global Search - External Content on page 320 for additional information.

External Content on Learning Transcript

Learners can add external content to their transcripts by requesting it from a playlist, from Learner Home, or from Learning Search. After the external content has been added to their transcript, options are available for managing the content. See External Content on Learning Transcript on page 318 for additional information.
External Content - Training Details

Users can access the Training Details page for external content items by clicking the external content training tile from Learner Home, Learning Search, or a playlist. The Training Details page provides basic information about the external content.

Training Details

The following information and options appear on the Training Details page for external content, depending on the accessing user’s permissions:

- Title
- Duration (if available)
- Description
- Actions - The following actions may be available for external content:
  - **Launch** - Click this option to launch the training as a learner.
  - **Assign** - This option is available to managers, and allows them to assign the external content to users within their permission constraints.
- Ratings and Reviews (if available)
External Content on Learning Transcript

External content can appear on learners' transcripts, along with information and actions that allow the learner to manage the external content.

To access your learning transcript, go to: LEARNING > VIEW YOUR TRANSCRIPT.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Transcript Item</td>
<td>Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>

Learning Transcript

The following information and actions may be available when the user views an external content item on their transcript:
Training type icon - The icon for external content appears for the external content item on the user's transcript.

Training Title - Click the training title to launch the external content.

Due Date - Due dates cannot be associated with external content, so this field defaults to "No Due Date."

Status - The following transcript statuses may display for external content:
- In Progress
- Completed

Transcript Actions - The following actions may be available for external content on a user's transcript:
- Mark Complete - This option moves the external content to a status of Complete. This is the default action for external content. The completion date for the external content is set to the date the training was marked complete.
- Launch - Clicking the Launch option opens the external content item in a new window.

Note: The View Training Details option, which is available for other learning types, is not available for external content.
Global Search - External Content

With this enhancement, external content items are a type of learning object (LO), and they can be searched for via Global Search. In addition, users can filter for external content LOs specifically using the External Content filter.

To access Global Search, place your cursor in the Global Search bar located in the upper-right corner of any system page and press the Enter key on your keyboard. You can either enter a search term into the Search bar or leave it blank before pressing Enter. You will be navigated to the Global Search page. **Note:** External content can also be included in Global Search predictive search results.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Search - Training</td>
<td>Grants ability to search for training via Global Search. If this permission is constrained to a specific OU, then that constraint is automatically applied within Global Search, including search filters and search results. This is an end user permission. The availability of this permission is controlled by a backend setting.</td>
<td>Learning</td>
</tr>
</tbody>
</table>

Training Filters

Available training filters display on the left side of the Global Search page in the form of icons. To filter by a certain training type, click the icon which represents the desired training.
type. If you hover over an icon, a pop-up bubble appears and displays the name of the training type. To filter by Playlist LOs, click the Playlist icon.

**Note:** *In order for the Playlist filter to be available on the Global Search page, Playlists must be designated as available for searching via Search Preferences.*

### Training Results

If the user has the permission to view playlists, available playlists related to the search criteria appear in the Training Results section. Each playlist displays with the following information:

- **Title** - This field displays the name of the playlist. Click the title to navigate to the Playlist Details page. *See Playlist Details.*
- **Price** (if applicable) - This field displays the price of the training item, if pricing functionality is enabled in the portal.
- **Rating** (if applicable) - This field displays the average star rating of the training item, if ratings functionality is enabled in the portal.
- **Description** - This field displays the playlist description provided by the playlist provider.
Default Training Image Preferences - External Content

With this enhancement, the external content training type is added to the Default Training Image Preferences page. When a user creates an external content item from within a playlist, the system attempts to automatically provide a thumbnail image for the external content, based on its source. If this is not possible, or the user removed the thumbnail image, the external content thumbnail image defaults to the image configured via Default Training Image Preferences. Administrators can upload an alternate default image for external content items from this page. See Default Training Image Preferences.
Search Preferences - External Content

Using Search Preferences, administrators can configure the Global Search page to allow users to filter and search for external content learning objects (LOs).

To access the Search Preferences - Training page, go to ADMIN > TOOLS > CORE FUNCTIONS > CORE PREFERENCES > SEARCH. Then, click the Training tab on the left navigation bar.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin Search Preferences - Manage</td>
<td>Grants ability to configure preferences for Global Search and Course Catalog within Search Preferences. The constraints of this permission are inherited from the Global Search Preferences - Manage permission. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Global Search Preferences - Manage</td>
<td>Grants ability to configure Global Search Preferences. This is an administrator permission. The availability of this permission is controlled by a backend setting. This permission can be constrained by OU and User's OU. By default, this permission is constrained to the organization.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>

Customize searchable training types. If disabled, even if user has availability to the training, user will not be able to view in search results.

<table>
<thead>
<tr>
<th>Training Types</th>
<th>Available for searching</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Class</td>
<td>✓</td>
</tr>
<tr>
<td>Event</td>
<td>✓</td>
</tr>
<tr>
<td>Curriculum</td>
<td>✓</td>
</tr>
<tr>
<td>Quick Course</td>
<td>✓</td>
</tr>
<tr>
<td>Material</td>
<td>✓</td>
</tr>
<tr>
<td>Library</td>
<td>✓</td>
</tr>
<tr>
<td>Posting</td>
<td>✓</td>
</tr>
<tr>
<td>Test</td>
<td>✓</td>
</tr>
<tr>
<td>Video</td>
<td>✓</td>
</tr>
<tr>
<td>Playlist</td>
<td>✓</td>
</tr>
<tr>
<td>Program</td>
<td>✓</td>
</tr>
<tr>
<td>External Content</td>
<td>✓</td>
</tr>
</tbody>
</table>
Training Types - External Content

In order for the **External Content** filter to be visible and for external content to be searchable in Global Search, the Available for Searching checkbox must be checked for External Content on the Search Preferences - Training page. If this field is not checked, the **External Content** filter is not available, and external content cannot be found using Global Search.
External Content Reporting

With this enhancement, it is possible to report on certain external content information using reporting functionality.

To create a custom report, go to REPORTS > CUSTOM REPORTS and click the NEW button.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Playlist Reports - Create</td>
<td>Grants the ability to create and edit custom Playlist reports.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Playlist Report - View</td>
<td>Grants ability to view results of custom Playlist reports created by self or shared by others.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Training Reports - Create</td>
<td>Grants ability to create and edit Custom Training (Catalog) reports. This permission can be constrained by Provider. <strong>Note:</strong> When the constraint is set for the permission, users will only be able to view training data for the constrained providers.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Training Reports - View</td>
<td>Grants ability to view results of Custom Training (Catalog) reports created by self or shared by others. This permission can be constrained by Provider. <strong>Note:</strong> When the constraint is set for the permission, users will only be able to view training data for the constrained providers.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>

The following existing training report fields can be used to capture information about external content:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By (Name)</td>
<td>Text</td>
<td>This is the full name of the user who created the playlist or external content.</td>
</tr>
<tr>
<td>Created By (User ID)</td>
<td>Text</td>
<td>This is the user ID of the user who created the playlist or external content.</td>
</tr>
<tr>
<td>Language</td>
<td>Text</td>
<td>This is the language in which the playlist or external content was created.</td>
</tr>
<tr>
<td>Last Modified By</td>
<td>Text</td>
<td>This is the full name of the user who last modified the playlist or external content.</td>
</tr>
<tr>
<td>FIELD NAME</td>
<td>FIELD TYPE</td>
<td>FIELD DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Last Modified By (User ID)</td>
<td>Text</td>
<td>This is the user ID of the user who last modified the playlist or external content.</td>
</tr>
<tr>
<td>Last Modified Date</td>
<td>Date</td>
<td>This is the date on which the playlist or external content was last modified.</td>
</tr>
<tr>
<td>Training Active</td>
<td>Text</td>
<td>This field indicates whether the learning object (LO) is active or inactive. The report displays &quot;Y&quot; for active and &quot;N&quot; for inactive. The value is pulled from the Active field for the LO.</td>
</tr>
<tr>
<td>Training Hours</td>
<td>Numeric</td>
<td>This is the number of training hours users can learn by completing the playlist or external content.</td>
</tr>
<tr>
<td>Training ID</td>
<td>Text</td>
<td>An ID is automatically generated for training on the backend. This field reports on the IDs of training items.</td>
</tr>
<tr>
<td>Training Status</td>
<td>Text</td>
<td>This field displays the status of the learning object (i.e., Approved, Expired, Tentative, Completed). This field does not display user transcript status for the LO. For the user transcript status, include the Transcript Status field in your report. For a list of training statuses and descriptions, see Transcripts Troubleshooting Guide.</td>
</tr>
<tr>
<td>Training Title</td>
<td>Text</td>
<td>This is the title of the playlist or external content.</td>
</tr>
<tr>
<td>Training Type</td>
<td>Text</td>
<td>This displays the learning object (LO) type of the training (i.e. playlist, external content)</td>
</tr>
<tr>
<td>Training Version</td>
<td>Numeric</td>
<td>This field displays the version number of the training. As of the May '18 release, it is not possible to reversion playlists or external content, so for these two training types, the Training Version value always defaults to 1.</td>
</tr>
<tr>
<td>User Training Availability</td>
<td>Text</td>
<td>This field displays the user availability criteria that is configured for the training. The value is obtained from the Criteria column in the Availability section of the Course Console or Course Catalog when &quot;Users&quot; has been selected from the Select Criteria drop-down. <strong>Note:</strong> This field only applies to individual users who are added to the Availability section; it does not apply to organizational unit (OU) criteria that may be defined in the Availability section. To include OU availability criteria data, you must include the OU Training Availability fields in the report.</td>
</tr>
</tbody>
</table>

**Considerations**

It is **NOT** yet possible to report on the following:

- Approval workflows for external content
- Preferences for external content
Insights Home - Favorites

With this enhancement, you can now tag your favorite Insights and access them from a new Favorites section right at the top of the Insights homepage.

Prior to this enhancement, users had to scroll down the homepage to find the Insights they wanted to use. Now, you can access all your favorites without any scrolling.

Add and Manage Favorites

To add and manage favorites:

1. Click the plus icon at the top of the Insights homepage. This opens the Browse tab on the Manage Favorites flyout.
2. Select the box next to each Insight you want to favorite. There is no limit to the number of favorites.
3. Deselect a box to remove the Insight as a favorite.
4. Click SAVE.

Your favorites will appear at the top of the Insights homepage. When an Insight is a favorite, it no longer appears in its default location on the homepage.

To view your list of favorites, click the Favorites tab in the Manage Favorites flyout.

Implementation

This enhancement is available for portals with Insights enabled. To enable this functionality, contact Global Product Support.
Security

The following existing permission applies to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insights Dashboard</td>
<td>Allows user to access Insights Dashboard. This permission cannot be constrained.</td>
<td>Core</td>
</tr>
</tbody>
</table>
Learning Playlists
Learning Playlists - Overview

In March 2018, Learning Playlist functionality was released as part of an Early Adopter program.

With the May 2018 release, Learning Playlist functionality has been enhanced in the following ways:

- External content can be added to learning playlists (See External Content - Overview on page 303 for additional information.)
- Data related to playlists is discoverable in reporting
- Email digest options are available for playlists
- Deep linking functionality can be used to share playlists
- Information about the playlists a user has created and followed displays on the Learner Home page

Click here to access the Learning Playlists Starter Guide in the Client Success Center.

Click here to access the Learning Playlists Adoption Kit.

Use Cases

Use Case #1: Follow Playlists

Larry is a learner at ACME Corp. He wants to stay up-to-date on a few learning playlists he is interested in. Larry can click the Follow option for a playlist he likes, and it is added to the Following tab on his My Playlists page. Now he can easily find these playlists. Furthermore, his administrator set up a weekly email digest that will notify Larry of all the newest learning content in the playlists that he is following.

Use Case #2: Share Playlists

Larry decides he wants to share one of his favorite playlists with some of his coworkers. He opens the options on the Playlist Details page, copies the link that appears after clicking the Share option, and emails this link to his colleagues. Because this is a deep link, all his coworkers need to do is click the link that Larry sent them to access the playlist in the learning management system.

Implementation

Previously, playlists were available as part of an early adopter program, and it was necessary to self-activate playlists in order to use the functionality. With the May 2018 release, playlists are generally available and activated by default.

For information about playlist functionality as it was released in February 2018, see the following resources:

- Manage Playlists.
- Create Playlists.
- Playlist Details.
## Permissions

The following new permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Content - Create</td>
<td>Grants the ability to create external content. This permission can be constrained by OU or by aspects of the user. When a user creates external content, the availability is determined by the constraints of the permission. This is an end user permission.</td>
<td>Learning</td>
</tr>
<tr>
<td>Custom Playlist Reports - Create</td>
<td>Grants the ability to create and edit custom Playlist reports.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Playlist Report - View</td>
<td>Grants ability to view results of custom Playlist reports created by self or shared by others.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course Catalog - Update</td>
<td>Grants ability to manage/edit learning objects listed in the Course Catalog and also grants access to the Course Console, where LOs can also be managed/edited. This permission also grants access to the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, User, User Self and Subordinates, and User's LO Availability. This is an administrator permission. With the Oct '17 release, this permission allows administrators to reversion online classes via the Course Console page.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Course Catalog - View</td>
<td>Grants access to view the learning objects in the course catalog and enables administrators to view the Course Console and the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission).</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Category</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td><strong>Console - View permission</strong></td>
<td>This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, and User's LO Availability. This is an administrator permission.</td>
<td><strong>Performance - Administration</strong></td>
</tr>
<tr>
<td><strong>Email Digest Administration - Manage</strong></td>
<td>Grants ability to create, edit, view, and delete email digests. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. The permission constraints determine which email digests the administrator can edit and delete. This is an administrator permission.</td>
<td><strong>Performance - Administration</strong></td>
</tr>
<tr>
<td><strong>Email Digest Administration - View</strong></td>
<td>Grants ability to view email digests. This permission cannot be constrained. This is an administrator permission.</td>
<td><strong>Performance - Administration</strong></td>
</tr>
<tr>
<td><strong>Playlist Preferences</strong></td>
<td>Grants access to the Learning Playlist Preferences, where administrators can configure settings for the Playlist feature.</td>
<td><strong>Learning - Administration</strong></td>
</tr>
<tr>
<td><strong>Playlists - Create</strong></td>
<td>Grants ability to create private Learning Playlists. This permission cannot be constrained. This is an end user permission.</td>
<td><strong>Learning - Administration</strong></td>
</tr>
<tr>
<td><strong>Playlists - Make Visible</strong></td>
<td>Grants the playlist creator the ability to make their playlists visible to others. This permission can be constrained by OU, User's OU, User's Direct Reports, User, and User Self and Subordinates. If this permission is constrained, then only users within the constraints can see the playlist. If this permission is not constrained, all users in the portal can see the Playlist. This is an end user permission. If this permission is added to a standard security role (Approver, Cost Center Approver, Instructor, Manager, etc.), the constraints of the role are applied to the permission. The users included in the constraints of the role are also the users who can view the playlists made visible by a user with the Playlists - Make Visible permission. If this is not the desired result, add this permission to a non-standard security role to ensure the constraints appropriately.</td>
<td><strong>Learning - Administration</strong></td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Permission</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Playlists - View</td>
<td>Grants ability to view Learning Playlists within user’s availability. Select Playlist features will become visible to users with this permission. This permission cannot be constrained. This is an end user permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Learning Features Self Activation</td>
<td>Grants access to the Feature Activation Preferences page, where an administrator can activate new features associated with Learning, Connect and Extended Enterprise.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Learner Home</td>
<td>Grants access to the Learner Home and the Learning Search page. This is an end user permission. This permission cannot be constrained.</td>
<td>Learning</td>
</tr>
</tbody>
</table>
Learning Playlists - Playlist Preferences

Prior to this enhancement, it was only possible to configure creator information via the Playlist Preferences page. With this enhancement, administrators can configure the following using Playlist Preferences:

- Creator Information
- Follower Information
- External Content

To access the Playlist Preferences page, go to: ADMIN > TOOLS > LEARNING > LEARNING PREFERENCES and click the Playlist Preferences link.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Playlist Preferences</td>
<td>Grants access to the Learning Playlist Preferences, where administrators can configure settings for the Playlist feature.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>

Playlists Preferences: Techwriter

Creator Information

Enable/disable displaying information about the creator of the Playlist. When enabled, the bio section and creator's image next to their annotation will display. The creator's image, first and last name will also display on Playlist tiles.

- Display creator information.

Follower Information

Enable/disable displaying information about the followers of the Playlist. When enabled, the followers section containing the profile images of the playlist's followers will display. This section appears on the playlist details page.

- Display follower information.

External Content

If enabled, the duration fields will be shown and the user-submitted value will be saved as training hours. If disabled, the duration fields will be hidden and no value will be saved for training hours.

- Display duration fields.

- Overwrite custom settings for all child Divisions

To apply new options, you must reset all of the subordinate Divisions' preferences. If this is not checked, the preferences for child Divisions that were set in the past will remain the same.
**Creator Information**

In the Creator Information section of the Playlist Preferences page, administrators can use the **Display creator information** toggle switch to enable or disable the display of creator information on playlists. To allow the playlist creator's image and biography summary to display with their playlists, leave the switch in the On (green) position. To prevent the playlist creator's image and biography summary from displaying with their playlists, toggle the switch to the Off (gray) position.

**Follower Information**

The **Display Follower Information** setting determines whether or not follower information displays on the Playlist Details page of a playlist. Information included about followers includes the followers' names, profile photos, and positions. To allow follower information to display on the Playlist Details page for playlists, leave the **Display Follower Information** switch toggled to the On position. To prevent follower information from displaying, toggle the switch to the Off position. **Note:** The number of followers displays on the Playlist Details page and playlist tiles regardless of this preference setting. See Playlist Details Page on page 344 for additional information.

**External Content**

External content can be added to playlists. Using the **Enable Duration Fields** setting, external content can be accompanied by **Duration** fields, which playlist creators can use to indicate the duration time of the external content. To allow creators to populate the duration for external content they have added to playlists, leave the **Enable Duration Fields** switch toggled to the On position. To hide the **Duration** fields for external content, toggle this switch to the Off position. See External Content - Overview on page 303 for additional information.

**Overwrite Settings**

Choose whether or not to overwrite custom settings for child division OUs. If you choose to overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.

If this option is unselected, then only the child OUs that do not have customized settings will be updated, as well as any OUs that are added in the future.

A child OU that has not been customized always inherits from the parent, regardless of whether this option is selected.

An OU is considered customized if its preferences or settings have been changed.

**Save**

Click the **SAVE** button at the bottom of the page to save any changes you have made to Playlist Preferences.
Learning Playlists - External Content

With the May 2018 release, a new External Content training type can be created and included in playlists. External content allows playlist creators to add training to their playlists even if the training is published outside the learning management system (LMS). Creators can add links to videos, books, external online courses, and more. See External Content - Overview on page 303 for additional information.
Learning Playlists - Social Sharing

With this enhancement, users can share links to playlists, follow their favorite playlists, and receive emails detailing updates to their followed playlists.

Users can follow and share playlists via the Playlist Details page. To access the Playlist Details page for a playlist, find the playlist via Learner Home, Learning Search, or the My Playlists page and click the title of the playlist. To access your own My Playlists page, go to LEARNING > MY PLAYLISTS.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Playlists - Create</td>
<td>Grants ability to create private Learning Playlists. This permission cannot be constrained. This is an end user permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Playlists - View</td>
<td>Grants ability to view Learning Playlists within user’s availability. Select Playlist features will become visible to users with this permission. This permission cannot be constrained. This is an end user permission.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>

Share Playlist

From the Playlist Details page for a playlist, learners can obtain a deep link which can be used to provide other learners with direct access to the playlist. To get a deep link for a playlist:

1. Navigate to the Playlist Details page for the playlist.
2. Click the "..." icon in the upper-right corner of the Playlist Details page. An Options menu expands.
3. Click the Share option. This opens the Share This Playlist pop-up window, where a deep link to the playlist is provided in a text box.
4. Either click the CLICK TO COPY button or manually copy the link, and use the link to share the playlist with other users (i.e. via email, using a button, etc.). You can close the pop-up window by clicking the Close icon in the upper-right corner of the window.

When the link is used, the user will be navigated to the playlist in the learning management system (LMS). **Note:** Sharing functionality for playlists leverages existing Deep Linking functionality. In order for playlist sharing links to function correctly, your organization must ensure that the portals Deep Link base URLs are correctly configured. If your playlists are not generating functional links, ensure the Base URLs you have configured for Deep Links are correct. For more information about configuring Deep Links, see [Deep Link Management](#).

![Share This Playlist](image)

**Follow Playlist**

Learners can follow playlists in order to be notified when updates are made to those playlists. The followed playlists are also added to the Following tab on the user's My Playlists page. The Follow option is available in the bottom right corner of playlist tiles when they display in the following system areas:

- Learner Home
- Learning Search
- My Playlists
To follow a playlist from the Learner Home or the Learning Search pages, click the **Follow** link in the playlist tile. To follow a playlist from the Playlist Details page, click the **FOLLOW** button in the upper-right corner of the Playlist Details page.

The playlist is added to the Following tab on the user’s My Playlists page. If more than 24 playlists have been added to a user’s Following tab, the Following tab paginates with up to 24 playlist tiles per page.

If configured, when items are added to a playlist a user is following, the user can receive an email digest notifying them of the addition. See **Email Digest Management - Playlist Item Added** on page 346 for additional information.
Number of Followers
The number of followers who have followed each playlist displays below the playlist title when the playlist displays on Learner Home, Learning Search, and the My Playlists page.

Unfollow
If a user is already following a playlist, an **UNFOLLOW** button is available in the upper-right corner of the Playlist Details page for the playlist. Click the **UNFOLLOW** button to remove the playlist from your Following tab and stop receiving email notifications for the playlist. After unfollowing a playlist, the **Follow** option reappears.
Users can also unfollow playlists from the Learner Home page and the Learning Search page. If the user finds a playlist they have already followed, an **Unfollow** link appears on the playlist’s tile on Learner Home and Learning Search. Click the **Unfollow** option to remove the playlist from your Following tab and stop receiving email notifications for the playlist. After unfollowing a playlist, the **Follow** option appears on the playlist’s tile.

**Search the Catalog**

If a user has not yet followed any playlists, when they navigate to the Followed tab of the My Playlists page, the statement, "You're not following any playlists!" appears, along with a **SEARCH THE CATALOG** button. Click the **SEARCH THE CATALOG** button to be navigated to the Learning Search page, where search results will be pre-filtered to only display playlists. You can browse the playlists and add them to the Following tab, if desired.
My Playlists on Learner Home

Information about the playlists a user has created and followed display in the Your Playlists section on the Learner Home page. This section also provides access to various learning playlist pages in the system.

To access the Learner Home page, go to: LEARNING > LEARNER HOME.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learner Home</td>
<td>Grants access to the Learner Home and the Learning Search page. This is an end user permission. This permission cannot be constrained.</td>
<td>Learning</td>
</tr>
<tr>
<td>Playlists - Create</td>
<td>Grants ability to create private Learning Playlists. This permission cannot be constrained. This is an end user permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Playlists - View</td>
<td>Grants ability to view Learning Playlists within user's availability. Select Playlist features will become visible to users with this permission. This permission cannot be constrained. This is an end user permission.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>
Your Playlists

Users with permission to view playlists can view the number of followers their playlists have and the number of playlists they are following from the Learner Home page. In the Your Playlists section on the left side of the Learner Home page, the following fields display:

- **Created** - This field displays the number of playlists the user has created. Click the number to be navigated to the My Playlists page, where you can access the playlists you have created.

- **Followers** - This field displays the total number of followers that are currently following the user’s playlists. Click the number to be navigated to the My Playlists page, where you can access the playlists you have created.

- **Followed** - This field displays the total number of playlists that the user is following. Click the number to be navigated to the Following tab of the My Playlists page, where you can view all the playlists you are following.

- **Create New Playlist** - Click this link to begin creating a new playlist. You will be navigated to the Playlist Details page for a new playlist. **Note:** If the user does not have permission to create playlists, this link does not display. See Create Playlists for more information.
Playlist Details Page

With this enhancement, the top of the Playlist Details page displays more information about the playlist and users' interactions with it.

To access the Playlist Details page, click on the title of the playlist from the Learner Home, Learning Search, or the My Playlists page.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Playlists - Create</td>
<td>Grants ability to create private Learning Playlists. This permission cannot be constrained. This is an end user permission.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Playlists - Make Visible</td>
<td>Grants the playlist creator the ability to make their playlists visible to others. This permission can be constrained by OU, User's OU, User's Direct Reports, User, and User Self and Subordinates. If this permission is constrained, then only users within the constraints can see the playlist. If this permission is not constrained, all users in the portal can see the Playlist. This is an end user permission. If this permission is added to a standard security role (Approver, Cost Center Approver, Instructor, Manager, etc.), the constraints of the role are applied to the permission. The users included in the constraints of the role are also the users who can view the playlists made visible by a user with the Playlists - Make Visible permission. If this is not the desired result, add this permission to a non-standard security role to ensure the constraints appropriately limit access to playlists.</td>
<td>Learning - Administration</td>
</tr>
<tr>
<td>Playlists - View</td>
<td>Grants ability to view Learning Playlists within user's availability. Select Playlist features will become visible to users with this permission. This permission cannot be constrained. This is an end user permission.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>
Playlist Information
The information bar located below the banner of the Playlist Details page displays the following information:

- **Privacy Switch** - This toggle switch allows users with the appropriate permission to specify whether or not the playlist can be accessed by other system users. When the switch is toggled to the Private setting, the playlist cannot be accessed by other users in the system, and only the playlist creator can access the playlist. When the switch is toggled to the Public setting, the playlist is visible to other system users, according to the constraints of the permission. This switch is only visible to the creator of the playlist, and is only available if they have the permission to make playlists visible.

- **Items** - This field displays the total number of training items contained within the playlist. All training items added to the playlist are included in this figure, including items that are active, inactive, available, and unavailable.

- **Playlist Followers** - This field displays the total number of users who are following the playlist.

- **View all followers** - If the playlist has one or more followers, the View all followers link displays below the number of followers. Click the View all followers link to open a flyout with the names, profile photos, and positions of all users who are currently following the playlist. The total number of followers appears at the top of the flyout, and all followers appear in alphabetical order. Clicking the name or photo of a user opens the user's Universal Profile - Bio page in a separate window. If the playlist has more than ten followers, the flyout paginates with up to ten followers per page. Click the CLOSE button at the bottom of the flyout to close the flyout. **Note: The View all followers link does not display if Follower Information has been disabled via Playlist Preferences.**

- **Last Updated** - This field displays the last date the playlist was modified.
Email Digest Management - Playlist Item Added

With the May '18 release, users can follow playlists and be notified when the playlist is updated with new content. Users are notified of updates to followed playlists by an email digest, if configured, which can now include a Playlist Item Added section. **Note:** The Playlist Item Added email digest section notifies users when items are added to a playlist, but it does NOT notify users when items are removed from a playlist.

If a user is following at least one playlist which is updated with new content, when an email digest containing a Playlist Item Added section is deployed, the user receives an email with information about the updated playlist, as configured by an administrator. Administrators can create a Playlist Item Added section within an email digest and create an email body using playlist-specific tags, which helps provide users with relevant information about their followed playlists.

To create an email digest which can notify users of updates to their followed playlists, go to **ADMIN > TOOLS > CORE FUNCTIONS > EMAIL DIGEST MANAGEMENT**. Click the **CREATE EMAIL DIGEST** button to create a new email digest, or click the **Edit** option for an existing playlist to simply add a Playlist Item Added section to that playlist.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Digest Administration - Manage</td>
<td>Grants ability to create, edit, view, and delete email digests. This permission can be constrained by OU, User’s OU, User Self and Subordinates, and User. The permission constraints determine which email digests the administrator can edit and delete. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
<tr>
<td>Email Digest Administration - View</td>
<td>Grants ability to view email digests. This permission cannot be constrained. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
</tbody>
</table>
Add Section

To configure the Playlist Item Added section for an email digest:

1. Click the **ADD SECTION** button at the bottom of the Create Email Digest page. This opens the Add Section pop-up window.

2. Click the name of the Playlist Item Added section type. The section will be added to the email digest, and you will need to provide more information.

3. Configure the following fields for the section:
   
   - **Section Name** - Enter the name of the email digest section, up to 100 characters. The name defaults to “Playlist Item Added.”
   - **Send To** - Select to whom the email digest section should be sent. This field is required. You can either send the email digest section to specific users or to playlist followers, using the Select Relation drop-down menu. Click the **ADD** button after selecting the appropriate user or relation:
     
     - To select a specific user, either enter the user’s name in the field or click the Select icon to select a user from the system. See Select User Pop-up for additional information.
     
     - To select a relation, select the appropriate relation from the drop-down menu. The type of section determines which relations are available.
   - **Body** - To edit the body of the email section, click the **EDIT BODY** button. This opens the Edit Section pop-up. The text included in the body of the email is what will be send to users specified in the Send To section when a new item is added to a playlist. You can use tags to provide relevant information about the playlists which
have been updated to the email. *See Email Digest - Edit Section Body for additional information.*

4. After you are finished configuring the email digest, click the **SAVE** button at the bottom of the page.

**Note:** *Up to 250 items per user may display in the Playlist Item Added section of an email digest. Items are primarily sorted by date (most recent to least recent) and secondarily in alphabetical order according to playlist title.*

For more information about creating an email digest: *See Email Digest - Create/Edit.*

---

### Playlist Item Added Tags

The following new tags are available when configuring the body of the Playlist Item Added section in an email digest:

<table>
<thead>
<tr>
<th>TAG NAME</th>
<th>TAG DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>{LIST.BEGIN}</td>
<td>This tag is used to begin a custom formatted activity list. Tags, text, and formatting that are between the LIST.BEGIN and LIST.END tags will be repeated to create an activity list.</td>
</tr>
<tr>
<td>{LIST.END}</td>
<td>This tag is used to end a custom formatted activity list. Tags, text and formatting that are between the LIST.BEGIN and LIST.END tags will be repeated to create an activity list.</td>
</tr>
<tr>
<td>{RECIPIENT.FIRST.NAME}</td>
<td>This tag can be used to add the email recipient's first name to the email body.</td>
</tr>
<tr>
<td>{RECIPIENT.LAST.NAME}</td>
<td>This tag can be used to add the email recipient's last name to the email body.</td>
</tr>
<tr>
<td>{PLAYLIST.TITLE}</td>
<td>This tag is used to add the name of the updated playlist to the email body.</td>
</tr>
<tr>
<td>TAG NAME</td>
<td>TAG DESCRIPTION</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>{PLAYLIST.DESCRIPTION}</code></td>
<td>This tag is used to add the description of the updated playlist to the email body.</td>
</tr>
<tr>
<td><code>{PLAYLIST.ITEM.ADD.DATE}</code></td>
<td>This tag adds the date the new training item was added to the updated playlist.</td>
</tr>
<tr>
<td><code>{PLAYLIST.ITEM.TITLE}</code></td>
<td>This tag adds the title of the new training item that was added to the updated playlist.</td>
</tr>
<tr>
<td><code>{PLAYLIST.ITEM.DESCRIPTION}</code></td>
<td>This tag adds the description of the new training item that was added to the updated playlist.</td>
</tr>
<tr>
<td><code>{PLAYLIST.ITEM.ANNOTATION}</code></td>
<td>This tag adds the annotation the playlist creator provided for the new training item that was added to the updated playlist.</td>
</tr>
<tr>
<td><code>{PLAYLIST.ITEM.TYPE}</code></td>
<td>This tag adds the training type of the new training item that was added to the updated playlist (i.e. online class, material, video, etc.).</td>
</tr>
<tr>
<td><code>{PLAYLIST.ITEM.LINK}</code></td>
<td>This tag adds a direct link to the Training Details page of the item that was added to the playlist.</td>
</tr>
<tr>
<td><code>{PLAYLIST.CREATOR.FIRST.NAME}</code></td>
<td>This tag adds the first name of the creator of the updated playlist to the body of the email.</td>
</tr>
<tr>
<td><code>{PLAYLIST.CREATOR.LAST.NAME}</code></td>
<td>This tag adds the last name of the creator of the updated playlist to the body of the email.</td>
</tr>
<tr>
<td><code>{PLAYLIST.LINK}</code></td>
<td>This tag adds a direct link to the Playlist Details page of the updated playlist.</td>
</tr>
</tbody>
</table>
Playlist Reporting

With this enhancement, it is possible to report on certain learning playlist and external content information using reporting functionality. There is a new Playlist report type, and some existing training fields may be used to report on playlists and external content.

To create a Playlist custom report, go to REPORTS > CUSTOM REPORTS and click the NEW button. Select Playlist Report from the drop-down menu.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Playlist Reports - Create</td>
<td>Grants the ability to create and edit custom Playlist reports.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Playlist Report - View</td>
<td>Grants ability to view results of custom Playlist reports created by self or shared by others.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Training Reports - Create</td>
<td>Grants ability to create and edit Custom Training (Catalog) reports. This permission can be constrained by Provider. <strong>Note:</strong> When the constraint is set for the permission, users will only be able to view training data for the constrained providers.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Training Reports - View</td>
<td>Grants ability to view results of Custom Training (Catalog) reports created by self or shared by others. This permission can be constrained by Provider. <strong>Note:</strong> When the constraint is set for the permission, users will only be able to view training data for the constrained providers.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>

Playlist Report

A new Playlist custom report type is available, which contains a new Playlist field section. In addition to the Playlist field section, the Playlist report type also includes the existing Training and User report field sections. See the chart below for the fields contained within the Playlist section:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By (Name)</td>
<td>Text</td>
<td>This is the full name of the user who created the playlist.</td>
</tr>
<tr>
<td>(Playlist)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Created By</td>
<td>Text</td>
<td>This is the user ID of the user who created the playlist.</td>
</tr>
<tr>
<td>FIELD NAME</td>
<td>FIELD TYPE</td>
<td>FIELD DESCRIPTION</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>(User ID) (Playlist)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyword (Playlist)</td>
<td>Text</td>
<td>This field shows the keywords associated with the training item. All keywords are listed in the same cell separated by a comma.</td>
</tr>
<tr>
<td>Language (Playlist)</td>
<td>Text</td>
<td>This is the language in which the playlist was created.</td>
</tr>
<tr>
<td>Last Modified By (Playlist)</td>
<td>Text</td>
<td>This is the full name of the user who last modified the playlist.</td>
</tr>
<tr>
<td>Last Modified By (User ID)</td>
<td>Text</td>
<td>This is the user ID of the user who last modified the playlist.</td>
</tr>
<tr>
<td>Last Modified Date (Playlist)</td>
<td>Date</td>
<td>This is the date on which the playlist was last modified.</td>
</tr>
<tr>
<td>Private Status (Playlist)</td>
<td>Yes/No</td>
<td>Playlists can be created as either private or public. This field indicates whether or not the playlist is private.</td>
</tr>
<tr>
<td>Training Active (Playlist)</td>
<td>Yes/No</td>
<td>This field specifies whether or not the playlist is currently active in the system (for example, if a curator leaves the organization, an administrator may decide to deactivate the curator’s playlists in the system).</td>
</tr>
<tr>
<td>Training Annotation (in Playlist)</td>
<td>Text</td>
<td>When creating a playlist, the playlist creator can add an annotation to each training item added to the playlist. This is the annotation provided for a training item within a playlist. This field is limited to 300 characters.</td>
</tr>
<tr>
<td>Training Creation Date (Playlist)</td>
<td>Date</td>
<td>This is the date on which the playlist was originally created.</td>
</tr>
<tr>
<td>Training Date/Time Added (in Playlist)</td>
<td>Date/Time</td>
<td>This is the date that the training was added to the Playlist.</td>
</tr>
<tr>
<td>Training Date/Time Modified (in Playlist)</td>
<td>Date/Time</td>
<td>This is the date that the training was re-ordered or a comment was edited</td>
</tr>
<tr>
<td>Training Text</td>
<td>Text</td>
<td>This is the description that was provided by the training creators.</td>
</tr>
</tbody>
</table>
### Description (Playlist)
- **FIELD TYPE**: Text
- **FIELD DESCRIPTION**: Playlist creator when the playlist was created. This field is limited to 4000 characters.

### Training ID (Playlist)
- **FIELD TYPE**: Text
- **FIELD DESCRIPTION**: Unique training IDs are automatically generated for training items on the backend. This field is the training ID generated for a playlist.

### Training Object ID (Playlist)
- **FIELD TYPE**: Text
- **FIELD DESCRIPTION**:  
  - The unique, system generated learning object ID that is created for all learning objects.  
  - This object ID is used to identify learning objects for historical data loads of transcript information.

### Training Order (in Playlist)
- **FIELD TYPE**: Numeric
- **FIELD DESCRIPTION**: Items within a playlist are sequentially ordered. This field indicates the order number of a training item within the playlist.

### Training Status (Playlist)
- **FIELD TYPE**: Text
- **FIELD DESCRIPTION**: This field displays the status of the learning object (i.e., Approved, Expired, Tentative, Completed). This field does not display user transcript status for the LO. For the user transcript status, include the Transcript Status field in your report. For a list of training statuses and descriptions, see Transcripts Troubleshooting Guide.

### Training Title (Playlist)
- **FIELD TYPE**: Text
- **FIELD DESCRIPTION**: This is the title of the playlist.

### Training Type (Playlist)
- **FIELD TYPE**: Text
- **FIELD DESCRIPTION**: Does this refer to the playlist itself or to items within the playlist?

---

### Training Report - Training Fields Applicable to Playlists and External Content

The following existing fields included in the Training custom report section can now be used to capture information about learning playlists and external content:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD TYPE</th>
<th>FIELD DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By (Name)</td>
<td>Text</td>
<td>This is the full name of the user who created the playlist or external content.</td>
</tr>
<tr>
<td>Created By (User ID)</td>
<td>Text</td>
<td>This is the user ID of the user who created the playlist or external content.</td>
</tr>
<tr>
<td>Language</td>
<td>Text</td>
<td>This is the language in which the playlist or external content was created.</td>
</tr>
<tr>
<td>Last Modified By</td>
<td>Text</td>
<td>This is the full name of the user who last modified the playlist or external content.</td>
</tr>
<tr>
<td>FIELD NAME</td>
<td>FIELD TYPE</td>
<td>FIELD DESCRIPTION</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Last Modified By (User ID)</td>
<td>Text</td>
<td>This is the user ID of the user who last modified the playlist or external content.</td>
</tr>
<tr>
<td>Last Modified Date</td>
<td>Date</td>
<td>This is the date on which the playlist or external content was last modified.</td>
</tr>
<tr>
<td>Training Active</td>
<td>Yes/No</td>
<td>This field indicates whether the learning object (LO) is active or inactive. The report displays &quot;Y&quot; for active and &quot;N&quot; for inactive. The value is pulled from the Active field for the LO.</td>
</tr>
<tr>
<td>Training Hours</td>
<td>Numeric</td>
<td>This is the number of training hours users can learn by completing the playlist or external content.</td>
</tr>
<tr>
<td>Training ID</td>
<td>Text</td>
<td>An ID is automatically generated for training on the backend. This field reports on the IDs of training items.</td>
</tr>
<tr>
<td>Training Status</td>
<td>Text</td>
<td>This field displays the status of the learning object (i.e., Approved, Expired, Tentative, Completed). This field does not display user transcript status for the LO. For the user transcript status, include the Transcript Status field in your report. For a list of training statuses and descriptions, see Transcripts Troubleshooting Guide.</td>
</tr>
<tr>
<td>Training Title</td>
<td>Text</td>
<td>This is the title of the playlist or external content.</td>
</tr>
<tr>
<td>Training Type</td>
<td>Text</td>
<td>This displays the learning object (LO) type of the training (i.e. playlist, external content)</td>
</tr>
<tr>
<td>Training Version</td>
<td>Numeric</td>
<td>This field displays the version number of the training. As of the May ‘18 release, it is not possible to reversion playlists or external content, so for these two training types, the Training Version value always defaults to 1.</td>
</tr>
<tr>
<td>User Training Availability</td>
<td>Text</td>
<td>This field displays the user availability criteria that is configured for the training. The value is obtained from the Criteria column in the Availability section of the Course Console or Course Catalog when &quot;Users&quot; has been selected from the Select Criteria drop-down. Note: This field only applies to individual users who are added to the Availability section; it does not apply to organizational unit (OU) criteria that may be defined in the Availability section. To include OU availability criteria data, you must include the OU Training Availability fields in the report.</td>
</tr>
</tbody>
</table>
Training Removal Tool Enhancements
Training Removal Tool Enhancements - Overview

With these Training Removal Tool enhancements, the Training Removal Tool uses consistent behaviors for removing event and session learning objects (LOs) from users’ transcripts, and payment refund logic has been redesigned to facilitate an intuitive, simple Training Removal Tool experience.

Implementation

This functionality is automatically enabled for all portals using the Learning module.

Permissions

The following existing permission applies to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bulk Training Removal - Manage</td>
<td>Grants ability to bulk remove training from users’ transcripts. This permission can be constrained by OU and User's OU. Creator constraints also apply. This is an administrator permission.</td>
<td>Learning - Administration</td>
</tr>
</tbody>
</table>
Training Removal Tool - Remove Events and Sessions

With this enhancement, the Training Removal Tool, the manual removal process, and dynamic removal behave in the following ways when removing instructor-led training (ILT) events and sessions from users' transcripts:

- The Training Removal Tool can only remove an event from a user's transcript if there are currently no active sessions of the event on the user's transcript. If the administrator wants to remove an event from a user's transcript, but a session for the event is active on the user's transcript, the administrator must first remove the session before they are able to remove the event using the Training Removal Tool. This behavior also applies to events removed manually and via dynamic removal.
  
  **Example:** Mary attempts to remove an event called Customer Service 101 from a user's transcript, because the user no longer needs to attend that training, which is occurring in one week. However, because the session the user signed up for is still active on their transcript, Mary is not able to remove the event learning object (LO). She must first remove the scheduled session from the user's transcript, and then she can remove the event.

- When an administrator removes a curriculum containing events and sessions from a user's transcript, the system removes the sessions from the user's transcript before also removing the events.
  
  **Example:** Mary is removing a curriculum which contains an event from a user's transcript. When the training removal job processes, any sessions of this event are removed from the user's transcript before the event itself is removed from the transcript. By the time the job finishes processing, both the event and any related sessions are removed from the user's transcript.

- It is now possible to remove sessions from users' transcripts without also removing the associated event (previously, if a session was removed, the associated event was also removed).
  
  **Example:** Mary wants to remove a specific session from a user's transcript, but NOT the event the session is associated with. When she runs a training removal job to remove the session, the event automatically remains on the user's transcript.
Training Removal Tool Enhancements - FAQ

See below for some common questions and answers related to this enhancement:

Q: Is it possible to remove an event AND its session from a user’s transcript at the same time?

A: Only if the event and session are contained within the same curriculum. If the event or session are part of other curricula, or are standalone items on the user’s transcript, the session and event must be removed separately, and the session must be removed before the event is removed.

Q: If you remove a session, is the associated event also removed?

A: No, UNLESS the session and event are contained in the same curriculum (see the question above). Otherwise, the session and event must be removed separately, and the session must be removed before the event is removed.

Q: Why can’t I remove an event from a user’s transcript?

A: If the event has active sessions, and the session is also on the user’s transcript, it cannot be removed. You will need to first remove the session before you are allowed to remove the event.
Performance
Custom Reports - Development Plan Fields

When Development Plans are created using the redesigned Development Plans, additional custom reporting fields are now available for development plans.

The following fields are now available in the Dev Plan section when creating a custom Development Plan Report or a Multi-Module Report:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>TYPE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dev Plan Created by Full Name</td>
<td>Text</td>
<td>This field displays the full name of the user who created the development plan. This field can be used to display data for development plans created using either the legacy or redesigned Development Plans functionality.</td>
</tr>
<tr>
<td>Dev Plan Created by User ID</td>
<td>Text</td>
<td>This field displays the User ID of the user who created the development plan. This field can be used to display data for development plans created using either the legacy or redesigned Development Plans functionality.</td>
</tr>
<tr>
<td>Dev Plan Template External ID</td>
<td>Text</td>
<td>This field displays the template from which a development plan was created. This value does not change if the template is updated. This field is empty if a plan was not created using a template. This field only displays data for development plans created using the redesigned Development Plans functionality. This value is pulled from the Template Management page.</td>
</tr>
<tr>
<td>Dev Plan Template Title at Plan Creation</td>
<td>Text</td>
<td>This field displays the title of the template from which a development plan was created at the time the plan was created. This field is empty if a plan was not created using a template. This field only displays data for development plans created using the redesigned Development Plans functionality. This value is pulled from the version of the template, which is not accessible in the system.</td>
</tr>
</tbody>
</table>

Implementation

This functionality is automatically enabled for all organizations using the redesigned Development Plans functionality.

Security

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>Grants ability to create and edit custom reports</td>
<td>Reports -</td>
</tr>
<tr>
<td>Development Plan Report - Create</td>
<td>Development Plan reports. This permission can be constrained by OU, User’s OU, User Self and Subordinates, User, and User’s Direct Subordinates.</td>
<td>Analytics</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Custom Development Plan Report - View</td>
<td>Grants ability to view results of custom Development Plan reports created by self or shared by others. This permission can be constrained by OU, User’s OU, User Self and Subordinates, User, and User’s Direct Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Multi-Module Report - Create</td>
<td>Grants ability to create and edit custom Multi-Module reports. This permission works in conjunction with other Custom Report - Create permissions. This permission can be constrained by OU, User’s OU, User Self and Subordinates, User’s Direct Subordinates, and User.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Multi-Module Report - View</td>
<td>Grants ability to view results of custom Multi-Module reports created by self. This permission works in conjunction with other Custom Report - View permissions. This permission can be constrained by OU, User’s OU, User Self and Subordinates, User’s Direct Subordinates, and User.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>
Development Plans Redesign (Early Adopter)
Development Plans Redesign (Early Adopter)

With this Early Adopter feature, the Development Plan Experience is redesigned to focus on providing the essential functionality with a modern, responsive user interface (UI), while improving the infrastructure for faster performance. Development plans are now easier to use, with reduced time and effort to build and manage plans. The responsive design accommodates users on any platform.

Machine learning is now integrated into the functionality to provide recommended learning to users as they create their development plan. In addition, attachments can now be added to plans.

Considerations

- Standard Reports are not available with this release.
- Modification History is not currently available for development plans. Prior to the August release, development plan modification history is not migrated and will be unrecoverable. If maintaining legacy modification history is important to your organization, it is recommended to wait until the August release to enable this functionality.
- The legacy MyTeam functionality is not supported with this functionality.
- Drafts and cancelled plans can no longer be used as a primary plan. In cases where a draft or cancelled plan was previously the primary plan, the most recently created plan that is not completed or cancelled becomes the primary plan.
- Due dates are now required for development plans. As a result, any existing plan that previously did not have a due date will have their due date set to the latest possible due date.
- Attachments can only be added to an assigned development plan. Attachments cannot be added to a draft or a plan template. Also, attachments cannot be added to a Completed plan.
- When configuring Development Plan Preferences, the Page Instructions field is enhanced to allow administrators to provide formatting options. This field no longer accepts HTML code. Any existing HTML code is migrated as plain text, which can be removed by administrators and reapplied using the formatting options.
- When configuring Development Plan Preferences, administrators can not include recommended training from past development plans or competency models. The option to include recommendations from competency models will be added in a future release. The option to include recommendations from past development plans is not currently planned.

Implementation

This functionality can be self-activated from the Corporate Preferences page. Once enabled, existing development plans are migrated to the new format. Development plan instructions are migrated as plain text even if they previously contained HTML.
This functionality is available to organizations using the Performance module. The Learning features within this functionality are only available to organizations using the Learning module.

The new Recommended Learning - View Recommended Learning for Others permission is controlled by a backend setting, which is disabled by default.

### Security

The following new permission is available with this enhancement:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended Learning - View Recommended Learning for Others</td>
<td>Grants ability to view the recommended learning that is generated by machine learning for another user. The availability of this permission is controlled by a backend setting. This permission can be constrained by OU. This is a manager permission.</td>
<td>Performance</td>
</tr>
</tbody>
</table>

The following permissions are updated with this enhancement:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plans - Manage</td>
<td>Grants ability to create, edit and manage development plans for self (and others depending on role and permissions). This is an end user permission. For organizations using the Redesigned Development Plans functionality, the Snapshot - Development Plans permission enables user to create, edit, and manage development plans. However, users must also have the &quot;Development Plans - Manage&quot; permission to create a development plan.</td>
<td>Performance</td>
</tr>
<tr>
<td>MyTeam Development Plans</td>
<td>Grants ability for manager (or others depending on constraints) to view and manage progress of development plans via MyTeam and Talent Profile. Managers can also edit a subordinate's development plan. This permission can be constrained by OU, User's OU, User's Direct Reports, User, and User Self and Subordinates. The permission constraints determine for which users the Dev Plans tab is available when viewing a</td>
<td>Performance</td>
</tr>
</tbody>
</table>
user in My Team. **Note:** By design, for any My Team permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role. **Note:** If the user's permission is also constrained by User Self and Subordinates, then this overrides the User's Direct Reports constraint.

For organizations using the Redesigned Development Plans functionality, this permission enables the user to access the Development Plans List page.

| Snapshot - Development Plans | Enables user to view the Development Plans widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. **Best Practice:** For most users, this permission should be constrained by User Self and Subordinates. For organizations using the Redesigned Development Plans functionality, this permission also grants the ability to create, edit, and manage development plans. In order to create a development plan, users must also have the Development Plans - Manage permission. | Universal Profile |

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign OU Development Plans</td>
<td>Grants ability to create and assign Development Plans to all users within specified organizational units or custom groups. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
<tr>
<td>Corporate Preferences - Manage</td>
<td>Grants ability to manage Corporate Preferences, which includes several portal-wide settings. This is an administrator permission.</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Development Plan Activity Types - Manage</td>
<td>Grants ability to create and edit activity types used in the development plans and templates. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Development Plan Objective Categories - Manage</td>
<td>Grants ability to create and edit objective categories used in the development plans and templates.</td>
<td>Performance - Administration</td>
</tr>
<tr>
<td>Development Plan Preferences - Manage</td>
<td>Grants ability to manage Development Plan Preferences, where various Development Plan features can be enabled or disabled according to the needs of the organization. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
<tr>
<td>Development Plan Templates - Manage</td>
<td>Grants ability to create and edit development plan templates that can be made available for use by end users. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
<tr>
<td>Development Plans - Approve</td>
<td>Grants ability to approve or deny development plans that are pending the user's approval. This is a manager/approver permission.</td>
<td>Performance</td>
</tr>
</tbody>
</table>
Corporate Preferences - Redesigned Development Plans Enablement

Organizations may choose to enable the Redesigned Development Plans functionality at any time via Corporate Preferences.

To manage Corporate Preferences, go to ADMIN > TOOLS > CORE FUNCTIONS > CORE PREFERENCES > CORPORATE PREFERENCES.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate Preferences - Manage</td>
<td>Grants ability to manage Corporate Preferences, which includes several portal-wide settings. This is an administrator permission.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>

Redesigned Development Plans Enablement

This section enables administrators to enable the redesign of development plans. This applies to all new and existing development plans.

Select the ACCEPT AND ENABLE button in this section to enable the development plans redesign.

This action cannot be undone. When this button is selected, the page is refreshed, and this section is hidden.
Development Plan Preferences

If the Redesigned Development Plans functionality is enabled, the existing Development Plan Preferences page is enhanced with the following new features:

- The appearance and functionality of the page is enhanced. The page is now fully responsive, so it can be effectively viewed on a mobile device.
- The Page Instructions field is enhanced to allow administrators to provide formatting options. This field no longer accepts HTML code. Any existing HTML code is migrated as plain text, which can be removed by administrators and reapplied using the formatting options.
- The character limit for the Page Instructions field is increased from 2,000 to 10,000.
- If the selected approver role changed (e.g., from manager to a custom relationship) and there are existing plans pending approval, the new approver is responsible for approving the plan. If there is no user in the new approver role, then the plan is automatically approved.
- In the User Allowances section, the Permanently delete all comments from development plans option is removed.
- In the Include Recommended Trainings From section, a new Machine Learning option is now available. Also, the previously existing Competency Models and Past Plans options are not available.
- New custom fields are now added by selecting the ADD CUSTOM FIELD button. In addition, custom fields are now added via a flyout.
- New objective categories are now added by selecting the ADD OBJECTIVE CATEGORY button. In addition, objective categories are now added via a flyout.
- New activity types are now added by selecting the ADD ACTIVITY TYPE button. In addition, activity types are now added via a flyout.

To manage Development Plan Preferences, go to ADMIN > TOOLS > PERFORMANCE MANAGEMENT > DEVELOPMENT PLAN PREFERENCES. These preferences are managed by division.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plan Preferences - Manage</td>
<td>Grants ability to manage Development Plan Preferences, where various Development Plan features can be enabled or disabled according to the needs of the organization. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
</tbody>
</table>

Emails

<table>
<thead>
<tr>
<th>EMAIL NAME</th>
<th>EMAIL DESCRIPTION</th>
<th>ACTION TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plan</td>
<td>This email is triggered when a development plan that</td>
<td>Performance</td>
</tr>
<tr>
<td>Approval Requested</td>
<td>requires approval has been submitted. The user in the approver role receives the email stating that a new development plan now exists in their list of development plans to approve. If the &quot;Plans must be approved by&quot; preference is not selected, this email is not triggered.</td>
<td>Management</td>
</tr>
</tbody>
</table>
Cornerstone May 2018 Release Notes: What's New for May 2018
Page instructions for creating development plans

The following changes have been made to the Page Instructions field:

- The field is enhanced to allow administrators to provide formatting options. Because of this, any existing HTML code is migrated as plain text, which must be removed by administrators and reapplied using the formatting options.
- The character limit for this field is increased from 2,000 to 10,000.

In this field, enter the instructions you want users to see when creating a development plan. The character limit for this field is 10,000 characters. This field does not accept HTML code; any HTML code is automatically removed when the preferences are saved. This field is required.

If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. A Localization flyout opens in which you can provide localized content for all available languages.

Manager Allowances

The Manager Allowances section is unchanged.

The following options are available in the Manager Allowances section:

- Allow managers to create and assign development plans for their subordinates - Select this option to enable the Assignment Selection Criteria option on the Create Development Plan page, enabling managers to create and assign development plans to their subordinates.
- Allow managers to edit their development plans for their subordinates - Select this option to allow managers to edit development plans from the Approve Development Plan page. Deselect this option to prevent managers from modifying their subordinate’s plans.
- Allow managers to approve/deny multiple development plans at once - Select this option to allow managers with the appropriate permission to approve or deny more than one development plan at a time via the Bulk Approval page. Selecting this option also enables the Check All/Uncheck All option on the Approve Development Plans page. If this option is not selected, managers must approve or deny development plans one at a time.
- Plans must be approved by - Select this option if approval is required for new development plans, edits to existing plans, or to cancel plans. Select the role that is responsible for approving these development plan actions. This person receives an email alert (if the corresponding email is active) when one of these events occurs and an item appears in their Actions > Requests page. This can be set to the user’s Manager, Approver, or a custom relationship. If manager or approver is selected, this is the manager or approver that is specified in the user’s user record. If no one is assigned to this role, these actions are automatically approved. See Create Role and Permissions for additional information. If this option is not selected, then development plans do not need approval and no emails are triggered and sent to the approver role.
If this setting is changed, then this immediately impacts existing plans when the changes are saved. For example, if this setting is changed from requiring approval to not requiring approval, then a plan that was previously awaiting completion approval would become Completed.

If the selected approver role changed (e.g., from manager to a custom relationship) and there are existing plans pending approval, the new approver is responsible for approving the plan. If there is no user in the new approver role, then the plan is automatically approved.

If the user gets a new manager or if a new person moves into the approver role, the new approver receives an email for any plans still pending approval. The old approver no longer has the ability to approve or deny the plans.

**User Allowances**

The following changes have been made to the *User Allowances* section:

- The *Permanently delete all comments from development plans XX Days/Weeks/Months after the following events (whichever event occurs first will be used)* option is no longer available.

The following options are available in the *User Allowances* section:

- **Allow users to select a development plan template** - Select this option to enable the *Create Plan from Template* option when creating a development plan. This option appears in the Options menu on the Development Plans Snapshot page. Development plan templates can be created by administrators from the Development Plan Templates page. See [Development Plan Templates](#) on page 385 for additional information.

- **Allow users to view their current transcript learning objects while viewing merged development plans** - This option is currently not being used.

- **Display merged view of user's individual development plans** - This option is currently not being used.

- **Allow users to participate in a threaded discussion about the development plan** - Deselect this option to disable the ability to participate in a threaded discussion within a development plan. This option applies to all development plans of any users within the selected OU. When this option is deselected, all development plans within the selected OU appear without the comment control.
  - If a development plan is assigned, the ability to comment within that development plan is determined by the assignee's OU settings, not those of the assigning user.

**Include Recommended Trainings From**

The following changes have been made to the *Include Recommended Trainings From* section:

- The following options are not available in this section:
  - Competency Models
  - Past Plans

- The following option is added to this section:
Machine Learning

Select each source from which you'd like to include training recommendations. The following options are available:

- **Machine Learning** - When this option is selected, users who are creating or editing their own development plan have the option to view training recommendations based on machine learning, such as training based on the user's position, training the user has saved for later, or recommendations based on the user's learning history. These carousels mirror the functionality that is available in Learner Home. See Learner Home - Training and Banner Carousels.

- **Competency Assessment** - When this option is selected, users who are creating a development plan have the option to view training recommendations based on the results of the user's five most recently completed competency assessments that contain recommendations.

If no recommendation sources are enabled, then the Add Recommended option is not available on the Create Development Plan and Create Development Plan Template page and the Browse Recommended option is not available on the Add Development Objective page.

*Note: The Competency Models option is not currently available. This will be added in the August 2018 release.*

**Default Target/Due Date**

The Default Target/Due Date section is unchanged.

Select a default target due date for action steps or learning objects within an objective. The due dates for the individual action steps and training will determine the overall due date for each plan objective. The due dates for an objective are defined as the latest due date of any action step or learning object within that objective. The due date for the entire plan is the latest due date for any objective in the plan.

The following options are available in the first drop-down menu:

- **Date** - Select this option to select a due date that is relative to the development plan creation date (e.g., 3 months after development plan creation date).
- **End of the year** - Select this option to set the due date to the end of the calendar year.
- **The following date** - Select this option to select a specific date (e.g., 06/15/2018).

*Note: Due dates for objectives are defined as the latest due date for any action step or learning object within that objective. Due dates for development plans are defined as the latest due date for any objective within that development plan.*

**Custom Fields**

The following changes have been made to the Custom Fields section:

- New custom fields are now added by selecting the ADD CUSTOM FIELD button. In addition, custom fields are now added via a flyout.
The **Custom Fields** section allows you to add custom fields to development plans. The selected custom fields are included in development plans that are created by clicking the **CREATE NEW PLAN** button from the Development Plans Snapshot page. **Note:** *This does not apply to development plans created from a template.* The fields must be created first from the Custom Fields area of the system. [See Custom Field Admin - Development Plans.](#)

To add a custom field, select the **ADD CUSTOM FIELD** button within the **Custom Fields** section. The Add Custom Field flyout opens. Select the desired custom fields, and select the **SAVE** button.

**Note:** *When adding development plan custom fields to development plans, the custom fields are displayed in the order in which they are created in Custom Field Administration. Because of this, it is important to take consideration when creating custom fields.*

To remove a custom field, select the Remove icon next to the field. If a custom field is removed that exists in a user's development plan, that custom field remains in that development plan.

Select the **Required** option next to a custom field to require users to enter information for that field to submit the development plan. If the **Required** option is not selected, the custom field is optional and users do not have to complete the field.

### Objective Categories

The following changes have been made to the **Objective Categories** section:

- New objective categories are now added by selecting the **ADD OBJECTIVE CATEGORY** button. In addition, objective categories are now added via a flyout.

The **Objective Categories** section allows you to add categories that will be available for users to select for their development plan objectives. The categories must be created first from the Objective Categories administration page. [See Development Plan Objective Categories on page 379](#) for additional information.

To add an objective category, select the **ADD OBJECTIVE CATEGORY** button within the **Objective Categories** section. The Add Objective Category flyout opens. Select the desired categories, and select the **SELECT** button.

To remove an objective category, select the Remove icon next to the category. If an objective category is removed that is used in a user's development plan, that category remains in that development plan. If the default category is removed, the first category in the table is automatically selected as the new default.

The Default category is the category that is automatically selected for new development plan objectives. Users can change the category, as needed. To change the Default category, select the **Make Default** link next to the appropriate category. This change is applied to new objectives that are added after the change is saved.

### Activity Type

The following changes have been made to the **Activity Type** section:
New activity types are now added by selecting the **ADD ACTIVITY TYPE** button. In addition, activity types are now added via a flyout.

The **Activity Type** section allows you to add activity types that will be available for users to select for their development plan activities. The activity types must be created first from the Activity Types administration page. See **Development Plan Activity Types** on page 382 for additional information.

To add an activity type, select the **ADD ACTIVITY TYPE** button within the **Activity Type** section. The Add Activity Type flyout opens. Select the desired activity types, and select the **SELECT** button.

To remove an activity type, select the Remove icon next to the activity type. If an activity type is removed that is used in a user’s development plan, that activity type remains in that development plan. If the default activity type is removed, the first activity type in the table is automatically selected as the new default.

The Default activity type is the activity type that is automatically selected for new development plan activities. Users can change the type, as needed. To change the Default activity type, select the **Make Default** link next to the appropriate activity type. This change is applied to new activities that are added after the change is saved.

**Development Plan Categories**

The following changes have been made to the **Development Plan Categories** section:

- New development plan categories are now added by selecting the **ADD DEVELOPMENT PLAN CATEGORY** button. In addition, development plan categories are now added via a flyout.

The **Development Plan Categories** section allows you to add development plan categories that will be available for users to select for their development plan. The development plan categories must be created first from the Development Plan Categories administration page. See **Development Plan Categories** on page 376 for additional information.

To add a development plan category, select the **ADD DEVELOPMENT PLAN CATEGORY** button within the **Development Plan Categories** section. The Add Development Plan Category flyout opens. Select the desired categories, and select the **SELECT** button.

To remove a category, select the Remove icon next to the category. If a category is removed that is used in a user’s development plan, that category remains associated with that development plan. If the default category is removed, the first category in the table is automatically selected as the new default.

The Default category is the category that is automatically selected for new development plans. Users can change the category, as needed. To change the Default category, select the **Make Default** link next to the appropriate category. This change is applied to new development plans that are created after the change is saved.

**Overwrite Settings**
Choose whether or not to overwrite custom settings for child division OUs. If you choose to overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.

If this option is unselected, then only the child OUs that do not have customized settings will be updated, as well as any OUs that are added in the future.

A child OU that has not been customized always inherits from the parent, regardless of whether this option is selected.

An OU is considered customized if its preferences or settings have been changed.

**Save/Cancel**

Select the **SAVE** button to save all changes to the page. Or, select the **CANCEL** button to discard any unsaved changes.
Development Plan Categories

If the Redesigned Development Plans functionality is enabled, the existing Development Plan Categories page is enhanced with the following new features:

- The appearance and functionality of the page is enhanced. The page is now fully responsive, so it can be effectively viewed on a mobile device.
- New development plan categories are now added by selecting the ADD DEVELOPMENT PLAN CATEGORY button. In addition, development plan categories are now added and edited via a flyout.
- When the Active status for a development plan category is changed or when a development plan category is removed, this action is automatically saved by the system.
- The ability to search for existing development plan categories is no longer available.
- The ability to hide inactive development plan categories is no longer available.

Development plan categories enable users to categorize their development plans. From the Development Plan Categories page, administrators can create, view, edit, and manage development plan categories.

To access the Development Plan Categories page, go to ADMIN > TOOLS > PERFORMANCE MANAGEMENT, and in the Development Plan section, select Development Plan Categories.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plan Objective</td>
<td>Grants ability to create and edit objective categories used in the development plans and templates.</td>
<td>Performance - Administration</td>
</tr>
<tr>
<td>Objective Categories - Manage</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Add Development Plan Category

To add a development plan category, follow these steps:

1. Select the **ADD DEVELOPMENT PLAN CATEGORY** button. The Add Development Plan Category flyout opens, where you specify the category name. The character limit for this field is 256. If multiple languages are enabled for your portal, you can provide localized content for all available languages. The category name must be populated for the default language.

2. After entering a name, select the **SAVE** button. The new category appears in the list of categories.
3. After you create a development plan category, you must add them in the Development Plan Categories section of Development Plan Preferences to make them available within a development plan. See Development Plan Preferences.

**Change Active Status**

To make a development plan category active or inactive, select or deselect the Active option next to the category. This action is automatically saved. Development plan categories are active when this option is selected. When a category is inactive, it is not available for selection within the system.

**Development Plan Category Options**

For each existing category, in the Options column you can perform the following actions:

- **Localize/Edit** - Either the Localize or Edit option is available for each item.
  - **Localize** - If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. This option also enables you to edit the category name for the default language.
  - **Edit** - If multi-language is not enabled, select this icon to edit the category name. This opens a flyout in which you can modify the name.
- **Delete** - Select this icon to delete the development plan category. A confirmation pop-up opens. This option is only available if the category is not in use.
Development Plan Objective Categories

If the Redesigned Development Plans functionality is enabled, the existing Objective Categories page is enhanced with the following new features:

- The appearance and functionality of the page is enhanced. The page is now fully responsive, so it can be effectively viewed on a mobile device.
- New objective categories are now added by selecting the **ADD OBJECTIVE CATEGORY** button. In addition, objective categories are now added and edited via a flyout.
- When the Active status for an objective category is changed or when an objective category is removed, this action is automatically saved by the system.
- The ability to search for existing objective categories is no longer available.
- The ability to hide inactive objective categories is no longer available.

Development plan objective categories enable users to categorize their development plan objectives. From the Objective Categories page, administrators can create, view, edit, and manage development plan objective categories.

To access the Objective Categories page, go to **ADMIN > TOOLS > PERFORMANCE MANAGEMENT**, and in the Development Plan section, select **Objective Categories**.

### Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plan Objective Categories - Manage</td>
<td>Grants ability to create and edit objective categories used in the development plans and templates.</td>
<td>Performance - Administration</td>
</tr>
</tbody>
</table>
**Objective Categories**

Categories that are in use cannot be deleted

**Add Objective Category**

<table>
<thead>
<tr>
<th>TITLE</th>
<th>ACTIVE</th>
<th>OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analytical Thinking</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attention to Detail</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Developing Others</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initiative</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planning and Organizing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Solving</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Strategic Thinking</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Add Objective Category**

To add an objective category, follow these steps:

1. Select the **ADD OBJECTIVE CATEGORY** button. The Add Objective Category flyout opens, where you specify the objective category name. The character limit for this field is 256. If multiple languages are enabled for your portal, you can provide localized content for all available languages. The objective category name must be populated for the default language.

2. After entering a name, select the **SAVE** button. The new category appears in the list of objective categories.
3. After you create an objective category, you must add them in the *Objective Categories* section of Development Plan Preferences to make them available within a development plan. *See Development Plan Preferences.*

**Change Active Status**

To make an objective category active or inactive, select or deselect the *Active* option next to the category. This action is automatically saved. Objective categories are active when this option is selected. When a category is inactive, it is not available for selection within the system.

**Objective Category Options**

For each existing objective category, in the Options column you can perform the following actions:

- **Localize/Edit** - Either the Localize or Edit option is available for each item.
  - **Localize** - If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. This option also enables you to edit the category name for the default language.
  - **Edit** - If multi-language is not enabled, select this icon to edit the objective category name. This opens a flyout in which you can modify the name.
- **Delete** - Select this icon to delete the objective category. A confirmation pop-up opens. This option is only available if the objective category is not in use.
Development Plan Activity Types

If the Redesigned Development Plans functionality is enabled, the existing Activity Types page is enhanced with the following new features:

- The appearance and functionality of the page is enhanced. The page is now fully responsive, so it can be effectively viewed on a mobile device.
- New activity types are now added by selecting the **ADD ACTIVITY TYPE** button. In addition, activity types are now added and edited via a flyout.
- When the Active status for an activity type is changed or when an activity type is removed, this action is automatically saved by the system.
- The ability to search for existing activity types is no longer available.
- The ability to hide inactive activity types is no longer available.

Development plan activity types enable users to categorize their development plan activities. From the Activity Types page, administrators can create, view, edit, and manage development plan activity types.

To access the Activity Types page, go to **ADMIN > TOOLS > PERFORMANCE MANAGEMENT**, and in the Development Plan section, select the **Activity Types** link.

### Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plan Activity Types - Manage</td>
<td>Grants ability to create and edit activity types used in the development plans and templates. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
</tbody>
</table>
Add Activity Type

To add an activity type, follow these steps:

1. Select the **ADD ACTIVITY TYPE** button. The Add Activity Type flyout opens, where you specify the activity type name. The character limit for this field is 256. If multiple languages are enabled for your portal, you can provide localized content for all available languages. The activity type name must be populated for the default language.

2. After entering a name, select the **SAVE** button. The new type appears in the list of activity types.

3. After you create an activity type, you must add them in the **Activity Types** section of Development Plan Preferences to make them available within a development plan. See Development Plan Preferences.
Change Active Status
To make an activity type active or inactive, select or deselect the **Active** option next to the type. This action is automatically saved. Activity types are active when this option is selected. When a type is inactive, it is not available for selection within the system.

Activity Type Options
For each existing activity type, in the Options column you can perform the following actions:

- **Localize/Edit** - Either the Localize or Edit option is available for each item.
  - **Localize** - If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. This option also enables you to edit the category name for the default language.
  - **Edit** - If multi-language is not enabled, select this icon to edit the activity type name. This opens a flyout in which you can modify the name.
- **Delete** - Select this icon to delete the activity type. A confirmation pop-up opens. This option is only available if the activity type is not in use.
Development Plan Templates

If the Redesigned Development Plans functionality is enabled, the existing Development Plan Templates page is enhanced with the following new features:

- The appearance and functionality of the page is enhanced. The page is now fully responsive, so it can be effectively viewed on a mobile device.
- Administrators can no longer add development plan categories from this page.
- Administrators can no longer search for templates.
- The option to copy and print a template is not available.

Development plan templates allow an administrator to create a predefined development plan, including objectives, training, and action items that a user can access and then modify to match their specific needs. When creating a template, the administrator selects a specific user population that can view and request the template. For example, if an administrator is creating a development plan template for managers, they can configure the availability so that it is only available to managers. Or, if an administrator is creating a development plan template for the marketing department, the administrator can configure the availability so that it is only available to users in the marketing department.

The Development Plan Templates page enables administrators to view, manage, and create development plan templates.

To access the Development Plan Templates page, go to ADMIN > PERFORMANCE, and in the Development Plan section, select Plan Templates.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plan Categories - Manage</td>
<td>Grants ability to create and edit categories used to classify development plans. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
<tr>
<td>Development Plan Templates - Manage</td>
<td>Grants ability to create and edit development plan templates that can be made available for use by end users. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
</tbody>
</table>
Add New Template

Select this button to create a new development plan template. This opens the Create Development Plan Template page. See Create/Edit Development Plan Template on page 387 for additional information.

Templates Table

All existing templates are displayed in the table. The following information is displayed for each template:

- Template - This is the template title.
- ID - This is the system-generated ID that is associated with the template.
- Category - This is the development plan category that was selected for the template.
- Date Created - This is the date on which the template was created.

Actions

The following actions may be available in the Actions column:

- Edit - Select this option to edit the development plan template. See Create/Edit Development Plan Template on page 387 for additional information.
- Delete - Select this option to delete the development plan template. The deleted template will no longer be available for users to use to create a development plan.
Create/Edit Development Plan Template

If the Redesigned Development Plans functionality is enabled, the existing Create Development Plan Template page is enhanced with the following new features:

- The appearance and functionality of the page is enhanced. The page is now fully responsive, so it can be effectively viewed on a mobile device.
- The **Description** field is enhanced to allow administrators to provide formatting options. This field no longer accepts HTML code. Any existing HTML code is migrated as plain text, which can be removed by administrators and reapplied using the formatting options.
- The process of adding objectives is streamlined and is now completed on a separate page.
- The Availability is now managed via a flyout.

Development plan templates allow an administrator to create a predefined development plan, including objectives, training, and action items that a user can access and then modify to match their specific needs. When creating a template, the administrator selects a specific user population that can view and request the template. For example, if an administrator is creating a development plan template for managers, they can configure the availability so that it is only available to managers. Or, if an administrator is creating a development plan template for the marketing department, the administrator can configure the availability so that it is only available to users in the marketing department.

To create a development plan template, go to **ADMIN > PERFORMANCE > PLAN TEMPLATES**. Then, click the **ADD NEW TEMPLATE** button.

To edit a development plan template, go to **ADMIN > PERFORMANCE > PLAN TEMPLATES**. Next to the plan you are editing, select the Edit icon.

**Permissions**

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plan Templates - Manage</td>
<td>Grants ability to create and edit development plan templates that can be made available for use by end users. This is an administrator permission.</td>
<td>Performance Administration</td>
</tr>
</tbody>
</table>
General Information

Begin defining the development plan template by entering the following basic information about the plan:

- **Template Title** - Enter a title for the development plan template. This title appears on the Development Plan Templates page. The character limit for this field is 3,000 characters. This field is required. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages.

- **Category** - From the drop-down list, select a category for the development plan template, which is intended to help organize development plans. Selecting a development plan category is optional. Administrators can configure which categories are available to select by configuring the Development Plan Preferences. See Development Plan Preferences on page 367 for additional information.

- **Description** - Enter an overview of the development plan template, including its purpose or focus. This field can be formatted using the text formatting options. The character limit for this field is 3,000 characters. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages.

Custom Fields

Custom fields can be added to a template by selecting the ADD CUSTOM FIELD button. The selected custom fields are included in any development plan created using this template. The fields must be created first from the Custom Fields area of the system. See Custom Field Admin - Development Plans.

Objectives

Development plans are creating by adding development objectives to outline what you are trying to achieve in your development plan. Objectives are the target areas of the plan. For example, if you are creating a development plan to improve your communication skills, you may create an objective to improve your writing skills. This objective should contain all of the training and actions you need to complete in order to achieve the objective, such as completing writing classes or shadowing a writer at your organization.

To add an objective to the development plan template, select the ADD OBJECTIVE button. This opens the Add Development Objective page where you can define the objective. Begin by providing an overview of the objective:

- **Objective Title** - Enter a title for the development plan. This title appears on your Snapshot: Development Plans page as well as anywhere else your plan is visible. The character limit for this field is 3,000 characters. This field is required.

- **Category** - From the drop-down list, select a category for the objective, which is intended to help organize development plan objectives. Selecting an objective category is optional. If there are no categories available, then this drop-down is hidden. Administrators can configure which categories are available to select by configuring the Development Plan Preferences. See Development Plan Preferences on page 367 for additional information.
Learning and Development - This section provides different ways for you to add learning and development actions to your plan. The following options may be available:

- **Search for Learning** - Select this option to search for learning opportunities that may support your development objective. See the Add Objective - Search for Learning section below for additional information.
- **Add Development Action** - Select this option to add an action step that is required to achieve the development objective. See the Add Objective - Add Development Action section below for additional information.

After defining the objective, select one of the following options:

- **SAVE AND RETURN TO PLAN** - Select this button to save the objective and return to the Create a Plan page.
- **SAVE AND ADD ANOTHER** - Select this button to save the objective and begin adding another objective to the plan.

### Add Objective - Search for Learning

The SEARCH FOR LEARNING option is only available to organizations that are using the Learning functionality. Select this option to search for learning opportunities that may support your development objective. For example, if you are creating an objective to improve your writing skills, you may search for online classes related to writing. The following learning types cannot be added to a development plan: Certification, Cohort.

To search for learning items:

1. In the Learning and Development section, select the SEARCH FOR LEARNING button.
2. From the Add Learning page, select the Add to Objective link for each item you want to add. If a learning item is already in the plan, then "Included in Plan" is displayed.
3. Select the RETURN TO OBJECTIVE button to add the selected items to your development plan.
4. Set a due date for the item by selecting the Due Date field. Administrators can configure the default due date by configuring the Development Plan Preferences. See Development Plan Preferences (Redesign).

- **Note:** The overall due date for a development plan is the latest due date for any objective within the development plan. The due date for an objective is the latest due date for any learning item or action step within the objective.

### Add Objective - Add Development Action

Select this option to add an action step that is required to achieve the development objective. For example, if you are creating an objective to improve your writing skills, you may add a development action to shadow the Technical Writer in your organization for one hour to learn some of their best practices.

To add a development action:

1. In the Learning and Development section, select the ADD DEVELOPMENT ACTION button.
2. From the Development Action flyout, enter the following information:
A. Description - Enter a description of an action that must be completed to achieve the objective. The character limit is 3,000.

B. Activity Type - From the drop-down menu, select the activity type that corresponds with the action you are adding.

C. Due Date - Set a due date for the item by selecting the Due Date field. Administrators can configure the default due date by configuring the Development Plan Preferences. See Development Plan Preferences (Redesign).
   - Note: The overall due date for a development plan is the latest due date for any objective within the development plan. The due date for an objective is the latest due date for any learning item or action step within the objective.

D. Progress - If there is already progress made on the action step at the time it is added to the plan, you may update the percentage complete at that time. If the step has not been started, enter 0, and if the step is complete, enter 100.

3. Select the DONE button to save the development action.

### Availability

This section enables you to determine which users can create a development plan using this template.

Select the SELECT USERS button to open the Select Users flyout. From the drop-down menu, select the user criteria type, such as User, Group, and OU type. You can select any combination of criteria to create the availability, and the selected criteria appear in the Selected tab.

### Save Template / Cancel

When you are finished creating the template, select the SAVE TEMPLATE button. The template will be available to users who are within the configured availability.

To discard the template or any unsaved changes, select the CANCEL button.
Development Plans Snapshot

If the Redesigned Development Plans functionality is enabled, the existing Development Plans Snapshot page is enhanced with the following new features:

- The Development Plans Snapshot page now serves as the Development Plans homepage. The previously existing Development Plan Overview page is no longer available.
- The Primary Plan is more prominently displayed in a **Primary Plan** section at the top of the page, while all other plans are displayed in an **Other Plans** section.
- The option to View Merged Plans is no longer available.

To access the Development Plans Snapshot page:

- Go to **PERFORMANCE > DEVELOPMENT PLANS**.
- Go to **HOME > UNIVERSAL PROFILE**. Select the Snapshot tab. Then, select the Development Plans widget.

### Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plans - Approve</td>
<td>Grants ability to approve or deny development plans that are pending the user's approval. This is a manager/approver permission.</td>
<td>Performance</td>
</tr>
<tr>
<td>Development Plans - Manage</td>
<td>Grants ability to create, edit and manage development plans for self (and others depending on role and permissions). This is an end user permission. For organizations using the Redesigned Development Plans functionality, the Snapshot - Development Plans permission enables user to create, edit, and manage development plans. However, users must also have the &quot;Development Plans - Manage&quot; permission to create a development plan.</td>
<td>Performance</td>
</tr>
<tr>
<td>MyTeam Development Plans</td>
<td>Grants ability for manager (or others depending on constraints) to view and manage progress of development plans via MyTeam and Talent Profile. Managers can also edit a subordinate's development plan. This permission can be constrained by OU, User's OU, User's Direct</td>
<td>Performance</td>
</tr>
</tbody>
</table>
Reports, User, and User Self and Subordinates. The permission constraints determine for which users the Dev Plans tab is available when viewing a user in My Team. **Note:** By design, for any My Team permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role. **Note:** If the user’s permission is also constrained by User Self and Subordinates, then this overrides the User’s Direct Reports constraint.

For organizations using the Redesigned Development Plans functionality, this permission enables the user to access the Development Plans List page.

| Snapshot - Development Plans | Enables user to view the Development Plans widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User’s OU, User Self and Subordinates, User, User’s Self, User’s Manager, User’s Superiors, User’s Subordinates, User’s Direct Reports, and Employee Relationship. **Best Practice:** For most users, this permission should be constrained by User Self and Subordinates. For organizations using the Redesigned Development Plans functionality, this permission also grants the ability to create, edit, and manage development plans. In order to create a development plan, users must also have the Development Plans - Manage permission. | Universal Profile |
## Development Plan

### Primary Plan

<table>
<thead>
<tr>
<th>Plan Name</th>
<th>Status</th>
<th>Due Date</th>
<th>Created</th>
<th>Complete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Manager Plan for Promotion</td>
<td>Past Due</td>
<td>5/15/2017</td>
<td>6/15/2017</td>
<td>20%</td>
</tr>
<tr>
<td>Team Leader Plan for Promotion</td>
<td>Past Due</td>
<td>5/15/2017</td>
<td>6/15/2017</td>
<td>1%</td>
</tr>
<tr>
<td>Sales Manager Plan for Promotion</td>
<td>Past Due</td>
<td>5/15/2017</td>
<td>6/15/2017</td>
<td>0%</td>
</tr>
</tbody>
</table>

### Other Plans

<table>
<thead>
<tr>
<th>Plan Name</th>
<th>Status</th>
<th>Due Date</th>
<th>Created</th>
<th>Complete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improve Writing Skills</td>
<td>Not Started</td>
<td>7/3/2018</td>
<td>4/4/2018</td>
<td>0%</td>
</tr>
</tbody>
</table>
Create/Edit Development Plan

If the Redesigned Development Plans functionality is enabled, the process of creating a development plan is enhanced with the following new features:

- The appearance and functionality of the page is enhanced. The page is now fully responsive, so it can be effectively viewed on a mobile device.
- The **Description** field is enhanced to allow administrators to provide formatting options. This field no longer accepts HTML code. Any existing HTML code is migrated as plain text, which can be removed by administrators and reapplied using the formatting options.
- The process of adding objectives is streamlined and is now completed on a separate page.
- Users may be able to use machine learning to get recommended development actions and learning.
- The Assignment process is streamlined and is now managed in a single section.

Employees can collaborate online with their managers to create objective-based development plans and can also design a career path by determining proactive developmental activities and tracking and measuring targeted improvements that coincide with an employee's development plan.

To create a development plan, go to **PERFORMANCE > DEVELOPMENT PLANS**, and click the **CREATE NEW PLAN** button.

To edit a development plan, go to **PERFORMANCE > DEVELOPMENT PLANS**. Next to the appropriate development plan, select the Options drop-down icon 💾, and select Edit.

**Permissions**

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign OU</td>
<td>Grants ability to create and assign Development Plans to all users within specified organizational units or custom groups. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
<tr>
<td>Development Plans - Manage</td>
<td>Grants ability to create, edit and manage development plans for self (and others depending on role and permissions). This is an end user permission. For organizations using the Redesigned Development Plans functionality, the Snapshot - Development Plans permission enables user to create, edit, and manage development plans. However, users must also have the &quot;Development Plans - Manage&quot; permission to create a development plan.</td>
<td>Performance</td>
</tr>
<tr>
<td>Recommended Learning - View Recommended Learning for Others</td>
<td>Grants ability to view the recommended learning that is generated by machine learning for another user. The availability of this permission is controlled by a backend setting. This permission can be constrained by OU. This is a manager permission.</td>
<td>Performance</td>
</tr>
</tbody>
</table>
General Information

Begin defining the development plan by entering the following basic information about the plan:

- **Plan Title** - Enter a title for the development plan. This title appears on your Snapshot: Development Plans page as well as anywhere else your plan is visible. The character limit for this field is 3,000 characters. This field is required.

- **Category** - From the drop-down list, select a category for the development plan, which is intended to help organize development plans. Selecting a development plan category is optional. If no categories are available, then this field is hidden. Administrators can configure which categories are available to select by configuring the Development Plan Preferences. See Development Plan Preferences on page 367 for additional information.

- **Description** - Enter an overview of the development plan, including its purpose or focus. This field can be formatted using the text formatting options. The character limit for this field is 3,000 characters.

Additional Information

An Additional Information section may appear containing additional questions that must be answered.

**Administrator Note:** When creating a plan from a template, the custom fields within the template override any custom fields that are configured within Development Plan Preferences.

Add Development Objective

Development plans are creating by adding development objectives to outline what you are trying to achieve in your development plan. Objectives are the target areas of the plan. For example, if you are creating a development plan to improve your communication skills, you may create an objective to improve your writing skills. This objective should contain all of the training and actions you need to complete in order to achieve the objective, such as completing writing classes or shadowing a writer at your organization.

To add an objective to the development plan, select the ADD OBJECTIVE button. This opens the Add Development Objective page where you can define the objective. Begin by providing an overview of the objective:

- **Objective Title** - Enter a title for the development plan. This title appears on your Snapshot: Development Plans page as well as anywhere else your plan is visible. The character limit for this field is 3,000 characters. This field is required.

- **Category** - From the drop-down list, select a category for the objective, which is intended to help organize development plan objectives. Selecting an objective category is optional. If there no categories available, then this drop-down is hidden. Administrators can configure which categories are available to select by configuring the Development Plan Preferences. See Development Plan Preferences on page 367 for additional information.
Learning and Development - This section provides different ways for you to add learning and development actions to your plan. The following options may be available:

- Search for Learning - Select this option to search for learning opportunities that may support your development objective. See the Add Objective - Search for Learning section below for additional information.
- Browse Recommended - Select this option to browse all recommended learning and development actions that may support your development objective. See the Add Objective - Browse Recommended section below for additional information.
- Add Development Action - Select this option to add an action step that is required to achieve the development objective. See the Add Objective - Add Development Action section below for additional information.

After defining the objective, select one of the following options:

- SAVE AND RETURN TO PLAN - Select this button to save the objective and return to the Create a Plan page.
- SAVE AND ADD ANOTHER - Select this button to save the objective and begin adding another objective to the plan.

Add Objective - Search for Learning

The SEARCH FOR LEARNING option is only available to organizations that are using the Learning functionality. Select this option to search for learning opportunities that may support your development objective. For example, if you are creating an objective to improve your writing skills, you may search for online classes related to writing. The following learning types cannot be added to a development plan: Certification, Cohort.

To search for learning items:
1. In the Learning and Development section, select the SEARCH FOR LEARNING button.
2. From the Add Learning page, select the Add to Objective link for each item you want to add. If a learning item is already in the plan, then "Included in Plan" is displayed.
3. Select the RETURN TO OBJECTIVE button to add the selected items to your development plan.
4. Set a due date for the item by selecting the Due Date field. Administrators can configure the default due date by configuring the Development Plan Preferences. See Development Plan Preferences (Redesign).
   - Note: The overall due date for a development plan is the latest due date for any objective within the development plan. The due date for an objective is the latest due date for any learning item or action step within the objective.

Add Objective - Browse Recommended

The BROWSE RECOMMENDED option is only available if administrators have enabled recommendations in Development Plan Preferences. Select this option to browse all recommended learning and development actions that may support your development objective. Recommendations may be based on competency assessments or machine
learning. For example, if you have already completed learning items related to business writing, then the system may recommend similar learning items.

To browse recommended learning and development actions:

1. In the Learning and Development section, select the BROWSE RECOMMENDED button.
2. On the Recommended Learning & Development Actions page, various carousels of recommendations may be displayed. When editing another user’s development plan, the editor can only view recommended learning for another user if they have the appropriate permission. Select the Add to Objective link for each item you want to add. If a learning item is already in the plan, then "Included in Plan" is displayed.
3. At the top of the page, the Display Recommendations from option displays all potential sources for recommended training and development actions. Select or deselect options to control which recommendations are displayed. Administrators can configure which recommendation sources are available by configuring the Development Plan Preferences. See Development Plan Preferences on page 367 for additional information. The following options may be available:
   A. Machine Learning - When this option is selected, the page displays a carousel of recommended training based on machine learning, such as training based on the user’s position, training the user has saved for later, or recommendations based on the user’s learning history. These carousels mirror the functionality that is available in Learner Home. See Learner Home - Training and Banner Carousels.
   B. Competency Assessments - When this option is selected, the page displays a carousel of recommended training based on the results of the user’s completed competency assessments.
4. Select the RETURN TO OBJECTIVE button to add the selected items to your development plan.
5. Set a due date for the item by selecting the Due Date field. Administrators can configure the default due date by configuring the Development Plan Preferences. See Development Plan Preferences on page 367 for additional information.
   - Note: The overall due date for a development plan is the latest due date for any objective within the development plan. The due date for an objective is the latest due date for any learning item or action step within the objective.

Add Objective - Add Development Action
Select this option to add an action step that is required to achieve the development objective. For example, if you are creating an objective to improve your writing skills, you may add a development action to shadow the Technical Writer in your organization for one hour to learn some of their best practices.

To add a development action:

1. In the Learning and Development section, select the ADD DEVELOPMENT ACTION button.
2. From the Development Action flyout, enter the following information:
A. Description - Enter a description of an action that must be completed to achieve the objective. The character limit is 3,000.

B. Activity Type - From the drop-down menu, select the activity type that corresponds with the action you are adding.

C. Due Date - Set a due date for the item by selecting the Due Date field. Administrators can configure the default due date by configuring the Development Plan Preferences. See Development Plan Preferences (Redesign).

   o Note: The overall due date for a development plan is the latest due date for any objective within the development plan. The due date for an objective is the latest due date for any learning item or action step within the objective.

D. Progress - If there is already progress made on the action step at the time it is added to the plan, you may update the percentage complete at that time. If the step has not been started, enter 0, and if the step is complete, enter 100.

3. Select the DONE button to save the development action.

Assignment

Depending on your role in the organization and your security permissions, you may be able to assign a development plan to other users. This section enables you to determine who is assigned the development plan.

Note: When editing a development plan, the Assignment section is no longer available because the plan has already been assigned. Individuals may be able to edit their own instance of the development plan.

The following assignment options may be available:

   o Self Only - Select this option to only assign the plan to you.
   o My Team - Select this option to assign the plan to members of your team, which may include you.
   o Custom Assignment - Select this option to assign the plan to any combination of users, organizational units (OUs), and groups.

Assignment - My Team

Select this option to assign the plan to members of your team, which may include you. This option is only available if you are a manager with direct reports. Administrators can prevent managers from assigning a development plan to their direct reports by configuring the Development Plan Preferences. See Development Plan Preferences on page 367 for additional information.

When this option is selected, a table displays all of your direct reports, alphabetized by last name.

   o Select the Include Self checkbox to include yourself in the assignment.
   o Select the My Team checkbox to automatically select all users on your team.
   o Select the checkbox to the left of a direct report to assign the development plan to the user. All direct reports are selected by default.
To select all direct reports, select the **My Team** checkbox. To deselect all direct reports, deselect this checkbox.

To include a direct report's subordinates in the assignment, select the **Include Subordinates** checkbox to the right of the user.

- This option can only be selected for direct reports who are already selected. If a direct report is not selected, the **Include Subordinates** option for that direct report cannot be selected.
- To include the subordinates for all selected direct reports, select the **Include All** checkbox.

**Assignment - Custom Assignment**

Select this option to assign the plan to any combination of users, organizational units (OUs), and groups.

When this option is selected, a **SELECT USERS** button is available. Select this button to open the Select Users flyout. From the drop-down menu, select the user criteria type, such as User, Group, and OU type. You can select any combination of criteria to create the assignment, and the selected criteria appear in the Selected tab. You must have permission to assign OU development plans to select an OU type as a criterion.

**Designate this as the Primary Plan for assignees**

Select this option to automatically set this development plan as the primary plan for all users who are assigned the plan. This option is only available until the plan is submitted.

**Submit Plan / Save as Draft / Discard Changes**

When you are finished creating your plan, select the **SUBMIT PLAN** button to send your development plan to the appropriate approving user; the plan status is Pending Approval. If approval is not required, the plan is automatically approved. Once a development plan is approved, it is available for you to begin updating your progress.

If you are creating a plan, but are not ready to submit, select the **SAVE AS DRAFT** button. This saves the plan in Draft status and you may continue editing it prior to submission.

To discard the plan or any unsaved changes, select the **DISCARD CHANGES** button.
Create Development Plan from Template

If the Redesigned Development Plans functionality is enabled, the process of creating a development plan from a template is enhanced with the following new features:

- The appearance and functionality of the pages and workflows are enhanced. The page is now fully responsive, so it can be effectively viewed on a mobile device.
- The Description field is enhanced to allow administrators to provide formatting options. This field no longer accepts HTML code. Any existing HTML code is migrated as plain text, which can be removed by administrators and reapplied using the formatting options.
- The process of adding objectives is streamlined and is now completed on a separate page.
- Users may be able to use machine learning to get recommended development actions and learning.
- The Assignment process is streamlined and is now managed in a single section.

Development plan templates allow an administrator to create a predefined development plan, including objectives, training, and action items that a user can access and then modify to match their specific needs. When creating a template, the administrator selects a specific user population that can view and request the template. For example, if an administrator is creating a development plan template for managers, they can configure the availability so that it is only available to managers. Or, if an administrator is creating a development plan template for the marketing department, the administrator can configure the availability so that it is only available to users in the marketing department.

When development plan templates are created and made available by administrators, you can use them to assist in creating your development plan. When you selects a plan template, all of the information in the template is added to a development plan, at which point you can modify or remove any of the objectives, learning items, or action steps. The development plan name, description, etc. default to those of the template, but you may modify them as appropriate.

To create a development plan using a template, go to PERFORMANCE > DEVELOPMENT PLANS. Then, select the Options button and select the Create Plan from Template link. This option is not available if no templates are available.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign OU Development Plans</td>
<td>Grants ability to create and assign Development Plans to all users within specified organizational units or custom groups. This is an administrator permission.</td>
<td>Performance - Administration</td>
</tr>
<tr>
<td>Development Plans - Manage</td>
<td>Grants ability to create, edit and manage development plans for self (and others depending on)</td>
<td>Performance</td>
</tr>
</tbody>
</table>
role and permissions). This is an end user permission. For organizations using the Redesigned Development Plans functionality, the Snapshot - Development Plans permission enables user to create, edit, and manage development plans. However, users must also have the "Development Plans - Manage" permission to create a development plan.

**Development Plan Templates**

Choose a template to create a development plan from.

<table>
<thead>
<tr>
<th>Template</th>
<th>ID</th>
<th>Category</th>
<th>Date Created</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Skills</td>
<td>Preview</td>
<td>BVVIIKDF</td>
<td>4/5/2018</td>
<td>Apply Template</td>
</tr>
</tbody>
</table>

**Preview Template**

To view a template before selecting it, select the **Preview** link for the template. A preview of the template opens in a flyout. You can then select the **APPLY** button within the flyout to begin creating a development plan from the template.

**Select Template for Development Plan**

To select a template, select the **Apply Template** link for the template. This creates a new development plan with the information contained in the selected template. You can then modify or remove most of the information as needed. Any custom fields that were added to the template will appear in the plan, which overrides any custom fields that were added via Development Plan Preferences.

*See Create/Edit Development Plan on page 395 for additional information.*
Manage Development Plan

If the Redesigned Development Plans functionality is enabled, the process of managing and updating a development plan is enhanced with the following new features:

- The appearance and functionality of the page is enhanced. The page is now fully responsive, so it can be effectively viewed on a mobile device.
- Users may now add attachments to a development plan.
- The History section is not currently available.
- The option to print the plan is not currently available.

The Manage Plan page enables users to view their overall progress, edit the plan, launch learning items, update plan progress, view and add comments, and add attachments.

To manage an existing development plan, go to PERFORMANCE > DEVELOPMENT PLANS. Then, select the title link for the development plan.
Options

The following options may be available in the Options menu:
Edit Development Plan - Select this option to edit the details of the plan, such as title, category, description, and objectives. See Create/Edit Development Plan on page 395 for additional information.

Plan Overview
At the top of the page, an overview of the development plan is displayed. This includes the following information:

- Due Date - **Note:** The overall due date for a development plan is the latest due date for any objective within the development plan. The due date for an objective is the latest due date for any learning item or action step within the objective.
- Plan Category
- Assignee
- Description
- Progress

Objectives
This section displays each of the plan's objectives, including the learning items and action steps within the objective.

To access a learning item, select the Launch link next to the item.

To update the progress for an action item, using the progress slider next to the item. When you update the progress, this action is automatically saved by the system, and a confirmation message appears at the top of the page.

You can add comments to an objective by selecting the ADD A COMMENT button below the objective. These comments should be specific to the objective. The character limit for comments is 5,000. This option is only available if enabled by the administrator in Development Plan Preferences. See Development Plan Preferences on page 367 for additional information.

Plan Comments
You can add comments to your overall plan by selecting the ADD A COMMENT button in the Plan Comments section. For example, you may add a comment to explain your recent efforts toward this plan. You manager can then reply to your comments or they can add an unrelated comment. The character limit for comments is 5,000. This option is only available if enabled by the administrator in Development Plan Preferences. See Development Plan Preferences on page 367 for additional information.

To reply to a comment, select the Reply link below the comment. You are also able to edit or delete your own comment by selecting the appropriate link. A comment cannot be deleted if there are replies to the comment.

Attachments
You can attach files to your development plan when managing the plan. Each plan is limited to 25MB of attached items, and a maximum of 50 files may be attached.
The following file types are supported:

- Audio:
  - mid
  - m4a
  - mp3
  - wav

- Compressed
  - zip

- Data
  - xls/xlsx

- Image
  - bmp
  - gif
  - jpeg/jpg
  - png

- Presentation
  - pps/ppsx
  - ppt/pptx

- Project
  - mpp

- Recording
  - arf

- Text
  - doc/docx
  - dot/dotx
  - htm/html - The ability to upload htm/html files is controlled by a backend setting.
  - pdf
  - txt
  - csv
  - rtf

- Video
  - avi
  - flv
  - m4v
  - mpeg/mpg
  - mp4
  - rm
  - wma/wmv
Approve Development Plans

If the Redesigned Development Plans functionality is enabled, the existing Development Plan Approval page is enhanced with the following new features:

- The appearance and functionality of the page is enhanced. The page is now fully responsive, so it can be effectively viewed on a mobile device.

The Development Plan Approval page displays all development plans that are pending your acceptance, cancellation, or completion approval. You have the option to approve or deny each request individually or in bulk.

The Development Plan Approval page can be accessed in the following ways:

- From the Welcome Page Inbox, click the View Development Plans link. The Inbox link indicates how many development plans are pending your approval.
- From the Snapshot Development Plans page, select the Approve Plans option from the OPTIONS menu.

**Note:** These options are not available if development plans do not require approval or if you are not responsible for approving development plans.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plans - Approve</td>
<td>Grants ability to approve or deny development plans that are pending the user's approval. This is a manager/approver permission.</td>
<td>Performance</td>
</tr>
</tbody>
</table>

Development Plan Approval

Pending Development Plans

<table>
<thead>
<tr>
<th>Employee Name</th>
<th>Plan Title</th>
<th>Status</th>
<th>Date Submitted</th>
<th>Due Date</th>
<th>Progress</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charles Co...</td>
<td>Development Plan 2017</td>
<td>Pending Acceptance</td>
<td>4/30/2018</td>
<td>7/29/2018</td>
<td>0%</td>
</tr>
<tr>
<td>Charles Co...</td>
<td>Improve Writing Skills</td>
<td>Pending Acceptance</td>
<td>4/30/2018</td>
<td>7/29/2018</td>
<td>0%</td>
</tr>
</tbody>
</table>

[Deny] [Approve]
Approve/Deny Plans

To approve or deny a plan, select the checkbox to the left of the employee's name, and then select the APPROVE or DENY button.

You can also approve or deny all plans in bulk by selecting the checkbox at the top of the Employee Name column and then selecting the appropriate action button. This Select All checkbox is only available if enabled by the system administrator.

The plan's status is dependent on the following:
  o Plan Denied - If the plan was denied, then the plan's status is Plan Denied.
  o Not Started - If the plan was approved and progress is 0%, then the plan's status is Not Started.
  o In Progress - If the plan was approved and progress is greater than 0% but less than 100%, then the plan's status is In Progress.
  o Pending Completion Approval - If the plan was approved and progress is 100%, then the plan's status is Pending Completion Approval.
  o Past Due - If the plan was approved and it is past the due date, then the plan's status is Past Due.
  o Cancelled - If the plan was Pending Cancellation Approval and this request was approved, then the plan's status is Cancelled.
Performance Review - Development Plan Section

If the Redesigned Development Plans functionality is enabled, development plans can be created or updated during a Development Plan section of a performance review. This is previously existing functionality. The Development Plan Preferences are respected.

The user's primary development plan is pulled in to the Development Plan section of the performance review. If the user's primary plan changes while the performance review is open, the user is notified within the Development Plans section of the review, and they are given the option to sync the new or updated primary plan into the review and remove the previous plan from the review. When the new plan is synced with the review, any comments or modifications that were added to the plan within the review are not saved.
Succession Task - Development Plan Sub-step

If the Redesigned Development Plans functionality is enabled, development plans can be created or updated during a Development Plan section of a succession task. This is previously existing functionality.

The functionality within performance reviews is unchanged.
Competency Assessments

If the Redesigned Development Plans functionality is enabled, development actions can be added to a competency and suggested as a result of a user's competency assessment score. This is previously existing functionality.

The functionality within competencies and competency assessments is unchanged.
Career Center - Career Path

If the Redesigned Development Plans functionality is enabled, users can create a development plan based on the recommended activities or training that is available for a position or competency assessment from the Career Path tab within Career Center. This is previously existing functionality.

The functionality within performance reviews is unchanged.
Not Started Status

Prior to this enhancement, when a development plan had 0% progress, the plan was considered In Progress.

With this enhancement, a development plan has 0%, the plan is considered Not Started. This is a new plan status, which will aid in reporting because managers and administrators can easily identify plans that have not been started.
Development Plan Title Email Tag

This functionality will be available in Stage portals with the April 12th UAT deployment.

With this enhancement, a new DEVPLAN.TITLE email tag is now available. This is available for the legacy and redesigned Development Plans functionality.

This tag displays the title of the development plan, and it is available in the following email triggers:

<table>
<thead>
<tr>
<th>EMAIL NAME</th>
<th>EMAIL DESCRIPTION</th>
<th>ACTION TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development Plan Approval Denied</td>
<td>This email is triggered when a development plan approval request is denied. The user receives the email stating that their Development Plan Approval Request is denied.</td>
<td>Performance Management</td>
</tr>
<tr>
<td>Development Plan Approval Granted</td>
<td>This email is triggered when a user's development plan is approved. This email is sent to the user who submitted the plan.</td>
<td>Performance Management</td>
</tr>
<tr>
<td>Development Plan Approval Requested</td>
<td>This email is triggered when a development plan that requires approval has been submitted. The user in the approver role receives the email stating that a new development plan now exists in their list of development plans to approve. If the &quot;Plans must be approved by&quot; preference is not selected, this email is not triggered.</td>
<td>Performance Management</td>
</tr>
<tr>
<td>Development Plan Assigned</td>
<td>This email is triggered when a development plan has been created by anyone other than the user. The user receives the email stating that a new development plan now exists in their list of development plans.</td>
<td>Performance Management</td>
</tr>
<tr>
<td>Development Plan Cancellation Approval Requested</td>
<td>This email is triggered when a user attempts to cancel a development plan that has been approved and approval/cancellation approval is required. The approval setting is configurable by OU on the Development Plan Preferences page. This email is sent to the user in the approver role. If no approver exists, the development plan is automatically cancelled and no email is sent. If the “Plans must be approved by” preference is not</td>
<td>Performance Management</td>
</tr>
<tr>
<td>Development Plan Due Date Approaching</td>
<td>This email is triggered when a development plan is due. The user receives the email stating that they have a Development Plan due date approaching. Reminder emails can be set similar to other reminder emails.</td>
<td>Performance Management</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Development Plan Item Due Date Approaching</td>
<td>This email is triggered when a development plan item (either an action step or training item) is coming due. The user receives the email stating that they have a Development Plan item due date approaching. Reminder emails can be set similar to other reminder emails.</td>
<td>Performance Management</td>
</tr>
</tbody>
</table>

**Implementation**

This functionality is automatically enabled for all organizations using the Development Plan functionality.
Performance Suite Technology Update

In addition to the functionality your users work with every day, Cornerstone is also making valuable changes behind the scenes and has started moving to a microservices architecture to bring our clients increased stability, flexibility, long-term scalability, and innovation. First announced in October 2017, Cornerstone gradually has started building, updating, and hosting applications and functionality in Amazon Web Services (AWS) data centers. As part of this ongoing process, in the May ’18 Release, we plan to begin moving Development Plans Redesign of Performance to AWS. Other functionality for various modules will be migrated over time without additional AWS announcements.

For more information, please see the announcement in the Success Center.
Planning
Moving Positions (Seats) Enhancements
Moving Positions (Seats) Enhancements Overview

With this enhancement, planners can move positions to different managers within their organization at any month during the plan period.

Prior to this enhancement, users could only move planned positions that they created in the plan, but they could not move real positions that already existed in the organization’s snapshot. Now, planners can move both new and existing positions.

Use Case

A senior leader in the technology division of a software company has committed to a large initiative that will require a permanent shift in his organization’s structure.

Instead of simply adding new positions for the initiative, he wants to reassign teams that had been working on other areas. Looking at the next year, he wants to permanently reassign 15 total employees, in waves over three quarters.

He can use the position move feature to move the first five positions in the first quarter, five more in the second quarter, and five more in the third quarter.

Considerations

- Cannot move positions to which subplans are assigned.
- Subplan cannot be assigned to a moved position.
- Cannot move positions with subordinates (i.e., sub-trees within the org chart). This enhancement only allows moving individual contributor positions (i.e., leaves within the org chart).
- Cannot move positions more than once within the planning period.
- Position moves will generally be included in plan updates. However, there are certain cases in which the planned move is so different than the new snapshot that the planned move will be ignored and the new snapshot will be displayed. In those cases, the user will be given a message explaining that the position move was not included.

Implementation

For portals using Headcount Planning, this functionality is automatically enabled.

Note: Headcount Planning is available by request at an additional cost. Contact your Client Executive for additional information.

Security

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Email Administration - Manage</td>
<td>Grants ability to manage email trigger templates across all active modules in the portal. Enables creating, editing and deleting email message</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Role</td>
<td>Permission</td>
<td>Core Administration</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Global Email Administration - View</td>
<td>Grants view only access to email templates/triggers and email logs at the global level for the portal. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. This is an administrator permission.</td>
<td></td>
</tr>
<tr>
<td>Work Force Planning - Administrator</td>
<td>Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.</td>
<td></td>
</tr>
<tr>
<td>Work Force Planning - Owner</td>
<td>Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.</td>
<td></td>
</tr>
<tr>
<td>Work Force Planning - Reporting Analyst</td>
<td>Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained.</td>
<td></td>
</tr>
<tr>
<td>Work Force Planning - Subplanner</td>
<td>Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.</td>
<td></td>
</tr>
</tbody>
</table>
Move Positions

With this enhancement, a **Move Position** option is added to the actions drop-down that appears next to the position name in the Hierarchy column of the plan page. This option lets planners move positions to different managers within their organization at any month during plan period.

To access the plan, navigate to the Headcount Planning page from your navigation tab (the location may vary based on your portal's configuration). Then, click **GO TO PLAN**.

**Permissions**

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Force Planning - Administrator</td>
<td>Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Work Force Planning - Owner</td>
<td>Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Work Force Planning - Reporting Analyst</td>
<td>Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained.</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Work Force Planning - Subplanner</td>
<td>Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>
To move a position to another manager:

1. Navigate to the plan page.
2. Open one of the plan tabs (not the Summary tab).
3. Click the **Move Position** option from the actions drop-down to the right of the position name.
4. Enter a start date in the Start Date field or use the Calendar icon to select a date.
5. Select the manager within the hierarchy in the Manager field to which you want to move the position.
6. Click OK. This moves the position.
Planning Comments
Planning Comments Overview

With this enhancement, planners can provide qualitative commentary about their plans to others, enabling more seamless collaboration within the application.

Prior to this enhancement, subplans could be submitted for approval, and then either accepted or rejected. But, there was no ability to comment on the submission or approval or any other steps in the workflow. Now, planners can comment on areas of the plan to which they have access, reducing any back-and-forth exchanges between senior planners and subplanners or amongst co-planners.

Use Case

1. A senior leader in the technology division of a software company is given a planning target by his manager. The manager has put careful thought into a plan that meets that target.
2. When the senior leader submits the plan for approval, he wants to give a brief explanation of the strategy he laid out in his plan. The plan in some ways speaks for itself, but it would save his manager time and effort to get an overview.
3. He can use the Comments section to write a few comments to his manager. His manager can in turn respond back after reviewing the plan to provide follow-up questions/comments.
4. The head of the company can also see all of the comments.

Implementation

For portals using Headcount Planning, this functionality is automatically enabled.

*Note: Headcount Planning is available by request at an additional cost. Contact your Client Executive for additional information.*

Security

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Email Administration - Manage</td>
<td>Grants ability to manage email trigger templates across all active modules in the portal. Enables creating, editing and deleting email message templates for various system actions and workflows. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. This is an administrator permission.</td>
<td>Core Administration</td>
</tr>
<tr>
<td>Global Email Administration - View</td>
<td>Grants view only access to email templates/triggers and email logs at the global</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>
This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. This is an administrator permission.

| Work Force Planning - Administrator | Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission. |
| Work Force Planning - Owner | Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained. |
| Work Force Planning - Reporting Analyst | Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained. |
| Work Force Planning - Subplanner | Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports. |
View and Add Comments

You can now add comments when submitting actions for plans. Comments can be added when assigning subplans, submitting a subplan step, and accepting/rejecting a subplan. Comments are entered into a new Comments section that is available on the associated pop-up when looking at a specific area of the plan. The Comments section also displays comments that have already been added by other users.

To add comments when submitting a subplan:

1. From the main Headcount Planning page, click GO TO PLAN. This opens the plan.
2. Click Show Comments from the actions drop-down for the main position. This opens the Comments pop-up.
3. Click ADD A COMMENT in the pop-up.
4. Enter comments in the Share your comment box.
5. Click COMMENT. This adds the comment to the position.

Comments can be viewed by any user who has access to the specific area (subplan) of the plan. They can also post their own comments to the plan or subplan.
Recruiting
Accept/Decline Offer Letter on Mobile Device
Accept/Decline Offer Letter on Mobile Overview

With this enhancement, applicants can now accept/decline offer letters via a mobile-friendly experience on the candidate’s My Profile page on the career site.

Use Case

Meg the Applicant needs to accept her offer letter but does not have a desktop computer. She would like a quick and user friendly way to accept the offer via her mobile device.

1. Meg accesses her My Profile page from her mobile device.
2. She opens the offer from her Pending Tasks.
3. She views, accepts, and signs the offer directly from her mobile device.

Implementation

This functionality is automatically enabled for all organizations using Recruiting.
Accept Decline Offer Letter

Applicants can now accept/decline offer letters via a mobile-friendly experience on the candidate’s My Profile page on the career site.

To accept or decline an offer letter:

1. Open your My Profile page on the career site.
2. Tap LAUNCH to open the offer letter page.
3. Tap the offer letter icon to view the offer letter.
4. Open any additional attachments by tapping the icon for the attachment. Note: This section is hidden if there are no additional attachments.
5. Select Accept or Decline from the Response drop-down. Note: You may be asked to upload a signed offer letter document to serve as your acceptance of the offer. In such cases, you cannot submit your offer acceptance until the document is uploaded.
6. Enter your name in the Full Name field. This serves as your signature.
7. Enter your email address in the Email field.
   - If you are using an email address that is associated with a social network account, then you will be required to create a password in order to sign the offer letter.
8. Enter your career site password in the Password field.
   - Forgot Password - If you do not know your password, tap Forgot Password to reset your password. Once you have reset your password, you are redirected back to the offer letter page. Note: The Password field does not display if you are required to upload a signed offer letter document because you are not being asked to sign the document electronically.
   - Email Associated with Social Network - If you are using an email address that is associated with a social network account (i.e., LinkedIn), then you will be required to create a password in order to sign the offer letter.
9. Tap SUBMIT. This submits your offer decision.
Meg Offer Letter Temp

Instructions
Please review your offer letter and call us if you have any questions. We are excited to have you join us!

Offer Letter
Meg Offer Letter Temp

Additional Attachments
Additional Attachment #1.doc
Additional Attachment #2.doc
Additional Attachment #3.doc

Response*
Accept

Message
By signing your offer letter electronically, you agree that EngUS Lorem ipsum dolor sit amet, consectetur adipiscing elit. Aenean commodo ligula eget dolor. Aenean massa. Cum sociis natoque penatibus et magnis dis parturient monies, nascetur ridicul

Full Name*

Email*
Add to Move to Requisition Logic Supported in Mobile-Friendly Workflow

*This enhancement will be released as part of a post-release patch.*

With this enhancement, when an applicant is added or moved to a new requisition and some but not all answers have been answered from the first requisition, the applicant will continue with the second application using the mobile-friendly candidate workflow. In addition, the applicant's previously answered questions will populate in the new mobile-friendly workflow.

**Use Case**

1. Scott is a recruiter for IMEC. Scott has self-enabled the new mobile-friendly candidate experience in his Production portal.
2. Alex is interested in a position at IMEC and applies for the Senior Project Manager role. Alex completes the application in the mobile-friendly workflow.
3. Scott really likes Alex but thinks she is more qualified for the Junior Project Manager role. Scott moves Alex to the Junior Project Manager role. There are a few additional questions in the Junior Project Manager role that were not in the original Senior Project Manager Application workflow. Scott invites Alex to apply to the new requisition.
4. Alex receives an email to apply to the Junior Project Manager role. Alex clicks the link to apply and is prompted to sign in. For security reasons, Alex will have to claim her account or log in to continue the new application with her previously answered questions populated.
5. When the application workflow loads, it is in the new mobile-friendly application workflow, not the standard workflow. Alex is taken to page 1 of the application. All previously answered questions from the Senior Project Manager role populate the new application.
6. On page 2, the pre-screening questions are exactly the same on the Senior and Junior Project Manager requisition, so her previously answered questions are populated. On page 3, only some of the pre-screening questions are the same. Because some and not all of the pre-screening questions are the same on page 3, Alex's previously answered pre-screening questions do not populate.

**Considerations**

- The questions in the two requisitions (source and new requisition) have to be exactly the same in order for an applicant's answers to pre-populate.
- If some but not all pre-screening questions in a specific section are the same, then none of the previously answered pre-screening questions will populate.
- The applicant will be taken to the first page of the application workflow, regardless of how many questions are complete.
- Applicants will have to log in or claim their account in order to continue on the new application and have their previously answered questions populate on the new application.
Implementation

This is available in a post-release patch for the May 2018 release for Recruiting clients who have self-enabled the mobile-friendly candidate experience.

For information about enabling the mobile-friendly candidate experience, see the Enable Mobile-Friendly Candidate Experience topic in Online Help.
Apply with LinkedIn (with Apply Starters)
Apply with LinkedIn (with Apply Starters) Overview

Apply with LinkedIn (with Apply Starters) is a plugin that you can implement on your career site, enabling candidates to apply with their LinkedIn profiles in the application workflow. When applying with LinkedIn, a job seeker's profile information instantly populates the resume fields and gets sent directly to the Applicant Tracking System (ATS) upon submission. This makes for a fast and easy candidate experience.

Recruiters can easily view an applicant's LinkedIn profile, getting access to valuable information that cannot always be found on a resume.

Apply with LinkedIn (with Apply Starters) is an evolution to the original plugin and differs from the previous integration in two significant ways:

- **Connect with Applicants Who Start an Application** - Candidates who start but do not complete the application are surfaced as an “Apply Starter” in LinkedIn Recruiter. These candidates have a significantly higher InMail response rate. Recruiters can connect with interested job seekers by messaging those who have started but not completed an application.

- **Increased Conversion Rate** - In the previous version of Apply with LinkedIn, candidates would need to log in to their LinkedIn account to “authenticate” on that customer’s career page, which led to drop-off. With the new Apply with LinkedIn, this additional step of logging in to LinkedIn to complete the application is removed if they have an active LinkedIn cookie tied to their session. This update to Apply with LinkedIn ensures a higher rate of completed applications.

Click here to download the Apply with LinkedIn (with Apply Starters) starter guide.

Features of Apply with LinkedIn (with Apply Starters)

<table>
<thead>
<tr>
<th>WHEN A CANDIDATE CLICKS APPLY WITH LINKEDIN:</th>
<th>OLD INTEGRATION</th>
<th>NEW INTEGRATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefill resume with LinkedIn profile</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create account with LinkedIn email and password</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Option to “create account” on Thank You page</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Available on Standard Application Workflow</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Available on Mobile-Friendly Application Workflow</td>
<td>Yes (Until the end of 2018)</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Use Cases**

- As an administrator who has a LinkedIn Recruiter contract, I would like the ability to support the new LinkedIn integration in my mobile-friendly application workflow so that more applicants complete the application.
o As an administrator who has both the new and old Apply with LinkedIn integration, I would like to use the new integration on mobile-friendly application workflows and the old integration on standard application workflows because that is what is supported.

o As an administrator who only has the new Apply with LinkedIn (with Apply Starters) integration, I would like to know that it is only functional on mobile-friendly experiences in the career site settings so that I know all dependencies.

o As a candidate, I would like the ability to upload my resume in an application via my LinkedIn profile so that it saves me multiple steps in the application and makes it easier to submit my application.

o As a candidate, I would like my LinkedIn profile to prefill my resume details so that I can quickly complete and submit the application.

o As an administrator, I would like to know why I cannot move an applicant to a new requisition on their profile so that I know the system is not broken. There will be a notification that says this applicant has applied with LinkedIn.

o As a recruiter, if I try to move multiple candidates at once to a new requisition, I will be notified that the LinkedIn candidates were not moved. An explanation will be included that lets me know that candidates who apply with LinkedIn cannot be added or moved to another requisition.

o As a candidate who has applied via Apply with LinkedIn (with Apply starters), when I return to the career site to check the progress of my application, I will have to either sign in with LinkedIn or create a password through the Forgot Password or Create Password user flow.

### Implementation

Apply with LinkedIn (with Apply Starters) is available for Recruiting clients who also have LinkedIn Recruiter and/or active LinkedIn Job Slots. The plugin is available without cost to those clients. The plugin must be enabled from the Edge Marketplace. For questions about the plugin, please reach out to your LinkedIn representative.

When enabling Apply with LinkedIn (with Apply Starters) in Edge, you will need to use the LinkedIn account that is tied to LinkedIn Recruiter or the active Job Slots. If an administrator tries to enable Apply with LinkedIn (with Apply Starters) with their personal LinkedIn account, they will receive an error.

Once Apply with LinkedIn (with Apply Starters) is installed via Edge, you will then need to enable it on an individual career site basis in Career Site Settings. The plugin is only compatible with mobile-friendly application workflows.

LinkedIn is sunsetting Apply with LinkedIn 1.0 at the end of 2018. [See Retirement of Apply with LinkedIn 1.0](#) on page 488 for additional information.

If you have both Apply with LinkedIn (with Apply Starters) and Apply with LinkedIn 1.0, the system will automatically use the Apply with LinkedIn (with Apply Starters) for mobile-friendly application workflows.
Considerations

**Will the Reset Password experience be the same in the new integration as the old integration when an applicant is about to sign an offer letter?**
Yes. This process will not change.

**Can all clients use the new integration?**
No. The Apply with LinkedIn (with Apply Starters) integration is only available for those with LinkedIn Recruiter and/or LinkedIn Jobs.

**Will the new integration be supported on both standard and mobile-friendly workflows?**
No, this will only be supported on mobile-friendly workflows.

**Will the career site automatically use the new integration on mobile friendly workflows if both are enabled in Edge?**
Yes. If a client has both the new and old integration, and is leveraging the mobile friendly candidate experience, we will automatically use the new integration.

**Can candidates who applied with Apply with LinkedIn (with Apply Starters) be moved or copied to other requisitions?**
Those who have applied with LinkedIn (with Apply Starters) cannot be moved to other requisitions. This is a setting set by LinkedIn so that all LinkedIn conversion rate and Apply Starter data is accurate.

**Can candidates who applied with Apply with LinkedIn 1.0 continue to be moved or copied to new requisitions?**
Yes. If a candidate applies using the old integration, they can continue to be moved to other requisitions.

**How is the new candidate experience different than the old?**
If an applicant does not have an active LinkedIn cookie, they will click the LinkedIn button twice: once to sign in to LinkedIn, and then again to populate their resume. In addition, LinkedIn applicants will be asked if they want to create an account on the Thank You page.

Security

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Career Site - Manage</td>
<td>Grants ability to access and manage Career Site Management. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Career Site - View</td>
<td>Grants ability to access and view Career Site Management. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Edge Integrations - Manage</td>
<td>Grants access to the Integrations service for Edge Integrate where the administrator can configure, enable, and disable their third-party integrations that are used within the Cornerstone system. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Edge Marketplace - Manage</td>
<td>Grants access to the Marketplace service for Edge Integrate where the administrator can browse and purchase third-party integrations that can be used to extend the Cornerstone system. This permission cannot be constrained. This is an administrator permission.</td>
<td>Edge</td>
</tr>
</tbody>
</table>
Enable Apply with LinkedIn (with Apply Starters)

To enable Apply with LinkedIn (with Apply Starters), complete the following steps:

1. Navigate to Admin > Tools > Edge > Marketplace.
2. Click the Apply with LinkedIn (with Apply Starters) icon. This opens the Edge Integrate page.
3. Click Install. No payment through Edge is required.
4. Configure the integration now.
5. Continue to login to LinkedIn with your corporate LinkedIn recruiter account.
6. After successfully logging in to LinkedIn, you will see an option to enable the new Apply with LinkedIn (with Apply Starters).
7. Click continue to enable Apply with LinkedIn (with Apply Starters).
8. Return to the Edge > Integrations page and toggle LinkedIn (with Apply Starters) on so that the toggle is blue.

Once you have enabled Apply with LinkedIn 2.0, you will then need to enable it on an individual career site basis in Career Site Settings by checking the Allow Apply with LinkedIn option. The plugin is only compatible with mobile-friendly application workflows.

Additional Information

- You must have Cornerstone Recruiting.
- You must have LinkedIn Recruiter and/or LinkedIn Jobs.
- There is no added cost to use Apply with LinkedIn 2.0.
- No migration is required. Cornerstone will automatically look at the appropriate integration based on what is enabled and what application template is being used (either standard or mobile-friendly).
Add/Move LinkedIn Applicants to Another Requisition

Apply with LinkedIn (with Apply Starters) does not come with the ability to add or move LinkedIn applicants to another requisition, as the action would disrupt LinkedIn's conversion rate.

If a recruiter attempts to add/move LinkedIn applicants, an error message displays in the Applicant Action Results pop-up to explain that they cannot be added/moved because they applied with LinkedIn.

What if I select multiple applicants (some who did and some who did not Apply with LinkedIn (with Apply Starters) on the Manage Applicants page and move them all to another requisition? Will they be moved?

Those who did not apply with Apply with LinkedIn (with Apply Starters) will be successfully moved or copied. You will see an error message for those who applied with Apply with LinkedIn (with Apply Starters).
Can I still invite LinkedIn applicants to apply?
Yes. You can still invite LinkedIn applicants to apply by using the Invite to Apply option in the Application Received field on the Applicant Profile > Summary tab.
**Applicant Experience - Apply with LinkedIn (with Apply Starters)**

Applicants can apply with Apply with LinkedIn (with Apply Starters) on mobile-friendly career sites by clicking the **APPLY WITH LINKEDIN** button on the job details page. The applicant's contact information and resume details are automatically prefilled on the application. This saves applicants time in filling out application fields so that they can quickly apply to the job.

Once the applicant applies with LinkedIn, recruiters can view their profile by clicking the LinkedIn icon that appears by the applicant's name when viewing applicant details in Recruiting.

*Note: If resume parsing is not enabled but contact information parsing is enabled, then the contact information will still populate but resume details are not prefilled. If no parsing is enabled, then there are no fields that are prefilled.*

**Account Creation on Career Site**

When an applicant applies with Apply with LinkedIn (with Apply Starters), they are prompted on the Thank You page to create a profile. This allows LinkedIn applicants to set a user name and password for the career site.

With the previous experience with Apply with LinkedIn 1.0, an account was created automatically when applicants applied with LinkedIn. Their LinkedIn user name and password were used to set up the account. This resulted in numerous password resets for applicants when they did not remember (or realize) that their LinkedIn login credentials were used to create the account.

**Visibility on Non-Mobile-Friendly Career Sites**

For mobile-friendly applications that are on a career site that is not mobile-friendly, the Apply with LinkedIn (with Apply Starters) and Apply with Seek options do not appear on the job details page. All social media buttons for mobile-friendly application workflows now live on the Application Workflow page.

**Offer Letters for Apply with LinkedIn (with Apply Starters) Candidates**

For security reasons, when an applicant who has applied with LinkedIn, and has not created an account, accepts or declines an offer letter, they will need to create a password with Cornerstone to submit their responses.
Offer Letter

Offer Letter:

Offer Letter

Additional Attachments:

None

Response:

Decision: Accepted Via Electronic Signature
Message: Please sign the form electronically to accept the offer.
Full Name: samantha
Email: email@email.com
Password: *

Forgot password or need to create a password?

Submit
Compliance Enhancements to Application Workflow

To ensure GDPR and OFCCP compliance, this enhancement updates compliance in the application workflow for veteran status and the option to be searchable for other positions. The following compliance updates are made with this enhancement:

Veteran Status (Part 60-300)

For portals with the Veteran Status (Part 60-300) enabled, the following updates are made to provide additional explanation of "veteran":

- **Standard Application Workflows** - When compliance questions have been added to a workflow and Veteran Status (Part 60-300) has been enabled, additional text defining "veteran" is explained.
- **Mobile-Friendly Application Workflows** - When compliance questions have been added to a workflow and Veteran Status (Part 60-300) has been enabled, additional text defining "veteran" is explained and is controlled in an expandable and collapsible link.

![Compliance Questions](image-url)
Allow Me to Be Searchable

With this enhancement, the **Consider me for other positions and allow my information to be searchable** option on the My Profile page will be unchecked by default. Prior to this enhancement, the option was checked by default.

In addition, on the Submit section of an application, if an applicant has the option to declare if they would like to be considered for other positions and appear in the candidate search results, the option is unchecked by default.

Clients who do not give candidates the option to uncheck or check this question when submitting the application will continue to see all candidates in search results.
Custom Reports - Recruiting Fields

With this enhancement, a new field is added for Recruiting Custom Reports.

**Note:** This field will also be available in the new Reporting 2.0 functionality, which is in the Early Adopter phase for the May ‘18 release. See Reporting 2.0 (Early Adopter) Overview on page 183 for additional information.

To create Recruiting Custom Reports, go to REPORTS > CUSTOM REPORTS. Then, select Recruiting Report from the NEW drop-down.

**Permissions**

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Recruiting Report - Create</td>
<td>Grants ability to create and edit Custom Recruiting reports. This permission can be constrained by Division, Position, Location, and User's Direct Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Recruiting Report - View</td>
<td>Grants ability to view results of Custom Recruiting reports created by self or shared by others. This permission can be constrained by Division, Position, Location, and User's Direct Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>

**Applicant Fields**

The following field is added to the Applicant fields section:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>FIELD DESCRIPTION</th>
<th>FIELD TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-specific Comment</td>
<td>Enables recruiter to view user-specific comments (comments that are addressed specifically to applicants as opposed to the requisition related-comments).</td>
<td>Text</td>
</tr>
</tbody>
</table>
Hiring Manager Shortlist Summary Email Tag SSO Enhancement

*This enhancement will be released as part of a post-release patch.*

For organizations that use SSO, the REVIEW.APPLICANT.RESUME.SUMMARY email tag will now be SSO enabled so that hiring managers do not have to log in to Cornerstone to review applicants. Many hiring managers do not log into Cornerstone on a daily basis, so needing to remember a new login only to review resumes is unnecessary.

Hiring managers and recruiters want to be able to use their SSO functionality so that they can quickly and easily review candidates. Prior to this enhancement, hiring managers were sent to the custom login page after clicking the REVIEW.APPLICANT.RESUME.SUMMARY email tag.

For organizations that use SSO, hiring managers will be automatically logged in when they click on an applicant within the Review Applicant Resume Summary email. For organizations that do not use SSO, hiring managers will be directed to the custom log in page.

**Availability Post-Release**

This enhancement will be available in a post-release patch.
Manage Candidates Early Adopter
Manage Candidates (Early Adopter) Overview

With this enhancement, a new Manage Candidates page is available for Recruiting. Manage Candidates provides a one-stop shop where recruiters can quickly and effectively assess and manage all their candidates through the hiring process on one page. Further, recruiters can change the status of candidates from across all their requisitions using a single Change Status page.

Manage Candidates is an alternative to the current Manage Applicants, New Submissions, and Suggested Referrals experiences. From this page, you can:

- View Suggested Referrals, New Submissions, and other applicants across requisitions in a single view
- View a candidate's name, phone number, email address, requisition (title and requisition ID), current status, days in status, and submission date
- Search for candidates by name, email address, phone number, and parsed resume keyword
- Sort candidates by application/referral submission date, candidate first name, days in status, and requisition ID
- Filter candidates by requisition, status, or both
- Change status for one or more candidates in one or multiple requisitions
- Change status for suggested referrals, new submissions, and all other statuses in one place
- View the next available status for one or more candidates when changing status
- Assign disposition(s) to one or more candidates
- Click a candidate’s name redirects to Applicant Profile (Suggested Referrals excluded)
- Click candidate's email address to send email
- Click requisition title to edit requisition
- View/download a candidate's resume and application
- View the Manage Candidates experience on a mobile device

Click here for instructions to enable Manage Candidates.

Should my organization be an Early Adopter of Manage Candidates?

Consider the following when determining whether being an Early Adopter for Manage Candidates is right for your organization:

- My organization wants to view and manage candidates on a mobile device
- My organization wants to change status across all requisitions
- My organization understands that not all planned Manage Candidate features are currently available in the Early Adopter program, but we are eager to start using the features that are available now.
- My organization does not need to configure which columns appear on the table and the column order to begin using the Manage Candidate experience. We understand that this is planned.
My organization can begin using the Manage Candidate experience using only Requisition and Status filters. We understand that additional filters and the ability to configure which filters are displayed is planned.

**Considerations**

- Access to the Manage Candidates page is only available to users with Requisition: Manage permission and/or Requisition: Owner permission.
- Job seekers who used Connect With Us but have not applied to or been suggested for a job will not be displayed on the Manage Candidates page.
- Searching:
  - When a search is performed it will search across the following fields:
    - Name
    - Email
    - Phone Number
    - Parsed Resume Keyword
  
  Note: You cannot specify which field you are searching for (i.e., “First name = John”).
  - Searches are performed using a "starts with" method. This means that a search for "Art" will yield "Arthur" but not "Martin."
    - Names will be searched by first name and last name individually, meaning if I search for “John”, it will match a candidate “John Newton,” as well as “Sally Johnson”
    - Exception: Japanese or Chinese characters are searched using a "contains" method. This means that a search for "Art" would yield “Arthur” and "Martin" as a match.
  - In some cases the data shown in Manage Candidates may temporarily not match what is seen in Manage Applicants and other pages. There may be a delay of up to 20 minutes before changes to candidate information are reflected.

**Implementation**

Manage Candidates will be available for Recruiting clients through the Feature Activation Preferences page in Stage portals in May 2018.

Manage Candidates will be available in Production portals for Recruiting clients in a post-release patch.

**Frequently Asked Questions**

**Who will appear in the Manage Candidates table?**
Suggested Referrals, New Submissions, and Active Applicants will appear in the table. These candidates are all associated with jobs and will appear with their current status and requisition. Job seekers who used “Connect With Us” but have not applied to or been suggested for a job will not be displayed.

**What is the default view for the Manage Candidates page?**
The recruiter will only see active candidates (not in a Closed or Hired status) for open jobs for which the recruiter is a requisition owner. The recruiter can change the filter to show other candidates, but this will always be the default view upon returning to this page.

If a candidate is associated with more than one requisition, what will be displayed?
There will be a record for each requisition with which a candidate is associated. For example, if John Smith is a “New Submission” for Req1 and Req2, he would appear twice when filtering only for candidates in “New Submission” status.

Can users configure which filters are available?
With the May ’18 release, only requisition and status filters will be available. Additional filters and the ability to configure which filters are displayed may be available in a future release.

Can users configure which columns appear on the table and the order of the columns?
With the May ’18 release, the candidate table will not be configurable. The ability to configure the table may be available in a future release.

When searching, can users specify which field they want to search (e.g., Only search in "email address" field)?
No. Searching is across the available fields. For example, a search for “New” will show matches for “John Newton” (name) as well as Newton@emailaddress.com (email).

Will the Manage Candidates page achieve feature parity with the Manage Applicants page?
Additional features from the Manage Applicants page may be added to the Manage Candidates page in a future release.

Is Manage Candidates FedRAMP certified?
The project is in the process of becoming FedRAMP certified. While awaiting certification, United States government clients will not be able to self-enable this functionality so that they stay in compliance.

Will the new Manage Candidates page work with the existing Manage Applicants/Applicant Profile/New Submissions/Suggested Referral pages?
Yes, the new Manage Candidates page will work in tandem with the legacy pages. What this means is that if you change a candidate’s status via the New Submissions page, the change will also show up on the new Manage Candidates page. The same applies in the reverse so that any changes on the new Manage Candidates page will appear on the legacy pages.

What if the preference is not enabled for changing the date of the status change?
If the Allow applicant status change date option is unchecked in General Preferences, then the option to change the date of a status change does not display in the Change Status flyout. The date of change will be the date you made the change in the system, which is consistent with current functionality.

What if the client does not allow anyone from New Submissions to go to a status past the In Review status?
All required statuses will be validated and candidates will not be able to skip a required status. The only caveat is that it will no longer be necessary to click the Complete button on a status. As long as the candidate has been in the required status, they can move forward.

**What happens if I have moved someone from Suggested Referral to Invite to Apply?**

With this enhancement, you will be able to see referrals on the Manage Candidates page, with detail as to whether they have been “Invited to Apply” or “Declined.” Since this information will now be displayed on the Manage Candidates page, recruiters will be able to more easily follow up with candidates that have been “Invited to Apply.”

**Can I move candidates from a Closed or Hired status to another status from the Manage Candidates page?**

Yes, you will now be able to move candidates from a Closed or Hired status to another status from the Manage Candidates page, in addition to the Applicant Profile.

**What if I’m changing a candidate’s status at the same time as another recruiter?**

A validation message will appear to whoever changes the status second to indicate that another user recently updated the status. The message will prompt the user to refresh the page in order to view and change the status. If you tried to change the status for multiple candidates, when you receive this message, some of the candidates may already be successfully processed. The message at the top of the flyout will indicate any successfully processed candidates.

**How do I quickly send a suggested referral another invitation to apply?**

Leave the Invite to Apply status as is in the Change Status flyout. Then, click **SAVE**. This will resend the Invitation to Apply email, provided the email is configured and active in Email Administration.

**Security**

The following new permission applies to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recruiting Feature Activation Preferences - Manage</td>
<td>Grants ability to access and manage Feature Activation Preferences in Recruiting. This permission cannot be constrained. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
</tbody>
</table>

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requisition: Manage</td>
<td>Grants ability to access and manage all requisitions regardless of ownership (constraints permitting). This permission also grants read-only access to the Applicant Review tab when creating or editing a job</td>
<td>Recruiting</td>
</tr>
</tbody>
</table>
| Requisition: Owner | Enables owner to access requisitions and applicants for requisitions for which they are an owner. This permission also grants read-only access to video interviews that are completed by applicants via HireVue. For portals with Referral Suite enabled, this permission also enables requisition owners to edit the referral source on the Applicant Profile page. This permission cannot be constrained.  

**Note:** This is a dynamically assigned permission that is not available in Security Role Administration. If the user is removed as an owner, the permission is revoked for the associated requisition. This permission cannot be manually assigned. Also, if a user has both the permission necessary to manage requisitions and be a requisition owner, the constraints of the **Requisition: Manage** permission overrule those of the **Requisition: Owner** permission. For requisition owners that do not also have permission to manage requisitions, only certain fields are editable when editing a requisition. | Recruiting |
Feature Activation Preferences - Enable Manage Candidates

Feature Activation Preferences is a new page that provides top-level system administrators and recruiting administrators the option to self-enable Recruiting functionality.

With this enhancement, the Manage Candidates functionality must be self-enabled on the Feature Activation Preferences page. This is a one-time self-enablement and cannot be reversed.

After self-enabling, users will still be able to access and use the Manage Requisitions, Manage Applicants, New Submissions, and Suggested Referral pages as they would normally. The Manage Candidates page will be accessible by its own link in the navigation menu.

To enable the functionality, Click the ACTIVATE button. Then, click ACTIVATE on the confirmation pop-up.

Once the functionality is enabled, a Manage Candidates link will automatically be added beneath the Manage Requisition link in the Recruit navigation tab. The link will be visible by all users with permission to manage requisitions or for requisition owners. This applies to users with one or both of these permissions in any organizational unit (OU).

*Activation Availability Note*: If Manage Candidates is not yet available to enable in your portal, the following message will appear: "There are no features to activate at this time."

![Feature Activation Preferences](image-url)
Manage Candidates Page

The Manage Candidates page provides a one-stop shop where recruiters can quickly and effectively assess and manage all their candidates through the hiring process.

Prior to this enhancement, recruiters had to navigate to various pages to manage their candidates (Manage Requisition, Submitted Referrals, New Submissions, Manage Applicants, etc.). Further, recruiters could only view candidates for one requisition at a time. With the new Manage Candidates page, recruiters will be able to view all of their candidates across their requisitions in a single screen, eliminating the need to navigate to other pages in the system. Recruiters will also be able to search and filter to find specific candidates, as well as view their candidates on a mobile device.

To access the Manage Candidates page after enabling, go to RECRUIT > MANAGE CANDIDATES.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicants: Status Change</td>
<td>Grants ability to change applicant status for any applicant to whom the user already has access. This permission cannot be constrained.</td>
<td>Recruiting</td>
</tr>
<tr>
<td>Requisition: Manage</td>
<td>Grants ability to access and manage all requisitions regardless of ownership (constraints permitting). This permission also grants read-only access to the Applicant Review tab when creating or editing a job requisition. This permission can be constrained by OU, User's OU, and Grade.</td>
<td>Recruiting</td>
</tr>
<tr>
<td>Requisition: Owner</td>
<td>Enables owner to access requisitions and applicants for requisitions for which they are an owner. This permission also grants read-only access to video interviews that are completed by applicants via HireVue. For portals with Referral Suite enabled, this permission also enables requisition owners to edit the referral source on the Applicant Profile page. This permission cannot be constrained.</td>
<td>Recruiting</td>
</tr>
</tbody>
</table>

Note: This is a dynamically assigned permission that is not available in Security Role Administration. If the user is removed as an owner, the permission is revoked for the associated requisition. This permission cannot be manually assigned. Also, if a user has both the permission necessary to manage requisitions and be a requisition owner, the constraints of the |
Requisition: Manage permission overrule those of the Requisition: Owner permission. For requisition owners that do not also have permission to manage requisitions, only certain fields are editable when editing a requisition.

Change Candidate Status
The Change Status feature on Manage Candidates lets you change the status of one or more candidates across all your requisitions from a single page. All candidates can be changed to the same status at once, or you can change individual candidate statuses.

Having a single page to change statuses can save recruiters an inordinate amount of time.

To change the status:
1. Check the Select All box to change the status of all candidates on the page. Or, choose individual candidates by checking the box to the left of the candidate's name.
   Or, you can also individually change status for a candidate by clicking the candidate's current status in the Manage Candidates table.
2. Click the CHANGE STATUS button. This opens the Change Status flyout. For each candidate, the next status in the workflow is auto-populated.
   A. **Bulk Status Change** - Change all candidates to the same status by selecting a status from the Change all statuses to drop-down. Required statuses cannot be skipped, so the status for some candidates may need to be changed individually. The statuses that appear in the drop-down are common statuses that are used across requisitions.
   B. **Individual Status Change** - Change the status individually by choosing the status from the drop-down in the New Status column for each candidate. Required statuses cannot be skipped.

A validation message will be shown for each candidate that has an error, prior to being able to save the new status.

When changing candidates to the Closed status, you can select a disposition in bulk or for each candidate individually.

**Note:** Suggested referrals will appear with the status of Suggested Referrals. You can only change a suggested referral to Invite to Apply or Decline. As with existing functionality, candidates in the Invite to Apply or Decline status cannot be moved into another status. However, you can change a suggested referral from Invite to Apply to Decline or vice-versa, which is consistent with current functionality.

3. Select a status change date in the Date column. The date cannot be a future date, or earlier than the start date of the current status, or earlier than the date the requisition was created.
   A. **Bulk Date Change** - Select a status change date for all candidates by using the Change all dates to field at the top of the flyout. Or,
   B. **Individual Date Change** - Select a status change date for individual candidates from the date option in the Date column.
Note: This option does not display if the Allow applicant status change date option is unchecked in General Preferences.

4. Remove candidates from the Change Status flyout by clicking the X in the last column. This option is helpful if you change your mind about wanting to change a candidate’s status.

5. Click SAVE. This updates the status in all locations in the system. If you change a candidate from New Submission or Suggested Referral, the candidate will no longer appear on those respective pages.

View Candidate Statuses

The total number of active candidates is displayed at the top of the page, along with the number of active candidates in each status. The statuses reflect all relevant candidates, based on the filters that have been applied.

By default, candidates in the Closed and Hired status do not display. You can view these candidates by toggling the Show only active candidates filter.

Status Colors

Each status has its own color bar. The color bar appears in the dashboard at the top of the page, and also appears in the Status column in the table. This can help to quickly identify a candidate’s status in the table.

Search Candidates

You can search for candidates by name, email address, phone number, and parsed resume keyword. Simply enter the search term(s) in the Search candidates and resume field and the page will update to only show candidates that match the search criteria.

Note: You cannot specify which field you are searching for (i.e., “First name = John”).

- Searches are performed using a "starts with" method. This means that a search for "Art" will yield "Arthur" but not "Martin."
Names will be searched by first name and last name individually, meaning if I search for “John”, it will match a candidate “John Newton,” as well as “Sally Johnson”

Exception: Japanese or Chinese characters are searched using a "contains" method. This means that a search for "Art" would yield “Arthur” and "Martin" as a match.

Note: Anonymized New Submissions are not searchable by their anonymized data (name, email address, phone number). However, other data from their resume is searchable.

Search Suggestions
- Name
- Email Address
- Phone Number
- Job Title*
- Education Details*
- Skills*

*The resume fields that are available for keyword search may vary depending on which fields are mapped for the resume, as well as whether or not resume parsing is turned on in the application workflow.

Searchable Resume Field Types
When using the search box to search for data in parsed resume fields, the following types of resume fields are used in the search:
- Short Text Box
- Scrolling Text Box
- Dropdown
- Attribute List

Candidate/Recruiter Language
Resume keywords are not translated. If a recruiter searches for terms in a language that the candidate did not use, their search may not result in a match. For example, if a candidate applies in French (France), and a recruiter whose language is English (UK) enters an English search term (e.g., "accounting"). then the search will not return results for candidates whose resume data is in French (France).

Filters
You can decide which requisitions and statuses you would like to view on the Manage Candidates page by configuring the filters in the Filters panel.

You can remove all filters by clicking Reset. Filters can be collapsed.

The following filters are available:
- Requisition
Show only open reqs - By default, candidates in the Closed and Hired statuses are not displayed on the Manage Candidates page. To view these candidates, toggle the **Show only open reqs** option.

All Jobs - Click **All Jobs** to show candidates in all jobs you have access to, regardless of whether or not you are a requisition owner. To view all jobs, a user must have permission to manage candidates. The candidates that display are the candidates that are within your permission constraints.

My Jobs - Click **My Jobs** to show candidates in jobs for which you are a requisition owner.

Select Requisition - Check the box next to the requisitions you would like to view. To filter the list, enter keywords into the search field. The list updates automatically to match the search criteria. The most recently created jobs will appear at the top of the list. If no requisitions are selected, candidates from all of the displayed requisitions will appear.

Current Status

Show only active candidates - By default, only open requisitions are shown on the page. To show requisitions in other statuses, toggle the **Show only active candidates** option.

Select Status - Check the box next to the statuses you would like to view. The candidates table updates automatically to show candidates who are in the selected statuses. Default and custom statuses are available as filters, as well as referral statuses including Suggested, Invited to Apply, and Declined.

Tip: Searching by status can help you quickly find candidates in one or more statuses across your requisitions, or within one or more particular requisitions. This can provide helpful flexibility to enable the recruiter to execute their work as they see fit.
### Candidates Table

<table>
<thead>
<tr>
<th>Position</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting Manager - New</td>
<td>8</td>
</tr>
<tr>
<td>Senior Accountant (req33)</td>
<td>2</td>
</tr>
<tr>
<td>Benefit Service Represent...</td>
<td>1</td>
</tr>
<tr>
<td>CSR - West (req20)</td>
<td>6</td>
</tr>
<tr>
<td>Customer Service Repres...</td>
<td>5</td>
</tr>
<tr>
<td>Senior Accountant (req10)</td>
<td>1</td>
</tr>
<tr>
<td>Senior Accountant (req9)</td>
<td>39</td>
</tr>
<tr>
<td>Accountant - Entry Level I...</td>
<td>2</td>
</tr>
<tr>
<td>Accountant (req7)</td>
<td>14</td>
</tr>
<tr>
<td>Customer Service Repres...</td>
<td>1</td>
</tr>
<tr>
<td>Accountant (req5)</td>
<td>3</td>
</tr>
</tbody>
</table>

### Current Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Review</td>
<td>35</td>
</tr>
<tr>
<td>Interview</td>
<td>15</td>
</tr>
<tr>
<td>Invited to Apply</td>
<td>1</td>
</tr>
<tr>
<td>New Submission</td>
<td>20</td>
</tr>
<tr>
<td>Offer Letter</td>
<td>6</td>
</tr>
<tr>
<td>Phone Screening</td>
<td>5</td>
</tr>
</tbody>
</table>

Hide or show open requisitions

All Jobs

My Jobs

Search requisition

Show only active candidates
Manage Candidates displays candidates from all the requisitions you can access and that are within your permission constraints. By default, candidates are sorted by newest to oldest submission date. Up to 20 candidates display per page. Additional candidates can be viewed by clicking on the pagination controls at the bottom of the page.

The following information displays for candidates:

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort by</td>
<td>You can sort the candidates table by the following:</td>
</tr>
<tr>
<td></td>
<td>o First Name (A-Z)</td>
</tr>
<tr>
<td></td>
<td>o First Name (Z-A)</td>
</tr>
<tr>
<td></td>
<td>o Req ID (Ascending)</td>
</tr>
<tr>
<td></td>
<td>o Req ID (Descending)</td>
</tr>
<tr>
<td></td>
<td>o Days in Status (Shortest)</td>
</tr>
<tr>
<td></td>
<td>o Days in Status (Longest)</td>
</tr>
<tr>
<td></td>
<td>o Submission Date (Oldest)</td>
</tr>
<tr>
<td></td>
<td>o Submission Date (Newest)</td>
</tr>
<tr>
<td></td>
<td>o Relevance - This setting sorts by the candidate’s relevance to the search</td>
</tr>
<tr>
<td></td>
<td>criteria you entered in the search candidates and resume search field.</td>
</tr>
<tr>
<td>Select All Checkbox</td>
<td>The Select All checkbox is used to quickly select all candidates that</td>
</tr>
<tr>
<td></td>
<td>are visible on the page so that you can change the status of all the</td>
</tr>
<tr>
<td></td>
<td>selected candidates at once. Once candidates are selected, click the</td>
</tr>
<tr>
<td></td>
<td>CHANGE STATUS button to change all the candidates’ status at the same time.</td>
</tr>
<tr>
<td>Select Single Candidate</td>
<td>Each row displays a checkbox next to the candidate’s name. The box is</td>
</tr>
<tr>
<td>Checkbox</td>
<td>used to select candidates for whom you would like to process the Change</td>
</tr>
<tr>
<td></td>
<td>Status action. The box is unchecked by default. Check the box to select a</td>
</tr>
<tr>
<td></td>
<td>candidate. Check the box again to deselect a candidate.</td>
</tr>
<tr>
<td></td>
<td>Once candidates are selected, click the CHANGE STATUS button to change the</td>
</tr>
<tr>
<td></td>
<td>candidates’ status. Alternatively, you can initiate a status change for a</td>
</tr>
<tr>
<td></td>
<td>single candidate by clicking their current status.</td>
</tr>
<tr>
<td>Candidate</td>
<td>The following information displays in the Candidate column:</td>
</tr>
<tr>
<td></td>
<td>o Name - The name displays as a link to the Applicant Profile page, from</td>
</tr>
<tr>
<td></td>
<td>which you can view additional details about the candidate. Click your</td>
</tr>
<tr>
<td></td>
<td>browser’s &quot;Back&quot; option to return to Manage Candidates. All filter settings</td>
</tr>
<tr>
<td></td>
<td>remain upon return.</td>
</tr>
</tbody>
</table>


## FEATURE

**Note:** Suggested Referrals who have applied for a requisition do not have an Applicant Profile. Clicking the name of such a candidate will result in no action.

- Last/Current Job and Company - This is the candidate's most recent job and employer. Note: The data may display as "Not Defined." This is a known issue for which a fix is planned in a post-release patch.
- Phone Number - The candidate’s phone number appears as a link. Click the phone number to call the candidate. This feature is available for both mobile and desktop.
- Email Address - Click the email address to email the candidate. This opens an email pop-up from your email provider.
- Resume/CV - To view/download the applicant's resume/CV, select the Resume icon.
- View Application - To view/download the application, select the View Application icon. This option only displays for internal and external candidates, as well as candidates submitted by a recruiting agency. This option does not display for candidates who are added manually. See View Application as PDF for additional information.
- View LinkedIn Submission - To view the candidate's LinkedIn profile, select the LinkedIn icon.
- View Seek Submission - For candidates who applied using their Seek profile, a Seek icon displays. Click the icon to view the candidate's profile.

**Note:** If the Anonymize personal applicant data for New Submissions option is enabled in Compliance Enablement Preferences, then a New Submission’s name, email address, phone number, and location are hidden. In addition, their PDF application is disabled and their resume is hidden. Contact information for such candidates is not searchable, but these candidates may appear in searches for resume keyword.

<table>
<thead>
<tr>
<th>Location</th>
<th>This column displays the candidate's location, if available. The following location information displays:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td>• State/Region/Province</td>
</tr>
<tr>
<td></td>
<td>• Country</td>
</tr>
<tr>
<td>FEATURE</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Requisition</td>
<td>This column displays the requisition display job title and the requisition ID. For users with permission to manage requisitions or who are a requisition owner, the name appears as a link. Click the name to view and edit the requisition. Click the BACK button to return to Manage Candidates. All filter settings remain upon return.</td>
</tr>
<tr>
<td>Status</td>
<td>This column displays the candidate's current status. Below the status is the number of days since the status was changed. For candidates who have been dispositioned, the disposition reason displays below the status.</td>
</tr>
<tr>
<td>Type</td>
<td>This column indicates whether a submission is Internal or External. The candidate type is not searchable.</td>
</tr>
<tr>
<td>Submission Date</td>
<td>This column displays the date on which the candidate submitted their application, was added by a recruiter or agency, or was submitted as a suggested referred.</td>
</tr>
</tbody>
</table>
Mobile-Friendly Candidate Experience Enhancements
Mobile-Friendly Application Workflow - Custom Integrations
Mobile-Friendly Application Workflow - Custom Integrations Overview

With this enhancement, custom integrations can now be included in mobile-friendly application workflows. Prior to this enhancement, custom integrations were not part of the mobile-friendly application workflow and could not be launched by applicants on the mobile-friendly candidate experience.

Click here to download the Mobile-Friendly Candidate Experience (Early Adopter) starter guide.

Implementation

The ability to add custom integrations is automatically available for all organizations using Recruiting, provided that you have self-enabled the Mobile-Friendly Candidate Experience and that you have at least one custom integration enabled and active in your portal. See Enable Mobile-Friendly Candidate Experience.

Considerations

Adding custom integrations to mobile-friendly application workflows does not guarantee that each integration will be responsive on the application workflow. For an integration to be responsive, it is necessary that the technology for that specific integration is also responsive.

Security

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Workflow Template - Manage</td>
<td>Grants ability to access and manage Application Workflow Templates. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Application Workflow Template - View</td>
<td>Grants ability to access and view Application Workflow Templates.</td>
<td>Recruiting Administration</td>
</tr>
</tbody>
</table>
Add Custom Integration to Application Workflow

With this enhancement, custom integrations can now be included in mobile-friendly application workflows. Prior to this enhancement, custom integrations were not part of the mobile-friendly application workflow and could not be launched by applicants on the mobile-friendly candidate experience.

To create an application workflow template, go to ADMIN > TOOLS > RECRUIT > APPLICATION WORKFLOW TEMPLATES. Then click the Create Template link. On the application workflow template page, select Mobile-Friendly from the Application Type field.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Workflow Template - Manage</td>
<td>Grants ability to access and manage Application Workflow Templates. This permission can be constrained by OU and User’s OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Application Workflow Template - View</td>
<td>Grants ability to access and view Application Workflow Templates.</td>
<td>Recruiting Administration</td>
</tr>
</tbody>
</table>

Add Custom Integration

To add the action item:
1. Click **Add Integration** from the **Add Action** Item option on the application workflow page. This opens the Edit Action Item pop-up.

2. Complete the following fields in the pop-up:
   - **Title** - This is a required field. Enter a title, up to 50 characters.
   - **Instructions** - Enter instructions for the action item. This field is optional. This field accepts HTML, and there is no character limit.
   - **Integration** - Select the integration from the drop-down. The drop-down displays integrations that are defined as active and available to select for application workflows.
   - **Conditionally Administer** - When this option is selected, the assessment step does not appear in the application workflow. Instead, the assessment is only available to the applicant if they do not fail the pre-screening step. In such cases, the assessment is automatically assigned to them and can be accessed from the My Profile > Pending Tasks section page on the career site. This will trigger the Assign Integration Assessment email to be sent to the recipients that are configured for the email, provided that the email is active in **Email Administration**. However, if the applicant fails the pre-screening step, the assessment will not be assigned to them at all.
     
     Also, when the **Conditionally Administer** option is selected, the **Completion Required** option is disabled and no longer selectable.

   - **Completion Required** - Select this option to require applicants to complete the integration step before moving to the next step in the application workflow. Completion occurs when the integration step has received a response from the third party integration partner.
     
     If this option is *not* selected, then the applicant can skip the assessment when completing their application. Once their application is submitted, the assessment is automatically assigned to them and can be accessed on their My Profile page on the career site.

**Preview Application Workflow**

You can preview the custom integration in the workflow by clicking Preview at the bottom of the application workflow page. The preview is read-only.
Applicant Experience - Custom Integration

As with custom integrations for standard application workflows, applicants can launch a custom integration for mobile-friendly application workflows from the application.

Contact Information

For applicants who are not logged in to the career site, the Contact Information section cannot be modified once the applicant launches the integration.

Note: Contact information is entered automatically for applicants who are logged in to the career site.

Required Integration Section

If the integration section is required (indicated by a red asterisk), applicants cannot move forward in the application process until the integration is completed.

Applicant Screened Out Before Integration Section

If the integration section is after a pre-screening questions section and the applicant fails a screen out question, then the applicant will not reach the integration section.

View Integration Results

Recruiters can view the integration results in the following areas of Recruiting:
o Applicant Profile > Statuses > Integration Step
o Manage Applicants
o PDF version of the application
Mobile-Friendly Application Workflow - Preview Workflow
Mobile Friendly Application Workflow - Preview Workflow Overview

*This enhancement was released as part of the 9 March 2018 patch release.*

With this enhancement, you can now preview mobile-friendly application workflows prior to saving the workflow so that you can reconfigure as necessary to achieve the right set-up for your application.

Prior to this enhancement, a preview was not available when creating mobile-friendly application workflows.

**Click here to download the Mobile-Friendly Candidate Experience (Early Adopter) starter guide.**

### Implementation

This functionality is part of the self-enabled Mobile-Friendly Candidate Experience functionality. In order for mobile-friendly application workflows to be available, the Mobile-Friendly Candidate Experience functionality must be self-enabled on the Career Site Management page. *See Enable Mobile-Friendly Candidate Experience.*

### Considerations

The following information does not appear in the preview:

- **Header and Footer** - The header and footer will still be included in the application workflow but is not visible when previewing the workflow.
- **Job Title** - The job title does not display because the application might not be tied to a job requisition yet.
- **Compliance Questions** - The actual compliance questions do not appear in the preview because the application might not be tied to a Location Organizational Unit (OU) yet. If you include instructions with the Compliance Questions section, the instructions will appear in the preview.

### Security

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Workflow Template - Manage</td>
<td>Grants ability to access and manage Application Workflow Templates. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Application Workflow Template - View</td>
<td>Grants ability to access and view Application Workflow Templates.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Role</td>
<td>Permission Description</td>
<td>Module</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Career Site - Manage</td>
<td>Grants ability to access and manage Career Site Management. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Career Site - View</td>
<td>Grants ability to access and view Career Site Management. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Requisition: Manage</td>
<td>Grants ability to access and manage all requisitions regardless of ownership (constraints permitting). This permission also grants read-only access to the Applicant Review tab when creating or editing a job requisition. This permission can be constrained by OU, User's OU, and Grade.</td>
<td>Recruiting</td>
</tr>
</tbody>
</table>
| Requisition: Owner         | Enables owner to access requisitions and applicants for requisitions for which they are an owner. This permission also grants read-only access to video interviews that are completed by applicants via HireVue. For portals with Referral Suite enabled, this permission also enables requisition owners to edit the referral source on the Applicant Profile page. This permission cannot be constrained.  

*Note: This is a dynamically assigned permission that is not available in Security Role Administration. If the user is removed as an owner, the permission is revoked for the associated requisition. This permission cannot be manually assigned. Also, if a user has both the permission necessary to manage requisitions and be a requisition owner, the constraints of the Requisition: Manage permission overrule those of the Requisition: Owner permission. For requisition owners that do not also have permission to manage requisitions, only certain fields are editable when editing a requisition.* | Recruiting                  |
Create Application Workflows - Preview Workflow

With this enhancement, a Preview link is added to the Create Application Workflow page for mobile-friendly workflows. Clicking the link lets you preview the workflow prior to saving it so that you can reconfigure as necessary to achieve the right set-up for your action items.

To create an application workflow template, go to ADMIN > TOOLS > RECRUIT > APPLICATION WORKFLOW TEMPLATES. Then click the Create Template link.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Workflow Template - Manage</td>
<td>Grants ability to access and manage Application Workflow Templates. This permission can be constrained by OU and User’s OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Application Workflow Template - View</td>
<td>Grants ability to access and view Application Workflow Templates.</td>
<td>Recruiting Administration</td>
</tr>
</tbody>
</table>

Action Items in Preview

The preview lets you view the set-up of the actions items in your application workflow so that you get to see what the applicant will see. The functionality of the action items is disabled in the preview, which lets you review your entire workflow quickly without having to engage in the steps for each action.

You can also click SUBMIT to view the Thank You page.
Compliance Questions

The actual compliance questions do not appear in the preview. If you include instructions with the Compliance Questions section, the instructions will appear in the preview.

Header/Footer

The header and footer do not display in the preview. They will still be included in the application workflow but do not appear when previewing the workflow.
Mobile-Friendly Career Sites - Custom Banner Image on Job Details Page
Mobile-Friendly Career Sites - Custom Banner Overview Image on Job Details Page

With this enhancement, administrators can now brand the Job Details page on mobile-friendly career sites by adding a banner image via the Career Site Settings page. The image appears as a bar behind the job details.

**Click here to download the Mobile-Friendly Candidate Experience (Early Adopter) starter guide.**

**Implementation**

This functionality is automatically available for all organizations using Recruiting, provided that you have self-enabled the Mobile-Friendly Candidate Experience. *See Enable Mobile-Friendly Candidate Experience.*

**Security**

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Career Site - Manage</td>
<td>Grants ability to access and manage Career Site Management. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Career Site - View</td>
<td>Grants ability to access and view Career Site Management. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Corporate Preferences - Manage</td>
<td>Grants ability to manage Corporate Preferences, which includes several portal-wide settings. This is an administrator permission.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>
Add Banner Image for Job Details Page

Administrators can now brand the Job Details page on mobile-friendly career sites by adding a banner image via Career Site Settings.

To create a mobile-friendly career site, click the Add Mobile-Friendly Career Site option on the Career Site Management page.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Career Site - Manage</td>
<td>Grants ability to access and manage Career Site Management. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Career Site - View</td>
<td>Grants ability to access and view Career Site Management. This permission can be constrained by OU and User's OU. This is an administrator permission.</td>
<td>Recruiting Administration</td>
</tr>
<tr>
<td>Corporate Preferences - Manage</td>
<td>Grants ability to manage Corporate Preferences, which includes several portal-wide settings. This is an administrator permission.</td>
<td>Core Administration</td>
</tr>
</tbody>
</table>
A **Job Details Banner Image** field is added to the Career Site Settings page. This field lets administrators add a banner image that will appear as a bar behind the job details section on career sites.

To select an image, click the **Job Details Banner Image** drop-down and select from the available images. The images in the drop-down are pulled from **Corporate Preferences**. There must be at least one image available in Corporate Preferences in order to add a banner image. Images cannot be uploaded from the Career Site Settings page.
While there is no required image resolution, we recommend that a high resolution image be used, and that the image is wider than it is tall.

**Note:** If an image is not selected, then the background is gray.

**Permission to Manage Corporate Preferences:** Administrators with permission to manage Corporate Preferences can upload new images from the Corporate Preferences page. Once the image is uploaded and the preferences are saved, the image can be selected from the Job Details Banner Image field.
Mobile-Friendly Career Sites - Social Sharing

With this enhancement, options are added to the Job Details page on mobile-friendly career sites to allow applicants to share jobs on LinkedIn and Facebook. Prior to this enhancement, applicants could only share jobs via email.

These options can be hidden.

Click here to download the Mobile-Friendly Candidate Experience (Early Adopter) starter guide.

Share on LinkedIn

To share on LinkedIn:

1. Click the LinkedIn option in the Share drop-down. This opens a LinkedIn pop-up. The Share an update field will be checked by default.
2. Complete the following information:
   a. Share an update - This option is checked by default. If you are entering an update in the text box, then this option needs to be checked so that the update will appear when you share the job.
   b. Share Text Box - You can enter an update into the text box. The text will appear in your posting along with the shared job
   c. Share With - This option lets you choose with whom you would like to share the job. Select either Public or Connections.
   d. Twitter - Check the Twitter box to share the job on Twitter.
   e. Post to groups - This option lets you post to your groups.
   f. Send to individuals - This option lets you post to individuals.
3. Click SHARE. This shares the job on LinkedIn to the recipients selected in the pop-up. A link to the job will be included in the posting. If you selected the Twitter option, the job
will also be posted to Twitter and will include the link to the job and any text you included.

**Share on Facebook**

To share on Facebook:

1. Click the **Facebook** option in the Share drop-down. This opens the Share on Facebook pop-up.
2. Complete the following information:
   - **Say something about this** - You can enter a comment into the text box. The text will appear in your posting along with the shared job.
   - **Share Options** - Select an option from the drop-down in the bottom-right corner to choose with whom you would like to share the job.
3. Click **SHARE**. This shares the job on Facebook to the recipients selected in the pop-up. A link to the job will be included in the posting, as well as any text you included.

*Note: The Facebook option does not include an additional option to share on Twitter.*

**Hide Social Sharing**

The social sharing options can be hidden by adding additional code to the HTML tab on either the Advanced Header or Advanced Footer. After clicking the HTML tab, enter `<style>` with one or more of the following lines of code in-between:

Hide “LinkedIn” option on Share Button

```
.p-button-dropdown-list [title="LinkedIn"] {
    display:none;
}
```

Hide “Facebook” option on Share Button

```
.p-button-dropdown-list [title="Facebook"] {
    display:none;
}
```
**Applicant Source Name**

Applicants who apply to a job via a shared job posting will have the following source:

- Referral-LinkedIn
- Referral-Facebook

**Implementation**

This functionality is automatically available for all organizations using Recruiting, provided that you have self-enabled the Mobile-Friendly Candidate Experience. See [Enable Mobile-Friendly Candidate Experience](#).
Recruiting Suite Technology Update

In addition to the functionality your users work with every day, Cornerstone is also making valuable changes behind the scenes and has started moving to a microservices architecture to bring our clients increased stability, flexibility, long-term scalability, and innovation. First announced in October 2017, Cornerstone gradually has started building, updating, and hosting applications and functionality in Amazon Web Services (AWS) data centers. As part of this ongoing process, in the May ’18 Release, we plan to begin moving Manage Candidates of Recruiting to AWS. Other functionality for various modules will be migrated over time without additional AWS announcements.

For more information, please see the announcement in the Success Center.
Retirement of Apply with LinkedIn 1.0

LinkedIn is sun-setting their current version of Apply with LinkedIn by the end of 2018. Clients who have a LinkedIn Recruiter contract, or a LinkedIn corporate account with active LinkedIn job slots, can leverage the new Apply with LinkedIn 2.0. The new Apply with LinkedIn 2.0 will only be supported on mobile friendly workflows.
Retirement of Mobile Optimized Career Site Support (August '18 Release)

Following the August '18 Release, Cornerstone will remove the option “Enable Mobile Site” from the Standard Career Site. To create a mobile supported career site after the August '18 Release, clients will need to create a Mobile-Friendly Career Site on the Career Site Management page. Mobile optimized career sites created prior to the August '18 Release will be able to continue to be used but Cornerstone will no longer support fixing defects for mobile optimized career sites and when copied, “Enable Mobile Site” will no longer be an option.
Succession
Custom Reports - Succession Fields

With this enhancement, additional custom reporting fields are now available for succession metric calibration and resume data.

The following fields are now available in the Resume section when creating a custom Resume Report:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>TYPE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resume Last Modified By</td>
<td>Text</td>
<td>This field displays the name of the user who last modified a resume.</td>
</tr>
<tr>
<td>Resume Last Modified Date</td>
<td>Date/Time</td>
<td>This field displays the date and time at which a resume was last modified.</td>
</tr>
</tbody>
</table>

The following field is now available in the User Succession Metrics and Successor Succession Metrics sections when creating a custom Succession Report and in the Position Criteria, Incumbent, and Successor sections when creating a custom Job Pool Succession Report:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>TYPE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
</table>
| [metric name] - Calibration Source | Text      | This field displays from which calibration source a metric value originated. Because SMP Metrics are unique to each organization, the Calibration Source field names will vary. For example, for the "Potential" SMP metric, there will be a "Potential - Calibration Source" field. This field has four possible values:  
  o Helicopter View  
  o Task  
  o Snapshot  
  o Metric Grid Report |

Implementation

This functionality is automatically enabled for all organizations using the Succession module.

Security

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
</table>
| Custom Job Pool | Grants ability to create and edit custom Job Pool           | Reports -
<table>
<thead>
<tr>
<th>Succession Report - Create</th>
<th>Succession reports. This permission can be constrained by Position and User's Direct Subordinates.</th>
<th>Analytics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Job Pool Succession Report - View</td>
<td>Grants ability to view results of custom Job Pool Succession reports created by self or shared by others. This permission can be constrained by Position and User's Direct Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Resume Report - Create</td>
<td>Grants ability to create and edit custom Resume reports. This permission can be constrained by OU, User's OU, User, User's Direct Subordinates, and User Self and Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Resume Report - View</td>
<td>Grants ability to view results of custom Resume reports created by self or shared by others. This permission can be constrained by OU, User's OU, User, User's Direct Subordinates, and User Self and Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Succession Report - Create</td>
<td>Grants ability to create and edit Custom Succession Management (SMP) Reports. This permission can be constrained by OU, User's OU, User Self and Subordinates, User's Direct Subordinates, and User's Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
<tr>
<td>Custom Succession Report - View</td>
<td>Grants ability to view results of Custom Succession Management (SMP) Reports created by self or shared by others. This permission can be constrained by OU, User's OU, User Self and Subordinates, User's Direct Subordinates, and User's Subordinates.</td>
<td>Reports - Analytics</td>
</tr>
</tbody>
</table>
View
Display Country Name on Org Chart Flyout

With this enhancement, the **Country** field on the user flyout on the Org Chart page will display the full name of the country instead of the ISO code.

For example, prior to this enhancement, Sweden appeared as SWE. Following this enhancement, the country will be spelled out.

![User Flyout with Country Name](image)

**Implementation**

This functionality is automatically enabled for all organizations using Cornerstone HR, View, or Succession.

**Security**

The following existing permissions apply to this enhancement:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org Chart - View</td>
<td>Grants access to the new Org Chart page for organizations with Cornerstone HR, Succession, or View. This permission can be constrained by OU, User's OU, Users, User's Self, User Self and Subordinates, User's Manager, User's Superiors, Employee Relationship, User's Direct Subordinates, User's Subordinates.</td>
<td>Core</td>
</tr>
</tbody>
</table>
**View People - Additional Fields**

As part of upcoming May and June 2018 patches, new field types can be added as Succession Metric filters and Career Preferences Attribute filters to View People Preferences. The new field types can then be used as filters on the View People page.

**Succession Field Types**

The following additional Succession field types can be added to View People:

- Checkbox - Available 15 June 2018 as part of a patch release
- Dropdown - Available 18 May 2018 as part of a patch release
- Radio Button - Available 15 June 2018 as part of a patch release

**Career Preferences Field Types**

- Location Bank Questions - Available 18 May 2018 as part of a patch release
- Standard and Custom Organizational Unit Type - Available 18 May 2018 as part of a patch release

**Implementation**

On the above-mentioned patch date, this functionality will be automatically enabled for all organizations using View and that also have Succession enabled.

**Security**

The following existing permissions apply to this functionality:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>View People Preferences Page</td>
<td>Grants access to the View People Preferences page, which allows administrators to configure the View People page according to their needs per organizational unit (OU). This permission can be constrained by OU, User’s OU, User, User Self and Subordinates, and User’s Subordinates.</td>
<td>View</td>
</tr>
<tr>
<td>View People: View</td>
<td>Grants access to open View People to see results and share lists. This permission can be constrained by OU, User’s OU, User, User Self and Subordinates, and User’s Subordinates.</td>
<td>View</td>
</tr>
</tbody>
</table>
View People Enhancements
View People Enhancements Overview

This enhancement was released as part of the 9 March 2018 patch release.

With this enhancement, SSO support is added for the deep link that appears in the email when sharing lists from the My Lists page. This allows recipients of a shared list, who have availability to SSO, to access the list directly from the email without being prompted to manually log in to the portal.

In addition, administrators can determine the click behavior of the user card. Prior to this enhancement, the user card opened the employee’s profile within View People. With this enhancement, administrators can redirect to the employee's profile or a specific tab on their Universal Profile page.

Considerations

SSO must be enabled in a portal in order for SSO links to be generated.

Implementation

This functionality is automatically enabled for all organizations using View People.

Security

The following existing permissions apply to this enhancement:

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>View People Preferences Page</td>
<td>Grants access to the View People Preferences page, which allows administrators to configure the View People page according to their needs per organizational unit (OU). This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User's Subordinates.</td>
<td>View</td>
</tr>
<tr>
<td>View People: View</td>
<td>Grants access to open View People to see results and share lists. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User's Subordinates.</td>
<td>View</td>
</tr>
</tbody>
</table>
View People Preferences

This enhancement was released as part of the 9 March 2018 patch release.

With this enhancement, you can now set the click behavior of the user card on the View People page. Prior to this enhancement, clicking the user card opened the employee’s profile page within View People, and the click behavior was not configurable.

To access View People Preferences, go to ADMIN > PREFERENCES > VIEW PEOPLE.

Permissions

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>View People Preferences Page</td>
<td>Grants access to the View People Preferences page, which allows administrators to configure the View People page according to their needs per organizational unit (OU). This permission can be constrained by OU, User’s OU, User, User Self and Subordinates, and User’s Subordinates.</td>
<td>View</td>
</tr>
</tbody>
</table>

Employee Card Configuration

Select Organizational Unit types displayed in the employee cards. Your selections are based on the Organizational Unit types selected as filters above.

- John Doe
  - Division
  - Grade

Select up to 6 fields to display on the expanded card.

- Readiness (Succession)
- Impact of Loss (Succession)
- Potential (Succession)
- Probability of Loss (Succession)
- Employee Performance (Succession)
- Location (Organization)

Set click behavior for the Employee Card.

When the employee card is clicked display the View Employee Profile.
To set the click behavior of the user card, select one of the following options from the drop-down:

- **View Employee Profile** - This opens the employee’s profile page within View People. This is the current click behavior of the user card and is set by default.
- **Universal Profile > Bio** - This will open the Universal Profile > Bio page in a new tab. This option does not display if the Bio page is not available in your portal.
- **Universal Profile > Snapshot** - This will open the Universal Profile > Snapshot page in a new tab. This option does not display if the Snapshot page is not available in your portal.
- **Universal Profile > User Record** - This will open the Universal Profile > User Record page in a new tab.
View People - My Lists

*This enhancement was released as part of the 9 March 2018 patch release.*

With this enhancement, SSO support is added for the deep link that appears in the email that is sent to users when sharing lists from the My Lists page. This allows recipients of a shared list, who have availability to SSO, to access the list directly from the email without being prompted to manually log in to the portal.

**Note:** *The deep link is automatically added to the email when sharing lists. The link does not need to be configured.*

To access the Share list with others pop-up, click the list mode icon on the View People page. This opens the My Lists page. Then, click the Share option from the drop-down for the list.

**Permissions**

<table>
<thead>
<tr>
<th>PERMISSION NAME</th>
<th>PERMISSION DESCRIPTION</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>View People: View</td>
<td>Grants access to open View People to see results and share lists. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User's Subordinates.</td>
<td>View</td>
</tr>
</tbody>
</table>

![Share list with others](image)